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     [bookmark: pgfId-998217]About This Guide
      
      
 
     
 
 
     [bookmark: pgfId-1014625]This preface introduces  Cisco ASA Series General Operations ASDM Configuration Guide and includes the following sections:
 
     
     	 [bookmark: pgfId-1014626]Document Objectives
 
     	 [bookmark: pgfId-1016990]Related Documentation
 
     	 [bookmark: pgfId-1017013]Conventions
 
     	 [bookmark: pgfId-1016998]Obtaining Documentation and Submitting a Service Request
 
    
 
     
      [bookmark: pgfId-1009635][bookmark: 86515]Document Objectives
 
      [bookmark: pgfId-1009638]The purpose of this guide is to help you configure general operations for the ASA using ASDM. This guide does not cover every feature, but describes only the most common configuration scenarios.
 
      [bookmark: pgfId-1022646]This guide applies to the Cisco ASA series. Throughout this guide, the term “ASA” applies generically to supported models, unless specified otherwise.
 
      
       
     
 
     
 
     [bookmark: pgfId-1032652]Note ASDM supports many ASA versions. The ASDM documentation and online help includes all of the latest features supported by the ASA. If you are running an older version of ASA software, the documentation might include features that are not supported in your version. Similarly, if a feature was added into a maintenance release for an older major or minor version, then the ASDM documentation includes the new feature even though that feature might not be available in all later ASA releases. Please refer to the feature history table for each chapter to determine when features were added. For the minimum supported version of ASDM for each ASA version, see Cisco ASA Series Compatibility. 

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1009667][bookmark: 94160][bookmark: 59628]Related Documentation
 
      [bookmark: pgfId-1009670]For more information, see  Navigating the Cisco ASA Series Documentation  at  http://www.cisco.com/en/US/docs/security/asa/roadmap/asaroadmap.html .
 
    
 
     
      [bookmark: pgfId-1028120][bookmark: 76447]Conventions
 
      [bookmark: pgfId-1028121]This document uses the following conventions:
 
      [bookmark: pgfId-1028167]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1028124]Convention
          
  
         	
           
           [bookmark: pgfId-1028126]Indication
          
  
        
 
         
         	 [bookmark: pgfId-1028128] bold font
  
         	 [bookmark: pgfId-1028130]Commands and keywords and user-entered text appear in  bold font.
  
        
 
         
         	 [bookmark: pgfId-1028132] italic font
  
         	 [bookmark: pgfId-1028134]Document titles, new or emphasized terms, and arguments for which you supply values are in  italic font.
  
        
 
         
         	 [bookmark: pgfId-1028136][ ]
  
         	 [bookmark: pgfId-1028138]Elements in square brackets are optional.
  
        
 
         
         	 [bookmark: pgfId-1028140]{x | y | z }
  
         	 [bookmark: pgfId-1028142]Required alternative keywords are grouped in braces and separated by vertical bars.
  
        
 
         
         	 [bookmark: pgfId-1028144][ x | y | z ]
  
         	 [bookmark: pgfId-1028146]Optional alternative keywords are grouped in brackets and separated by vertical bars.
  
        
 
         
         	 [bookmark: pgfId-1028148]string
  
         	 [bookmark: pgfId-1028150]A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.
  
        
 
         
         	 [bookmark: pgfId-1028152] courier font
  
         	 [bookmark: pgfId-1028154]Terminal sessions and information the system displays appear in  courier font.
  
        
 
         
         	 [bookmark: pgfId-1029444] courier bold  font
  
         	 [bookmark: pgfId-1029464]Commands and keywords and user-entered text appear in bold courier font.
  
        
 
         
         	 [bookmark: pgfId-1029446] courier italic font
  
         	 [bookmark: pgfId-1029476]Arguments for which you supply values are in courier italic font.
  
        
 
         
         	 [bookmark: pgfId-1028156]< >
  
         	 [bookmark: pgfId-1028158]Nonprinting characters such as passwords are in angle brackets.
  
        
 
         
         	 [bookmark: pgfId-1028160][ ]
  
         	 [bookmark: pgfId-1028162]Default responses to system prompts are in square brackets.
  
        
 
         
         	 [bookmark: pgfId-1028164]!, #
  
         	 [bookmark: pgfId-1028166]An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.
  
        
 
       
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1028168]Note Means reader take note.

      
      
 
     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-1028169]Tip Means the following information will help you solve a problem. 

      
      
 
     

     
 
      
       
     
 
     
 
     
      [bookmark: pgfId-1028170]
      Caution Means 
      reader be careful. In this situation, you might perform an action that could result in equipment damage or loss of data.
       
       
 
      

     
 
    
 
     
      [bookmark: pgfId-1032989][bookmark: 70056][bookmark: 74565]Obtaining Documentation and Submitting a Service Request
 
      [bookmark: pgfId-1032990]For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and gathering additional information, see  What’s New in Cisco Product Documentation at:  http://www.cisco.com/c/en/us/td/docs/general/whatsnew/whatsnew.html .
 
      [bookmark: pgfId-1032992]Subscribe to  What’s New in Cisco Product Documentation , which lists all new and revised Cisco technical documentation, as an RSS feed and deliver content directly to your desktop using a reader application. The RSS feeds are a free service.
 
    
 
     
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1045399][bookmark: 69804]Configuring Basic Settings
      
      
 
     
 
 
     [bookmark: pgfId-1046025]This chapter describes how to configure basic settings on the ASA that are typically required for a functioning configuration and includes the following sections:
 
     
     	 [bookmark: pgfId-1046043]Configuring the Hostname, Domain Name, and Passwords
 
     	 [bookmark: pgfId-1223539]Setting the Date and Time
 
     	 [bookmark: pgfId-1088661]Configuring the Master Passphrase
 
     	 [bookmark: pgfId-1080523]Configuring the DNS Server
 
     	 [bookmark: pgfId-1240100]Changing the Heap Memory Size
 
     	 [bookmark: pgfId-1271785]Monitoring DNS Cache
 
    
 
   
 
    
     [bookmark: pgfId-1103007]Configuring the [bookmark: 94827]Hostname, Domain Name, and Passwords
 
     [bookmark: pgfId-1268635]This section includes the following topic:
 
     
     	 [bookmark: pgfId-1321899]Setting the Hostname, Domain Name, and the enable and Telnet Passwords
 
     	 [bookmark: pgfId-1297623]Feature History for the Hostname, Domain Name, and Passwords
 
    
 
     
      [bookmark: pgfId-1321910][bookmark: 72869]Setting the Hostname, Domain Name, and the enable and Telnet Passwords
 
      [bookmark: pgfId-1321911]To set the hostname, domain name, and the enable and Telnet passwords, perform the following steps.
 
    
 
     
      [bookmark: pgfId-1321912]Detailed Steps
 
     
 
      [bookmark: pgfId-1321913] Step 1[image: ] In ASDM, choose  Configuration > Device Setup > Device Name/Password .
 
      [bookmark: pgfId-1321914]Step 2[image: ] Enter the hostname. The default hostname is “asa.”
 
      [bookmark: pgfId-1321915]The hostname appears in the command line prompt, and if you establish sessions to multiple devices, the hostname helps you keep track of where you enter commands. The hostname is also used in syslog messages.
 
      [bookmark: pgfId-1321916]For multiple context mode, the hostname that you set in the system execution space appears in the command line prompt for all contexts. The hostname that you optionally set within a context does not appear in the command line; it can be used for a banner.
 
      [bookmark: pgfId-1321917]Step 3[image: ] Enter the domain name. The default domain name is default.domain.invalid.
 
      [bookmark: pgfId-1321921]The ASA appends the domain name as a suffix to unqualified names. For example, if you set the domain name to “example.com” and specify a syslog server by the unqualified name of “jupiter,” then the ASA qualifies the name to “jupiter.example.com.”
 
      
       
     
 
     
 
     [bookmark: pgfId-1321925]Note In multiple context mode, the Enable Password area only appears in contexts; it does not appear in the system execution space.

      
      
 
     

     
 
      [bookmark: pgfId-1321926]Step 4[image: ] Change the privileged mode (enable) password. 
 
      [bookmark: pgfId-1321927]The enable password lets you access privileged EXEC mode after you log in. Also, this password is used to access ASDM with a blank username. (If you configure user authentication for enable access, then each user has a separate password, and this enable password is not used. In addition, you can configure authentication for HTTP/ASDM access.)
 
      [bookmark: pgfId-1321931]Step 5[image: ] Enter the old password.
 
      [bookmark: pgfId-1321932]Step 6[image: ] Enter the new password.
 
      [bookmark: pgfId-1321933]Step 7[image: ] Confirm the new password.
 
      
       
     
 
     
 
     [bookmark: pgfId-1321934]Note In multiple context mode, the Telnet Password area only appears in contexts; it does not appear in the system execution space.

      
      
 
     

     
 
      [bookmark: pgfId-1321935]Step 8[image: ] Change the login password for Telnet access.
 
      [bookmark: pgfId-1321936]The Telnet password sets the login password. 9.1(1): By default, it is “cisco.” 9.1(2) and later: There is no default password. The login password lets you access EXEC mode if you connect to the ASA using a Telnet session. (If you configure user authentication for Telnet access, then each user has a separate password, and this login password is not used.)
 
      [bookmark: pgfId-1321940]Step 9[image: ] Enter the old password.
 
      [bookmark: pgfId-1321941]Step 10[image: ] Enter the new password.
 
      [bookmark: pgfId-1321942]Step 11[image: ] Confirm the new password.
 
      [bookmark: pgfId-1321943]Step 12[image: ] Click  Apply to save your changes.
 
      [bookmark: pgfId-1321944]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1297411][bookmark: 54865]Feature History for the Hostname, Domain Name, and Passwords
 
      [bookmark: pgfId-1297415] Table 16-1  lists each feature change and the platform release in which it was implemented. ASDM is backward-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
      [bookmark: pgfId-1297452]
 
      
       
        
         [bookmark: pgfId-1297419]Table 16-1 [bookmark: 84947]Feature History for the Master Passphrase
 
        
       
         
         	
           
           [bookmark: pgfId-1297425]Feature Name
          
  
         	
           
           [bookmark: pgfId-1297427]Platform Releases
          
  
         	
           
           [bookmark: pgfId-1297429]Feature Information
          
  
        
 
         
         	 [bookmark: pgfId-1297431]Removal of the default Telnet password
  
         	 [bookmark: pgfId-1297433]9.0(2), 9.1(2)
  
         	 [bookmark: pgfId-1297438]To improve security for management access to the ASA, the default login password for Telnet was removed; you must manually set the password before you can log in using Telnet.  Note : The login password is only used for Telnet if you do not configure Telnet user authentication.
  [bookmark: pgfId-1297442]Formerly, when you cleared the password, the ASA restored the default of “cisco.” Now when you clear the password, the password is removed.
  [bookmark: pgfId-1297443]The login password is also used for Telnet sessions from the switch to the ASASM (see the  session command). For initial ASASM access, you must use the  service-module session command, until you set a login password.
  [bookmark: pgfId-1297451]We did not modify any ASDM screens.
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1297455][bookmark: 15602][bookmark: 60724]Setting the Date and Time
 
     
      
    
 
    
 
    [bookmark: pgfId-1228427]Note Do not set the date and time for the ASASM; it receives these settings from the host switch.

     
     
 
    

    
 
     [bookmark: pgfId-1223733]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1223741]Setting the Date and Time Using an NTP Server
 
     	 [bookmark: pgfId-1223745]Setting the Date and Time Manually
 
    
 
     
      [bookmark: pgfId-1223768][bookmark: 93003][bookmark: 94744]Setting the Date and Time Using an NTP Server
 
      [bookmark: pgfId-1223769]To obtain the date and time from an NTP server, choose Configuration > Device Setup > System Time > NTP :
 
    
 
     
      [bookmark: pgfId-1223770]Detailed Steps
 
      [bookmark: pgfId-1321967]Use the NTP pane to define NTP servers for setting the time dynamically on the ASA. The time appears in the status bar at the bottom of the main ASDM window. Time derived from an NTP server overrides any time set manually in the Clock pane.
 
      [bookmark: pgfId-1321971]NTP is used to implement a hierarchical system of servers that provide a precisely synchronized time among network systems. This kind of accuracy is required for time-sensitive operations, such as validating CRLs, which include a precise time stamp. You can configure multiple NTP servers. The ASA chooses the server with the lowest stratum—a measure of how reliable the data is. 
 
    
 
     
      [bookmark: pgfId-1321976]Adding or Editing the NTP Server Configuration
 
      [bookmark: pgfId-1321977]To add or edit an NTP server, perform the following steps:
 
     
 
      [bookmark: pgfId-1321978] Step 1[image: ] In ASDM, choose  Configuration > Device Setup > System[image: ] Time > NTP .
 
      [bookmark: pgfId-1321979]Step 2[image: ] Click  Add to display the Add N TP Server Configuration dialog box. 
 
      [bookmark: pgfId-1321980]Step 3[image: ] Enter the NTP server IP address.
 
      [bookmark: pgfId-1321981]Step 4[image: ] Check the  Preferred check box to set this server as a preferred server. NTP uses an algorithm to determine which server is the most accurate and synchronizes to it. If servers are of similar accuracy, then the preferred server is used. However, if a server is significantly more accurate than the preferred one, the ASA uses the more accurate one.
 
      [bookmark: pgfId-1321985]Step 5[image: ] Choose the interface from the drop-down list. This setting specifies the outgoing interface for NTP packets. If the interface is blank, then the ASA uses the default admin context interface according to the routing table. To change the admin context (and the available interfaces), choose None (the default interface) for stability.
 
      [bookmark: pgfId-1321989]Step 6[image: ] Choose the key number from the drop-down list. This setting specifies the key ID for this authentication key, which enables you to use MD5 authentication to communicate with the NTP server. The NTP server packets must also use this key ID. If you have previously configured a key ID for another server, you can select it from the list; otherwise, enter a number between 1 and 4294967295.
 
      [bookmark: pgfId-1321990]Step 7[image: ] Check the  Trusted[image: ] check box to set this authentication key as a trusted[image: ] key, which is required for authentication to succeed.
 
      [bookmark: pgfId-1321991]Step 8[image: ] Enter the key value to set the authentication key, which is a string that can be up to 32 characters long.
 
      [bookmark: pgfId-1321992]Step 9[image: ] Reenter the key value to make sure that you enter it correctly twice.
 
      [bookmark: pgfId-1321993]Step 10[image: ] Click  OK .
 
      [bookmark: pgfId-1321994]Step 11[image: ] Check the  Enable NTP authentication check box to turn on NTP authentication.
 
      [bookmark: pgfId-1321995]Step 12[image: ] Click  Apply to save your changes.
 
      [bookmark: pgfId-1321996]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1223959][bookmark: 20895]Setting the Date and Time Manually
 
      [bookmark: pgfId-1322004]The time is based on a 24-hour clock and displays in the status bar at the bottom of the main ASDM pane.
 
      [bookmark: pgfId-1322005]In multiple context mode, you can set the time in the system configuration only.
 
      [bookmark: pgfId-1322006]To dynamically set the time using an NTP server, choose  Configuration > Device Setup > System Time > NTP ; time derived from an NTP server overrides any time set manually in the Clock  pane.
 
      [bookmark: pgfId-1322010]To manually set the date and time for the ASA, perform the following steps:
 
     
 
      [bookmark: pgfId-1322011] Step 1[image: ] In ASDM, choose  Configuration > Device Setup > System[image: ] Time > Clock .
 
      [bookmark: pgfId-1322012]Step 2[image: ] Choose the time zone from the drop-down list. This setting specifies the time zone as GMT plus or minus the appropriate number of hours. If you select the Eastern Time, Central Time, Mountain Time, or Pacific Time zone, then the time adjusts automatically for daylight savings time, from 2:00 a.m. on the second Sunday in March to 2:00 a.m. on the first Sunday in November.
 
      
       
     
 
     
 
     [bookmark: pgfId-1322019]Note Changing the time zone on the ASA may drop the connection to intelligent SSMs.

      
      
 
     

     
 
      [bookmark: pgfId-1322020]Step 3[image: ] Click the Date drop-down list to display a calendar. Then find the correct date using the following methods:
 
      
       
       	 [bookmark: pgfId-1322021]Click the name of the month to display a list of months, then click the desired month. The calendar updates to that month.
 
       	 [bookmark: pgfId-1322022]Click the year to change the year. Use the up and down arrows to scroll through the years, or enter a year in the entry field.
 
       	 [bookmark: pgfId-1322023]Click the arrows to the right and left of the month and year to scroll the calendar forward and backward one month at a time.
 
       	 [bookmark: pgfId-1322024]Click a day on the calendar to set the date.
 
      
 
     
 
      [bookmark: pgfId-1322025]Step 4[image: ] Enter the time manually in hours, minutes, and seconds.
 
      [bookmark: pgfId-1322026]Step 5[image: ] Click  Update Display  Time to update the time shown in the bottom right corner of the ASDM pane. The current time updates automatically every ten seconds.
 
      [bookmark: pgfId-1322030]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1087800][bookmark: 33806][bookmark: marker-1087797][bookmark: marker-1087798][bookmark: 78076]Configuring the Master Passphrase
 
     [bookmark: pgfId-1087801]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1087805]Information About the Master Passphrase
 
     	 [bookmark: pgfId-1096420]Licensing Requirements for the Master Passphrase
 
     	 [bookmark: pgfId-1096440]Guidelines and Limitations
 
     	 [bookmark: pgfId-1096456]Adding or Changing the Master Passphrase
 
     	 [bookmark: pgfId-1096497]Disabling the Master Passphrase
 
     	 [bookmark: pgfId-1096514]Recovering the Master Passphrase
 
     	 [bookmark: pgfId-1087849]Feature History for the Master Passphrase
 
    
 
     
      [bookmark: pgfId-1087850][bookmark: 28503]Information About the Master Passphrase
 
      [bookmark: pgfId-1087851]The master passphrase allows you to securely store plain text passwords in encrypted format and provides a key that is used to universally encrypt or mask all passwords, without changing any functionality. Features that use the master passphrase include the following:
 
      
      	 [bookmark: pgfId-1095936]OSPF
 
      	 [bookmark: pgfId-1095981]EIGRP
 
      	 [bookmark: pgfId-1095961]VPN load balancing
 
      	 [bookmark: pgfId-1095970]VPN (remote access and site-to-site)
 
      	 [bookmark: pgfId-1095990]Failover
 
      	 [bookmark: pgfId-1095991]AAA servers
 
      	 [bookmark: pgfId-1096000]Logging
 
      	 [bookmark: pgfId-1096011]Shared licenses
 
     
 
    
 
     
      [bookmark: pgfId-1089087][bookmark: 33387]Licensing Requirements for the Master Passphrase
 
      [bookmark: pgfId-1332930]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1332923]Model
          
  
         	
           
           [bookmark: pgfId-1332925]License Requirement
          
  
        
 
         
         	 [bookmark: pgfId-1332927]All models
  
         	 [bookmark: pgfId-1332929]Base License.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1089103][bookmark: 82316]Guidelines and Limitations
 
      [bookmark: pgfId-1089104]This section includes the guidelines and limitations for this feature.
 
      [bookmark: pgfId-1089105]Context Mode Guidelines
 
      [bookmark: pgfId-1089107]Supported in single and multiple context mode.[bookmark: 16966]
 
      [bookmark: pgfId-1270591]Failover Guidelines
 
      [bookmark: pgfId-1270641]If failover is enabled but no failover shared key is set, an error message appears if you change the master passphrase, informing you that you must enter a failover shared key to protect the master passphrase changes from being sent as plain text.
 
      [bookmark: pgfId-1322035]Choose  Configuration > Device Management > High Availability > Failover , enter any character in the Shared Key field or 32 hexadecimal numbers (0-9A-Fa-f) if a failover hexadecimal key is selected, except a backspace. Then click Apply.
 
    
 
     
      [bookmark: pgfId-1089108][bookmark: 99495]Adding or Changing the Master Passphrase
 
      [bookmark: pgfId-1209657]To add or change the master passphrase, perform the following steps:
 
     
 
      [bookmark: pgfId-1322040] Step 1[image: ] In single context mode, choose Configuration > Device Management > Advanced > Master Passphrase.
 
      [bookmark: pgfId-1322041]In multiple context mode, choose Configuration > Device Management > Device Administration > Master Passphrase. 
 
      [bookmark: pgfId-1322042]Step 2[image: ] Check the Advanced Encryption Standard (AES) password encryption check box.
 
      [bookmark: pgfId-1322043]If no master passphrase is in effect, a warning message appears when you click Apply. You can click OK or Cancel to continue.
 
      [bookmark: pgfId-1322044]If you later disable password encryption, all existing encrypted passwords are left unchanged, and as long as the master passphrase exists, the encrypted passwords will be decrypted as required by the application.
 
      [bookmark: pgfId-1322045]Step 3[image: ] Check the Change the encryption master passphrase check box to enable you to enter and confirm your new master passphrases. By default, they are disabled.
 
      [bookmark: pgfId-1322046]Your new master passphrase must be between 8 and 128 characters long.
 
      [bookmark: pgfId-1322047]If you are changing an existing passphrase, you must enter the old passphrase before you can enter a new one.
 
      [bookmark: pgfId-1322048]To delete the master passphrase, leave the New and Confirm master passphrase fields blank.
 
      [bookmark: pgfId-1322049]Step 4[image: ] Click  Apply .
 
      [bookmark: pgfId-1322050]When you click Apply, warning messages appear under the following conditions:
 
      
      	 [bookmark: pgfId-1322051]The Change the encryption master passphrase field is enabled, and the New master passphrase field is empty. The no key configuration-key password-encrypt command is then sent to the device. 
 
      	 [bookmark: pgfId-1322052]The old master passphrase does not match the hash value in the show password encryption command output.
 
      	 [bookmark: pgfId-1322053]You use non-portable characters, particularly those with the high-order bit set in an 8-bit representation. 
 
      	 [bookmark: pgfId-1322054]A master passphrase and failover are in effect, then an error message appears if an attempt to remove the failover shared key occurs.
 
      	 [bookmark: pgfId-1322055]Encryption is disabled, but a new or replacement master passphrase is supplied. Click OK or Cancel to continue.
 
      	 [bookmark: pgfId-1322056]If the master passphrase is changed in multiple context mode. 
 
      	 [bookmark: pgfId-1322057]If Active/Active failover is configured and the master passphrase is changed.
 
      	 [bookmark: pgfId-1322058]If any running configurations are configured so that their configurations cannot be saved to their server, such as with context configuration URLs that use HTTP or HTTPS, and the master passphrase is changed. 
 
     
 
      [bookmark: pgfId-1322059]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1270728][bookmark: 51313]Disabling the Master Passphrase
 
      [bookmark: pgfId-1270729]Disabling the master passphrase reverts encrypted passwords into plain text passwords. Removing the passphrase might be useful if you downgrade to a previous software version that does not support encrypted passwords.
 
      [bookmark: pgfId-1239160]You must know the current master passphrase to disable it. If you do not know the passphrase, see the “Recovering the Master Passphrase” section.
 
      [bookmark: pgfId-1270760]To disable the master passphrase, perform the following steps:
 
     
 
      [bookmark: pgfId-1322064] Step 1[image: ] In single context mode, choose Configuration > Device Management > Advanced > Master Passphrase.
 
      [bookmark: pgfId-1322065]In multiple context mode, choose Configuration > Device Management > Device Administration > Master Passphrase. 
 
      [bookmark: pgfId-1322066]Step 2[image: ] Check the Advanced Encryption Standard (AES) password encryption check box.
 
      [bookmark: pgfId-1322067]If no master passphrase is in effect, a warning statement appears when you click Apply. Click OK or Cancel to continue.
 
      [bookmark: pgfId-1322068]Step 3[image: ] Check the Change the encryption master passphrase check box.
 
      [bookmark: pgfId-1322069]Step 4[image: ] Enter the old master passphrase in the Old master passphrase field. You must provide the old master passphrase to disable it.
 
      [bookmark: pgfId-1322070]Step 5[image: ] Leave the New master passphrase and the Confirm master passphrase fields empty.
 
      [bookmark: pgfId-1322071]Step 6[image: ] Click  Apply .
 
      [bookmark: pgfId-1322072]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1094288][bookmark: 49936]Recovering the Master Passphrase
 
      [bookmark: pgfId-1095190]You cannot recover the master passphrase. If the master passphrase is lost or unknown, you can remove it.
 
      [bookmark: pgfId-1270788]To remove the master passphrase, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1088152][bookmark: 38319]Feature History for the Master Passphrase
 
      [bookmark: pgfId-1088156] Table 16-2  lists each feature change and the platform release in which it was implemented. ASDM is backward-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
      [bookmark: pgfId-1088181]
 
      
       
        
         [bookmark: pgfId-1088160]Table 16-2 [bookmark: 88464]Feature History for the Master Passphrase
 
        
       
         
         	
           
           [bookmark: pgfId-1088166]Feature Name
          
  
         	
           
           [bookmark: pgfId-1088168]Platform Releases
          
  
         	
           
           [bookmark: pgfId-1088170]Feature Information
          
  
        
 
         
         	 [bookmark: pgfId-1088172]Master Passphrase
  
         	 [bookmark: pgfId-1088174]8.3(1)
  
         	 [bookmark: pgfId-1158018]We introduced this feature. The master passphrase allows you to securely store plain text passwords in encrypted format and provides a key that is used to universally encrypt or mask all passwords, without changing any functionality. 
  [bookmark: pgfId-1093214]We introduced the following screens: Configuration > Device Management > Advanced > Master Passphrase.
 Configuration > Device Management > Device Administration > Master Passphrase.
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1080248][bookmark: 49626]Configuring the [bookmark: marker-1083859]DNS Server
 
     [bookmark: pgfId-1084291]Some ASA features require use of a DNS server to access external servers by domain name; for example, the Botnet Traffic Filter feature requires a DNS server to access the dynamic database server and to resolve entries in the static database. Other features, such as the  ping or  traceroute command, let you enter a name that you want to ping or traceroute, and the ASA can resolve the name by communicating with a DNS server. Many SSL VPN and certificate commands also support names.
 
     
      
    
 
    
 
    [bookmark: pgfId-1097498]Note The ASA has limited support for using the DNS server, depending on the feature. For these feature, to resolve the server name to an IP address, you must enter the IP address manually by adding the server name in the Configuration > Firewall > Objects > Network Object/Groups pane.

     
     
 
    

    
 
     [bookmark: pgfId-1103624]For information about dynamic DNS, see the “Configuring Dynamic DNS” section.
 
     
      [bookmark: pgfId-1103633]Prerequisites
 
      [bookmark: pgfId-1084981]Make sure that you configure the appropriate routing for any interface on which you enable DNS domain lookup so you can reach the DNS server. See the “Information About Routing” section for more information about routing.
 
      [bookmark: pgfId-1311061]To configure the DNS server, perform the following steps:
 
     
 
      [bookmark: pgfId-1322101] Step 1[image: ] In the ASDM main application window, choose  Configuration > Device Management > DNS > DNS Client .
 
      [bookmark: pgfId-1322102]Step 2[image: ] In the DNS Setup area, choose one of the following options:
 
      
       
       	 [bookmark: pgfId-1322103]Configure one DNS server group.
 
       	 [bookmark: pgfId-1322104]Configure multiple DNS server groups.
 
      
 
     
 
      [bookmark: pgfId-1322106]Step 3[image: ] Click  Add to display the Add DNS Server Group dialog box.
 
      [bookmark: pgfId-1322110]Step 4[image: ] Specify up to six addresses to which DNS requests can be forwarded. The ASA tries each DNS server in order until it receives a response.
 
      
       
     
 
     
 
     [bookmark: pgfId-1322111]Note You must first enable DNS on at least one interface before you can add a DNS server. The DNS Lookup area shows the DNS status of an interface. A False setting indicates that DNS is disabled. A True setting indicates that DNS is enabled.

      
      
 
     

     
 
      [bookmark: pgfId-1322112]Step 5[image: ] Enter the name of each configured DNS server group.
 
      [bookmark: pgfId-1322113]Step 6[image: ] Enter the IP addresses of the configured servers, and click  Add to include them in the server group. To remove a configured server from the group, click  Delete .
 
      [bookmark: pgfId-1322114]Step 7[image: ] To change the sequence of the configured servers, click  Move Up or  Move Down .
 
      [bookmark: pgfId-1322115]Step 8[image: ] In the Other Settings area, enter the number of seconds to wait before trying the next DNS server in the list, between 1 and 30 seconds. The default is 2 seconds. Each time the ASA retries the list of servers, the timeout time doubles.
 
      [bookmark: pgfId-1322119]Step 9[image: ] Enter the number of seconds to wait before trying the next DNS server in the group.
 
      [bookmark: pgfId-1322120]Step 10[image: ] Enter a valid DNS domain name for the group of configured servers.
 
      [bookmark: pgfId-1322121]Step 11[image: ] Click  OK to close the Add DNS Server Group dialog box.
 
      [bookmark: pgfId-1322122]The new DNS server settings appear.
 
      [bookmark: pgfId-1322123]Step 12[image: ] To change these settings, click  Edit to display the Edit DNS Server Group dialog box.
 
      [bookmark: pgfId-1322124]Step 13[image: ] Make your desired changes, then click  OK to close the Edit DNS Server Group dialog box.
 
      [bookmark: pgfId-1322125]The revised DNS server settings appear.
 
      [bookmark: pgfId-1322126]Step 14[image: ] To enable a DNS server group to receive DNS requests, click  Set Active .
 
      [bookmark: pgfId-1322127]Step 15[image: ] In the DNS Guard area, to enforce one DNS response per query, check the  Enable DNS Guard on all interfaces check box. If DNS inspection is enabled, this setting is ignored on the selected interface.
 
      [bookmark: pgfId-1322128]Step 16[image: ] Click  Apply to save your changes, or click  Reset to discard those changes and enter new ones.
 
      [bookmark: pgfId-1322129]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1322135][bookmark: 40537][bookmark: 35144]Changing the Heap Memory Size
 
     [bookmark: pgfId-1322136]ASDM supports a maximum configuration size of 512 KB. If you exceed this amount you may experience performance issues. For example, when you load the configuration, the status dialog box shows the percentage of the configuration that is complete, yet with large configurations it stops incrementing and appears to suspend operation, even though ASDM might still be processing the configuration. If this situation occurs, we recommend that you consider increasing the ASDM system heap memory.
 
     [bookmark: pgfId-1322137]To increase the ASDM heap memory size, modify the launcher shortcut by performing the following procedure: 
 
     [bookmark: pgfId-1322138]

     
     
 
    
 
    Step 1
    [image: ] Right-click the shortcut for the ASDM-IDM Launcher, and choose 
     Properties .
    
 
     [bookmark: pgfId-1322139]Step 2[image: ] Click the  Shortcut tab.
 
     [bookmark: pgfId-1322140]Step 3[image: ] In the Target field, change the argument prefixed with “-Xmx” to specify your desired heap size. For example, change it to -Xmx768m for 768 MB or -Xmx1g for 1 GB. For more information about this parameter, see the Oracle document in the following location:  http://docs.oracle.com/javase/1.5.0/docs/tooldocs/windows/java.html  
 
     [bookmark: pgfId-1322142]

     
     
 
    
 
    
 
     [bookmark: pgfId-1322143]Along with using troubleshooting information in this guide, see the  ASDM Troubleshooting document at the following URL:
 
     [bookmark: pgfId-1311100] http://www.cisco.com/en/US/products/ps6121/products_tech_note09186a0080aaeff5.shtml 
 
   
 
    
     [bookmark: pgfId-1240622][bookmark: 35332]Monitoring DNS Cache
 
     [bookmark: pgfId-1240626]The ASA provides a local cache of DNS information from external DNS queries that are sent for certain clientless SSL VPN and certificate commands. Each DNS translation request is first looked for in the local cache. If the local cache has the information, the resulting IP address is returned. If the local cache can not resolve the request, a DNS query is sent to the various DNS servers that have been configured. If an external DNS server resolves the request, the resulting IP address is stored in the local cache with its corresponding hostname.
 
     [bookmark: pgfId-1139306]To monitor the DNS cache, see the following pane:
 
     [bookmark: pgfId-1133491]
 
     
      
      
        
        	
          
          [bookmark: pgfId-1133481]Path
         
  
        	
          
          [bookmark: pgfId-1133483]Purpose
         
  
       
 
        
        	 [bookmark: pgfId-1322158] Tools > Command Line Interface 
  [bookmark: pgfId-1135633]Enter the  show  dns-hosts command, then press  Send. 
  
        	 [bookmark: pgfId-1133490]Show the DNS cache, which includes dynamically learned entries from a DNS server as well as manually entered name and IP addresses using the name command.
  
       
 
      
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1250595][bookmark: marker-1250591][bookmark: bblocks][bookmark: 89144]Configuring Objects
      
      
 
     
 
 
     [bookmark: pgfId-1304131]This chapter describes how to configure reusable named objects and groups for use in your configuration, and it includes the following sections:
 
     
     	 [bookmark: pgfId-1552467]Information About Objects
 
     	 [bookmark: pgfId-1553080]Licensing Requirements for Objects
 
     	 [bookmark: pgfId-1553096]Configuring Objects
 
     	 [bookmark: pgfId-1552490]Monitoring Objects
 
     	 [bookmark: pgfId-1552506]Feature History for Objects
 
    
 
   
 
    
     [bookmark: pgfId-1552644][bookmark: 68206]Information About Objects
 
     [bookmark: pgfId-1552748]Objects are reusable components for use in your configuration. They can be defined and used in ASA configurations in the place of inline IP addresses, services, names, and so on. Objects make it easy to maintain your configurations because you can modify an object in one place and have it be reflected in all other places that are referencing it. Without objects you would have to modify the parameters for every feature when required, instead of just once. For example, if a network object defines an IP address and subnet mask, and you want to change the address, you only need to change it in the object definition, not in every feature that refers to that IP address.
 
   
 
    
     [bookmark: pgfId-1552831][bookmark: 20891]Licensing Requirements for Objects
 
     [bookmark: pgfId-1681802]
 
     
      
      
        
        	
          
          [bookmark: pgfId-1681795]Model
         
  
        	
          
          [bookmark: pgfId-1681797]License Requirement
         
  
       
 
        
        	 [bookmark: pgfId-1681799]All models
  
        	 [bookmark: pgfId-1681801]Base License.
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-1553186]Guidelines and Limitations
 
     [bookmark: pgfId-1553189]Context Mode Guidelines
 
     [bookmark: pgfId-1553190]Supported in single and multiple context mode.
 
     [bookmark: pgfId-1553194]Firewall Mode Guidelines
 
     [bookmark: pgfId-1553195]Supported in routed and transparent firewall mode.
 
     [bookmark: pgfId-1553202]IPv6 Guidelines
 
     
     	 [bookmark: pgfId-1554963]Supports IPv6.
 
     	 [bookmark: pgfId-1561881]The ASA does not support IPv6 nested network object groups, so you cannot group an object with IPv6 entries under another IPv6 object group.
 
     	 [bookmark: pgfId-1561890]You can mix IPv4 and IPv6 entries in a network object group; you cannot use a mixed object group for NAT.
 
    
 
     [bookmark: pgfId-1553214][bookmark: 23253]Additional Guidelines and Limitations
 
     
     	 [bookmark: pgfId-1554720]Object must have unique names. While you might want to create a network object group named “Engineering” and a service object group named “Engineering,” you need to add an identifier (or “tag”) to the end of at least one object group name to make it unique. For example, you can use the names “Engineering_admins” and “Engineering_hosts” to make the object group names unique and to aid in identification.
 
     	 [bookmark: pgfId-1554901]Objects and object groups share the same name space.
 
     	 [bookmark: pgfId-1554721]You cannot remove an object or make an object empty if it is used in a command. 
 
    
 
   
 
    
     [bookmark: pgfId-1550324][bookmark: 58870]Configuring Objects
 
     
     	 [bookmark: pgfId-1550556]Configuring Network Objects and Groups
 
     	 [bookmark: pgfId-1550560]Configuring Service Objects and Service Groups
 
     	 [bookmark: pgfId-1550564]Configuring Local User Groups
 
     	 [bookmark: pgfId-1550568]Configuring Security Group Object Groups
 
     	 [bookmark: pgfId-1550572]Configuring Regular Expressions
 
     	 [bookmark: pgfId-1550577]Configuring Time Ranges[bookmark: 48451]
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1668857]Note For other objects not included in this chapter, see the following chapters:
 
     
     	 [bookmark: pgfId-1668861]Local Users—See Chapter33, “Configuring the Local Database for AAA”
 
     	 [bookmark: pgfId-1668865]Class Maps—See Chapter 9, “Getting Started with Application Layer Protocol Inspection,” in the firewall configuration guide.
 
     	 [bookmark: pgfId-1668872]Inspect Maps—See Chapter 9, “Getting Started with Application Layer Protocol Inspection,” in the firewall configuration guide.
 
     	 [bookmark: pgfId-1668881]TCP Maps—See the Configuring Connection Settings section in the firewall configuration guide.
 
    
 
     [bookmark: pgfId-1668883]

     
     
 
    
 
    
 
     
      [bookmark: pgfId-1543634][bookmark: 55942][bookmark: 74795]Configuring Network Objects and Groups
 
      [bookmark: pgfId-1543635]This section describes how to configure network objects and groups, and it includes the following topics:
 
      
      	 [bookmark: pgfId-1543643]Configuring a Network Object
 
      	 [bookmark: pgfId-1543647]Configuring a Network Object Group
 
     
 
    
 
     
      [bookmark: pgfId-1543669][bookmark: 72979]Configuring a Network Object 
 
      [bookmark: pgfId-1548325]A network object can contain a host, a network IP address, or a range of IP addresses, a fully qualified domain name (FQDN). You can also enable NAT rules on the object (excepting FQDN objects). (See Chapter 4, “Configuring Network Object NAT,” in the firewall configuration guide for more information.)
 
    
 
     
      [bookmark: pgfId-1543675]Detailed Steps
 
     
 
      [bookmark: pgfId-1668890] Step 1[image: ] Choose  Configuration >  Firewall >  Objects >  Network Objects/Group . 
 
      [bookmark: pgfId-1668891]Step 2[image: ] Click  Add , and choose Network Object  to add a new object, or choose an existing object to edit, and click  Edit .
 
      [bookmark: pgfId-1668892]You can also add or edit network objects from the Addresses side pane in a rules window or when you are adding a rule.
 
      [bookmark: pgfId-1668893]To find an object in the list, enter a name or IP address in the Filter field, and click  Filter . The wildcard characters asterisk (*) and question mark (?) are allowed.
 
      [bookmark: pgfId-1668894]The Add/Edit Network Object dialog box appears.
 
      [bookmark: pgfId-1668895]Step 3[image: ] Fill in the following values:
 
      
       
       	 [bookmark: pgfId-1668896]Name—The object name. Use characters a to z, A to Z, 0 to 9, a period, a dash, a comma, or an underscore. The name must contain 64 characters or fewer.
 
       	 [bookmark: pgfId-1668897]Type—Either Network, Host, Range, or FQDN.
 
       	 [bookmark: pgfId-1668898]IP Address—An IPv4 or an IPv6 address, either a host or network address. When you enter a colon (:) in this field for an IPv6 address, the Netmask field changes to Prefix Length. If you select Range as the object type, the IP Address field changes to allow you to enter a Start Address and an End address.
 
       	 [bookmark: pgfId-1668899]Netmask or Prefix Length—If the IP address is an IPv4 address, enter the subnet mask. If the IP address is an IPv6 address, enter the prefix. (This field is not available if you enter the object type as Host.)
 
       	 [bookmark: pgfId-1668900]Description—(Optional) The description of the network object (up to 200 characters in length).
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1668903]Note To add NAT rules to the network object, see “Configuring Network Object NAT (ASA 8.3 and Later),” in the firewall configuration guide for more information.

      
      
 
     

     
 
      [bookmark: pgfId-1668908]Step 4[image: ] Click  OK .
 
      [bookmark: pgfId-1668909]Step 5[image: ] Click  Apply to save the configuration.
 
      [bookmark: pgfId-1668910]You can now use this network object when you create a rule. If you edit an object, the change is inherited automatically by any rules using the object.
 
      [bookmark: pgfId-1668911]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1543697][bookmark: 49679][bookmark: 86292]Configuring a Network Object Group 
 
      [bookmark: pgfId-1561774]Network object groups can contain multiple network objects as well as inline networks. Network object groups can support a mix of both IPv4 and IPv6 addresses.
 
    
 
     
      [bookmark: pgfId-1561795]Restrictions
 
      [bookmark: pgfId-1561775]You cannot use a mixed IPv4 and IPv6 object group for NAT, or object groups that include FQDN objects.
 
    
 
     
      [bookmark: pgfId-1557011]Detailed Steps
 
     
 
      [bookmark: pgfId-1668922] Step 1[image: ] Choose  Configuration >  Firewall >  Objects >  Network Objects/Groups .
 
      [bookmark: pgfId-1668923]Step 2[image: ] Click click  Add > Network Object Group to add either a new object or a new object group.
 
      [bookmark: pgfId-1668924]You can also add or edit network object groups from the Addresses side pane in a rules window, or when you add a rule.
 
      [bookmark: pgfId-1668925]To find an object in the list, enter a name or IP address in the Filter field, and click Filter. The wildcard characters asterisk (*) and question mark (?) are allowed.
 
      [bookmark: pgfId-1668926]The Add Network Object Group dialog box appears.
 
      [bookmark: pgfId-1668927]Step 3[image: ] In the Group Name field, enter a group name.
 
      [bookmark: pgfId-1668928]Use characters a to z, A to Z, 0 to 9, a period, a comma, a dash, or an underscore. The name must contain 64 characters or fewer.
 
      [bookmark: pgfId-1668929]Step 4[image: ] (Optional) In the Description field, enter a description, up to 200 characters in length.
 
      [bookmark: pgfId-1668930]Step 5[image: ] You can add existing objects or groups to the new group (nested groups are allowed), or you can create a new address to add to the group:
 
      
       
       	 [bookmark: pgfId-1668931]To add an existing network object or group to the new group, double-click the object in the Existing Network Objects/Groups pane.
 
      
 
     
 
      [bookmark: pgfId-1668932]You can also select the object, and then click  Add . The object or group is added to the right-hand Members in Group pane.
 
      
       
       	 [bookmark: pgfId-1668933]To add a new address, fill in the values under the Create New Network Object Member area, and click  Add .
 
      
 
     
 
      [bookmark: pgfId-1668934]The object or group is added to the right-hand Members in Group pane. This address is also added to the network object list.
 
      [bookmark: pgfId-1668935]To remove an object, double-click the object in the Members in Group pane, or select the object and click  Remove .
 
      [bookmark: pgfId-1668936]Step 6[image: ] After you add all the member objects, click  OK .
 
      [bookmark: pgfId-1668937]You can now use this network object group when you create a rule. For an edited object group, the change is inherited automatically by any rules using the group.
 
      [bookmark: pgfId-1668938]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1569440][bookmark: 61887][bookmark: 99763][bookmark: 82484][bookmark: 37203]Configuring Service Objects and Service Groups
 
      [bookmark: pgfId-1569441]Service objects and groups identify protocols and ports. This section describes how to configure service objects, service groups, TCP and UDP port service groups, protocol groups, and ICMP groups, and it includes the following topics:
 
      
      	 [bookmark: pgfId-1567271]Configuring a Service Object
 
      	 [bookmark: pgfId-1567276]Configuring a Service Group
 
      	 [bookmark: pgfId-1567297]Configuring a TCP or UDP Port Service Group
 
      	 [bookmark: pgfId-1567330]Configuring an ICMP Group
 
      	 [bookmark: pgfId-1567363]Configuring an ICMP Group
 
     
 
    
 
     
      [bookmark: pgfId-1543795][bookmark: 56437]Configuring a Service Object
 
      [bookmark: pgfId-1567175]The service object can contain a protocol, ICMP, ICMPv6, TCP or UDP port or port ranges.
 
    
 
     
      [bookmark: pgfId-1557096]Detailed Steps
 
      [bookmark: pgfId-1668951]

      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > Firewall > Objects > Service Object/Group .
     
 
      [bookmark: pgfId-1668952]Step 2[image: ] Choose  Add >  Service Object  from the drop-down list. 
 
      [bookmark: pgfId-1668953]Step 3[image: ] In the name field, enter a name for the service object. Use characters a to z, A to Z, 0 to 9, a period, a dash, a comma, or an underscore. The name must be 64 characters or fewer.
 
      [bookmark: pgfId-1668954]Step 4[image: ] From the Service Type field, choose the desired type: tcp, udp, icmp, or icmp6 protocol.
 
      [bookmark: pgfId-1668955]Step 5[image: ] (Optional) If you chose tcp or udp as the Service Type, enter the following:
 
      
       
       	 [bookmark: pgfId-1668956]Destination Port/Range
 
       	 [bookmark: pgfId-1668957]Source Port/Range—Lists the protocol source ports/ranges.
 
       	 [bookmark: pgfId-1668958]Description—Lists the service group description.
 
      
 
     
 
      [bookmark: pgfId-1668959]Step 6[image: ] (Optional) If you chose icmp or icmp6 as the Service Type, enter the following:
 
      
       
       	 [bookmark: pgfId-1668960]ICMP Type—Lists the service group ICMP type.
 
       	 [bookmark: pgfId-1668961]ICMP Code—(Optional) Valid values range from 1 to 255. 
 
       	 [bookmark: pgfId-1668962]Description—(Optional) Lists the service group description.
 
      
 
     
 
      [bookmark: pgfId-1668963]Step 7[image: ] If you chose protocol as the Service Type, enter the following:
 
      
       
       	 [bookmark: pgfId-1668964]Protocol—Lists the service group protocol.
 
       	 [bookmark: pgfId-1668965]Description—(Optional) Lists the service group description.
 
      
 
     
 
      [bookmark: pgfId-1668966]Step 8[image: ] Click  OK , and then  Apply .
 
      [bookmark: pgfId-1668967]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1543860][bookmark: 51549]Configuring a Service Group
 
      [bookmark: pgfId-1565053]A service object group includes a mix of protocols, if desired, including optional source and destination ports for TCP or UDP.
 
    
 
     
      [bookmark: pgfId-1557968]Detailed Steps
 
     
 
      [bookmark: pgfId-1668972] Step 1[image: ] Choose  Configuration > Firewall > Objects > Service Object/Group .  
 
      [bookmark: pgfId-1668973]Step 2[image: ] Choose  Add >  Service Group from the drop-down list.
 
      [bookmark: pgfId-1668974]The Add Service Group dialog box appears.
 
      [bookmark: pgfId-1668975]Step 3[image: ] In the Name field, enter a name for the new service group. The name can be up to 64 characters in length and must be unique for all object groups. A service group name cannot share a name with other objects and groups.
 
      [bookmark: pgfId-1668976]Step 4[image: ] In the Description field, enter a description for this service group (up to 200 characters in length).
 
      [bookmark: pgfId-1668977]Step 5[image: ] To add an existing service object or group, or predefined protocol or port, click the  Existing Service/Service Group radio button, select the entry from the Name field, and click  Add .
 
      [bookmark: pgfId-1668978]Step 6[image: ] To create a new service, click the  Create new member radio button and then choose the Service Type from the drop-down list:
 
      
       
       	 [bookmark: pgfId-1668979]If you choose tcp, udp, or tcp/udp, enter a name, the destination port/range, the source port/range, and an optional description.
 
       	 [bookmark: pgfId-1668980]If you choose icmp or icmp6, enter a name, the ICMP Type (from the Existing Service/Service Group list), an ICMP Code (a value from 0-255), and an optional description.
 
       	 [bookmark: pgfId-1668981]If you choose protocol, enter a name, the protocol, and an optional description.
 
      
 
     
 
      [bookmark: pgfId-1668982]Click  Add to add the new service.
 
      [bookmark: pgfId-1668983]Step 7[image: ] Click  OK , and then  Apply .
 
      [bookmark: pgfId-1668984]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1565146][bookmark: 67306]Configuring a TCP or UDP Port Service Group
 
      [bookmark: pgfId-1598385]A TCP or UDP service group includes a group of ports for a specific protocol (TCP, UDP, or TCP-UDP).
 
     
 
      [bookmark: pgfId-1668989] Step 1[image: ] Choose  Configuration > Firewall > Objects > Service Object/Group .  
 
      [bookmark: pgfId-1668990]Step 2[image: ] Choose  Add >  TCP  Service Group ,  UDP  Service Group , or TCP-UDP  Service Group  from the drop-down list.
 
      [bookmark: pgfId-1668991]The Add Service Group dialog box appears.
 
      [bookmark: pgfId-1668992]Step 3[image: ] In the Name field, enter a name for the new service group. The name can be up to 64 characters in length and must be unique for all object groups. A service group name cannot share a name with other objects and groups.
 
      [bookmark: pgfId-1668993]Step 4[image: ] In the Description field, enter a description for this service group (up to 200 characters in length).
 
      [bookmark: pgfId-1668994]Step 5[image: ] To add an existing service group, or predefined port, click the  Existing Service/Service Group radio button, select the entry from the Name field, and click  Add .
 
      [bookmark: pgfId-1668995]Step 6[image: ] To create a new port, click the  Create new member radio button, enter the port name, number, or range and then click  Add to add the new port.
 
      [bookmark: pgfId-1668996]Step 7[image: ] Click  OK , and then  Apply .
 
      [bookmark: pgfId-1668997]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1564752][bookmark: 77416][bookmark: 43877]Configuring an ICMP Group
 
      [bookmark: pgfId-1546429]An ICMP group includes multiple ICMP types.
 
    
 
     
      [bookmark: pgfId-1546430]Detailed Steps
 
     
 
      [bookmark: pgfId-1669002] Step 1[image: ] Choose  Configuration > Firewall > Objects > Service Object/Group .  
 
      [bookmark: pgfId-1669003]Step 2[image: ] Choose  Add >  ICMP Group  from the drop-down list.
 
      [bookmark: pgfId-1669004]The Add ICMP Group dialog box appears.
 
      [bookmark: pgfId-1669005]Step 3[image: ] In the Name field, enter a name for the new ICMP group. The name can be up to 64 characters in length and must be unique for all object groups. An ICMP group name cannot share a name with other objects and groups..
 
      [bookmark: pgfId-1669006]Step 4[image: ] In the Description field, enter a description for this ICMP group (up to 200 characters in length).
 
      [bookmark: pgfId-1669007]Step 5[image: ] To add an existing ICMP group, or predefined type, click the  Existing Service/Service Group radio button, select the entry from the Name field, and click  Add .
 
      [bookmark: pgfId-1669008]Step 6[image: ] To create a new type, click the  Create new member radio button, enter the type name or number, and then click  Add to add the new type.
 
      [bookmark: pgfId-1669009]Step 7[image: ] Click  OK , and then  Apply .
 
      [bookmark: pgfId-1669010]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1569261]Configuring a Protocol Group
 
      [bookmark: pgfId-1569262]A protocol group contains IP protocol types.
 
    
 
     
      [bookmark: pgfId-1569263]Detailed Steps
 
     
 
      [bookmark: pgfId-1669015] Step 1[image: ] Choose  Configuration > Firewall > Objects > Service Object/Group .  
 
      [bookmark: pgfId-1669016]Step 2[image: ] Choose  Add >  Protocol Group  from the drop-down list.
 
      [bookmark: pgfId-1669017]The Add Protocol Group dialog box appears.
 
      [bookmark: pgfId-1669018]Step 3[image: ] In the Name field, enter a name for the new group. The name can be up to 64 characters in length and must be unique for all object groups. A group name cannot share a name with other objects and groups.
 
      [bookmark: pgfId-1669019]Step 4[image: ] In the Description field, enter a description for this group (up to 200 characters in length).
 
      [bookmark: pgfId-1669020]Step 5[image: ] To add an existing protocol group, or predefined protocol, click the  Existing Service/Service Group radio button, select the entry from the Name field, and click  Add .
 
      [bookmark: pgfId-1669021]Step 6[image: ] To create a new protocol, click the  Create new member radio button, enter the protocol name or number, and then click  Add to add the new protocol.
 
      [bookmark: pgfId-1669022]Step 7[image: ] Click  OK , and then  Apply .
 
      [bookmark: pgfId-1669023]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1550012][bookmark: 64987]Configuring Local User Groups 
 
      [bookmark: pgfId-1570335]You can create local user groups for use in features that support the identity firewall (IDFW) by including the group in an extended ACL, which in turn can be used in an access rule, for example.
 
      [bookmark: pgfId-1570360]The ASA sends an LDAP query to the Active Directory server for user groups globally defined in the Active Directory domain controller. The ASA imports these groups for identity-based rules. However, the ASA might have localized network resources that are not defined globally that require local user groups with localized security policies. Local user groups can contain nested groups and user groups that are imported from Active Directory. The ASA consolidates local and Active Directory groups.
 
      [bookmark: pgfId-1570347]A user can belong to local user groups and user groups imported from Active Directory.
 
    
 
     
      [bookmark: pgfId-1569957]Prerequisites
 
      [bookmark: pgfId-1570287]See “Configuring the Identity Firewall,” to enable IDFW.
 
    
 
     
      [bookmark: pgfId-1569967]Detailed Steps
 
     
 
      [bookmark: pgfId-1669036] Step 1[image: ] Open the  Configuration >  Firewall >  Objects  > Local User Groups  pane.
 
      [bookmark: pgfId-1669037]A table of user groups and their members appears. 
 
      [bookmark: pgfId-1669038]Step 2[image: ] To add a group, click  Add . The Add User Object Group dialog appears. 
 
      [bookmark: pgfId-1669039]Step 3[image: ] Enter a name and description for the group. 
 
      [bookmark: pgfId-1669040]The group name can contain any character including [a-z], [A-Z], [0-9], [!@#$%^&()-_{}. ]. If the group name contains a space, you must enclose the name in quotation marks.
 
      [bookmark: pgfId-1669041]Step 4[image: ] From the Domain list, select the default domain for users in this group or click  Manage to add a new domain or edit and existing domain. 
 
      [bookmark: pgfId-1669042]Step 5[image: ] To add existing groups to this group, enter a search string in the text box and click  Find . 
 
      [bookmark: pgfId-1669043]Step 6[image: ] To add users to the group, enter a search string in the text box and click  Find . 
 
      [bookmark: pgfId-1669044]Step 7[image: ] Select groups and click the  Add button to add them to the group. 
 
      [bookmark: pgfId-1669045]Step 8[image: ] Select users and click the  Add button to add them to the group. 
 
      [bookmark: pgfId-1669046]Step 9[image: ] Click  OK to save your changes.
 
      [bookmark: pgfId-1669047]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1550240][bookmark: 10265]Configuring Security Group Object Groups 
 
      [bookmark: pgfId-1571630]You can create security group object groups for use in features that support Cisco TrustSec by including the group in an extended ACL, which in turn can be used in an access rule, for example.
 
      [bookmark: pgfId-1571468]When integrated with Cisco TrustSec, the ASA downloads security group information from the ISE. The ISE acts as an identity repository, by providing Cisco TrustSec tag to user identity mapping and Cisco TrustSec tag to server resource mapping. You provision and manage security group ACLs centrally on the ISE.
 
      [bookmark: pgfId-1571472]However, the ASA might have localized network resources that are not defined globally that require local security groups with localized security policies. Local security groups can contain nested security groups that are downloaded from the ISE. The ASA consolidates local and central security groups.
 
      [bookmark: pgfId-1571479]To create local security groups on the ASA, you create a local security object group. A local security object group can contain one or more nested security object groups or Security IDs or security group names. User can also create a new Security ID or security group name that does not exist on the ASA.
 
      [bookmark: pgfId-1571486]You can use the security object groups you create on the ASA to control access to network resources. You can use the security object group as part of an access group or service policy.
 
    
 
     
      [bookmark: pgfId-1570670]Prerequisites
 
      [bookmark: pgfId-1571584]See “Configuring the ASA to Integrate with Cisco TrustSec,” to enable TrustSec.
 
    
 
     
      [bookmark: pgfId-1570699]Detailed Steps
 
     
 
      [bookmark: pgfId-1669052] Step 1[image: ] In the main ASDM application window, choose  Configuration >  Firewall >  Objects >  Security Group Object Groups . The Security Group Object Groups pane appears:
 
      [bookmark: pgfId-1679021]
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1669057]
 
      [bookmark: pgfId-1669058]The Security Group Object Groups pane lists the members of the security object group and shows the number of members in the Count column. Click  Where Used to display where the selected security group object is used in an ACL or nested in another security group object.
 
      [bookmark: pgfId-1669059]Step 2[image: ] Click  Add . The Add Security ID Object Group dialog box appears.
 
      [bookmark: pgfId-1679029]
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1669064]Step 3[image: ] In the Group Name field, enter the name for the group as a 32-byte case sensitive string. The group name can contain any character including [a-z], [A-Z], [0-9], [!@#$%^&()-_{}. ].
 
      [bookmark: pgfId-1669065]Step 4[image: ] In the Description field, enter a description for the group.
 
      [bookmark: pgfId-1669066]Step 5[image: ] Add members to the security group object by performing the following task:
 
      [bookmark: pgfId-1669067] a.[image: ] Select one of the following options:
 
      
       
       	 [bookmark: pgfId-1669068]Existing Security ID Objects/Groups radio button
 
       	 [bookmark: pgfId-1669069]Existing Security ID Object radio button
 
      
 
     
 
      [bookmark: pgfId-1669070]In the Filter field, enter the security object ID number or the name of the security group and click  Filter . Use wildcards to broaden the search for security groups.
 
      [bookmark: pgfId-1669071] b.[image: ] Click  Add to select it as Members in Group.
 
      [bookmark: pgfId-1669072]A security object group must contain at least one member.
 
      [bookmark: pgfId-1669073] c.[image: ] Continue selecting members and clicking Add. You can create nested security object groups by selecting existing security ID object/groups and existing security ID objects.
 
      [bookmark: pgfId-1669074]Step 6[image: ] Create a locally defined object by performing the following tasks:
 
      [bookmark: pgfId-1669075] a.[image: ] Click the  Create new Security ID Object member radio button.
 
      [bookmark: pgfId-1669076] b.[image: ] From the Security Type drop-down field, select Tag or Name. 
 
      [bookmark: pgfId-1669077]An SGT is assigned to a device through IEEE 802.1X authentication, web authentication, or MAC authentication bypass (MAB) by the ISE. Security group names are created on the ISE and provide user-friendly names for security groups. The security group table maps SGTs to security group names. 
 
      [bookmark: pgfId-1669078] c.[image: ] In the Security ID/Name field, enter a number from 1 to 65533 for A Tag security type or a 32-byte case-sensitive string for a Name security type.
 
      [bookmark: pgfId-1669079]A security group has a single name assigned to it. The same name can only be associated with a single SGT.
 
      [bookmark: pgfId-1669080]Step 7[image: ] Click OK. The Security ID Objects/Groups pane reappears.
 
      [bookmark: pgfId-1669081]Step 8[image: ] Click  Apply to save the changes to the running configuration.
 
      [bookmark: pgfId-1669082]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1310726][bookmark: 57400]Configuring Regular Exp[bookmark: marker-1310723]ressions
 
      
      	 [bookmark: pgfId-1563356]Creating a Regular Expression
 
      	 [bookmark: pgfId-1563378]Creating a Regular Expression Class Map
 
     
 
    
 
     
      [bookmark: pgfId-1563336][bookmark: 25703]Creating a Regular Expression 
 
      [bookmark: pgfId-1563002]A regular expression matches text strings either literally as an exact string, or by using  metacharacters so that you can match multiple variants of a text string. You can use a regular expression to match the content of certain application traffic; for example, you can match a URL string inside an HTTP packet.
 
    
 
     
      [bookmark: pgfId-1563003]Guidelines
 
      
       
     
 
     
 
     [bookmark: pgfId-1310756]Note As an optimization, the ASA searches on the deobfuscated URL. Deobfuscation compresses multiple forward slashes (/) into a single slash. For strings that commonly use double slashes, like “http://”, be sure to search for “http:/” instead.

      
      
 
     

     
 
      [bookmark: pgfId-1310761] Table 20-1  lists the metach[bookmark: marker-1310760]aracters that have special meanings.
 
      [bookmark: pgfId-1310901]
 
      
       
        
         [bookmark: pgfId-1310768]Table 20-1 [bookmark: 23489]regex Metacharacters 
 
        
       
         
         	
           
           [bookmark: pgfId-1310774]Character
          
  
         	
           
           [bookmark: pgfId-1310776]Description
          
  
         	
           
           [bookmark: pgfId-1310778]Notes
          
  
        
 
         
         	 [bookmark: pgfId-1310780] . 
  
         	 [bookmark: pgfId-1310782]Dot
  
         	 [bookmark: pgfId-1310784]Matches any single character. For example,  d.g  matches dog, dag, dtg, and any word that contains those characters, such as doggonnit.
  
        
 
         
         	 [bookmark: pgfId-1310786] (  exp  ) 
  
         	 [bookmark: pgfId-1310788]Subexpression
  
         	 [bookmark: pgfId-1310790]A subexpression segregates characters from surrounding characters, so that you can use other metacharacters on the subexpression. For example,  d(o|a)g matches dog and dag, but  do|ag  matches do and ag. A subexpression can also be used with repeat quantifiers to differentiate the characters meant for repetition. For example,  ab(xy){3}z matches abxyxyxyz.
  
        
 
         
         	 [bookmark: pgfId-1310792] | 
  
         	 [bookmark: pgfId-1310794]Alternation
  
         	 [bookmark: pgfId-1310796]Matches either expression it separates. For example,  dog|cat matches dog or cat.
  
        
 
         
         	 [bookmark: pgfId-1310798]?
  
         	 [bookmark: pgfId-1310800]Question mark
  
         	 [bookmark: pgfId-1310802]A quantifier that indicates that there are 0 or 1 of the previous expression. For example,  lo?se matches lse or lose.
 and then the question mark or else the help function is invoked.
  
        
 
         
         	 [bookmark: pgfId-1310805] * 
  
         	 [bookmark: pgfId-1310807]Asterisk
  
         	 [bookmark: pgfId-1310809]A quantifier that indicates that there are 0, 1 or any number of the previous expression. For example,  lo*se matches lse, lose, loose, and so on.
  
        
 
         
         	 [bookmark: pgfId-1310811] + 
  
         	 [bookmark: pgfId-1310813]Plus
  
         	 [bookmark: pgfId-1310815]A quantifier that indicates that there is at least 1 of the previous expression. For example,  lo+se matches lose and loose, but not lse.
  
        
 
         
         	 [bookmark: pgfId-1310817] {  x  }  or  {  x  ,} 
  
         	 [bookmark: pgfId-1310819]Minimum repeat quantifier
  
         	 [bookmark: pgfId-1310821]Repeat at least  x times. For example,  ab(xy){2,}z  matches abxyxyz, abxyxyxyz, and so on.
  
        
 
         
         	 [bookmark: pgfId-1310823] [  abc  ] 
  
         	 [bookmark: pgfId-1310825]Character class
  
         	 [bookmark: pgfId-1310827]Matches any character in the brackets. For example,  [abc] matches a, b, or c.
  
        
 
         
         	 [bookmark: pgfId-1310829] [^  abc  ] 
  
         	 [bookmark: pgfId-1310831]Negated character class
  
         	 [bookmark: pgfId-1310833]Matches a single character that is not contained within the brackets. For example, [^abc] matches any character other than a, b, or c.  [^A-Z]  matches any single character that is not an uppercase letter.
  
        
 
         
         	 [bookmark: pgfId-1310835] [  a  -  c  ] 
  
         	 [bookmark: pgfId-1310837]Character range class
  
         	 [bookmark: pgfId-1310839]Matches any character in the range.  [a-z] matches any lowercase letter. You can mix characters and ranges:  [abcq-z] matches a, b, c, q, r, s, t, u, v, w, x, y, z, and so does [ a-cq-z] .
  [bookmark: pgfId-1310840]The dash (-) character is literal only if it is the last or the first character within the brackets: [abc-] or  [-abc] .
  
        
 
         
         	 [bookmark: pgfId-1310842] “” 
  
         	 [bookmark: pgfId-1310844]Quotation marks
  
         	 [bookmark: pgfId-1310846]Preserves trailing or leading spaces in the string. For example,  “ test” preserves the leading space when it looks for a match.
  
        
 
         
         	 [bookmark: pgfId-1310848] ^ 
  
         	 [bookmark: pgfId-1310850]Caret
  
         	 [bookmark: pgfId-1310852]Specifies the beginning of a line.
  
        
 
         
         	 [bookmark: pgfId-1310854] \ 
  
         	 [bookmark: pgfId-1310856]Escape character
  
         	 [bookmark: pgfId-1310858]When used with a metacharacter, matches a literal character. For example,  \[  matches the left square bracket.
  
        
 
         
         	 [bookmark: pgfId-1310860] char 
  
         	 [bookmark: pgfId-1310862]Character
  
         	 [bookmark: pgfId-1310864]When character is not a metacharacter, matches the literal character.
  
        
 
         
         	 [bookmark: pgfId-1310866] \r 
  
         	 [bookmark: pgfId-1310868]Carriage return
  
         	 [bookmark: pgfId-1310870]Matches a carriage return 0x0d.
  
        
 
         
         	 [bookmark: pgfId-1310872] \n 
  
         	 [bookmark: pgfId-1310874]Newline
  
         	 [bookmark: pgfId-1310876]Matches a new line 0x0a.
  
        
 
         
         	 [bookmark: pgfId-1310878] \t 
  
         	 [bookmark: pgfId-1310880]Tab
  
         	 [bookmark: pgfId-1310882]Matches a tab 0x09.
  
        
 
         
         	 [bookmark: pgfId-1310884] \f 
  
         	 [bookmark: pgfId-1310886]Formfeed
  
         	 [bookmark: pgfId-1310888]Matches a form feed 0x0c.
  
        
 
         
         	 [bookmark: pgfId-1310890] \x  NN 
  
         	 [bookmark: pgfId-1310892]Escaped hexadecimal number
  
         	 [bookmark: pgfId-1310894]Matches an ASCII character using hexadecimal (exactly two digits).
  
        
 
         
         	 [bookmark: pgfId-1310896] \  NNN 
  
         	 [bookmark: pgfId-1310898]Escaped octal number
  
         	 [bookmark: pgfId-1310900]Matches an ASCII character as octal (exactly three digits). For example, the character 040 represents a space.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1310902]Detailed Steps
 
     
 
      [bookmark: pgfId-1669088] Step 1[image: ] Choose [bookmark: 45627] Configuration > Global Objects > Regular Expressions .
 
      [bookmark: pgfId-1669089]Step 2[image: ] In the Regular Expressions area, click  Add .
 
      [bookmark: pgfId-1669090]The Add Regular Expression dialog box appears.
 
      [bookmark: pgfId-1669091]Step 3[image: ] In the Name field, name the expression, up to 40 characters in length.
 
      [bookmark: pgfId-1669095]Step 4[image: ] (Optional) Click  Build to use the Creating a Regular Expression Class Map dialog box. See Table 20-1 for more information about metacharacters.
 
      
      	 [bookmark: pgfId-1669099]Build Snippet—This area lets you build text snippets of regular text or lets you insert a metacharacter into the Regular Expression field.
 
      	 [bookmark: pgfId-1669100]Starts at the beginning of the line (^)—Indicates that the snippet should start at the beginning of a line, using the caret (^) metacharacter. Be sure to insert any snippet with this option at the beginning of the regular expression.
 
      	 [bookmark: pgfId-1669101]Specify Character String—Enter a text string manually.
 
     
 
      [bookmark: pgfId-1669102]–[image: ] Character String—Enter a text string.
 
      [bookmark: pgfId-1669103]–[image: ] Escape Special Characters—If you entered any metacharacters in your text string that you want to be used literally, check this box to add the backslash (\) escape character before them. for example, if you enter “example.com,” this option converts it to “example\.com”.
 
      [bookmark: pgfId-1669104]–[image: ] Ignore Case—If you want to match upper and lower case characters, this check box automatically adds text to match both upper and lower case. For example, entering “cats” is converted to “[cC][aA][tT][sS]”.
 
      
      	 [bookmark: pgfId-1669105]Specify Character—Lets you specify a metacharacter to insert in the regular expression.
 
     
 
      [bookmark: pgfId-1669106]–[image: ] Negate the character—Specifies not to match the character you identify.
 
      [bookmark: pgfId-1669107]–[image: ] Any character (.)—Inserts the period (.) metacharacter to match any character. For example,  d.g  matches dog, dag, dtg, and any word that contains those characters, such as doggonnit.
 
      [bookmark: pgfId-1669108]–[image: ] Character set—Inserts a character set. Text can match any character in the set. Sets include:
 
      [bookmark: pgfId-1669109][0-9A-Za-z]
 
      [bookmark: pgfId-1669110][0-9]
 
      [bookmark: pgfId-1669111][A-Z]
 
      [bookmark: pgfId-1669112][a-z]
 
      [bookmark: pgfId-1669113][aeiou]
 
      [bookmark: pgfId-1669114][\n\f\r\t] (which matches a new line, form feed, carriage return, or a tab)
 
      [bookmark: pgfId-1669115]For example, if you specify [0-9A-Za-z], then this snippet will match any character from A to Z (upper or lower case) or any digit 0 through 9.
 
      [bookmark: pgfId-1669116]–[image: ] Special character—Inserts a character that requires an escape, including \, ?, *, +, |, ., [, (, or ^. The escape character is the backslash (\), which is automatically entered when you choose this option.
 
      [bookmark: pgfId-1669117]–[image: ] Whitespace character—Whitespace characters include \n (new line), \f (form feed), \r (carriage return), or \t (tab).
 
      [bookmark: pgfId-1669118]–[image: ] Three digit octal number—Matches an ASCII character as octal (up to three digits). For example, the character \040 represents a space. The backslash (\) is entered automatically.
 
      [bookmark: pgfId-1669119]–[image: ] Two digit hexadecimal number—Matches an ASCII character using hexadecimal (exactly two digits). The backslash (\) is entered automatically.
 
      [bookmark: pgfId-1669120]–[image: ] Specified character—Enter any single character.
 
      
      	 [bookmark: pgfId-1669121]Snippet Preview— Display only . Shows the snippet as it will be entered in the regular expression.
 
      	 [bookmark: pgfId-1669122]Append Snippet—Adds the snippet to the end of the regular expression.
 
      	 [bookmark: pgfId-1669123]Append Snippet as Alternate—Adds the snippet to the end of the regular expression separated by a pipe (|), which matches either expression it separates. For example,  dog|cat matches dog or cat.
 
      	 [bookmark: pgfId-1669124]Insert Snippet at Cursor—Inserts the snippet at the cursor.
 
     
 
      [bookmark: pgfId-1669125]Regular Expression—This area includes regular expression text that you can enter manually and build with snippets. You can then select text in the Regular Expression field and apply a quantifier to the selection.
 
      
      	 [bookmark: pgfId-1669126]Selection Occurrences—Select text in the Regular Expression field, click one of the following options, and then click  Apply to Selection . For example, if the regular expression is “test me,” and you select “me” and apply  One or more times , then the regular expression changes to “test (me)+”.
 
     
 
      [bookmark: pgfId-1669127]–[image: ] Zero or one times (?)—A quantifier that indicates that there are 0 or 1 of the previous expression. For example,  lo?se matches lse or lose.
 
      [bookmark: pgfId-1669128]–[image: ] One or more times (+)—A quantifier that indicates that there is at least 1 of the previous expression. For example,  lo+se matches lose and loose, but not lse.
 
      [bookmark: pgfId-1669129]–[image: ] Any number of times (*)—A quantifier that indicates that there are 0, 1 or any number of the previous expression. For example,  lo*se matches lse, lose, loose, etc.
 
      [bookmark: pgfId-1669130]–[image: ] At least—Repeat at least  x times. For example,  ab(xy){2,}z  matches abxyxyz, abxyxyxyz, etc.
 
      [bookmark: pgfId-1669131]–[image: ] Exactly—Repeat exactly  x times. For example,  ab(xy){3}z matches abxyxyxyz.
 
      [bookmark: pgfId-1669132]–[image: ] Apply to Selection—Applies the quantifier to the selection.
 
      
      	 [bookmark: pgfId-1669133]Test—Tests a regular expression against some sample text.
 
     
 
      [bookmark: pgfId-1669134]Step 5[image: ] If you do not use the Build tool, enter the regular expression manually in the Value field, up to 100 characters in length. Refer to the metacharacters in  Table 20-1 .
 
      [bookmark: pgfId-1669138]Step 6[image: ] To test the regular expression before adding it, click  Test .
 
      [bookmark: pgfId-1669139]The Test Regular Expression dialog box appears.
 
      
      	 [bookmark: pgfId-1669140]Regular Expression—Enter the regular expression you want to test. By default, the regular expression you entered in the Add/Edit Regular Expression or Build Regular Expression dialog box is input into this field. If you change the regular expression during your testing, and click  OK , the changes are inherited by the Add/Edit Regular Expression or Build Regular Expression dialog boxes. Click  Cancel to dismiss your changes.
 
      	 [bookmark: pgfId-1669141]Test String—Enter a text string that you expect to match the regular expression.
 
      	 [bookmark: pgfId-1669142]Test—Tests the Text String against the Regular Expression,
 
      	 [bookmark: pgfId-1669143]Test Result— Display only . Shows if the test succeeded or failed.
 
     
 
      [bookmark: pgfId-1669144]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1311010][bookmark: 69888]  [bookmark: 28408][bookmark: 36125]Creating a Regular Express[bookmark: marker-1311008]ion Class Map
 
      [bookmark: pgfId-1311011]A regular expression class map identifies one or more regular expressions. You can use a regular expression class map to match the content of certain traffic; for example, you can match URL strings inside HTTP packets.
 
    
 
     
      [bookmark: pgfId-1563515]Prerequisites
 
      [bookmark: pgfId-1563542]Create one or more regular expressions according to the “Creating a Regular Expression” section.
 
    
 
     
      [bookmark: pgfId-1311012]Detailed Steps
 
     
 
      [bookmark: pgfId-1669155] Step 1[image: ] Choose  Configuration > Global Objects > Regular Expressions .
 
      [bookmark: pgfId-1669156]Step 2[image: ] In the Regular Expression Classes area, click  Add .
 
      
      	 [bookmark: pgfId-1669157]Name—Enter a name for the class map, up to 40 characters in length. The name “class-default” is reserved. All types of class maps use the same name space, so you cannot reuse a name already used by another type of class map.
 
      	 [bookmark: pgfId-1669158]Description—Enter a description, up to 200 characters in length.
 
      	 [bookmark: pgfId-1669159]Available Regular Expressions—Lists the regular expressions that are not yet assigned to the class map.
 
     
 
      [bookmark: pgfId-1669160]–[image: ] Edit—Edits the selected regular expression.
 
      [bookmark: pgfId-1669161]–[image: ] New—Creates a new regular expression.
 
      
      	 [bookmark: pgfId-1669162]Add—Adds the selected regular expression to the class map.
 
      	 [bookmark: pgfId-1669163]Remove—Removes the selected regular expression from the class map.
 
      	 [bookmark: pgfId-1669164]Configured Match Conditions—Shows the regular expressions in this class map, along with the match type.
 
     
 
      [bookmark: pgfId-1669165]–[image: ] Match Type—Shows the match type, which for regular expressions is always a positive match type (shown by the icon with the equal sign (=)) the criteria. (Inspection class maps allow you to create negative matches as well (shown by the icon with the red circle)). If more than one regular expression is in the class map, then each match type icon appears with “OR” next it, to indicate that this class map is a “match any” class map; traffic matches the class map if only one regular expression is matched.
 
      [bookmark: pgfId-1669166]–[image: ] Regular Expression—Lists the regular expression names in this class map.
 
      [bookmark: pgfId-1669167]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1544026][bookmark: 50889][bookmark: 64610]Configuring Time Ranges[bookmark: marker-1669173]
 
      [bookmark: pgfId-1563771]Create a reusable component that defines starting and ending times that can be applied to various security features. Once you have defined a time range, you can select the time range and apply it to different options that require scheduling. 
 
      [bookmark: pgfId-1563772]The time range feature lets you define a time range that you can attach to traffic rules, or an action. For example, you can attach an ACL to a time range to restrict access to the ASA.
 
      [bookmark: pgfId-1563776]A time range consists of a start time, an end time, and optional recurring entries.
 
    
 
     
      [bookmark: pgfId-1549970]Guidelines
 
      
      	 [bookmark: pgfId-1549971]Multiple periodic entries are allowed per time range. If a time range has both absolute and periodic values specified, then the periodic values are evaluated only after the absolute start time is reached, and they are not further evaluated after the absolute end time is reached.
 
      	 [bookmark: pgfId-1564246]Creating a time range does not restrict access to the device. This procedure defines the time range only. 
 
     
 
    
 
     
      [bookmark: pgfId-1549369]Detailed Steps
 
      [bookmark: pgfId-1549662]
 
     
 
      [bookmark: pgfId-1669180] Step 1[image: ] Choose  Configuration > Global Objects > Time Ranges .
 
      [bookmark: pgfId-1669181]Step 2[image: ] Click  Add .
 
      [bookmark: pgfId-1669182]The Add Time Range window appears.
 
      [bookmark: pgfId-1669183]Step 3[image: ] In the Time Range Name field, enter a time range name, with no spaces.
 
      [bookmark: pgfId-1669184]Step 4[image: ] Choose the Start Time and the End Time by doing one of the following:
 
      [bookmark: pgfId-1669185] a.[image: ] Allow the default settings, in which the Start Now and the Never End radio buttons are checked.
 
      [bookmark: pgfId-1669186] b.[image: ] Apply a specific time range by clicking the  Start at and End at radio buttons and selecting the specified start and stop times from the lists.
 
      [bookmark: pgfId-1669187]The time range is inclusive of the times that you enter.
 
      [bookmark: pgfId-1669188]Step 5[image: ] (Optional) To specify additional time constraints for the time range, such as specifying the days of the week or the recurring weekly interval in which the time range will be active, in the Recurring Time Ranges area, click  Add. 
 
      [bookmark: pgfId-1669189]The Add Recurring Time Range dialog box appears.
 
      [bookmark: pgfId-1669190]Step 6[image: ] Do one of the following:
 
      
       
       	 [bookmark: pgfId-1669191]Click  Specify days of the week and times on which this recurring range will be active , and choose the days and times from the lists, and click  OK .
 
       	 [bookmark: pgfId-1669192]Click  Specify a weekly interval when this recurring range will be active , and choose the days and times from the lists, and click  OK .
 
      
 
     
 
      [bookmark: pgfId-1669193]Step 7[image: ] Click  OK , and then click  Apply .
 
      [bookmark: pgfId-1669194]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1301460][bookmark: 50357]Monitoring Objects
 
     [bookmark: pgfId-1561382]
 
     [bookmark: pgfId-1669205]To view which rules use a network object or group, in the Configuration > Firewall > Objects > Network Objects/Group pane, click the magnifying glass Find icon.
 
     [bookmark: pgfId-1669206]The Usages dialog box appears, listing all the rules currently using the network object or group. This dialog box also lists any network object groups that contain the object.
 
   
 
    
     [bookmark: pgfId-1552499][bookmark: 27944]Feature History for Objects
 
     [bookmark: pgfId-1561687] Table 20-2  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
     [bookmark: pgfId-1586254]
 
     
      
       
        [bookmark: pgfId-1590091]Table 20-2 [bookmark: 50557]Feature History for Object Groups 
 
       
      
        
        	
          
          [bookmark: pgfId-1590097]Feature Name
         
  
        	
          
          [bookmark: pgfId-1590099]Platform
         
 
          
          [bookmark: pgfId-1590100]Releases
         
  
        	
          
          [bookmark: pgfId-1590102]Feature Information
         
  
       
 
        
        	 [bookmark: pgfId-1590104]Object groups
  
        	 [bookmark: pgfId-1590106]7.0(1)
  
        	 [bookmark: pgfId-1590108]Object groups simplify ACL creation and maintenance.
  
       
 
        
        	 [bookmark: pgfId-1626047]Regular expressions and policy maps
  
        	 [bookmark: pgfId-1626049]7.2(1)
  
        	 [bookmark: pgfId-1626051]Regular expressions and policy maps were introduced to be used under inspection policy maps. The following commands were introduced: class-map type regex ,  regex ,  match regex .
  
       
 
        
        	 [bookmark: pgfId-1590111]Objects
  
        	 [bookmark: pgfId-1590113]8.3(1)
  
        	 [bookmark: pgfId-1590115]Object support was introduced.
  
       
 
        
        	 [bookmark: pgfId-1590118]User Object Groups for Identity Firewall
  
        	 [bookmark: pgfId-1590120]8.4(2)
  
        	 [bookmark: pgfId-1590122]User object groups for identity firewall were introduced.
  
       
 
        
        	 [bookmark: pgfId-1590125]Mixed IPv4 and IPv6 network object groups
  
        	 [bookmark: pgfId-1590127]9.0(1)
  
        	 [bookmark: pgfId-1590129]Previously, network object groups could only contain all IPv4 addresses or all IPv6 addresses. Now network object groups can support a mix of both IPv4 and IPv6 addresses.
 [bookmark: pgfId-1590130]Note You cannot use a mixed object group for NAT.
  
       
 
        
        	 [bookmark: pgfId-1590133]Security Group Object Groups for Cisco TrustSec
  
        	 [bookmark: pgfId-1590135]8.4(2)
  
        	 [bookmark: pgfId-1590137]Security group object groups for TrustSec were introduced.
  
       
 
        
        	 [bookmark: pgfId-1590196]Extended ACLand object enhancement to filter ICMP traffic by ICMP code
  
        	 [bookmark: pgfId-1590174]9.0(1)
  
        	 [bookmark: pgfId-1590176]ICMP traffic can now be permitted/denied based on ICMP code.
  [bookmark: pgfId-1669216]We introduced or modified the following screens:
  [bookmark: pgfId-1590179]Configuration > Firewall > Objects > Service Objects/Groups
 Configuration > Firewall > Access Rule 
  
       
 
      
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1215703][bookmark: 16034][bookmark: 17790]Information About AA[bookmark: marker-1215716]A[bookmark: marker-1215717]
      
      
 
     
 
 
     [bookmark: pgfId-1215704]This chapter describes authentication, authorization, and accounting (AAA, pronounced “triple A”). AAA is a a set of services for controlling access to computer resources, enforcing policies, assessing usage, and providing the information necessary to bill for services. These processes are considered important for effective network management and security.
 
     [bookmark: pgfId-1217395]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1217400]Authentication
 
     	 [bookmark: pgfId-1217699]Authorization
 
     	 [bookmark: pgfId-1217736]Accounting
 
     	 [bookmark: pgfId-1217773]Interaction Between Authentication, Authorization, and Accounting
 
     	 [bookmark: pgfId-1218279]AAA Servers
 
     	 [bookmark: pgfId-1218753]AAA Server Groups
 
     	 [bookmark: pgfId-1218778]Local Database Support
 
     	 [bookmark: pgfId-1217810]Summary of AAA Service Support
 
    
 
   
 
    
     [bookmark: pgfId-1217115][bookmark: 38127]Authentication[bookmark: marker-1217563]
 
     [bookmark: pgfId-1217138]Authentication provides a way to identify a user, typically by having the user enter a valid username and valid password before access is granted. The AAA server compares a user's authentication credentials with other user credentials stored in a database. If the credentials match, the user is permitted access to the network. If the credentials do not match, authentication fails and network access is denied.
 
     [bookmark: pgfId-1217456]You can configure the ASA to authenticate the following items:
 
     
     	 [bookmark: pgfId-1217460]All administrative connections to the ASA, including the following sessions:
 
    
 
     [bookmark: pgfId-1217461]–[image: ] Telnet
 
     [bookmark: pgfId-1217462]–[image: ] SSH. For more information, see Chapter45, “Configuring Management Access”
 
     [bookmark: pgfId-1217463]–[image: ] Serial console
 
     [bookmark: pgfId-1217464]–[image: ] ASDM using HTTPS
 
     [bookmark: pgfId-1217465]–[image: ] VPN management access 
 
     
     	 [bookmark: pgfId-1217466]The  enable command. For more information, see Chapter45, “Configuring Management Access”
 
     	 [bookmark: pgfId-1217467]Network access. For more information, see “Configuring the Identity Firewall,” “Configuring the ASA to Integrate with Cisco TrustSec,” and the firewall configuration guide.
 
     	 [bookmark: pgfId-1218004]VPN access. For more information, see the VPN configuration guide.
 
    
 
   
 
    
     [bookmark: pgfId-1218011][bookmark: 24063]Authorization[bookmark: marker-1218010]
 
     [bookmark: pgfId-1218012]Authorization is the process of enforcing policies: determining what types of activities, resources, or services a user is permitted to access. After a user is authenticated, that user may be authorized for different types of access or activity.
 
     [bookmark: pgfId-1217513]You can configure the ASA to authorize the following items:
 
     
     	 [bookmark: pgfId-1217514]Management commands. For more information, see Chapter45, “Configuring Management Access”
 
     	 [bookmark: pgfId-1217515]Network access. For more information, see the firewall configuration guide. 
 
     	 [bookmark: pgfId-1225109]VPN access. For more information, see the VPN configuration guide.
 
    
 
   
 
    
     [bookmark: pgfId-1217297][bookmark: 28036]Accounting
 
     [bookmark: pgfId-1217366]Accounting measures the resources a user consumes during access, which may include the amount of system time or the amount of data that a user has sent or received during a session. Accounting is carried out through the logging of session statistics and usage information, which is used for authorization control, billing, trend analysis, resource utilization, and capacity planning activities.
 
   
 
    
     [bookmark: pgfId-1217033][bookmark: 92379]Interaction Between Authentication, Authorization, and Accounting
 
     [bookmark: pgfId-1052864]You can use authentication alone or with authorization and accounting. Authorization always requires a user to be authenticated first. You can use accounting alone, or with authentication and authorization.
 
   
 
    
     [bookmark: pgfId-1219293][bookmark: 52075]AAA Servers
 
     [bookmark: pgfId-1219294]The AAA server is a network server that is used for access control. Authentication identifies the user. Authorization implements policies that determine which resources and services an authenticated user may access. Accounting keeps track of time and data resources that are used for billing and analysis.
 
   
 
    
     [bookmark: pgfId-1219313][bookmark: 15893]AAA Server Groups
 
     [bookmark: pgfId-1218333]If you want to use an external AAA server for authentication, authorization, or accounting, you must first create at least one AAA server group per AAA protocol and add one or more servers to each group. You identify AAA server groups by name. Each server group is specific to one type of server or service.
 
   
 
    
     [bookmark: pgfId-1219033][bookmark: 52693]Local Database Support
 
     [bookmark: pgfId-1219142]The ASA maintains a local database that you can populate with user profiles. You can use a local database instead of AAA servers to provide user authentication, authorization, and accounting. For more information, see Chapter33, “Configuring the Local Database for AAA”
 
   
 
    
     [bookmark: pgfId-1219173][bookmark: 31689][bookmark: 10167]Summary of AAA Service Support[bookmark: marker-1219172]
 
     [bookmark: pgfId-1216336] Table 32-1  provides cross-references to the configuration guide chapters that describe support for specific AAA service types.
 
     [bookmark: pgfId-1053269]
 
     
      
       
        [bookmark: pgfId-1052982]Table 32-1 [bookmark: 90875]AAA Service Support 
 
       
      
        
        	
          
          [bookmark: pgfId-1053000]AAA Service
         
  
        	 
          
          [bookmark: pgfId-1053002]Configuration Guide Cross-Reference
         
  
       
 
        
        	 [bookmark: pgfId-1216393]Certificates
  
        	  [bookmark: pgfId-1216395]See Chapter40, “Configuring Digital Certificates”
  
       
 
        
        	 [bookmark: pgfId-1216411]HTTP Form
  
        	  [bookmark: pgfId-1216416]See the VPN configuration guide.
  
       
 
        
        	 [bookmark: pgfId-1216435]Identity Firewall
  
        	  [bookmark: pgfId-1216437]See Chapter38, “Configuring the Identity Firewall”
  
       
 
        
        	 [bookmark: pgfId-1216546]Kerberos
  
        	  [bookmark: pgfId-1216548]See the VPN configuration guide.
  
       
 
        
        	 [bookmark: pgfId-1216525]LDAP
  
        	  [bookmark: pgfId-1216530]See Chapter36, “Configuring LDAP Servers for AAA”
  
       
 
        
        	 [bookmark: pgfId-1216507]Local Database
  
        	  [bookmark: pgfId-1216509]See Chapter33, “Configuring the Local Database for AAA”
  
       
 
        
        	 [bookmark: pgfId-1216489]NT
  
        	  [bookmark: pgfId-1216491]See Chapter37, “Configuring Windows NT Servers for AAA”
  
       
 
        
        	 [bookmark: pgfId-1216471]RADIUS
  
        	  [bookmark: pgfId-1216473]See Chapter34, “Configuring RADIUS Servers for AAA”
  
       
 
        
        	 [bookmark: pgfId-1216453]RSA/SDI
  
        	  [bookmark: pgfId-1216455]See the VPN configuration guide.
  
       
 
        
        	 [bookmark: pgfId-1216564]TACACS+
  
        	  [bookmark: pgfId-1216566]See Chapter35, “Configuring TACACS+ Servers for AAA”
  
       
 
        
        	 [bookmark: pgfId-1216582]TrustSec
  
        	  [bookmark: pgfId-1216584]See Chapter39, “Configuring the ASA to Integrate with Cisco TrustSec”
  
       
 
      
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1071406][bookmark: 92075]Configuring Management Access
      
      
 
     
 
 
     [bookmark: pgfId-1042843]This chapter describes how to access the ASA for system management through Telnet, SSH, and HTTPS (using ASDM), how to authenticate and authorize users, and how to create login banners.
 
     [bookmark: pgfId-1044270]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1327798]Configuring ASA Access for ASDM, Telnet, or SSH
 
     	 [bookmark: pgfId-1327812]Configuring CLI Parameters
 
     	 [bookmark: pgfId-1327906]Configuring ICMP Access
 
     	 [bookmark: pgfId-1437429]Configuring Management Access Over a VPN Tunnel
 
     	 [bookmark: pgfId-1328093]Configuring AAA for System Administrators
 
     	 [bookmark: pgfId-1832502]Monitoring Device Access
 
     	 [bookmark: pgfId-1328263]Feature History for Management Access
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1186636]Note To access the ASA interface for management access, you do not also need an access rule allowing the host IP address. You only need to configure management access according to the sections in this chapter.

     
     
 
    

    
 
   
 
    
     [bookmark: pgfId-1186644][bookmark: 29729]Configuring ASA Access for ASDM, Telnet, or SSH [bookmark: marker-1186642][bookmark: marker-1186643]
 
     [bookmark: pgfId-1328656]This section describes how to allow clients to access the ASA using ASDM, Telnet, or SSH and includes the following topics:
 
     
     	 [bookmark: pgfId-1329092]Licensing Requirements for ASA Access for ASDM, Telnet, or SSH
 
     	 [bookmark: pgfId-1329100]Guidelines and Limitations
 
     	 [bookmark: pgfId-1832510]Configuring Management Access
 
     	 [bookmark: pgfId-1329199]Using a Telnet Client
 
     	 [bookmark: pgfId-1329386]Using an SSH Client
 
    
 
     
      [bookmark: pgfId-1328693][bookmark: 56928]Licensing Requirements for ASA Access for ASDM, Telnet, or SSH
 
      [bookmark: pgfId-1329938]The following table shows the licensing requirements for this feature:
 
      [bookmark: pgfId-1860655]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1860648]Model
          
  
         	
           
           [bookmark: pgfId-1860650]License Requirement
          
  
        
 
         
         	 [bookmark: pgfId-1860652]All models
  
         	 [bookmark: pgfId-1860654]Base License.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1329954][bookmark: 92937]Guidelines and Limitations
 
      [bookmark: pgfId-1329955]This section includes the guidelines and limitations for this feature.
 
      [bookmark: pgfId-1263202]Context Mode Guidelines
 
      [bookmark: pgfId-1263203]Supported in single and multiple context mode.
 
      [bookmark: pgfId-1263205]Firewall Mode Guidelines
 
      [bookmark: pgfId-1263206]Supported in routed and transparent firewall mode.
 
      [bookmark: pgfId-1263207]IPv6 Guidelines
 
      [bookmark: pgfId-1263208]Supports IPv6.
 
      [bookmark: pgfId-1449978]Model Guidelines
 
      [bookmark: pgfId-1449985]For the ASASM, a session from the switch to the ASASM is a Telnet session, but Telnet access configuration according to this section is not required.
 
      [bookmark: pgfId-1264920]Additional Guidelines
 
      
      	 [bookmark: pgfId-1264092]You cannot use Telnet to the lowest security interface unless you use Telnet inside a VPN tunnel.
 
      	 [bookmark: pgfId-1265936]Management access to an interface other than the one from which you entered the ASA is not supported. For example, if your management host is located on the outside interface, you can only initiate a management connection directly to the outside interface. The only exception to this rule is through a VPN connection. See the “Configuring Management Access Over a VPN Tunnel” section.
 
      	 [bookmark: pgfId-1264096]The ASA allows:
 
     
 
      [bookmark: pgfId-1264098]–[image: ] A maximum of 5 conc[bookmark: marker-1264097]urrent Telnet connections per context, if available, with a maximum of 100 connections divided among all contexts.
 
      [bookmark: pgfId-1264100]–[image: ] A maximum of 5 concurrent SS[bookmark: marker-1264099]H connections per context, if available, with a maximum of 100 connections divided among all contexts.
 
      [bookmark: pgfId-1264104]–[image: ] A maximum of 5 concurrent ASDM instances per context, if available, with a maximum of 32 ASDM instances among all contexts.
 
      
      	 [bookmark: pgfId-1264111]The ASA supports the SSH remote shell functionality provided in SSH Versions 1 and 2 and supports DES and 3DES ciphers.
 
      	 [bookmark: pgfId-1265829]XML management over SSL and SSH is not supported.
 
      	 [bookmark: pgfId-1478259](8.4 and later) The SSH default username is no longer supported. You can no longer connect to the ASA using SSH with the  pix or  asa username and the login password. To use SSH, you must configure AAA authentication using Configuration > Device Management > Users/AAA > AAA Access > Authentication; then define a local user by choosing Configuration > Device Management > Users/AAA > User Accounts. If you want to use a AAA server for authentication instead of the local database, we recommend also configuring local authentication as a backup method.
 
      	 [bookmark: pgfId-1478263](9.1(2) and later) The default Telnet login password was removed; you must manually set the password before using Telnet. See the “Configuring the Hostname, Domain Name, and Passwords” section.
 
      	 [bookmark: pgfId-1751332]If you cannot make a Telnet or SSH connection to the ASA interface, make sure that you have enabled Telnet or SSH to the ASA according to the instructions in the “Configuring ASA Access for ASDM, Telnet, or SSH” section.
 
      	 [bookmark: pgfId-1577917]The AES-CTR encryption for SSH supports only AES-128 on single-core platforms, which include the ASA 5505, 5510, 5520, 5540, and 5550.
 
     
 
    
 
     
      [bookmark: pgfId-1832526][bookmark: 63385]Configuring Management Access
 
      [bookmark: pgfId-1832530]To identify the client IP addresses allowed to connect to the ASA using Telnet, SSH, or ASDM, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1832531]Detailed Steps
 
     
 
      [bookmark: pgfId-1832532] Step 1[image: ] Choose  Configuration > Device Management > Management Access > ASDM/HTTPS/Telnet/SSH , and click  Add .
 
      [bookmark: pgfId-1832533]The Add Device Access Configuration dialog box appears.
 
      [bookmark: pgfId-1832534]Step 2[image: ] Choose the type of session from the three options listed:  ASDM/HTTPS ,  Telnet , or  SSH .
 
      [bookmark: pgfId-1832535]Step 3[image: ] From the Interface Name drop-down list, choose the interface to use for administrative access.
 
      [bookmark: pgfId-1832536]Step 4[image: ] In the IP Address field, enter the IP address of the network or host that is allowed access. The field allows IPv6 addresses.
 
      
       
     
 
     
 
     [bookmark: pgfId-1832537]Note When you enter a colon (:) in the IP Address field for an IPv6 address, the Netmask field changes to Prefix Length. 

      
      
 
     

     
 
      [bookmark: pgfId-1832538]Step 5[image: ] From the Mask drop-down list, choose the mask associated with the network or host that is allowed access.
 
      [bookmark: pgfId-1832539]Step 6[image: ] Click  OK .
 
      [bookmark: pgfId-1832540]Step 7[image: ] Configure HTTP Settings.
 
      [bookmark: pgfId-1832541] a.[image: ] Enable HTTP Server—Enable the HTTP server for ASDM access. This is enabled by default.
 
      [bookmark: pgfId-1832542] b.[image: ] (Optional) Port Number—The default port is 443.
 
      [bookmark: pgfId-1832543] c.[image: ] (Optional) Idle Timeout—The default idle timeout is 20 minutes.
 
      [bookmark: pgfId-1832544] d.[image: ] (Optional) Session Timeout—By default, the session timeout is disabled. ASDM connections have no session time limit.
 
      [bookmark: pgfId-1832545] e.[image: ] (Optional) Require client certificate to access ASDM on the following interfaces—Specify the interface from the drop-down list.
 
      [bookmark: pgfId-1832546]Step 8[image: ] (Optional) Configure Telnet Settings.
 
      [bookmark: pgfId-1832547] a.[image: ] Telnet Timeout—The default timeout value is 5 minutes.
 
      [bookmark: pgfId-1832548]Step 9[image: ] (Optional) Configure SSH Settings. 
 
      [bookmark: pgfId-1832549] a.[image: ] Allowed SSH Version(s)—The default value is 1 & 2.
 
      [bookmark: pgfId-1832550] b.[image: ] SSH Timeout—The default timeout value is 5 minutes.
 
      [bookmark: pgfId-1832551] c.[image: ] DH Key Exchange—Click the applicable radio button to choose Diffie-Hellman (DH) Key Exchange Group 1 or Group 14. Both the DH Group 1 and Group 14 key-exchange methods for key exchange are supported on the ASA. If no DH group key-exchange method is specified, the DH group 1 key-exchange method is used. For more information about using DH key-exchange methods, see RFC 4253. 
 
      [bookmark: pgfId-1832555]Step 10[image: ] Click  Apply .
 
      [bookmark: pgfId-1832556]The changes are saved to the running configuration.
 
      [bookmark: pgfId-1832557]Step 11[image: ] (Required for SSH) You must also configure SSH authentication.
 
      [bookmark: pgfId-1832558] a.[image: ] Choose  Configuration > Device Management > Users/AAA > AAA Access > Authentication .
 
      [bookmark: pgfId-1832559] b.[image: ] Check the  SSH check box.
 
      [bookmark: pgfId-1832560] c.[image: ] From the Server Group drop-down list, choose an already configured AAA server group name or the  LOCAL database.
 
      [bookmark: pgfId-1832564] d.[image: ] (Optional) If you chose a AAA server group, you can configure the ASA to use the local database as a fallback method if the AAA server is unavailable. Check the  Use LOCAL when server group fails  check box. We recommend that you use the same username and password in the local database as the AAA server because the ASA prompt does not give any indication of which method is being used.
 
      [bookmark: pgfId-1832568] e.[image: ] Click  Apply .
 
      [bookmark: pgfId-1832569] f.[image: ] If you chose the LOCAL database, add a local user. Choose  Configuration > Device Management > Users/AAA > User Accounts , and then click  Add .
 
      [bookmark: pgfId-1832570]The Add User Account-Identity dialog box appears.
 
      [bookmark: pgfId-1832571] g.[image: ] In the Username field, enter a username from 4 to 64 characters long.
 
      [bookmark: pgfId-1832572] h.[image: ] In the Password field, enter a password between 3 and 32 characters. Passwords are case-sensitive.
 
      [bookmark: pgfId-1832573] i.[image: ] In the Confirm Password field, reenter the password.
 
      [bookmark: pgfId-1832576]For information about other fields, see the “Adding a User Account to the Local Database” section.
 
      [bookmark: pgfId-1832578] j.[image: ] Click  OK, then click  Apply .
 
      [bookmark: pgfId-1832579]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1751486][bookmark: 44720]Using a Telnet Client
 
      [bookmark: pgfId-1751533]To gain ac[bookmark: marker-1751487]cess to the ASA CLI using Telnet, enter the login password. (9.1(2) and later) The default Telnet login password was removed; you must manually set the password before using Telnet. See the “Configuring the Hostname, Domain Name, and Passwords” section.
 
      [bookmark: pgfId-1751491]If you configure Telnet authentication (see the “Configuring Authentication for CLI, ASDM, and enable command Access” section), then enter the username and password defined by the AAA server or local database.
 
    
 
     
      [bookmark: pgfId-1272719][bookmark: 43191]Using an SSH Cli[bookmark: marker-1272718]ent
 
      [bookmark: pgfId-1272443][bookmark: marker-1390630]In the SSH client on your management host, enter the username and password. When starting an SSH sessi[bookmark: marker-1124289]on, a dot (.) displays on the ASA console before the following SSH user authentication prompt appears:
 
     
      [bookmark: pgfId-1079384]ciscoasa(config)#.
     

     
      [bookmark: pgfId-1079385]
     

      [bookmark: pgfId-1079386]The display of the dot does not affect the functionality of SSH. The dot appears at the console when generating a server key or decrypting a message using private keys during SSH key exchange before user authentication occurs. These tasks can take up to two minutes or longer. The dot is a progress indicator that verifies that the ASA is busy and has not hung.
 
      [bookmark: pgfId-1720888]You can alternatively configure a public key instead of using a password. See the “Adding a User Account to the Local Database” section.
 
    
 
   
 
    
     [bookmark: pgfId-1093906][bookmark: 31653]Configuring CLI Parameters
 
     [bookmark: pgfId-1093907]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1329797]Licensing Requirements for CLI Parameters
 
     	 [bookmark: pgfId-1329828]Guidelines and Limitations
 
     	 [bookmark: pgfId-1329844]Configuring a Login Banner
 
     	 [bookmark: pgfId-1330018]Customizing a CLI Prompt
 
     	 [bookmark: pgfId-1330055]Changing the Console Timeout
 
    
 
     
      [bookmark: pgfId-1267309][bookmark: 28243]Licensing Requirements for CLI Parameters
 
      [bookmark: pgfId-1267310]The following table shows the licensing requirements for this feature:
 
      [bookmark: pgfId-1860672]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1860665]Model
          
  
         	
           
           [bookmark: pgfId-1860667]License Requirement
          
  
        
 
         
         	 [bookmark: pgfId-1860669]All models
  
         	 [bookmark: pgfId-1860671]Base License.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1267326][bookmark: 59805]Guidelines and Limitations
 
      [bookmark: pgfId-1267327]This section includes the guidelines and limitations for this feature.
 
      [bookmark: pgfId-1267329]Context Mode Guidelines
 
      [bookmark: pgfId-1267330]Supported in single and multiple context mode.
 
      [bookmark: pgfId-1267332]Firewall Mode Guidelines
 
      [bookmark: pgfId-1568504]Supported in routed and transparent firewall mode.
 
    
 
     
      [bookmark: pgfId-1568508][bookmark: 35161][bookmark: 36060]Configuring a Login B[bookmark: marker-1568506]anner
 
      [bookmark: pgfId-1568512]You can configure a message to display when a user connects to the ASA, before a user logs in, or before a user enters privileged EXEC mode.
 
    
 
     
      [bookmark: pgfId-1093928]Restrictions
 
      [bookmark: pgfId-1093932]After a banner is added, Telnet or SSH sessions to ASA may close if:
 
      
      	 [bookmark: pgfId-1093933]There is not enough system memory available to process the banner message(s).
 
      	 [bookmark: pgfId-1093934]A TCP write error occurs when trying to display banner message(s).
 
     
 
    
 
     
      [bookmark: pgfId-1093935]Guidelines
 
      
      	 [bookmark: pgfId-1093936]From a security perspective, it is important that your banner discourage unauthorized access. Do not use the words “welcome” or “please,” as they appear to invite intruders in. The following banner sets the correct tone for unauthorized access:
 
     
 
     
      [bookmark: pgfId-1093937]You have logged in to a secure device. If you are not authorized to access this device, log out immediately or risk possible criminal consequences.
     

     
      [bookmark: pgfId-1093939]
     

      
      	 [bookmark: pgfId-1093940]See RFC 2196 for guidelines about banner messages. 
 
     
 
      [bookmark: pgfId-1388918]To configure a login banner, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1093941]Detailed Steps
 
     
 
      [bookmark: pgfId-1832590] Step 1[image: ] Choose  Configuration > Device Management > Management Access > Command Line (CLI) > Banner ,  then  add your banner text to the field for the type of banner that you are creating for the CLI:
 
      
       
       	 [bookmark: pgfId-1832591]The session (exec) banner appears when a user accesses privileged EXEC mode at the CLI.
 
       	 [bookmark: pgfId-1832592]The login banner appears when a user logs in to the CLI.
 
       	 [bookmark: pgfId-1832593]The message-of-the-day (motd) banner appears when a user first connects to the CLI.
 
       	 [bookmark: pgfId-1832594]The ASDM banner appears when a user connects to ASDM, after user authentication. The user is given two options for dismissing the banner: 
 
      
 
     
 
      [bookmark: pgfId-1832595]–[image: ] Continue—Dismiss the banner and complete login.
 
      [bookmark: pgfId-1832596]–[image: ] Disconnect—Dismiss the banner and terminate the connection.
 
      
       
       	 [bookmark: pgfId-1832597]Only ASCII characters are allowed, including a new line (Enter), which counts as two characters.
 
       	 [bookmark: pgfId-1832598]Do not use tabs in the banner, because they are not preserved in the CLI version. 
 
       	 [bookmark: pgfId-1832599]There is no length limit for banners other than those for RAM and flash memory.
 
       	 [bookmark: pgfId-1832603]You can dynamically add the hostname or domain name of the ASA by including the strings  $(hostname) and  $(domain) .
 
       	 [bookmark: pgfId-1832604]If you configure a banner in the system configuration, you can use that banner text within a context by using the  $(system) string in the context configuration.
 
      
 
     
 
      [bookmark: pgfId-1832605]Step 2[image: ] Click  Apply .
 
      [bookmark: pgfId-1832606]The new banner is saved to the running configuration.
 
      [bookmark: pgfId-1832607]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1093996][bookmark: 53907]Customizing a CLI Prompt 
 
      [bookmark: pgfId-1093997]The CLI Prompt pane lets you customize the prompt used during CLI sessions. By default, the prompt shows the hostname of the ASA. In multiple context mode, the prompt also displays the context name. You can display the following items in the CLI prompt:
 
      [bookmark: pgfId-1094026]
 
      
       
       
         
         	 [bookmark: pgfId-1461294] cluster-unit 
  
         	 [bookmark: pgfId-1461296](Single and multiple mode) Displays the cluster unit name. Each unit in a cluster can have a unique name.
  
        
 
         
         	 [bookmark: pgfId-1094003] context 
  
         	 [bookmark: pgfId-1094005](Multiple mode only) Displays the name of the current context.
  
        
 
         
         	 [bookmark: pgfId-1094007] domain 
  
         	 [bookmark: pgfId-1094009]Displays the domain name.
  
        
 
         
         	 [bookmark: pgfId-1094011] hostname 
  
         	 [bookmark: pgfId-1094013]Displays the hostname.
  
        
 
         
         	 [bookmark: pgfId-1094015] priority 
  
         	 [bookmark: pgfId-1094017]Displays the failover priority as pri (primary) or sec (secondary). 
  
        
 
         
         	 [bookmark: pgfId-1094019] state 
  
         	 [bookmark: pgfId-1094021]Displays the traffic-passing state of the unit. The following values appear for the state:
 
           
           	 [bookmark: pgfId-1094022]act—Failover is enabled, and the unit is actively passing traffic.
 
           	 [bookmark: pgfId-1094023]stby— Failover is enabled, and the unit is not passing traffic and is in a standby, failed, or another inactive state.
 
           	 [bookmark: pgfId-1094024]actNoFailover—Failover is not enabled, and the unit is actively passing traffic.
 
           	 [bookmark: pgfId-1094025]stbyNoFailover—Failover is not enabled, and the unit is not passing traffic. This condition might occur when there is an interface failure above the threshold on the standby unit.
 
          
  [bookmark: pgfId-1461297]Shows the role (master or slave) of a unit in a cluster. For example, in the prompt ciscoasa/cl2/slave, the hostname is ciscoasa, the unit name is cl2, and the state name is slave.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1094027]Detailed Steps
 
      [bookmark: pgfId-1236453]To customize the CLI prompt, perform the following steps:
 
     
 
      [bookmark: pgfId-1832617] Step 1[image: ] Choose  Configuration > Device Management > Management Access > Command Line (CLI) > CLI Prompt , then do any of the following to customize the prompt:
 
      
       
       	 [bookmark: pgfId-1832618]To add an attribute to the prompt, click the attribute in the Available Prompts list and then click  Add . You can add multiple attributes to the prompt. The attribute is moved from the Available Prompts list to the Selected Prompts list.
 
       	 [bookmark: pgfId-1832619]To remove an attribute from the prompt, click the attribute in the Selected Prompts list and then click  Delete . The attribute is moved from the Selected Prompts list to the Available Prompts list.
 
       	 [bookmark: pgfId-1832620]To change the order in which the attributes appear in the command prompt, click the attribute in the Selected Prompts list and click  Move Up or  Move Down to change the order.
 
      
 
     
 
      [bookmark: pgfId-1832621]The prompt is changed and displays in the CLI Prompt Preview field.
 
      [bookmark: pgfId-1832622]Step 2[image: ] Click  Apply .
 
      [bookmark: pgfId-1832623]The new prompt is saved to the running configuration.
 
      [bookmark: pgfId-1832624]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1094053][bookmark: 11936]Changing the Console Timeout
 
      [bookmark: pgfId-1207567]The console timeout sets how long a connection can remain in privileged EXEC mode or configuration mode; when the timeout is reached, the session drops into user EXEC mode. By default, the session does not time out. This setting does not affect how long you can remain connected to the console port, which never times out.
 
      [bookmark: pgfId-1388938]To change the console timeout, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1207568]Detailed Steps
 
     
 
      [bookmark: pgfId-1832629] Step 1[image: ] To define a new timeout value in minutes, choose  Configuration > Device Management > Management Access > Command Line (CLI) > Console Timeout .
 
      [bookmark: pgfId-1832630]Step 2[image: ] To specify an unlimited amount of time, enter  0 . The default value is 0.
 
      [bookmark: pgfId-1832631]Step 3[image: ] Click  Apply .
 
      [bookmark: pgfId-1832632]The timeout value is changed and the change is saved to the running configuration.
 
      [bookmark: pgfId-1832633]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1093364][bookmark: 81207]Configuring ICMP Access 
 
     [bookmark: pgfId-1269413]By default, you can send ICMP packets to any ASA interface using either IPv4 or IPv6. This section tells how to limit ICMP management access to the ASA. You can protect the ASA from attacks by limiting the addresses of hosts and networks that are allowed to have ICMP access to the ASA. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1270368]Note For allowing ICMP traffic through the ASA, see Chapter 6, “Configuring Access Rules,” in the firewall configuration guide.

     
     
 
    

    
 
     [bookmark: pgfId-1270358]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1330362]Information About ICMP Access
 
     	 [bookmark: pgfId-1330398]Licensing Requirements for ICMP Access
 
     	 [bookmark: pgfId-1330411]Guidelines and Limitations
 
     	 [bookmark: pgfId-1330423]Default Settings
 
     	 [bookmark: pgfId-1330451]Configuring ICMP Access
 
    
 
     
      [bookmark: pgfId-1268102][bookmark: 30751]Information About ICMP Access
 
      [bookmark: pgfId-1269305]ICMP in IPv6 functions the same as ICMP in IPv4. ICMPv6 generates error messages, such as ICMP destination unreachable messages and informational messages like ICMP echo request and reply messages. Additionally ICMP packets in IPv6 are used in the IPv6 neighbor discovery process and path MTU discovery.
 
      [bookmark: pgfId-1268760]We recommend that you always grant permission for the ICMP unreachable message type (type 3). Denying ICMP [bookmark: marker-1268761][bookmark: marker-1268762]unreachable messages disables ICMP path MTU discovery, which can halt IPsec and PPTP traffic. See RFC 1195 and RFC 1435 for details about path MTU discovery.
 
      [bookmark: pgfId-1268766]If you configure ICMP rules, then the ASA uses a first match to the ICMP traffic followed by an implicit deny all entry. That is, if the first matched entry is a permit entry, the ICMP packet continues to be processed. If the first matched entry is a deny entry or an entry is not matched, the ASA discards the ICMP packet and generates a syslog message. An exception is when an ICMP rule is not configured; in that case, a permit statement is assumed.
 
    
 
     
      [bookmark: pgfId-1342960][bookmark: 25551]Licensing Requirements for ICMP Access
 
      [bookmark: pgfId-1342961]The following table shows the licensing requirements for this feature:
 
      [bookmark: pgfId-1860689]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1860682]Model
          
  
         	
           
           [bookmark: pgfId-1860684]License Requirement
          
  
        
 
         
         	 [bookmark: pgfId-1860686]All models
  
         	 [bookmark: pgfId-1860688]Base License.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1342964][bookmark: 63849]Guidelines and Limitations
 
      [bookmark: pgfId-1268033]This section includes the guidelines and limitations for this feature.
 
      [bookmark: pgfId-1268034]Context Mode Guidelines
 
      [bookmark: pgfId-1268035]Supported in single and multiple context mode.
 
      [bookmark: pgfId-1268036]Firewall Mode Guidelines
 
      [bookmark: pgfId-1268037]Supported in routed and transparent firewall mode.
 
      [bookmark: pgfId-1270238]IPv6 Guidelines
 
      [bookmark: pgfId-1270239]Supports IPv6.
 
      [bookmark: pgfId-1270047]Additional Guidelines
 
      
      	 [bookmark: pgfId-1270004]The ASA does not respond to ICMP echo requests directed to a broadcast address. [bookmark: marker-1270003]
 
      	 [bookmark: pgfId-1270008]The ASA only responds to ICMP traffic sent to the interface that traffic comes in on; you cannot send ICMP traffic through an interface to a far interface.
 
      	 [bookmark: pgfId-1478274]If you cannot ping the ASA interface, make sure that you enable ICMP to the ASA for your IP address using the  icmp command.
 
     
 
    
 
     
      [bookmark: pgfId-1268115][bookmark: 11541]Default Settings
 
      [bookmark: pgfId-1268119]By default, you can send ICMP packets to any ASA interface using either IPv4 or IPv6.
 
    
 
     
      [bookmark: pgfId-1267985][bookmark: 47456]Configuring ICMP Access
 
      [bookmark: pgfId-1093400]To configure ICMP access rules, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1093401]Detailed Steps
 
     
 
      [bookmark: pgfId-1832845] Step 1[image: ] Choose  Configuration > Device Management > Management Access > ICMP , and click  Add .
 
      [bookmark: pgfId-1832846]Step 2[image: ] Choose which version of IP traffic to filter by clicking the applicable radio button:
 
      
      	 [bookmark: pgfId-1832847] Both (filters IPv4 and IPv6 traffic)
 
      	 [bookmark: pgfId-1832848] IPv4 only
 
      	 [bookmark: pgfId-1832849] IPv6 only
 
     
 
      [bookmark: pgfId-1832850]Step 3[image: ] If you want to insert a rule into the ICMP table, select the rule that the new rule will precede, and click  Insert .
 
      [bookmark: pgfId-1832851]The Create ICMP Rule dialog box appears in the right-hand pane.
 
      [bookmark: pgfId-1832852]Step 4[image: ] From the ICMP Type drop-down list, choose the type of ICMP message for this rule.
 
      [bookmark: pgfId-1832856]Step 5[image: ] From the Interface list, choose the destination ASA interface to which the rule is to be applied.
 
      [bookmark: pgfId-1832857]Step 6[image: ] In the IP Address field, do one of the following:
 
      
       
       	 [bookmark: pgfId-1832858]Add a specific IP address for the host or network.
 
       	 [bookmark: pgfId-1832862]Click  Any Address, then go to Step 9.
 
      
 
     
 
      [bookmark: pgfId-1832863]Step 7[image: ] From the Mask drop-down list, choose the network mask.
 
      [bookmark: pgfId-1832864]Step 8[image: ] Click  OK .
 
      [bookmark: pgfId-1832865]The Create ICMP Rule dialog box closes.
 
      [bookmark: pgfId-1832868]Step 9[image: ] [bookmark: 49946](Optional) To set [bookmark: marker-1832867]ICMP unreachable message limits, set the following options. Increasing the rate limit, along with enabling the  Decrement time to live for a connection option on the Configuration > Firewall > Service Policy Rules > Rule Actions > Connection Settings dialog box, is required to allow a traceroute through the ASA that shows the ASA as one of the hops. 
 
      
       
       	 [bookmark: pgfId-1832875]Rate Limit—Sets the rate limit of unreachable messages, between 1 and 100 messages per second. The default is 1 message per second. 
 
       	 [bookmark: pgfId-1832876]Burst Size—Sets the burst rate, between 1 and 10. This keyword is not currently used by the system, so you can choose any value. 
 
      
 
     
 
      [bookmark: pgfId-1832877]Step 10[image: ] Click  Apply .
 
      [bookmark: pgfId-1832881]The ICMP rule is added to the ASA, and the change is saved to the running configuration. 
 
      [bookmark: pgfId-1832882]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1438524][bookmark: 30377]Configuring Management Access Over a VPN Tunnel
 
     [bookmark: pgfId-1438528]If your VPN tunnel terminates on one interface, but you want to manage the ASA by accessing a different interface, you can identify that interface as a management-access interface. For example, if you enter the ASA from the outside interface, this feature lets you connect to the inside interface using ASDM, SSH, Telnet, or SNMP; or you can ping the inside interface when entering from the outside interface. Management access is available via the following VPN tunnel types: IPsec clients, IPsec site-to-site, and the AnyConnect SSL VPN client.
 
     [bookmark: pgfId-1438532]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1438536]Licensing Requirements for a Management Interface
 
     	 [bookmark: pgfId-1438540]Guidelines and Limitations
 
     	 [bookmark: pgfId-1438544]Configuring a Management Interface
 
    
 
     
      [bookmark: pgfId-1438546][bookmark: 74198]Licensing Requirements for a Management Interface
 
      [bookmark: pgfId-1438547]The following table shows the licensing requirements for this feature:
 
      [bookmark: pgfId-1860706]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1860699]Model
          
  
         	
           
           [bookmark: pgfId-1860701]License Requirement
          
  
        
 
         
         	 [bookmark: pgfId-1860703]All models
  
         	 [bookmark: pgfId-1860705]Base License.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1438587]Guidelines and Limitations
 
      [bookmark: pgfId-1438588]This section includes the guidelines and limitations for this feature.
 
      [bookmark: pgfId-1438589]Context Mode Guidelines
 
      [bookmark: pgfId-1438590]Supported in single mode.
 
      [bookmark: pgfId-1438591]Firewall Mode Guidelines
 
      [bookmark: pgfId-1438592]Supported in routed mode.
 
      [bookmark: pgfId-1438593]IPv6 Guidelines
 
      [bookmark: pgfId-1438594]Supports IPv6.
 
      [bookmark: pgfId-1438595]Additional Guidelines
 
      [bookmark: pgfId-1856901]You can define only one management access interface.
 
    
 
     
      [bookmark: pgfId-1856903][bookmark: 51211]Configuring a Management Interface
 
      [bookmark: pgfId-1856904]To configure the management interface, perform the following steps.
 
    
 
     
      [bookmark: pgfId-1438609]Detailed Steps
 
     
 
      [bookmark: pgfId-1832887] Step 1[image: ] From the Configuration > Device Management > Management Access > Management Interface pane, choose the interface with the highest security (the inside interface) from the Management Access Interface  drop-down list.
 
      [bookmark: pgfId-1832888]Step 2[image: ] Click  Apply .
 
      [bookmark: pgfId-1832889]The management interface is assigned, and the change is saved to the running configuration. 
 
      [bookmark: pgfId-1832890]

      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1145571][bookmark: 73014]Configuring AAA for System Administrators
 
     [bookmark: pgfId-1145572]This section describes how to enable authentication and command authorization for system administrators.
 
     
     	 [bookmark: pgfId-1330615]Information About AAA for System Administrators
 
     	 [bookmark: pgfId-1330623]Licensing Requirements for AAA for System Administrators
 
     	 [bookmark: pgfId-1330628]Prerequisites
 
     	 [bookmark: pgfId-1330633]Guidelines and Limitations
 
     	 [bookmark: pgfId-1330638]Default Settings
 
     	 [bookmark: pgfId-1330643]Configuring Authentication for CLI, ASDM, and enable command Access
 
     	 [bookmark: pgfId-1330666]Limiting User CLI and ASDM Access with Management Authorization
 
     	 [bookmark: pgfId-1712259]Configuring a Password Policy for Local Database Users
 
     	 [bookmark: pgfId-1330680]Configuring Command Authorization
 
     	 [bookmark: pgfId-1330689]Configuring Management Access Accounting
 
     	 [bookmark: pgfId-1330694]Viewing the Currently Logged-In User
 
     	 [bookmark: pgfId-1699295]Setting a Management Session Quota
 
     	 [bookmark: pgfId-1330736]Recovering from a Lockout
 
    
 
     
      [bookmark: pgfId-1270951][bookmark: 58151]Information About AAA for System Administrators
 
      [bookmark: pgfId-1271957]This section describes AAA for system administrators and includes the following topics:
 
      
      	 [bookmark: pgfId-1330902]Information About Management Authentication
 
      	 [bookmark: pgfId-1330986]Information About Command Authorization
 
     
 
    
 
     
      [bookmark: pgfId-1274999][bookmark: 69133]Information About Management Authentication
 
      [bookmark: pgfId-1275256]This section describes authentication for management access and includes the following topics:
 
      
      	 [bookmark: pgfId-1330794]Comparing CLI Access with and without Authentication
 
      	 [bookmark: pgfId-1330802]Comparing ASDM Access with and without Authentication
 
      	 [bookmark: pgfId-1450377]Authenticating Sessions from the Switch to the ASA Services Module
 
     
 
    
 
     
      [bookmark: pgfId-1271409][bookmark: 74802]Comparing CLI Access with and without Authentication
 
      [bookmark: pgfId-1271432]How you log into the ASA depends on whether or not you enable authentication:
 
      
      	 [bookmark: pgfId-1271433]No Authentication—If you do not enable any authentication for Telnet, you do not enter a username; you enter the login password. (SSH is not available without authentication). You access user EXEC mode.
 
      	 [bookmark: pgfId-1274638]Authentication—If you enable Telnet or SSH authentication according to this section, you enter the username and password as defined on the AAA server or local user database. You access user EXEC mode.
 
     
 
      [bookmark: pgfId-1274639]To enter privileged EXEC mode after logging in, enter the  enable command. How  enable works depends on whether you enable authentication:
 
      
      	 [bookmark: pgfId-1271436]No Authentication—If you do not configure enable authentication, enter the system enable password when you enter the  enable command. However, if you do not use enable authentication, after you enter the  enable command, you are no longer logged in as a particular user. To maintain your username, use enable authentication.
 
      	 [bookmark: pgfId-1271437]Authentication—If you configure enable authentication, the ASA prompts you for your username and password again. This feature is particularly useful when you perform command authorization, in which usernames are important in determining the commands that a user can enter.
 
     
 
      [bookmark: pgfId-1271439]For enable authentication using the local database, you can use the  login command instead of the  enable command.  login maintains the username but requires no configuration to turn on authentication.
 
    
 
     
      [bookmark: pgfId-1271440][bookmark: 40422]Comparing ASDM Access with and without Authentication
 
      [bookmark: pgfId-1271442]By default, you can log into ASDM with a blank username and the enable password. Note that if you enter a username and password at the login screen (instead of leaving the username blank), ASDM checks the local database for a match.
 
      [bookmark: pgfId-1271444]If you configure HTTP authentication, you can no longer use ASDM with a blank username and the enable password.
 
    
 
     
      [bookmark: pgfId-1450386][bookmark: 12407]Authenticating Sessions from the Switch to the ASA Services Module
 
      [bookmark: pgfId-1450390]For sessions from the switch to the ASASM (using the  session command), you can configure Telnet authentication. For virtual console connections from the switch to the ASASM (using the  service-module session  command), you can configure serial port authentication. 
 
      [bookmark: pgfId-1450394]In multiple context mode, you cannot configure any AAA commands in the system configuration. However, if you configure Telnet or serial authentication in the admin context, then authentication also applies to sessions from the switch to the ASASM. The admin context AAA server or local user database is used in this instance.
 
    
 
     
      [bookmark: pgfId-1275052][bookmark: 12946]Information About Command Authorization[bookmark: marker-1275051]
 
      [bookmark: pgfId-1275053]This section describes command authorization and includes the following topics:
 
      
      	 [bookmark: pgfId-1331066]Supported Command Authorization Methods
 
      	 [bookmark: pgfId-1331169]About Preserving User Credentials
 
      	 [bookmark: pgfId-1331198]Security Contexts and Command Authorization
 
     
 
    
 
     
      [bookmark: pgfId-1275067][bookmark: 64609]Supported Command Authorization Methods
 
      [bookmark: pgfId-1275068]You can use one of two command authorization methods:
 
      
      	 [bookmark: pgfId-1275072]Local privilege levels—Configure the command privilege levels on the ASA. When a local, RADIUS, or LDAP (if you map LDAP attributes to RADIUS attributes) user authenticates for CLI access, the ASA places that user in the privilege level that is defined by the local database, RADIUS, or LDAP server. The user can access commands at the assigned privilege level and below. Note that all users access user EXEC mode when they first log in (commands at level 0 or 1). The user needs to authenticate again with the  enable command to access privileged EXEC mode (commands at level 2 or higher), or they can log in with the  login command (local database only).
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1275076]Note You can use local command authorization without any users in the local database and without CLI or enable authentication. Instead, when you enter the enable command, you enter the system enable password, and the ASA places you in level 15. You can then create enable passwords for every level, so that when you enter enable n (2 to 15), the ASA places you in level n. These levels are not used unless you enable local command authorization (see the “Configuring Local Command Authorization” section). (See the command reference for more information about the enable command.)

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1275089]TACACS+ server privilege levels—On the TACACS+ server, configure the commands that a user or group can use after authenticating for CLI access. Every command that a user enters at the CLI is validated with the TACACS+ server.
 
     
 
    
 
     
      [bookmark: pgfId-1275091][bookmark: 61562]About Preserving User Credentials
 
      [bookmark: pgfId-1275095]When a user logs into the ASA, that user is required to provide a username and password for authentication. The ASA retains these session credentials in case further authentication is needed later in the session.
 
      [bookmark: pgfId-1275099]When the following configurations are in place, a user needs only to authenticate with the local server for login. Subsequent serial authorization uses the saved credentials. The user is also prompted for the privilege level 15 password. When exiting privileged mode, the user is authenticated again. User credentials are not retained in privileged mode.
 
      
      	 [bookmark: pgfId-1275100]The local server is configured to authenticate user access.
 
      	 [bookmark: pgfId-1275101]Privilege level 15 command access is configured to require a password.
 
      	 [bookmark: pgfId-1275102]The user account is configured for serial-only authorization (no access to console or ASDM).
 
      	 [bookmark: pgfId-1275103]The user account is configured for privilege level 15 command access.
 
     
 
      [bookmark: pgfId-1275107]The following table shows how credentials are used in this case by the ASA. 
 
      [bookmark: pgfId-1275149]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1275110]Credentials required
          
  
         	
           
           [bookmark: pgfId-1275112]Username and Password Authentication
          
  
         	
           
           [bookmark: pgfId-1275114]Serial 
           
 Authorization
          
  
         	
           
           [bookmark: pgfId-1275116]Privileged Mode Command Authorization
          
  
         	
           
           [bookmark: pgfId-1275118]Privileged 
           
 Mode Exit Authorization
          
  
        
 
         
         	 [bookmark: pgfId-1275120]Username
  
         	 [bookmark: pgfId-1275122]Yes
  
         	 [bookmark: pgfId-1275124]No
  
         	 [bookmark: pgfId-1275126]No
  
         	 [bookmark: pgfId-1275128]Yes
  
        
 
         
         	 [bookmark: pgfId-1275130]Password
  
         	 [bookmark: pgfId-1275132]Yes
  
         	 [bookmark: pgfId-1275134]No
  
         	 [bookmark: pgfId-1275136]No
  
         	 [bookmark: pgfId-1275138]Yes
  
        
 
         
         	 [bookmark: pgfId-1275140]Privileged Mode Password
  
         	 [bookmark: pgfId-1275142]No
  
         	 [bookmark: pgfId-1275144]No
  
         	 [bookmark: pgfId-1275146]Yes
  
         	 [bookmark: pgfId-1275148]No
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1275151][bookmark: 30969]Security Contexts and Command Authorization
 
      [bookmark: pgfId-1275153][bookmark: marker-1275152]The following are important points to consider when implementing command authorization with multiple security contexts:
 
      
      	 [bookmark: pgfId-1275154]AAA settings are discrete per context, not shared among contexts.
 
     
 
      [bookmark: pgfId-1275155]When configuring command authorization, you must configure each security context separately. This configuration provides you the opportunity to enforce different command authorizations for different security contexts.
 
      [bookmark: pgfId-1275156]When switching between security contexts, administrators should be aware that the commands permitted for the username specified when they login may be different in the new context session or that command authorization may not be configured at all in the new context. Failure to understand that command authorizations may differ between security contexts could confuse an administrator. This behavior is further complicated by the next point.
 
      
      	 [bookmark: pgfId-1275157]New context sessions started with the  changeto command always use the default enable_15 username as the administrator identity, regardless of which username was used in the previous context session. This behavior can lead to confusion if command authorization is not configured for the enable_15 user or if authorizations are different for the enable_15 user than for the user in the previous context session.
 
     
 
      [bookmark: pgfId-1275158]This behavior also affects command accounting, which is useful only if you can accurately associate each command that is issued with a particular administrator. Because all administrators with permission to use the  changeto command can use the enable_15 username in other contexts, command accounting records may not readily identify who was logged in as the enable_15 username. If you use different accounting servers for each context, tracking who was using the enable_15 username requires correlating the data from several servers.
 
      [bookmark: pgfId-1275159]When configuring command authorization, consider the following:
 
      
      	 [bookmark: pgfId-1275160]An administrator with permission to use the  changeto command effectively has permission to use all commands permitted to the enable_15 user in each of the other contexts.
 
      	 [bookmark: pgfId-1275161]If you intend to authorize commands differently per context, ensure that in each context the enable_15 username is denied use of commands that are also denied to administrators who are permitted use of the  changeto command.
 
     
 
      [bookmark: pgfId-1275162]When switching between security contexts, administrators can exit privileged EXEC mode and enter the  enable command again to use the username that they need.
 
      
       
     
 
     
 
     [bookmark: pgfId-1275163]Note The system execution space does not support AAA commands; therefore, command authorization is not available in the system execution space.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1270831][bookmark: 86793]Licensing Requirements for AAA for System Administrators
 
      [bookmark: pgfId-1270832]The following table shows the licensing requirements for this feature:
 
      [bookmark: pgfId-1860723]
 
      
       
       
         
         	
           
           [bookmark: pgfId-1860716]Model
          
  
         	
           
           [bookmark: pgfId-1860718]License Requirement
          
  
        
 
         
         	 [bookmark: pgfId-1860720]All models
  
         	 [bookmark: pgfId-1860722]Base License.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1272018][bookmark: 14737]Prerequisites
 
      [bookmark: pgfId-1705300]Prerequisites for the AAA Server or Local Database
 
      [bookmark: pgfId-1277800]You must configure users in a AAA server or the local database. For a AAA server, you then need to configure the ASA to communicate with it. See the following chapters:
 
      
      	 [bookmark: pgfId-1277790]AAA server—See theapplicable AAA server-type chapter.
 
      	 [bookmark: pgfId-1705326]Local Database—See the“Adding a User Account to the Local Database” section.
 
     
 
      [bookmark: pgfId-1705327]Prerequisites for Management Authentication
 
      [bookmark: pgfId-1705331]Before the ASA can authenticate a Telnet, SSH, or HTTP user, you must identify the IP addresses that are allowed to communicate with the ASA. For the ASASM, the exception is for access to the system in multiple context mode; a session from the switch to the ASASM is a Telnet session, but Telnet access configuration is not required. For more information, see the “Configuring ASA Access for ASDM, Telnet, or SSH” section.
 
      [bookmark: pgfId-1276288]Prerequisites for Local Command Authorization
 
      
      	 [bookmark: pgfId-1276345]Configure  enable authentication. (See the “Configuring Authentication for CLI, ASDM, and enable command Access” section.)
 
     
 
      [bookmark: pgfId-1276347] enable authentication is essential for maintaining the username after the user accesses the  enable command.
 
      [bookmark: pgfId-1276348]Alternatively, you can use the  login command (which is the same as the  enable command with authentication; for the local database only), which requires no configuration. We do not recommend this option because it is not as secure as  enable authentication.
 
      [bookmark: pgfId-1276349]You can also use CLI authentication, but it is not required.
 
      
      	 [bookmark: pgfId-1276350]See the following prerequisites for each user type:
 
     
 
      [bookmark: pgfId-1276351]–[image: ] Local database users—Configure each user in the local database at a privilege level from 0 to 15.
 
      [bookmark: pgfId-1276359]–[image: ] RADIUS users—Configure the user with Cisco VSA CVPN3000-Privilege-Level with a value between 0 and 15.
 
      [bookmark: pgfId-1276360]–[image: ] LDAP users—Configure the user with a privilege level between 0 and 15, and then map the LDAP attribute to Cisco VSA CVPN3000-Privilege-Level according to the“Configuring LDAP Attribute Maps” section.
 
      [bookmark: pgfId-1276771]Prerequisites for TACACS+ Command Authorization
 
      
      	 [bookmark: pgfId-1276775]Configure CLI and  enable authentication (see the “Configuring Authentication for CLI, ASDM, and enable command Access” section).
 
     
 
      [bookmark: pgfId-1277704]Prerequisites for Management Accounting
 
      
      	 [bookmark: pgfId-1277885]Configure CLI and  enable authentication (see the “Configuring Authentication for CLI, ASDM, and enable command Access” section).
 
     
 
    
 
     
      [bookmark: pgfId-1276290][bookmark: 67882]Guidelines and Limitations
 
      [bookmark: pgfId-1270849]This section includes the guidelines and limitations for this feature.
 
      [bookmark: pgfId-1270851]Context Mode Guidelines
 
      [bookmark: pgfId-1270852]Supported in single and multiple context mode.
 
      [bookmark: pgfId-1270854]Firewall Mode Guidelines
 
      [bookmark: pgfId-1270855]Supported in routed and transparent firewall mode.
 
      [bookmark: pgfId-1270856]IPv6 Guidelines
 
      [bookmark: pgfId-1270857]Supports IPv6.
 
    
 
     
      [bookmark: pgfId-1418140][bookmark: 66272]Default Settings
 
      [bookmark: pgfId-1418141]Default Command Privilege Levels
 
      [bookmark: pgfId-1276064]By default, the following commands are assigned to privilege level 0. All other commands are assigned to privilege level 15.
 
      
      	 [bookmark: pgfId-1276065] show checksum 
 
      	 [bookmark: pgfId-1276066] show curpriv 
 
      	 [bookmark: pgfId-1276067] enable 
 
      	 [bookmark: pgfId-1276068] help 
 
      	 [bookmark: pgfId-1276069] show history 
 
      	 [bookmark: pgfId-1276070] login 
 
      	 [bookmark: pgfId-1276071] logout 
 
      	 [bookmark: pgfId-1276072] pager 
 
      	 [bookmark: pgfId-1276073] show pager 
 
      	 [bookmark: pgfId-1276074] clear pager 
 
      	 [bookmark: pgfId-1276075] quit 
 
      	 [bookmark: pgfId-1276076] show version 
 
     
 
      [bookmark: pgfId-1276077]If you move any configure mode commands to a lower level than 15, be sure to move the  configure  command to that level as well, otherwise, the user will not be able to enter configuration mode.
 
      [bookmark: pgfId-1276081]To view all privilege levels, see the “Viewing Local Command Privilege Levels” section.
 
    
 
     
      [bookmark: pgfId-1145607][bookmark: 15979]Configuring Authen[bookmark: marker-1145606]tication for CLI, ASDM, and enable command Access
 
      [bookmark: pgfId-1332045]You can require authentication for CLI, ASDM, and enable command access.
 
    
 
     
      [bookmark: pgfId-1705502]Prerequisites
 
      
      	 [bookmark: pgfId-1705540]Configure Telnet, SSH, or HTTP access according to the “Configuring ASA Access for ASDM, Telnet, or SSH” section.
 
      	 [bookmark: pgfId-1705951]For SSH access, you must configure SSH authentication; there is no default username.
 
     
 
    
 
     
      [bookmark: pgfId-1332046]Detailed Steps
 
     
 
      [bookmark: pgfId-1832916] Step 1[image: ] To authenticate users who use the  enable command, choose  Configuration > Device Management > Users/AAA > AAA Access > Authentication , and configure the following settings:
 
      [bookmark: pgfId-1832917] a.[image: ] Check the  Enable check box.
 
      [bookmark: pgfId-1832918] b.[image: ] From the Server Group drop-down list, choose a server group name or the LOCAL database. 
 
      [bookmark: pgfId-1832922] c.[image: ] (Optional) If you chose a AAA server, you can configure the ASA to use the local database as a fallback method if the AAA server is unavailable. Click the  Use LOCAL when server group fails  check box. We recommend that you use the same username and password in the local database as the AAA server, because the ASA prompt does not give any indication of which method is being used.
 
      [bookmark: pgfId-1832926]Step 2[image: ] To authenticate users who access the CLI or ASDM, choose Configuration > Device Management > Users/AAA > AAA Access > Authentication , and configure the following settings:
 
      [bookmark: pgfId-1832927] a.[image: ] Check one or more of the following check boxes:
 
      [bookmark: pgfId-1832934]–[image: ]  HTTP/ASDM —Authenticates the ASDM client that accesses the ASA using HTTPS. HTTP management authentication does not support the SDI protocol for a AAA server group.
 
      [bookmark: pgfId-1832941]–[image: ]  Serial —Authenticates users who access the ASA using the console port. For the ASASM, this parameter affects the virtual console accessed from the switch using the  service-module session command. For multiple mode access, see the “Authenticating Sessions from the Switch to the ASA Services Module” section.
 
      [bookmark: pgfId-1832948]–[image: ]  SSH —Authenticates users who access the ASA using SSH.
 
      [bookmark: pgfId-1832955]–[image: ]  Telnet —Authenticates users who access the ASA using Telnet. For the ASASM, this parameter also affects the session from the switch using the  session command. For multiple mode access, see the “Authenticating Sessions from the Switch to the ASA Services Module” section.
 
      [bookmark: pgfId-1832959] b.[image: ] For each service that you checked, from the Server Group drop-down list, choose a server group name or the LOCAL database. 
 
      [bookmark: pgfId-1832963] c.[image: ] (Optional) If you chose a AAA server, you can configure the ASA to use the local database as a fallback method if the AAA server is unavailable. Click the  Use LOCAL when server group fails  check box. We recommend that you use the same username and password in the local database as the AAA server because the ASA prompt does not give any indication of which method is being used.
 
      [bookmark: pgfId-1832967]Step 3[image: ] Click  Apply .
 
      [bookmark: pgfId-1832968]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1274733][bookmark: 62263]Limiting User CLI and ASDM Access with Management Authorization
 
      [bookmark: pgfId-1708384]The ASA enables you to distinguish between administrative and remote-access users when they authenticate using RADIUS, LDAP, TACACS+, or the local user database. User role differentiation can prevent remote access VPN and network access users from establishing an administrative connection to the ASA.
 
      
       
     
 
     
 
     [bookmark: pgfId-1145724]Note Serial access is not included in management authorization, so if you enable the Authentication > Serial option, then any user who authenticates can access the console port.

      
      
 
     

     
 
    
 
     
      [bookmark: pgfId-1149342]Detailed Steps
 
     
 
      [bookmark: pgfId-1832983] Step 1[image: ] Choose one of the following options:
 
      
      	 [bookmark: pgfId-1832988]To enable management authorization, choose Configuration > Device Management > Users/AAA > AAA Access > Authorization, and check the Perform authorization for exec shell access >  Enable check box.
 
     
 
      [bookmark: pgfId-1828389]When the  LOCAL option is configured, the local user database is the source for the username entered and the Service-Type and Privilege-Level attributes assigned.
 
      [bookmark: pgfId-1828390]This option also enables support of administrative user privilege levels from RADIUS, which can be used in conjunction with local command privilege levels for command authorization. See the “Configuring Local Command Authorization” section for more information.
 
      [bookmark: pgfId-1828394]When the  authentication-server option is configured, the same server is used for both authentication and authorization.
 
      
      	 [bookmark: pgfId-1832993]To enable management authorization, choose Configuration > Device Management > Users/AAA > AAA Access > Authorization, and check the  Allow privileged users to enter into EXEC mode on login  check box.
 
     
 
      [bookmark: pgfId-1832994]The  auto-enable option allows users with sufficient privileges from the login authentication server to be placed directly in privileged EXEC mode. Otherwise, users are placed in user EXEC mode. These privileges are determined by the Service-Type and Privilege-Level attributes that are required to enter each EXEC mode. To enter privileged EXEC mode, users must have a Service-Type attribute of Administrative and a Privilege Level attribute of greater than 1 assigned to them.
 
      [bookmark: pgfId-1832995]This option is not supported in the system context. However, if you configure Telnet or serial authentication in the admin context, then authentication also applies to sessions from the switch to the ASASM.
 
      [bookmark: pgfId-1832999]There is no effect if you enter the  aaa authorization exec command alone.
 
      [bookmark: pgfId-1833000]The  auto-enable option is not included when you use serial authentication in management authorization.
 
      [bookmark: pgfId-1833001]The  aaa authentication http command is not affected by the  auto-enable option.
 
      [bookmark: pgfId-1833002]Before you configure the  auto-enable option, we recommend that you configure both protocol login and enable authentication, and that all authentication requests go to the same AAA server group, as shown in the following example: 
 
     
      [bookmark: pgfId-1833006]ciscoasa (config)# aaa authentication ssh console RADIUS 
     

     
      [bookmark: pgfId-1833010]ciscoasa (config)# aaa authentication enable console RADIUS
     

     
      [bookmark: pgfId-1833014]ciscoasa (config)# aaa authorization exec authentication-server auto-enable
     

     
      [bookmark: pgfId-1833015]
     

      [bookmark: pgfId-1833016]We do  not recommend that you use other types of configurations.
 
      [bookmark: pgfId-1780160]Step 2[image: ] To configure the user for management authorization, see the following requirements for each AAA server type or local user:
 
      [bookmark: pgfId-1706852]RADIUS or LDAP (mapped) users
 
      [bookmark: pgfId-1708487]When users are authenticated through LDAP, the native LDAP attributes and their values can be mapped to Cisco ASA attributes to provide specific authorization features. Configure Cisco VSA CVPN3000-Privilege-Level with a value between 0 and 15. and then map the LDAP attributes to Cisco VAS CVPN3000-Privilege-Level. For more information, see the “Configuring LDAP Attribute Maps”.
 
      [bookmark: pgfId-1709533]The RADIUS IETF  service-type attribute, when sent in an access-accept message as the result of a RADIUS authentication and authorization request, is used to designate which type of service is granted to the authenticated user: 
 
      
      	 [bookmark: pgfId-1706853]Service-Type 6 (Administrative)—Allows full access to any services specified by the Authentication tab options. 
 
      	 [bookmark: pgfId-1706854]Service-Type 7 (NAS prompt)—Allows access to the CLI when you configure the Telnet or SSH authentication options, but denies ASDM configuration access if you configure the HTTP option. ASDM monitoring access is allowed. If you configure  enable authentication with the Enable option, the user cannot access privileged EXEC mode using the  enable command. The Framed (2) and Login (1) service types are treated the same way.
 
      	 [bookmark: pgfId-1706855]Service-Type 5 (Outbound)—Denies management access. The user cannot use any services specified by the Authentication tab options (excluding the Serial option; serial access is allowed). Remote access (IPsec and SSL) users can still authenticate and terminate their remote access sessions. All other service types (Voice, FAX, and so on) are treated the same way.
 
     
 
      [bookmark: pgfId-1706856]The RADIUS Cisco VSA  privilege-level attribute (Vendor ID 3076, sub-ID 220), when sent in an access-accept message, is used to designate the level of privilege for the user.
 
      [bookmark: pgfId-1710059]When an authenticated user tries administrative access to the ASA through ASDM, SSH, or Telnet, but does not have the appropriate privilege level to do so, the ASA generates syslog message 113021. This message informs the user that the attempted login failed because of inappropriate administrative privileges.
 
      [bookmark: pgfId-1706860]TACACS+ users
 
      [bookmark: pgfId-1708500]Authorization is requested with “service=shell,” and the server responds with PASS or FAIL.
 
      
      	 [bookmark: pgfId-1706861]PASS, privilege level 1— Allows full access to any services specified by the Authentication tab options.
 
      	 [bookmark: pgfId-1706862]PASS, privilege level 2 and higher—Allows access to the CLI when you configure the Telnet or SSH authentication options, but denies ASDM configuration access if you configure the HTTP option. ASDM monitoring access is allowed. If you configure  enable authentication with the Enable option, the user cannot access privileged EXEC mode using the  enable command. You are not allowed to access privileged EXEC mode using the  enable command if your enable privilege level is set to 14 or less. 
 
      	 [bookmark: pgfId-1706863]FAIL—Denies management access. You cannot use any services specified by the Authentication tab options (excluding the Serial option; serial access is allowed).
 
     
 
      [bookmark: pgfId-1706864]Local users
 
      [bookmark: pgfId-1708510]Configure the Access Restriction option for a given username. By default, the access restriction is Full Access, which allows full access to any services specified by the Authentication tab options. For more information, see the “Adding a User Account to the Local Database” section. 
 
      [bookmark: pgfId-1710627]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1710665][bookmark: 73122][bookmark: 88174]Configuring a Password Policy for Local Database Users
 
      [bookmark: pgfId-1710669]When you configure authentication for CLI or ASDM access using the local database, you can configure a password policy that requires a user to change their password after a specified amount of time and also requires password standards such as a minimum length and the minimum number of changed characters.
 
      [bookmark: pgfId-1711370]The password policy only applies to administrative users using the local database, and not to other types of traffic that can use the local database, such as VPN or AAA for network access, and not to users authenticated by a AAA server.
 
      [bookmark: pgfId-1711427]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1711265]Configuring the Password Policy
 
      	 [bookmark: pgfId-1711291]Changing Your Password
 
     
 
    
 
     
      [bookmark: pgfId-1711061][bookmark: 34774]Configuring the Password Policy
 
      [bookmark: pgfId-1711101]After you configure the password policy, when you change a password (either your own or another user’s), the password policy applies to the new password. Any existing passwords are grandfathered in. The new policy applies to changing the password with the User Accounts pane as well as the Change My Password pane.
 
    
 
     
      [bookmark: pgfId-1711128]Prerequisites
 
      
      	 [bookmark: pgfId-1711129]Configure both CLI/ASDM and enable authentication according to the “Configuring Authentication for CLI, ASDM, and enable command Access” section. Be sure to specify the local database.
 
     
 
    
 
     
      [bookmark: pgfId-1710683]Detailed Steps
 
     
 
      [bookmark: pgfId-1833118] Step 1[image: ] Choose  Configuration > Device Management > Users/AAA > Password Policy .
 
      [bookmark: pgfId-1833122]
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1833123]Step 2[image: ] Configure any mix of the following options:
 
      
       
       	 [bookmark: pgfId-1833124]Minimum Password Length—Enter the minimum length for passwords. Valid values range from 3 to 64 characters. The recommended minimum password length is 8 characters.
 
       	 [bookmark: pgfId-1833125]Lifetime—Enter the interval in days after which passwords expire for remote users (SSH, Telnet, HTTP); users at the console port are never locked out due to password expiration. Valid values are between 0 and 65536 days. The default value is 0 days, a value indicating that passwords will never expire.
 
      
 
     
 
      [bookmark: pgfId-1833126]7 days before the password expires, a warning message appears. After the password expires, system access is denied to remote users. To gain access after expiration, do one of the following:
 
      [bookmark: pgfId-1833127]–[image: ] Have another administrator change your password.
 
      [bookmark: pgfId-1833128]–[image: ] Log in to the physical console port to change your password.
 
      
       
       	 [bookmark: pgfId-1833129]Minimum Number Of—Specify the minimum of characters from the following types:
 
      
 
     
 
      [bookmark: pgfId-1833130]–[image: ] Numeric Characters—Enter the minimum number of numeric characters that passwords must have. Valid values are between 0 and 64 characters. The default value is 0.
 
      [bookmark: pgfId-1833131]–[image: ] Lower Case Characters—Enter the minimum number of lower case characters that passwords must have. Valid values range from 0 to 64 characters. The default value is 0.
 
      [bookmark: pgfId-1833132]–[image: ] Upper Case Characters—Enter the minimum number of upper case characters that passwords must have. Valid values range from 0 to 64 characters. The default value is 0.
 
      [bookmark: pgfId-1833133]–[image: ] Special Characters—Enter the minimum number of special characters that passwords must have. Valid values range from 0 to 64 characters. Special characters include the following: !, @, #, $, %, ^, &, *, '(‘ and ‘)’.The default value is 0.
 
      [bookmark: pgfId-1833134]–[image: ] Different Characters from Previous Password—Enter the minimum number of characters that you must change between new and old passwords. Valid values are between 0 and 64 characters. The default value is 0. Character matching is position independent, meaning that new password characters are considered changed only if they do not appear anywhere in the current password.
 
      [bookmark: pgfId-1833135]Step 3[image: ] (Optional) Check the  Authentication Enable check box to require users to change their password on the Change My Password pane instea[image: ]d of the User Accounts pane. The default setting is disabled: a user can use either method to change their password.
 
      [bookmark: pgfId-1833136]If you enable this feature, if you try to change your password on the User Accounts pane, the following error message is generated:
 
     
      [bookmark: pgfId-1833137]ERROR: Changing your own password is prohibited
     

     
      [bookmark: pgfId-1833138]
     

      [bookmark: pgfId-1833139]Step 4[image: ] To reset the password policy to the default, click  Reset to Default .
 
      [bookmark: pgfId-1833140]Step 5[image: ] Click  Apply to apply the configuration settings.
 
      [bookmark: pgfId-1833141]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1710810][bookmark: 75496]Changing Your Password
 
      [bookmark: pgfId-1710815]If you configure a password lifetime in the password policy, you need to change your password to a new one when the old password expires. This password change method is required if you enable password policy authentication. If password policy authentication is not enabled, then you can use this method, or you can change your user account directly with the User Accounts pane.
 
    
 
     
      [bookmark: pgfId-1713048]Detailed Steps
 
     
 
      [bookmark: pgfId-1833157] Step 1[image: ] Choose  Configuration > Device Management > Users/AAA > Change Password .
 
      [bookmark: pgfId-1833161]
 
      
      [image: ] 
     
 
      [bookmark: pgfId-1833162]Step 2[image: ] Enter your old password.
 
      [bookmark: pgfId-1833163]Step 3[image: ] Enter your new password.
 
      [bookmark: pgfId-1833164]Step 4[image: ] Confirm your new password.
 
      [bookmark: pgfId-1833165]Step 5[image: ] Click  Make Change .
 
      [bookmark: pgfId-1833166]Step 6[image: ] Click the  Save icon to save your changes to the running configuration.
 
      [bookmark: pgfId-1833167]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1145756][bookmark: 53147]Configuring Command Autho[bookmark: marker-1145754]r[bookmark: marker-1145755]ization
 
      [bookmark: pgfId-1145760]If you want to control access to commands, the ASA lets you configure command authorization, where you can determine which commands that are available to a user. By default when you log in, you can access user EXEC mode, which offers only minimal commands. When you enter the  enable command (or the  login command when you use the local database), you can access privileged EXEC mode and advanced commands, including configuration commands.
 
      [bookmark: pgfId-1278491]You can use one of two command authorization methods:
 
      
      	 [bookmark: pgfId-1278495]Local privilege levels
 
      	 [bookmark: pgfId-1278525]TACACS+ server privilege levels
 
     
 
      [bookmark: pgfId-1275720]For more information about command authorization, see the “Information About Command Authorization” section.
 
      [bookmark: pgfId-1145761]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1331659]Configuring Local Command Authorization
 
      	 [bookmark: pgfId-1331679]Viewing Local Command Privilege Levels
 
      	 [bookmark: pgfId-1331692]Configuring Commands on the TACACS+ Server
 
      	 [bookmark: pgfId-1331705]Configuring TACACS+ Command Authorization
 
     
 
    
 
     
      [bookmark: pgfId-1145888][bookmark: 50716]Configuring Local Command Authorization
 
      [bookmark: pgfId-1145889]Local command authorization lets you assign commands to one of 16 privilege levels (0 to 15). By default, each command is assigned either to privilege level 0 or 15. You can define each user to be at a specific privilege level, and each user can enter any command at the assigned privilege level or below. The ASA supports user privilege levels defined in the local database, a RADIUS server, or an LDAP server (if you map LDAP attributes to RADIUS attributes). See the following sections for more information: 
 
      
      	 [bookmark: pgfId-1562711]“Adding a User Account to the Local Database”
 
      	 [bookmark: pgfId-1562750]“Supported Authentication Methods”
 
      	 [bookmark: pgfId-1562737]“Configuring LDAP Attribute Maps”
 
     
 
      [bookmark: pgfId-1353253]To configure local command authorization, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1149656]Detailed Steps
 
     
 
      [bookmark: pgfId-1833172] Step 1[image: ] To enable command authorization, choose  Configuration > Device Management > Users/AAA > AAA Access > Authorization , and check the  Enable authorization for command access >  Enable check box.
 
      [bookmark: pgfId-1833173]Step 2[image: ] From the Server Group drop-down list, choose LOCAL.
 
      [bookmark: pgfId-1833174]Step 3[image: ] When you enable local command authorization, you have the option of manually assigning privilege levels to individual commands or groups of commands or enabling the predefined user account privileges.
 
      
       
       	 [bookmark: pgfId-1833176]To use predefined user account privileges, click  Set ASDM Defined User Roles .
 
      
 
     
 
      [bookmark: pgfId-1833177]The ASDM Defined User Roles Setup dialog box shows the commands and their levels. Click  Yes to use the predefined user account privileges: Admin (privilege level 15, with full access to all CLI commands; Read Only (privilege level 5, with read-only access); and Monitor Only (privilege level 3, with access to the Monitoring section only).
 
      
       
       	 [bookmark: pgfId-1833179]To manually configure command levels, click  Configure Command Privileges .
 
      
 
     
 
      [bookmark: pgfId-1833180]The Command Privileges Setup dialog box appears. You can view all commands by choosing --All Modes-- from the Command Mode drop-down list, or you can choose a configuration mode to view the commands available in that mode. For example, if you choose context, you can view all commands available in context configuration mode. If a command can be entered in user EXEC or privileged EXEC mode as well as configuration mode, and the command performs different actions in each mode, you can set the privilege level for these modes separately.
 
      [bookmark: pgfId-1833181]The Variant column displays show, clear, or cmd. You can set the privilege only for the show, clear, or configure form of the command. The configure form of the command is typically the form that causes a configuration change, either as the unmodified command (without the  show or  clear prefix) or as the  no form.
 
      [bookmark: pgfId-1833182]To change the privilege level of a command, double-click it or click  Edit  to display the Select Command Privilege dialog box. You can set the privilege level between 0 and 15. You can only configure the privilege level of the  main command. For example, you can configure the privilege level of all  aaa commands, but not the privilege level of the  aaa authentication command and the  aaa authorization  command separately.
 
      [bookmark: pgfId-1833183]To change the privilege level of all commands that appear, click  Select All  and then  Edit .
 
      [bookmark: pgfId-1833184]Click  OK to accept your changes.
 
      [bookmark: pgfId-1833185]Step 4[image: ] To support administrative user privilege levels from RADIUS, check the  Perform authorization for exec shell access >  Enable check box.
 
      [bookmark: pgfId-1833189]Without this option, the ASA only supports privilege levels for local database users and defaults all other types of users to level 15.
 
      [bookmark: pgfId-1833190]This option also enables management authorization for local, RADIUS, mapped LDAP, and TACACS+ users. See the “Limiting User CLI and ASDM Access with Management Authorization” section for more information.
 
      [bookmark: pgfId-1833194]Step 5[image: ] Click  Apply .
 
      [bookmark: pgfId-1833195]The authorization settings are assigned, and the changes are saved to the running configuration. 
 
      [bookmark: pgfId-1833196]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1146051][bookmark: 72625]Viewing Local Command Privilege Levels
 
      [bookmark: pgfId-1146052]The following commands when entered in the Tools > Command Line Interface tool, let you view privilege levels for commands.
 
    
 
     
      [bookmark: pgfId-1278333][bookmark: 87167]Configuring Commands on the TACACS+ Server
 
      [bookmark: pgfId-1278334]You can configure commands on a Cisco Secure Access Control Server (ACS) TACACS+ server as a shared profile component, for a group, or for individual users. For third-party TACACS+ servers, see your server documentation for more information about command authorization support.
 
      [bookmark: pgfId-1278335]See the following guidelines for configuring commands in Cisco Secure ACS Version 3.1; many of these guidelines also apply to third-party servers:
 
      
      	 [bookmark: pgfId-1278339]The ASA sends the commands to be authorized as shell commands, so configure the commands on the TACACS+ server as shell commands.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1278340]Note Cisco Secure ACS might include a command type called “pix-shell.” Do not use this type for ASA command authorization.

      
      
 
     

     
 
      
      	 [bookmark: pgfId-1278344]The first word of the command is considered to be the main command. All additional words are considered to be arguments, which need to be preceded by  permit or  deny .
 
     
 
      [bookmark: pgfId-1278345]For example, to allow the  show running-configuration aaa-server  command, add   show running-configuration to the command field, and type  permit   aaa-server  in the arguments field.
 
      
      	 [bookmark: pgfId-1278346]You can permit all arguments of a command that you do not explicitly deny by checking the  Permit Unmatched Args check box.
 
     
 
      [bookmark: pgfId-1278347]For example, you can configure just the  show  command, then all the  show commands are allowed. We recommend using this method so that you do not have to anticipate every variant of a command, including abbreviations and a question mark, which shows CLI usage (see Figure 45-1).
 
      [bookmark: pgfId-1850891]Figure 45-1 [bookmark: 60001]Permitting All Related Commands
 
      [bookmark: pgfId-1850895]
 
      
      [image: ] 
     
 
      
      	 [bookmark: pgfId-1278357]For commands that are a single word, you  must permit unmatched arguments, even if there are no arguments for the command, for example  enable or  help (see Figure 45-2).
 
     
 
      [bookmark: pgfId-1850909]Figure 45-2 [bookmark: 42959]Permitting Single Word Commands
 
      [bookmark: pgfId-1850913]
 
      
      [image: ] 
     
 
      
      	 [bookmark: pgfId-1278367]To disallow some arguments, enter the arguments preceded by  deny .
 
     
 
      [bookmark: pgfId-1278368]For example, to allow  enable , but not  enable password , enter  enable in the commands field, and  deny password in the arguments field. Be sure to check the  Permit Unmatched Args check box so that  enable alone is still allowed (see Figure 45-3).
 
      [bookmark: pgfId-1850927]Figure 45-3 [bookmark: 32586]Disallowing Arguments
 
      [bookmark: pgfId-1850931]
 
      
      [image: ] 
     
 
      
      	 [bookmark: pgfId-1278381]When you abbreviate a command at the command line, the ASA expands the prefix and main command to the full text, but it sends additional arguments to the TACACS+ server as you enter them.
 
     
 
      [bookmark: pgfId-1278385]For example, if you enter  sh log , then the ASA sends the entire command to the TACACS+ server,  show logging . However, if you enter  sh log mess , then the ASA sends  show logging mess to the TACACS+ server, and not the expanded command  show logging message . You can configure multiple spellings of the same argument to anticipate abbreviations (see Figure 45-4).
 
      [bookmark: pgfId-1850945]Figure 45-4 [bookmark: 44298]Specifying Abbreviations
 
      [bookmark: pgfId-1850949]
 
      
      [image: ] 
     
 
      
      	 [bookmark: pgfId-1278398]We recommend that you allow the following basic commands for all users:
 
     
 
      [bookmark: pgfId-1278399]–[image: ]  show checksum 
 
      [bookmark: pgfId-1278400]–[image: ]  show curpriv 
 
      [bookmark: pgfId-1278401]–[image: ]  enable 
 
      [bookmark: pgfId-1278402]–[image: ]  help 
 
      [bookmark: pgfId-1278403]–[image: ]  show history 
 
      [bookmark: pgfId-1278404]–[image: ]  login 
 
      [bookmark: pgfId-1278405]–[image: ]  logout 
 
      [bookmark: pgfId-1278406]–[image: ]  pager 
 
      [bookmark: pgfId-1278407]–[image: ]  show pager 
 
      [bookmark: pgfId-1278408]–[image: ]  clear pager 
 
      [bookmark: pgfId-1278409]–[image: ]  quit 
 
      [bookmark: pgfId-1278410]–[image: ]  show version 
 
    
 
     
      [bookmark: pgfId-1146111][bookmark: 10465]Configuring TACACS+ Comm[bookmark: marker-1146110]and Authorization
 
      [bookmark: pgfId-1146114]If you enable TACACS+ command authorization, and a user enters a command at the CLI, the ASA sends the command and username to the TACACS+ server to determine if the command is authorized.
 
      [bookmark: pgfId-1277469]Before you enable TACACS+ command authorization, be sure that you are logged into the ASA as a user that is defined on the TACACS+ server, and that you have the necessary command authorization to continue configuring the ASA. For example, you should log in as an admin user with all commands authorized. Otherwise, you could become unintentionally locked out.
 
      [bookmark: pgfId-1146116]Do not save your configuration until you are sure that it works the way you want. If you get locked out because of a mistake, you can usually recover access by restarting the ASA. If you still get locked out, see the “Recovering from a Lockout” section.
 
      [bookmark: pgfId-1146123]Be sure that your TACACS+ system is completely stable and reliable. The necessary level of reliability typically requires that you have a fully redundant TACACS+ server system and fully redundant connectivity to the ASA. For example, in your TACACS+ server pool, include one server connected to interface 1, and another to interface 2. You can also configure local command authorization as a fallback method if the TACACS+ server is unavailable. In this case, you need to configure local users and command privilege levels according to procedures listed in the “Configuring Command Authorization” section.
 
      [bookmark: pgfId-1349168]To configure TACACS+ command authorization, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1277048]Detailed Steps
 
     
 
      [bookmark: pgfId-1833211] Step 1[image: ] To perform command authorization using a TACACS+ server, choose  Configuration > Device Management > Users/AAA > AAA Access > Authorization , and check the Enable authorization for command access >  Enable check box. 
 
      [bookmark: pgfId-1833212]Step 2[image: ] From the Server Group drop-down list, choose a AAA server group name.
 
      [bookmark: pgfId-1833216]Step 3[image: ] (Optional) you can configure the ASA to use the local database as a fallback method if the AAA server is unavailable. To do so, check the  Use LOCAL when server group fails  check box. We recommend that you use the same username and password in the local database as the AAA server, because the ASA prompt does not give any indication which method is being used. Be sure to configure users in the local database (see the “Adding a User Account to the Local Database” section) and command privilege levels (see the “Configuring Local Command Authorization” section).
 
      [bookmark: pgfId-1833226]Step 4[image: ] Click  Apply .
 
      [bookmark: pgfId-1833227]The command authorization settings are assigned, and the changes are saved to the running configuration. 
 
      [bookmark: pgfId-1833228]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1146262][bookmark: 72516]Configuring Management Access Accounting
 
      [bookmark: pgfId-1146263]You can send accounting messages to the TACACS+ accounting server when you enter any command other than  show commands at the CLI. You can configure accounting when users log in, when they enter the  enable command, or when they issue commands.
 
      [bookmark: pgfId-1278000]For command accounting, you can only use TACACS+ servers.
 
      [bookmark: pgfId-1349225]To configure management access and enable command accounting, perform the following steps:
 
    
 
     
      [bookmark: pgfId-1154012]Detailed Steps
 
     
 
      [bookmark: pgfId-1833233] Step 1[image: ] To enable accounting of users when they enter the  enable command, perform the following steps[image: ]:
 
      [bookmark: pgfId-1833234] a.[image: ] Choose Configuration > Device Management > Users/AAA > AAA Access > Accounting , and check the  Require accounting to allow accounting of user activity > Enable check box.
 
      [bookmark: pgfId-1833235] b.[image: ] From the Server Group drop-down list, choose a RADIUS or TACACS+ server group name.
 
      [bookmark: pgfId-1833239]Step 2[image: ] To enable accounting of users when they access the ASA using Telnet, SSH, or the serial console, perform the following steps:
 
      [bookmark: pgfId-1833240] a.[image: ] Under the Require accounting for the following types of connections area, check the check boxes for Serial, SSH, and/or Telnet.
 
      [bookmark: pgfId-1833241] b.[image: ] For each connection type, from the Server Group drop-down list, choose a RADIUS or TACACS+ server group name.
 
      [bookmark: pgfId-1833242]Step 3[image: ] To configure command accounting, perform the following steps:
 
      [bookmark: pgfId-1833243] a.[image: ] Under the Require command accounting area, check the  Enable check box.
 
      [bookmark: pgfId-1833244] b.[image: ] From the Server Group drop-down list, choose a TACACS+ server group name. RADIUS is not supported.
 
      [bookmark: pgfId-1833245]You can send accounting messages to the TACACS+ accounting server when you enter any command other than  show commands at the CLI. 
 
      [bookmark: pgfId-1833246] c.[image: ] If you customize the command privilege level using the Command Privilege Setup dialog box, you can limit which commands the ASA accounts for by specifying a minimum privilege level in the Privilege level drop-down list. The ASA does not account for commands that are below the minimum privilege level.
 
      [bookmark: pgfId-1833253]Step 4[image: ] Click  Apply .
 
      [bookmark: pgfId-1833254]The accounting settings are assigned, and the changes are saved to the running configuration. 
 
      [bookmark: pgfId-1833255]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1146287][bookmark: 44357]Viewing the Currently Logged-In User
 
      [bookmark: pgfId-1208072]To view the current logged-in user, in the Tools > Command Line Interface tool:
 
     
      [bookmark: pgfId-1208076]ciscoasa# show curpriv
     

     
      [bookmark: pgfId-1208077]
     

    
 
     
      [bookmark: pgfId-1146294]Examples
 
      [bookmark: pgfId-1565130]The following is sample output from the  show curpriv  command: 
 
     
      [bookmark: pgfId-1146298]ciscoasa# show curpriv
     

     
      [bookmark: pgfId-1146299]Username: admin
     

     
      [bookmark: pgfId-1146300]Current privilege level: 15
     

     
      [bookmark: pgfId-1146301]Current Mode/s: P_PRIV
     

     
      [bookmark: pgfId-1146302]
     

      [bookmark: pgfId-1146306] Table 45-1  describes the  show curpriv command output.
 
      [bookmark: pgfId-1565755]
 
      
       
        
         [bookmark: pgfId-1565733]Table 45-1 [bookmark: 65616]show curpriv Command Output Description
 
        
       
         
         	
           
           [bookmark: pgfId-1565737]Field
          
  
         	
           
           [bookmark: pgfId-1565739]Description
          
  
        
 
         
         	 [bookmark: pgfId-1565741]Username
  
         	 [bookmark: pgfId-1565743]Username. If you are logged in as the default user, the name is enable_1 (user EXEC) or enable_15 (privileged EXEC).
  
        
 
         
         	 [bookmark: pgfId-1565745]Current privilege level
  
         	 [bookmark: pgfId-1565747]Levels range from 0 to 15. Unless you configure local command authorization and assign commands to intermediate privilege levels, levels 0 and 15 are the only levels that are used.
  
        
 
         
         	 [bookmark: pgfId-1565749]Current Modes
  
         	 [bookmark: pgfId-1565751]The available access modes are the following:
 
           
           	 [bookmark: pgfId-1565752]P_UNPR—User EXEC mode (levels 0 and 1)
 
           	 [bookmark: pgfId-1565753]P_PRIV—Privileged EXEC mode (levels 2 to 15)
 
           	 [bookmark: pgfId-1565754]P_CONF—Configuration mode
 
          
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-1699563][bookmark: 11995]Setting a Management Session Quota
 
      [bookmark: pgfId-1699564]You can establish a maximum number of simultaneous management sessions. If the maximum is reached, no additional sessions are allowed and a syslog message is generated. To prevent a system lockout, the management session quota mechanism cannot block a console session.
 
      [bookmark: pgfId-1735095]To set a management session quota, perform the following steps:
 
     
 
      [bookmark: pgfId-1833271] Step 1[image: ] Choose  Configuration > Device Management > Management Access > Management Session Quota .
 
      [bookmark: pgfId-1833272]Step 2[image: ] Enter the maximum number of simultaneous ASDM, SSH, and Telnet sessions that are allowed on the ASA. Valid values range from 0 to 10000.
 
      
       
     
 
     
 
     [bookmark: pgfId-1833276]Note If the management quota session number is exceeded, an error message appears, and ASDM closes.

      
      
 
     

     
 
      [bookmark: pgfId-1833277]Step 3[image: ] Click  Apply to save the configuration changes.
 
      [bookmark: pgfId-1833278]

      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1566575][bookmark: 36545]Recovering from a Locko[bookmark: marker-1566574]ut
 
      [bookmark: pgfId-1566576]In some circumstances, when you turn on command authorization or CLI authentication, you can be locked out of the ASA CLI. You can usually recover access by restarting the ASA. However, if you already saved your configuration, you might be locked out.  Table 45-2  lists the common lockout conditions and how you might recover from them.
 
      [bookmark: pgfId-1146434]
 
      
       
        
         [bookmark: pgfId-1146352]Table 45-2 [bookmark: 85409]CLI Authentication and Command Authorization Lockout Scenarios 
 
        
       
         
         	
           
           [bookmark: pgfId-1146362]Feature
          
  
         	
           
           [bookmark: pgfId-1146364]Lockout Condition
          
  
         	
           
           [bookmark: pgfId-1146366]Description
          
  
         	
           
           [bookmark: pgfId-1146368]Workaround: Single Mode
          
  
         	
           
           [bookmark: pgfId-1146370]Workaround: Multiple Mode
          
  
        
 
         
         	 [bookmark: pgfId-1146372]Local CLI authentication
  
         	 [bookmark: pgfId-1146374]No users have been configured in the local database.
  
         	 [bookmark: pgfId-1146376]If you have no users in the local database, you cannot log in, and you cannot add any users.
  
         	 [bookmark: pgfId-1146378]Log in and reset the passwords and  aaa commands.
  
         	 [bookmark: pgfId-1146382]Session into the ASA from the switch. From the system execution space, you can change to the context and add a user.
  
        
 
         
         	 [bookmark: pgfId-1146385]TACACS+ command authorization
  [bookmark: pgfId-1146386]TACACS+ CLI authentication
  [bookmark: pgfId-1146387]RADIUS CLI authentication
  
         	 [bookmark: pgfId-1146389]The server is down or unreachable and you do not have the fallback method configured.
  
         	 [bookmark: pgfId-1146391]If the server is unreachable, then you cannot log in or enter any commands.
  
         	 [bookmark: pgfId-1146393] 1.[image: ] Log in and reset the passwords and AAA commands.
  [bookmark: pgfId-1146394] 2.[image: ] Configure the local database as a fallback method so you do not get locked out when the server is down.
  
         	 [bookmark: pgfId-1146396] 1.[image: ] If the server is unreachable because the network configuration is incorrect on the ASA, session into the ASA from the switch. From the system execution space, you can change to the context and reconfigure your network settings.
  [bookmark: pgfId-1146403] 2.[image: ] Configure the local database as a fallback method so that you do not get locked out when the server is down.
  
        
 
         
         	 [bookmark: pgfId-1146405]TACACS+ command authorization
  
         	 [bookmark: pgfId-1146407]You are logged in as a user without enough privileges or as a user that does not exist.
  
         	 [bookmark: pgfId-1146409]You enable command authorization, but then find that the user cannot enter any more commands.
  
         	 [bookmark: pgfId-1146411]Fix the TACACS+ server user account.
  [bookmark: pgfId-1146412]If you do not have access to the TACACS+ server and you need to configure the ASA immediately, then log into the maintenance partition and reset the passwords and  aaa commands. 
  
         	 [bookmark: pgfId-1146419]Session into the ASA from the switch. From the system execution space, you can change to the context and complete the configuration changes. You can also disable command authorization until you fix the TACACS+ configuration.
  
        
 
         
         	 [bookmark: pgfId-1146422]Local command authorization
  
         	 [bookmark: pgfId-1146424]You are logged in as a user without enough privileges.
  
         	 [bookmark: pgfId-1146426]You enable command authorization, but then find that the user cannot enter any more commands.
  
         	 [bookmark: pgfId-1146428]Log in and reset the passwords and  aaa commands. 
  
         	 [bookmark: pgfId-1146432]Session into the ASA from the switch. From the system execution space, you can change to the context and change the user level.
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1833284][bookmark: 45321]Monitoring Device Access 
 
     [bookmark: pgfId-1833285]To monitor device access, see the following panes:
 
     [bookmark: pgfId-1833307]
 
     
      
      
        
        	
          
          [bookmark: pgfId-1833288]Path
         
  
        	
          
          [bookmark: pgfId-1833290]Purpose
         
  
       
 
        
        	 [bookmark: pgfId-1833292]Monitoring > Properties > Device Access > ASDM/HTTPS/Telnet/SSH Sessions
  
        	 [bookmark: pgfId-1833295]The top pane lists the connection types, session IDs, and IP addresses for users connected through ASDM, HTTPS, and Telnet sessions. To disconnect a specific session, click  Disconnect .
  [bookmark: pgfId-1833296]The bottom pane lists the clients, usernames, connection states, software versions, incoming encryption types, outgoing encryption types, incoming HMACs, outgoing HMACs, SSH session IDs, remaining rekey data, remaining rekey time, data-based rekeys, time-based rekeys, and the last rekey time. To disconnect a specific session, click  Disconnect .
  
       
 
        
        	 [bookmark: pgfId-1833298]Monitoring > Properties > Device Access > Authenticated Users
  
        	 [bookmark: pgfId-1833301]Lists the usernames, IP addresses, dynamic ACLs, inactivity timeouts (if any), and absolute timeouts for users who were authenticated by AAA servers.
  
       
 
        
        	 [bookmark: pgfId-1833303]Monitoring > Properties > Device Access > AAA Local Locked Out Users
  
        	 [bookmark: pgfId-1833306]Lists the usernames of locked-out AAA local users, the number of failed attempts to authenticate, and the times that users were locked out. To clear a specific user who has been locked out, click  Clear Selected Lockout . To clear all users who have been locked out, click  Clear All Lockouts .
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-1223518][bookmark: 73792]Feature History for Management Access
 
     [bookmark: pgfId-1223522] Table 45-3  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
     [bookmark: pgfId-1223547]
 
     
      
       
        [bookmark: pgfId-1736982]Table 45-3 [bookmark: 40869]Feature History for Management Access 
 
       
      
        
        	
          
          [bookmark: pgfId-1736988]Feature Name
         
  
        	
          
          [bookmark: pgfId-1736990]Platform Releases
         
  
        	
          
          [bookmark: pgfId-1736992]Feature Information
         
  
       
 
        
        	 [bookmark: pgfId-1736994]Management Access
  
        	 [bookmark: pgfId-1736996]7.0(1)
  
        	 [bookmark: pgfId-1736998]We introduced this feature.
  [bookmark: pgfId-1833317]We introduced the following screens:
  [bookmark: pgfId-1737002]Configuration > Device Management > Management Access > ASDM/HTTPS/Telnet/SSH
 Configuration > Device Management > Management Access > Command Line (CLI) > Banner
 Configuration > Device Management > Management Access > CLI Prompt
 Configuration > Device Management > Management Access > ICMP
 Configuration > Device Management > Management Access > File Access > FTP Client
 Configuration > Device Management > Management Access > File Access > Secure Copy (SCP) Server
 Configuration > Device Management > Management Access > File Access > Mount-Points
 Configuration > Device Management > Users/AAA > AAA Access > Authentication
 Configuration > Device Management > Users/AAA > AAA Access > Authorization
 Configuration > Device Management > Users/AAA > AAA Access > > Accounting.
  
       
 
        
        	 [bookmark: pgfId-1737004]Increased SSH security; the SSH default username is no longer supported.
  
        	 [bookmark: pgfId-1737006]8.4(2)
  
        	 [bookmark: pgfId-1737008]Starting in 8.4(2), you can no longer connect to the ASA using SSH with the pix or asa username and the login password. To use SSH, you must configure AAA authentication using the  aaa authentication ssh console LOCAL command (CLI) or Configuration > Device Management > Users/AAA > AAA Access > Authentication (ASDM); then define a local user by entering the  username command (CLI) or choosing Configuration > Device Management > Users/AAA > User Accounts (ASDM). If you want to use a AAA server for authentication instead of the local database, we recommend also configuring local authentication as a backup method.
  
       
 
        
        	 [bookmark: pgfId-1737010]Support for administrator password policy when using the local database
  
        	 [bookmark: pgfId-1737012]8.4(4.1), 9.1(2)
  
        	 [bookmark: pgfId-1737014]When you configure authentication for CLI or ASDM access using the local database, you can configure a password policy that requires a user to change their password after a specified amount of time and also requires password standards such as a minimum length and the minimum number of changed characters.
  [bookmark: pgfId-1737016]We introduced the following screen: Configuration > Device Management > Users/AAA > Password Policy.
  
       
 
        
        	 [bookmark: pgfId-1737018]Support for SSH public key authentication
  
        	 [bookmark: pgfId-1737020]8.4(4.1), 9.1(2)
  
        	 [bookmark: pgfId-1737022]You can enable public key authentication for SSH connections to the ASA on a per-user basis. You can specify a public key file (PKF) formatted key or a Base64 key. The PKF key can be up to 4096 bits. Use PKF format for keys that are too large to for the ASA support of the Base64 format (up to 2048 bits).
  [bookmark: pgfId-1833328]We introduced the following screens:
  [bookmark: pgfId-1833329]Configuration > Device Management > Users/AAA > User Accounts > Edit User Account > Public Key Authentication
 Configuration > Device Management > Users/AAA > User Accounts > Edit User Account > Public Key Using PKF.
  [bookmark: pgfId-1737032] PKF key format support is only in 9.1(2) and later. 
  
       
 
        
        	 [bookmark: pgfId-1737034]Support for Diffie-Hellman Group 14 for the SSH Key Exchange
  
        	 [bookmark: pgfId-1737036]8.4(4.1), 9.1(2)
  
        	 [bookmark: pgfId-1737038]Support for Diffie-Hellman Group 14 for SSH Key Exchange was added. Formerly, only Group 1 was supported.
  [bookmark: pgfId-1737040]We modified the following screen: Configuration > Device Management > Management Access > ASDM/HTTPS/Telnet/SSH.
  
       
 
        
        	 [bookmark: pgfId-1737042]Support for a maximum number of management sessions
  
        	 [bookmark: pgfId-1737044]8.4(4.1), 9.1(2)
  
        	 [bookmark: pgfId-1737046]You can set the maximum number of simultaneous ASDM, SSH, and Telnet sessions.
  [bookmark: pgfId-1737048]We introduced the following screen: Configuration > Device Management > Management Access > Management Session Quota.
  
       
 
        
        	 [bookmark: pgfId-1737053]For the ASASM in multiple context mode, support for Telnet and virtual console authentication from the switch. 
  
        	 [bookmark: pgfId-1737055]8.5(1)
  
        	 [bookmark: pgfId-1737060]Although connecting to the ASASM from the switch in multiple context mode connects to the system execution space, you can configure authentication in the admin context to govern those connections.
  
       
 
        
        	 [bookmark: pgfId-1737062]AES-CTR encryption for SSH
  
        	 [bookmark: pgfId-1737064]9.1(2)
  
        	 [bookmark: pgfId-1737069]The SSH server implementation in the ASA now supports AES-CTR mode encryption.
  
       
 
        
        	 [bookmark: pgfId-1737071]Improved SSH rekey interval
  
        	 [bookmark: pgfId-1737073]9.1(2)
  
        	 [bookmark: pgfId-1737075]An SSH connection is rekeyed after 60 minutes of connection time or 1 GB of data traffic.
  [bookmark: pgfId-1737076].
  
       
 
        
        	 [bookmark: pgfId-1817547]Improved one-time password authentication
  
        	 [bookmark: pgfId-1817549]9.1(5)
  
        	 [bookmark: pgfId-1817551]Administrators who have sufficient authorization privileges may enter privileged EXEC mode by entering their authentication credentials once. The  auto-enable option was added to the  aaa authorization exec command.
  [bookmark: pgfId-1817553]We modified the following screen: Configuration > Device Management > Users/AAA > AAA Access > Authorization.
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     [bookmark: pgfId-1043201][bookmark: 63014]Using the ACL Manager
      
      
 
     
 

 
     [bookmark: pgfId-1043202]This chapter describes how to configure extended ACLs (also known as access control lists), and it includes the following sections:

 
     
     		 [bookmark: pgfId-1057264]Information About the ACL Manager

 
     		 [bookmark: pgfId-1096749]Licensing Requirements for the ACL Manager

 
     		 [bookmark: pgfId-1096750]Guidelines and Limitations

 
     		 [bookmark: pgfId-1096754]Adding ACLs and ACEs

 
     		 [bookmark: pgfId-1068119]Feature History for the ACL Manager

 
    

 
   
 
    
     [bookmark: pgfId-1056837][bookmark: 15525]Information About the ACL Manager

 
     [bookmark: pgfId-1057103]Access control lists (ACLs) are used to control network access or to specify traffic for many features to act upon. An ACL is made up of one or more access control entries (ACEs) in which you can specify the line number to insert the ACE, the source and destination addresses, and, depending upon the ACE type, the protocol, the ports (for TCP or UDP), or the ICMP type.

 
     [bookmark: pgfId-1092457]The [bookmark: marker-1092456]ACL Manager dialog box lets you define ACLs to control the access of a specific host or network to another host/network, including the protocol or port that can be used. 

 
     [bookmark: pgfId-1092458]You can configure ACLs (access control lists) to apply to user sessions. These are filters that permit or deny user access to specific networks, subnets, hosts, and web servers.

 
     
     		 [bookmark: pgfId-1092459]If you do not define any filters, all connections are permitted.

 
     		 [bookmark: pgfId-1092463]The ASA supports only an inbound ACL on an interface.

 
    

 
     [bookmark: pgfId-1092446]At the end of each ACL, there is an implicit, unwritten rule that denies all traffic that is not permitted. If traffic is not explicitly permitted by an access control entry (ACE), the ASA denies it. ACEs are referred to as rules in this section.

 
     [bookmark: pgfId-1094592]For information about adding ACLs and ACEs, see the “Adding ACLs and ACEs” section.

 
     [bookmark: pgfId-1095874]For information about finding specific ACLs and ACEs in your configuration, see the “Using the Find Function in the ACL Manager Pane” section.

 
   
 
    
     [bookmark: pgfId-1046838][bookmark: 89936][bookmark: 29596]Licensing Requirements for the ACL Manager

 
     [bookmark: pgfId-1103391] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1103384]Model
         
  
        		
          
          [bookmark: pgfId-1103386]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1103388]All models

  
        		 [bookmark: pgfId-1103390]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1100016][bookmark: 16098][bookmark: 58316][bookmark: 41891]Guidelines and Limitations

 
     [bookmark: pgfId-1096693]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1071231][bookmark: 87419]Context Mo[bookmark: marker-1071230]de Guidelines

 
     [bookmark: pgfId-1071232]Supported in single and multiple context mode. 

 
     [bookmark: pgfId-1071235][bookmark: 16807]Firewall Mode Guidelines

 
     [bookmark: pgfId-1071236]Supported in routed and transparent firewall modes only. 

 
     [bookmark: pgfId-1083322]IPv6 Guidelines

 
     [bookmark: pgfId-1083323]IPv6 is supported.

 
     [bookmark: pgfId-1071249][bookmark: 23253]Additional Guidelines and Limitations

 
     [bookmark: pgfId-1071250]The following guidelines and limitations apply to creating an extended ACL:

 
     
     		 [bookmark: pgfId-1080115]Enter the ACL name in uppercase letters so that the name is easy to see in the configuration. You might want to name the ACL for the interface (for example, INSIDE), or you can name it for the purpose for which it is created (for example, NO_NAT or VPN).

 
     		 [bookmark: pgfId-1094576]You can specify the source and destination ports only for the TCP or UDP protocols. For a list of permitted keywords and well-known port assignments, see the “TCP and UDP Ports” section. DNS, Discard, Echo, Ident, NTP, RPC, SUNRPC, and Talk each require one definition for TCP and one for UDP. TACACS+ requires one definition for port 49 on TCP.

 
    

 
   
 
    
     [bookmark: pgfId-1102403][bookmark: 60355][bookmark: 71793]Adding ACLs and ACEs 

 
     [bookmark: pgfId-1102404]An access control list (ACL) is made up of one or more access list entries (ACEs). To create an ACL, you start by creating an ACE and applying a list name. An ACL with one entry is still considered a list, although you can add multiple ACEs to the list.

 
     [bookmark: pgfId-1093810]To add an ACL and then add an ACE to that ACL, perform the following steps:

 
     [bookmark: pgfId-1093211]


     
     
 
    
 
    Step 1
    [image: ] Choose 
     Configuration > 
     Firewall > 
     Advanced > 
     ACL Manager .
    

 
     [bookmark: pgfId-1093245]Step 2[image: ] Select  Add > Add ACL . Adds an ACL configurable for IPv4 or IPv6 traffic.

 
     [bookmark: pgfId-1094240]Step 3[image: ] In the ACL name field, add a descriptive name for the ACL, and click  OK .

 
     [bookmark: pgfId-1094241]Your newly created ACL appears in the window.

 
     [bookmark: pgfId-1094242]Step 4[image: ] Select the newly created ACL, click  Add , and from the drop-down list, choose  Add ACE .

 
     [bookmark: pgfId-1094243]Step 5[image: ] In the Action field of the Add ACE window, click one of the following radio buttons to choose the action

 
     
      
      		 [bookmark: pgfId-1094244] Permit —Permits access if the conditions are matched.

 
      		 [bookmark: pgfId-1094245] Deny —Denies access if the conditions are matched.

 
     

 
    

 
     [bookmark: pgfId-1094246]Step 6[image: ] In the Source field, enter an IP address that specifies the network object group, interface IP, or any address from which traffic is permitted or denied. 

 
     [bookmark: pgfId-1094385]IPv6 must be enabled on at least one interface before you can configure an ACE with an IPv6 address. For more information about enabling IPv6 on an interface, see the “Configuring IPv6 Addressing” section.

 
     [bookmark: pgfId-1094386]Step 7[image: ] Select a destination to specify the IP addresses (host or network) that are permitted or denied to send traffic to the IP addresses listed in the Source section. 

 
     [bookmark: pgfId-1094387]Step 8[image: ] Specify the service to which this ACE applies. You can type a known service into the window or click browse to select from a list of services.

 
     [bookmark: pgfId-1094388]Service groups let you identify multiple non-contiguous port numbers that you want to match. 

 
     [bookmark: pgfId-1094883]For example, if you want to filter HTTP, FTP, and port numbers 5, 8, and 9, define a service group that includes all these ports.Without service groups, you would have to create a separate rule for each port

 
     [bookmark: pgfId-1094884]You can create service groups for TCP, UDP, TCP-UDP, ICMP, and other protocols. A service group with the TCP-UDP protocol contains services, ports, and ranges that might use either the TCP or UDP protocol.

 
     [bookmark: pgfId-1094391]–[image: ] Protocol—Selects the protocol to which this rule applies. Possible values are ip, tcp, udp, icmp, and other. The remaining available fields in the Protocol and Service area depend upon the protocol you select. The next few bullets describe the consequences of each of these selections:

 
     [bookmark: pgfId-1094392]–[image: ] Protocol: TCP and UDP—Selects the TCP/UDP protocol for the rule. The Source Port and Destination Port areas allow you to specify the ports that the ACL uses to match packets.

 
     [bookmark: pgfId-1094393]–[image: ] Source Port/Destination Port—( Available only for TCP and UDP protocols ) Specifies an operator and a port number, a range of ports, or a well-known service name from a list of services, such as HTTP or FTP. The operator list specifies how the ACL matches the port. Choose one of the following operators: = (equals the port number), not = (does not equal the port number), > (greater than the port number), < (less than the port number), range (equal to one of the port numbers in the range).

 
     [bookmark: pgfId-1094394]–[image: ] Group—( Available only for TCP and UDP protocols ) Selects a source port service group. The Browse (...) button opens the Browse Source Port or Browse Destination Port dialog box.

 
     [bookmark: pgfId-1094395]–[image: ] Protocol: ICMP—Enables you to choose an ICMP type or ICMP group from a preconfigured list or browse (...) for an ICMP group. The Browse button opens the Browse ICMP dialog box.

 
     [bookmark: pgfId-1094396]–[image: ] Protocol: IP—Specifies the IP protocol for the rule in the IP protocol box. No other fields are available when you make this selection.

 
     [bookmark: pgfId-1094397]–[image: ] Protocol: Other—Enables you to choose a protocol from a drop-down list, choose a protocol group from a drop-down list, or browse for a protocol group. The Browse (...) button opens the Browse Other dialog box.

 
     [bookmark: pgfId-1094398]Step 9[image: ] (Optional) Add text that provides a brief description of this rule. A description line can be up to 100 characters long, yet you can break a description into multiple lines. 

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1096196]Note If you add remarks with non-English characters on one platform (such as Windows) then try to remove them from another platform (such as Linux), you might not be able to edit or delete them because the original characters might not be correctly recognized. This limitation is due to an underlying platform dependency that encodes different language characters in different ways.


     
     
 
    

    

 
     [bookmark: pgfId-1094399]Step 10[image: ] (Optional) Check the Enable Logging check box to enable or disable logging or specify the use of the default logging settings. If logging is enabled, the Syslog Level and Log Interval fields become available.

 
     [bookmark: pgfId-1094400] a.[image: ] If logging is enables, choose a logging level to specify logging activity. The default is Informational. For information about logging levels, see the “Severity Levels” section.

 
     [bookmark: pgfId-1094404] b.[image: ] Choose a logging interval to display the interval, in seconds, that is used to limit how many messages at this logging level can be sent.

 
     [bookmark: pgfId-1094405]Step 11[image: ] Set the source service (TCP, UDP, and TCP/UDP only).

 
     [bookmark: pgfId-1094406]Step 12[image: ] Set the logging interval to establish the number of seconds between log messages. The default is 300.

 
     [bookmark: pgfId-1094407]Step 13[image: ] Set the time range during which the rule is applied.

 
     [bookmark: pgfId-1094887]Step 14[image: ] Click  Apply to save the ACL and ACE to the running configuration.

 
     [bookmark: pgfId-1095706]To see a condensed view of all ACLs in your configuration, click  Collapse All below the ACL Manager window. To see a comprehensive view of all ACLs and ACEs in your configuration, click  Expand All . 

 
     [bookmark: pgfId-1095905]For information about finding specific ACLs and ACEs in your configuration, see the “Using the Find Function in the ACL Manager Pane” section.

 
     [bookmark: pgfId-1094408]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1093304]Using Standard ACLs in the ACL Manager 

 
     [bookmark: pgfId-1094475]Standard ACLs identify the destination IP addresses (not source addresses). Standard ACLs cannot be applied to interfaces to control traffic. 

 
     [bookmark: pgfId-1094491]To add a standard ACL to your configuration, perform the following steps:

 
     [bookmark: pgfId-1094492]


     
     
 
    
 
    Step 1
    [image: ] Click 
     Add , and from the drop-down list, choose 
     Add ACL .
    

 
     [bookmark: pgfId-1094493]Step 2[image: ] In the Add ACL dialog box, add a name or number (without spaces) to identify the ACL.

 
     [bookmark: pgfId-1094494]Step 3[image: ] Click  OK 

 
     [bookmark: pgfId-1094495]The ACL name appears in the main pane.

 
     [bookmark: pgfId-1094515]Step 4[image: ] Select the newly created ACL, click  Add , and from the drop-down list, choose  Add ACE .

 
     [bookmark: pgfId-1094516]The Add ACE dialog box appears.

 
     [bookmark: pgfId-1094517]Step 5[image: ] (Optional) To specify the placement of the new ACE, select an existing ACE, and click Insert... to add the ACE before the selected ACE, or click Insert After... to add the ACE after the selected ACE.

 
     [bookmark: pgfId-1094518]Step 6[image: ] Click one of the following radio buttons to choose an action:

 
     
     		 [bookmark: pgfId-1094519] Permit —Permits access if the conditions are matched.

 
      
      		 [bookmark: pgfId-1094520] Deny —Denies access if the conditions are matched.

 
     

 
    

 
     [bookmark: pgfId-1094521]Step 7[image: ] In the Address field, enter the IP address of the destination to which you want to perform or deny access.

 
     [bookmark: pgfId-1094522]You can also browse for the address of a network object by clicking the ellipsis at the end of the Address field.

 
     [bookmark: pgfId-1094523]Step 8[image: ] (Optional) In the Description field, enter a description that makes an ACE easier to understand.

 
     [bookmark: pgfId-1094524]The description can contain multiple lines; however, each line can be no more than 100 characters in length.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1096274]Note If you add remarks with non-English characters on one platform (such as Windows) then try to remove them from another platform (such as Linux), you might not be able to edit or delete them because the original characters might not be correctly recognized. This limitation is due to an underlying platform dependency that encodes different language characters in different ways.


     
     
 
    

    

 
     [bookmark: pgfId-1096275]Step 9[image: ] Click  OK .

 
     [bookmark: pgfId-1094526]The newly created ACE appears under the ACL.

 
     [bookmark: pgfId-1094527]Step 10[image: ] Click  Apply to save the ACE to your configuration.

 
     [bookmark: pgfId-1094528]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1046350][bookmark: 56721][bookmark: 96108][bookmark: 92503]Feature History for the ACL Manager

 
     [bookmark: pgfId-1068790] Table 21-1  lists the release history for this feature.

 
     [bookmark: pgfId-1068794] 

 
     
      
       
        [bookmark: pgfId-1068883]Table 21-1 [bookmark: 50557]Feature History for Extended ACLs 

 
       
      
        
        		
          
          [bookmark: pgfId-1068889]Feature Name
         
  
        		
          
          [bookmark: pgfId-1068891]Releases
         
  
        		
          
          [bookmark: pgfId-1068893]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1068895]Extended ACLs

  
        		 [bookmark: pgfId-1068897]7.0(1)

  
        		 [bookmark: pgfId-1070971]ACLs are used to control network access or to specify traffic for many features to act upon. An extended access control list is made up of one or more access control entries (ACEs) in which you can specify the line number to insert the ACE, the source and destination addresses, and, depending upon the ACE type, the protocol, the ports (for TCP or UDP), or the IPCMP type (for ICMP). 
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     [bookmark: pgfId-1002608][bookmark: 97923]Configuring DHCP Services
      
      
 
     
 

 
     [bookmark: pgfId-1091911]This chapter describes how to configure the DHCP server or DHCP relay and includes the following sections: 

 
     
     		 [bookmark: pgfId-1136761]Information About DHCP Services

 
     		 [bookmark: pgfId-1125220]Licensing Requirements for DHCP

 
     		 [bookmark: pgfId-1125224]Guidelines and Limitations

 
     		 [bookmark: pgfId-1302695]Configuring DHCP Services

 
     		 [bookmark: pgfId-1202403]Additional References

 
     		 [bookmark: pgfId-1144379]Monitoring DHCP Services

 
     		 [bookmark: pgfId-1144395]Feature History for DHCP Services

 
    

 
   
 
    
     [bookmark: pgfId-1136783][bookmark: 79836]Information About DHCP Services

 
     
     		 [bookmark: pgfId-1311069]Information About the DHCP Server

 
     		 [bookmark: pgfId-1311129]Information About the DHCP Relay Agent

 
    

 
     
      [bookmark: pgfId-1311050][bookmark: 33090]Information About the DHCP Server

 
      [bookmark: pgfId-1136786]DHCP provides network configuration parameters, such as IP addresses, to DHCP clients. The ASA can provide a DHCP server to DHCP clients attached to ASA interfaces. The DHCP server provides network configuration parameters directly to DHCP clients. 

 
      [bookmark: pgfId-1224676]A client locates a DHCP server to request the assignment of configuration information using a reserved, link-scoped multicast address, which indicates that the client and server should be attached to the same link. However, in some cases where ease of management, economy, or scalability is the concern, we recommend that you allow a DHCP client to send a message to a server that is not connected to the same link. The DHCP relay agent, which may reside on the client network, can relay messages between the client and server. The relay agent operation is transparent to the client. 

 
      [bookmark: pgfId-1316905]An IPv4 DHCP client uses a broadcast rather than a multicast address to reach the server. The DHCP client listens for messages on UDP port 68; the DHCP server listens for messages on UDP port 67.

 
      [bookmark: pgfId-1202045]DHCP for IPv6 (DHCPv6) specified in RFC 3315 enables IPv6 DHCP servers to send configuration parameters such as network addresses or prefixes and DNS server addresses to IPv6 nodes (that is, DHCP clients). DHCPv6 uses the following multicast addresses:

 
      
      		 [bookmark: pgfId-1202047]All_DHCP_Relay_Agents_and_Servers (FF02::1:2) is a link-scoped multicast address used by a client to communicate with neighboring (that is, on-link) relay agents and servers. All DHCPv6 servers and relay agents are members of this multicast group.

 
      		 [bookmark: pgfId-1202039]The DHCPv6 relay service and server listen for messages on UDP port 547. The ASA DHCPv6 relay agent listens on both UDP port 547 and the All_DHCP_Relay_Agents_and_Servers multicast address. 

 
     

 
    
 
     
      [bookmark: pgfId-1300439][bookmark: 43050]Information About the DHCP Relay Agent

 
      [bookmark: pgfId-1311429]You can configure a DHCP relay agent to forward DHCP requests received on an interface to one or more DHCP servers. DHCP clients use UDP broadcasts to send their initial DHCPDISCOVER messages because they do not have information about the network to which they are attached. If the client is on a network segment that does not include a server, UDP broadcasts normally are not forwarded by the ASA because it does not forward broadcast traffic.

 
      [bookmark: pgfId-1311436]You can remedy this situation by configuring the interface of your ASA that is receiving the broadcasts to forward DHCP requests to a DHCP server on another interface.

 
    
 
   
 
    
     [bookmark: pgfId-1125251][bookmark: 47261]Licensing Requirements for DHCP

 
     [bookmark: pgfId-1125255] Table 17-1  shows the licensing requirements for DHCP.

 
     [bookmark: pgfId-1125257]Table 17-1 [bookmark: 32741]Licensing Requirements

 
     [bookmark: pgfId-1334316] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1334309]Model
         
  
        		
          
          [bookmark: pgfId-1334311]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1334313]All models

  
        		 [bookmark: pgfId-1334315]Base License.

  
       

 
      
     

 
    
 
     [bookmark: pgfId-1125269]For all ASA models, the maximum number of DHCP client addresses varies depending on the license:

 
     
     		 [bookmark: pgfId-1125272][bookmark: 99767][bookmark: 79799]If the limit is 10 hosts, the maximum available DHCP pool is 32 addresses.

 
     		 [bookmark: pgfId-1125273]If the limit is 50 hosts, the maximum available DHCP pool is 128 addresses.

 
     		 [bookmark: pgfId-1125274]If the number of hosts is unlimited, the maximum available DHCP pool is 256 addresses.

 
    

 
   
 
    
     [bookmark: pgfId-1125277][bookmark: 98392]Guidelines and Limitations

 
     [bookmark: pgfId-1132628]Firewall Mode Guidelines

 
     [bookmark: pgfId-1132629]Supported in routed firewall mode.

 
     [bookmark: pgfId-1201453]Not supported in transparent firewall mode. See the “DHCP Relay Guidelines” section for more information.

 
     [bookmark: pgfId-1132630]Context Mode Guidelines

 
     [bookmark: pgfId-1132631]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1210711]Failover Guidelines

 
     [bookmark: pgfId-1210712]Supports Active/Active and Active/Standby failover.

 
     [bookmark: pgfId-1210749]IPv6 Guidelines

 
     [bookmark: pgfId-1210731]Supports IPv6, except for interface-specific DHCP relay servers.

 
     [bookmark: pgfId-1311526]DHCP Server Guidelines

 
     
     		 [bookmark: pgfId-1311622]The maximum available DHCP pool is 256 addresses. 

 
     		 [bookmark: pgfId-1311908]You can configure only one DHCP server on each interface of the ASA. Each interface can have its own pool of addresses to use. However the other DHCP settings, such as DNS servers, domain name, options, ping timeout, and WINS servers, are configured globally and used by the DHCP server on all interfaces.

 
     		 [bookmark: pgfId-1311909]You cannot configure a DHCP client or DHCP relay service on an interface on which the server is enabled. Additionally, DHCP clients must be directly connected to the interface on which the server is enabled.

 
     		 [bookmark: pgfId-1311913]The ASA does not support QIP DHCP servers for use with the DHCP proxy service.

 
     		 [bookmark: pgfId-1311914]The relay agent cannot be enabled if the DHCP server is also enabled.

 
     		 [bookmark: pgfId-1311918]The ASA DHCP server does not support BOOTP requests. In multiple context mode, you cannot enable the DHCP server or DHCP relay service on an interface that is used by more than one context.

 
     		 [bookmark: pgfId-1321744]When it receives a DHCP request, the ASA sends a discovery message to the DHCP server. This message includes the IP address (within a subnetwork) that was configured with the dhcp-network-scope command in the group policy. If the server has an address pool that falls within that subnetwork, the server sends the offer message with the pool information to the IP address—not to the source IP address of the discovery message.

 
     		 [bookmark: pgfId-1326344](9.1.3 and earlier) When it receives a DHCP request, the ASA sends a discovery message to the DHCP server. This message includes the IP address (within a subnetwork) that was configured with the dhcp-network-scope command in the group policy. If the server has an address pool that falls within that subnetwork, the server sends the offer message with the pool information to the IP address—not to the source IP address of the discovery message.

 
     		 [bookmark: pgfId-1326345](9.1.4 and later) When a client connects, the ASA sends a discovery message to all the servers in the server list. This message includes the IP address (within a subnetwork) that was configured with the dhcp-network-scope command in the group policy. The ASA selects the first offer received and drops the other offers. If the server has an address pool that falls within that subnetwork, the server sends the offer message with the pool information to the IP address—not to the source IP address of the discovery message. When the address needs to be renewed, it attempts to renew it with the lease server (the server from which the address was acquired). If the DHCP renew fails after a specified number of retries ( four attempts), the ASA moves to the DHCP rebind phase after a predefined time period. During the rebind phase, the ASA simultaneously sends requests to all servers in the group. In a high availability environment, lease information is shared, so the other servers can acknowledge the lease and ASA will return to the bound state. During the rebind phase, if there is no response from any of the servers in the server list (after three retries), then the ASA will purge the entries.

 
    

 
     [bookmark: pgfId-1311923]For example, if the server has a pool in the range of 209.165.200.225 to 209.165.200.254, mask 255.255.255.0, and the IP address specified by the  dhcp-network-scope command is 209.165.200.1, the server sends that pool in the offer message to the ASA.

 
     [bookmark: pgfId-1316963]The  dhcp-network-scope command setting applies only to VPN users.

 
     [bookmark: pgfId-1311609][bookmark: 57433]DHCP Relay Guidelines

 
     
     		 [bookmark: pgfId-1312445]You can configure a maximum of 10 DHCPv4 relay servers in single mode and per context, global and interface-specific servers combined, with a maximum of 4 servers per interface.

 
     		 [bookmark: pgfId-1312446]You can configure a maximum of 10 DHCPv6 relay servers in single mode and per context. Interface-specific servers for IPv6 are not supported.

 
     		 [bookmark: pgfId-1312447]The relay agent cannot be enabled if the DHCP server feature is also enabled.

 
     		 [bookmark: pgfId-1312150]When the DHCP relay service is enabled and more than one DHCP relay server is defined, the ASA forwards client requests to each defined DHCP relay server. Replies from the servers are also forwarded to the client until the client DHCP relay binding is removed. The binding is removed when the ASA receives any of the following DHCP messages: ACK, NACK, ICMP unreachable, or decline.

 
     		 [bookmark: pgfId-1312154]You cannot enable DHCP relay service on an interface running as a DHCP proxy service. You must remove the VPN DHCP configuration first or an error message appears. This error occurs if both DHCP relay and DHCP proxy services are enabled. Make sure that either the DHCP relay or DHCP proxy service is enabled, but not both.

 
     		 [bookmark: pgfId-1312255]DHCP relay services are not available in transparent firewall mode. You can, however, allow DHCP traffic through using an access list. To allow DHCP requests and replies through the ASA in transparent mode, you need to configure two access lists, one that allows DCHP requests from the inside interface to the outside, and one that allows the replies from the server in the other direction.

 
     		 [bookmark: pgfId-1312262]For IPv4, clients must be directly-connected to the ASA and cannot send requests through another relay agent or a router. For IPv6, the ASA supports packets from another relay server.

 
     		 [bookmark: pgfId-1312266]For multiple context mode, you cannot enable DHCP relay on an interface that is used by more than one context.

 
     		 [bookmark: pgfId-1312270]The DHCP clients must be on different interfaces from the DHCP servers to which the ASA relays requests.

 
    

 
   
 
    
     [bookmark: pgfId-1310990][bookmark: 96754]Configuring DHCP Services

 
     
     		 [bookmark: pgfId-1311252]Configuring the DHCP Server

 
     		 [bookmark: pgfId-1311271]Configuring the DHCP Relay Agent

 
    

 
     
      [bookmark: pgfId-1302751][bookmark: 45286][bookmark: 11346][bookmark: 84415]Configuring the DHCP Server

 
      [bookmark: pgfId-1302755]This section describes how to configure a DHCP server provided by the ASA and includes the following topics:

 
      
      		 [bookmark: pgfId-1302759]Enabling the DHCP Server

 
      		 [bookmark: pgfId-1302763]Configuring Advanced DHCP Options

 
     

 
    
 
     
      [bookmark: pgfId-1302770][bookmark: 55313]Enabling the DHCP Server [bookmark: marker-1302769]

 
      [bookmark: pgfId-1302774]To enable the DHCP server on an ASA interface, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1305419]Detailed Steps

 
     
 
      [bookmark: pgfId-1326357] Step 1[image: ] Choose  Configuration > Device Management > DHCP > DHCP Server .

 
      [bookmark: pgfId-1326358]Step 2[image: ] Select an interface, and click  Edit .

 
      [bookmark: pgfId-1326359] a.[image: ] To enable the DHCP server on the selected interface, check the  Enable DHCP Server check box.

 
      [bookmark: pgfId-1326360] b.[image: ] In the DHCP Address Pool field, enter the range of IP addresses from lowest to highest that is used by the DHCP server. The range of IP addresses must be on the same subnet as the selected interface and cannot include the IP address of the interface itself.

 
      [bookmark: pgfId-1326361] c.[image: ] In the Optional Parameters area, set the following:

 
      [bookmark: pgfId-1326362]–[image: ] The DNS servers (1 and 2) configured for the interface.

 
      [bookmark: pgfId-1326363]–[image: ] The WINS servers (primary and secondary) configured for the interface.

 
      [bookmark: pgfId-1326364]–[image: ] The domain name of the interface.

 
      [bookmark: pgfId-1326368]–[image: ] The time in milliseconds that the ASA will wait for an ICMP ping response on the interface.

 
      [bookmark: pgfId-1326369]–[image: ] The duration of time that the DHCP server configured on the interface allows DHCP clients to use an assigned IP address.

 
      [bookmark: pgfId-1326370]–[image: ] The interface on a DHCP client that provides DNS, WINS, and domain name information for automatic configuration if the ASA is acting as a DHCP client on a specified interface (usually outside).

 
      [bookmark: pgfId-1313673]–[image: ] To configure more DHCP options, click  Advanced to display the Advanced DHCP Options dialog box. For more information, see the “Configuring Advanced DHCP Options” section.

 
      [bookmark: pgfId-1326382] d.[image: ] In the Dynamic Settings for DHCP Server area, check the  Update DNS Clients check box to specify that, in addition to the default action of updating the client PTR resource records, the selected DHCP server should also perform the following update actions:

 
      [bookmark: pgfId-1326383]–[image: ] To specify that the DHCP server should update both the A and PTR RRs, check the  Update Both Records check box.

 
      [bookmark: pgfId-1326384]–[image: ] To specify that DHCP server actions should override any update actions requested by the DHCP client, check the  Override Client Settings check box 

 
      [bookmark: pgfId-1326385] e.[image: ] Click  OK to close the Edit DHCP Server dialog box.

 
      [bookmark: pgfId-1326386]Step 3[image: ] In the Global DHCP Options area below the DHCP Server table, check the  Enable Auto-configuration from interface check box to enable DHCP auto configuration only if the ASA is acting as a DHCP client on a specified interface (usually outside).

 
      [bookmark: pgfId-1326390]DHCP auto configuration enables the DHCP Server to provide DHCP clients with DNS server, domain name, and WINS server information obtained from a DHCP client running on the specified interface. If information obtained through auto configuration is also specified manually in the Global DHCP Options area, the manually specified information takes precedence over the discovered information.

 
      [bookmark: pgfId-1326391]Step 4[image: ] Choose the interface from the drop-down list.

 
      [bookmark: pgfId-1326392]Step 5[image: ] To override the interface DHCP or PPPoE client WINS parameter with the VPN client parameter, check the  Allow VPN override check box. 

 
      [bookmark: pgfId-1326393]Step 6[image: ] In the DNS Server 1 field, enter the IP address of the primary DNS server for a DHCP client. 

 
      [bookmark: pgfId-1326394]Step 7[image: ] In the DNS Server 2 field, enter the IP address of the alternate DNS server for a DHCP client. 

 
      [bookmark: pgfId-1326395]Step 8[image: ] In the Domain Name field, enter the DNS domain name for DHCP clients (for example, example.com).

 
      [bookmark: pgfId-1326396]Step 9[image: ] In the Lease Length field, enter the amount of time, in seconds, that the client can use its allocated IP address before the lease expires. Valid values range from 300 to 1048575 seconds. The default value is 3600 seconds (1 hour).

 
      [bookmark: pgfId-1326397]Step 10[image: ] In the Primary WINS Server field, enter the IP address of the primary WINS server for a DHCP client. 

 
      [bookmark: pgfId-1326398]Step 11[image: ] In the Secondary WINS Server field, enter the IP address of the alternate WINS server for a DHCP client.

 
      [bookmark: pgfId-1326402]Step 12[image: ] To avoid address conflicts, the ASA sends two ICMP ping packets to an address before assigning that address to a DHCP client. In the Ping Timeout field, enter the amount of time, in milliseconds, that the ASA waits to time out a DHCP ping attempt. Valid values range from 10 to 10000 milliseconds. The default value is 50 milliseconds.

 
      [bookmark: pgfId-1326406]Step 13[image: ] To specify additional DHCP options and their parameters, click  Advanced to display the Configuring Advanced DHCP Options dialog box. For more information, see the “Configuring Advanced DHCP Options” section.

 
      [bookmark: pgfId-1326410]Step 14[image: ] In the Dynamic DNS Settings for DHCP Server area, you configure the DDNS update settings for the DHCP server. Check the  Update DNS Clients check box to specify that, in addition to the default action of updating the client PTR resource records, the selected DHCP server should also perform the following update actions:

 
      
       
       		 [bookmark: pgfId-1326411]Check the  Update Both Records check box to specify that the DHCP server should update both the A and PTR RRs.

 
       		 [bookmark: pgfId-1326412]Check the  Override Client Settings check box to specify that the DHCP server actions should override any update actions requested by the DHCP client.

 
      

 
     

 
      [bookmark: pgfId-1326413]Step 15[image: ] Click  Apply to save your changes.

 
      [bookmark: pgfId-1326414]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1302886][bookmark: 34565]Configuring Advanced DHCP Options

 
      [bookmark: pgfId-1326431][bookmark: marker-1326430]You can use advanced DHCP options to provide DNS, WINS, and domain name parameters to DHCP clients. You can also use the DHCP automatic configuration setting to obtain these values or define them manually. When you use more than one method to define this information, it is passed to DHCP clients in the following sequence:

 
      [bookmark: pgfId-1326432] 1.[image: ] Manually configured settings.

 
      [bookmark: pgfId-1326433] 2.[image: ] Advanced DHCP options settings.

 
      [bookmark: pgfId-1326434] 3.[image: ] DHCP automatic configuration settings.

 
      [bookmark: pgfId-1326435]For example, you can manually define the domain name that you want the DHCP clients to receive and then enable DHCP automatic configuration. Although DHCP automatic configuration discovers the domain together with the DNS and WINS servers, the manually defined domain name is passed to DHCP clients with the discovered DNS and WINS server names, because the domain name discovered by the DHCP automatic configuration process is superseded by the manually defined domain name.

 
    
 
     
      [bookmark: pgfId-1326436]Detailed Steps

 
     
 
      [bookmark: pgfId-1326437] Step 1[image: ] Choose  Configuration > Device Management > DHCP > DHCP Server , and click  Advanced .

 
      [bookmark: pgfId-1326438]Step 2[image: ] Choose the option code from the drop-down list. All DHCP options (options 1 through 255) are supported except 1, 12, 50–54, 58–59, 61, 67, and 82. 

 
      [bookmark: pgfId-1326439]Step 3[image: ] Choose the options that you want to configure. Some options are standard. For standard options, the option name is shown in parentheses after the option number and the option parameters are limited to those supported by the option. For all other options, only the option number is shown and you must choose the appropriate parameters to supply with the option. For example, if you choose DHCP Option 2 (Time Offset), you can only enter a hexadecimal value for the option. For all other DHCP options, all of the option value types are available and you must choose the appropriate options value type. 

 
      [bookmark: pgfId-1326440]Step 4[image: ] In the Option Data area, specify the type of information that the option returns to the DHCP client. For standard DHCP options, only the supported option value type is available. For all other DHCP options, all of the option value types are available. Click  Add to add the option to the DHCP option list. Click  Delete to remove the option from the DHCP option list.

 
      
       
       		 [bookmark: pgfId-1326441]Click  IP Address to indicate that an IP address is returned to the DHCP client. You can specify up to two IP addresses. IP Address 1 and IP Address 2 indicate an IP address in dotted-decimal notation.

 
      

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1326442]Note The name of the associated IP address fields can change based on the DHCP option that you chose. For example, if you choose DHCP Option 3 (Router), the fields names change to Router 1 and Router 2.


      
      
 
     

     

 
      
       
       		 [bookmark: pgfId-1326443]Click  ASCII to specify that an ASCII value is returned to the DHCP client. In the Data field, enter an ASCII character string. The string cannot include spaces.

 
      

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1326444]Note The name of the associated Data field can change based on the DHCP option that you chose. For example, if you choose DHCP Option 14 (Merit Dump File), the associated Data field names change to File Name.


      
      
 
     

     

 
      
       
       		 [bookmark: pgfId-1326445]Click  Hex to specify that a hexadecimal value is returned to the DHCP client. In the Data field, enter a hexadecimal string with an even number of digits and no spaces. You do not need to use a 0x prefix.

 
      

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1326446]Note The name of the associated Data field can change based on the DHCP option you chose. For example, if you choose DHCP Option 2 (Time Offset), the associated Data field becomes the Offset field.


      
      
 
     

     

 
      [bookmark: pgfId-1326447]Step 5[image: ] Click  OK to close the Advanced DHCP Options dialog box.

 
      [bookmark: pgfId-1326448]Step 6[image: ] Click  Apply to save your changes.

 
      [bookmark: pgfId-1326449]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1313052] Configuring the DHCP Rel [bookmark: 89705][bookmark: marker-1313047] ay Agent 

 
      [bookmark: pgfId-1308761]When a DHCP request enters an interface, the DHCP servers to which the ASA relays the request depends on your configuration. You can configure the following types of servers:

 
      
      		 [bookmark: pgfId-1306469]Interface-specific DHCP servers—When a DHCP request enters a particular interface, then the ASA relays the request only to the interface-specific servers.

 
      		 [bookmark: pgfId-1309072]Global DHCP servers—When a DHCP request enters an interface that does not have interface-specific servers configured, the ASA relays the request to all global servers. If the interface has interface-specific servers, then the global servers are not used.

 
     

 
    
 
     
      [bookmark: pgfId-1303246]Detailed Steps

 
     
 
      [bookmark: pgfId-1326467] Step 1[image: ] Choose  Configuration > Device Management > DHCP > DHCP Relay .

 
      [bookmark: pgfId-1326469]Step 2[image: ] [bookmark: 17688]In the DHCP Relay Agent area, check the check boxes for the services you want for each interface:

 
      
       
       		 [bookmark: pgfId-1326470] IPv4 > DHCP Relay Enabled .

 
       		 [bookmark: pgfId-1326471] IPv4 > Set Route — Changes the default gateway address in the DHCP message from the server to that of the ASA interface that is closest to the DHCP client, which relayed the original DHCP request. This action allows the client to set its default route to point to the ASA even if the DHCP server specifies a different router. If there is no default router option in the packet, the ASA adds one containing the interface address.

 
       		 [bookmark: pgfId-1326481] IPv6 > DHCP Relay Enabled .

 
       		 [bookmark: pgfId-1326482] Trusted Interface —Specifies a DHCP client interface that you want to trust. You can configure interfaces as trusted interfaces to preserve DHCP Option 82. DHCP Option 82 is used by downstream switches and routers for DHCP snooping and IP Source Guard. Normally, if the ASA DHCP relay agent receives a DHCP packet with Option 82 already set, but the giaddr field (which specifies the DHCP relay agent address that is set by the relay agent before it forwards the packet to the server) is set to 0, then the ASA will drop that packet by default. You can now preserve Option 82 and forward the packet by identifying an interface as a trusted interface. You can alternatively trust all interfaces using the  Set dhcp relay information as trusted on all interfaces check box (see Step 7).

 
      

 
     

 
      [bookmark: pgfId-1326492]Step 3[image: ] In the Global DHCP Relay Servers area, add one or more DHCP servers to which DHCP requests are relayed:

 
      [bookmark: pgfId-1326493] a.[image: ] Click  Add . The Add Global DHCP Relay Server dialog box appears.

 
      [bookmark: pgfId-1326494] b.[image: ] In the DHCP Server field, enter the IPv4 or IPv6 address of the DHCP server.

 
      [bookmark: pgfId-1326495] c.[image: ] From the Interface drop-down list, choose the interface to which the specified DHCP server is attached.

 
      [bookmark: pgfId-1326496] d.[image: ] Click  OK .

 
      [bookmark: pgfId-1326497]The newly added global DHCP relay server appears in the Global DHCP Relay Servers list.

 
      [bookmark: pgfId-1326498]Step 4[image: ] (Optional) In the IPv4 Timeout field, enter the amount of time, in seconds, allowed for DHCP address handling. Valid values range from 1 to 3600 seconds. The default value is 60 seconds.

 
      [bookmark: pgfId-1326499]Step 5[image: ] (Optional) In the IPv6 Timeout field, enter the amount of time, in seconds, allowed for DHCP address handling. Valid values range from 1 to 3600 seconds. The default value is 60 seconds. 

 
      [bookmark: pgfId-1326500]Step 6[image: ] In the DHCP Relay Interface Servers area, add one or more interface-specific DHCP servers to which DHCP requests on a given interface are relayed:

 
      [bookmark: pgfId-1326501] a.[image: ] Click  Add . The Add DHCP Relay Server dialog box appears.

 
      [bookmark: pgfId-1326502] b.[image: ] From the Interface drop-down list, choose the interface connected to the DHCP clients. Note that you do not specify the egress interface for the requests, as for a Global DHCP Server; instead, the ASA uses the routing table to determine the egress interface.

 
      [bookmark: pgfId-1326506] c.[image: ] In the Server to... field, enter the IPv4 address of the DHCP server, and click  Add>> . The server is added to the right-hand list. Add up to 4 servers, if available out of the overall maximum. IPv6 is not supported for interface-specific servers.

 
      [bookmark: pgfId-1326507] d.[image: ] Click  OK .

 
      [bookmark: pgfId-1326508]The newly added interface DHCP relay server(s) appear in the DHCP Relay Interface Servers list.

 
      [bookmark: pgfId-1326510]Step 7[image: ] [bookmark: 81040]To configure all interfaces as trusted interfaces, check the  Set dhcp relay information as trusted[image: ] on all interfaces check box.You can alternatively trust individual interfaces (see Step 2[image: ]).

 
      [bookmark: pgfId-1326514]Step 8[image: ] Click  Apply to save your settings.

 
      [bookmark: pgfId-1326515]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1284158][bookmark: 39280][bookmark: 28227][bookmark: 97628]Additional References

 
     [bookmark: pgfId-1202392]For additional information related to implementing DHCPv6, see the following section:

 
     
     		 [bookmark: pgfId-1202393]RFCs

 
    

 
     
      [bookmark: pgfId-1202394][bookmark: 98540]RFCs

 
      [bookmark: pgfId-1202321] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1202310]RFC
          
  
         		
           
           [bookmark: pgfId-1202312]Title
          
  
        

 
         
         		 [bookmark: pgfId-1202446]2132

  
         		 [bookmark: pgfId-1202448]DHCP Options and BOOTP Vendor Extensions 

  
        

 
         
         		 [bookmark: pgfId-1202425]2462

  
         		 [bookmark: pgfId-1202427]IPv6 Stateless Address Autoconfiguration

  
        

 
         
         		 [bookmark: pgfId-1202318]5510

  
         		 [bookmark: pgfId-1202320]DHCP for IPv6

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1202286]Monitoring [bookmark: 72190]DHCP Services

 
     [bookmark: pgfId-1138255]To monitor DHCP, perform one or more of the following steps:

 
     [bookmark: pgfId-1135827] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1135812]Path
         
  
        		
          
          [bookmark: pgfId-1135814]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1326546] Tools > Command Line Interface 

  [bookmark: pgfId-1135818]Enter the  show running-config dhcpd command, then click  Send .

  
        		 [bookmark: pgfId-1135820]Shows the current DHCP configuration.

  
       

 
        
        		 [bookmark: pgfId-1326558] Tools > Command Line Interface 

  [bookmark: pgfId-1135824]Enter the  show running-config dhcprelay command, then click  Send .

  
        		 [bookmark: pgfId-1135826]Shows the current DHCP relay service status.

  
       

 
        
        		 [bookmark: pgfId-1330386] Tools > Command Line Interface 

  [bookmark: pgfId-1330387]Enter the  show ip address dhcp lease proxy command, then click  Send .

  
        		 [bookmark: pgfId-1330519]Shows proxy entries in the IPL table.

  
       

 
        
        		 [bookmark: pgfId-1330470] Tools > Command Line Interface 

  [bookmark: pgfId-1330460]Enter the  show ip address dhcp lease summary command, then click  Send .

  
        		 [bookmark: pgfId-1330435]Shows summary for the entry.

  
       

 
        
        		 [bookmark: pgfId-1330492] Tools > Command Line Interface 

  [bookmark: pgfId-1330482]Enter the  show ip address dhcp lease server command, then click  Send .

  
        		 [bookmark: pgfId-1330527]Shows server entries in the IPL table.

  
       

 
        
        		 [bookmark: pgfId-1326582] Tools > Command Line Interface 

  [bookmark: pgfId-1202009]Enter the  show ipv6 dhcprelay binding  command, then click  Send .

  
        		 [bookmark: pgfId-1201992]Shows the relay binding entries that were created by the relay agent. 

  
       

 
        
        		 [bookmark: pgfId-1326564] Tools > Command Line Interface 

  [bookmark: pgfId-1202017]Enter the  show ipv6 dhcprelay statistics  command, then click  Send .

  
        		 [bookmark: pgfId-1201988]Shows DHCP relay agent statistics for IPv6.

  
       

 
        
        		 [bookmark: pgfId-1326552] Tools > Command Line Interface 

  [bookmark: pgfId-1224584]Enter the  clear config ipv6 dhcprelay  command, then click  Send .

  
        		 [bookmark: pgfId-1224524]Clears the IPv6 DHCP relay configuration.

  
       

 
        
        		 [bookmark: pgfId-1140886]Monitoring > Interfaces > DHCP > DHCP Client Lease Information

  
        		 [bookmark: pgfId-1140888]Shows configured DHCP client IP addresses.

  
       

 
        
        		 [bookmark: pgfId-1140882]Monitoring > Interfaces > DHCP > DHCP Server Table

  
        		 [bookmark: pgfId-1140884]Shows configured dynamic DHCP client IP addresses.

  
       

 
        
        		 [bookmark: pgfId-1140878]Monitoring > Interfaces > DHCP > DHCP Statistics

  
        		 [bookmark: pgfId-1140880]Shows DHCP message types, counters, values, directions, messages received, and messages sent.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1217733][bookmark: 92503]Feature History for DHCP Services

 
     [bookmark: pgfId-1326531] Table 17-2  each feature change and the platform release in which it was implemented. ASDM is backward-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1135861] 

 
     
      
       
        [bookmark: pgfId-1135838]Table 17-2 [bookmark: 76860]Feature History for DHCP Services

 
       
      
        
        		
          
          [bookmark: pgfId-1135844]Feature Name
         
  
        		
          
          [bookmark: pgfId-1135846]Releases
         
  
        		
          
          [bookmark: pgfId-1135848]Description
         
  
       

 
        
        		 [bookmark: pgfId-1135850]DHCP

  
        		 [bookmark: pgfId-1135852]7.0(1)

  
        		 [bookmark: pgfId-1135854]The ASA can provide a DHCP server or DHCP relay services to DHCP clients attached to ASA interfaces. 

  [bookmark: pgfId-1326576]We introduced the following screens:

  [bookmark: pgfId-1140095]Configuration > Device Management > DHCP > DHCP Relay.
 Configuration > Device Management > DHCP > DHCP Server.
 

  
       

 
        
        		 [bookmark: pgfId-1199858]DHCP for IPv6 (DHCPv6)

  
        		 [bookmark: pgfId-1199860]9.0(1)

  
        		 [bookmark: pgfId-1199882]Support for IPv6 was added.

  [bookmark: pgfId-1224183]We modified the following screen: Configuration > Device Management > DHCP > DHCP Relay.

  
       

 
        
        		 [bookmark: pgfId-1254731]DHCP relay servers per interface (IPv4 only)

  
        		 [bookmark: pgfId-1254733]9.1(2)

  
        		 [bookmark: pgfId-1254735]You can now configure DHCP relay servers per-interface, so requests that enter a given interface are relayed only to servers specified for that interface. IPv6 is not supported for per-interface DHCP relay.

  [bookmark: pgfId-1284646]We modified the following screen: Configuration > Device Management > DHCP > DHCP Relay.

  
       

 
        
        		 [bookmark: pgfId-1330587]DHCP lease information

  
        		 [bookmark: pgfId-1330589]9.1(4)

  
        		 [bookmark: pgfId-1330591]You can now view DHCP Client Lease information

  [bookmark: pgfId-1330636]We introduced the following screen: Monitoring > Interfaces > DHCP> DHCP Lease Information.

  
       

 
        
        		 [bookmark: pgfId-1297339]DHCP trusted interfaces

  
        		 [bookmark: pgfId-1297341]9.1(2)

  
        		 [bookmark: pgfId-1314443]You can now configure interfaces as trusted interfaces to preserve DHCP Option 82. DHCP Option 82 is used by downstream switches and routers for DHCP snooping and IP Source Guard. Normally, if the ASA DHCP relay agent receives a DHCP packet with Option 82 already set, but the giaddr field (which specifies the DHCP relay agent address that is set by the relay agent before it forwards the packet to the server) is set to 0, then the ASA will drop that packet by default. You can now preserve Option 82 and forward the packet by identifying an interface as a trusted interface.

  [bookmark: pgfId-1297492]We modified the following screen: Configuration > Device Management > DHCP > DHCP Relay.

  
       

 
        
        		 [bookmark: pgfId-1321846]DHCP rebind function

  
        		 [bookmark: pgfId-1321848]9.1(4)

  
        		 [bookmark: pgfId-1321878]During the DHCP rebind phase, the client now attempts to rebind to other DHCP servers in the tunnel group list. Prior to this release, the client did not rebind to an alternate server, when the DHCP lease fails to renew.

  [bookmark: pgfId-1321850]There is no change to the ASDM.

  
       

 
        
        		 [bookmark: pgfId-1330654]DHCP lease information

  
        		 [bookmark: pgfId-1330656]9.1(4)

  
        		 [bookmark: pgfId-1330676]You can now view DHCP Client Lease information

  [bookmark: pgfId-1330728]We introduced the following screen: Monitoring > Interfaces > DHCP> DHCP Lease Information.
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     [bookmark: pgfId-1228347][bookmark: 16034]Configuring Windows NT Servers for AAA
      
      
 
     
 

 
     [bookmark: pgfId-1052815]This chapter describes how to configure Windows NT servers used in AAA and includes the following sections:

 
     
     		 [bookmark: pgfId-1052820]Information About Windows NT Servers

 
     		 [bookmark: pgfId-1052824]Licensing Requirements for Windows NT Servers

 
     		 [bookmark: pgfId-1052828]Guidelines and Limitations

 
     		 [bookmark: pgfId-1052832]Configuring Windows NT Servers

 
     		 [bookmark: pgfId-1229788]Testing Windows NT Server Authentication and Authorization

 
     		 [bookmark: pgfId-1052840]Monitoring Windows NT Servers

 
     		 [bookmark: pgfId-1052844]Feature History for Windows NT Servers

 
    

 
   
 
    
     [bookmark: pgfId-1052852][bookmark: 17790]Information About Windows NT[bookmark: marker-1052851] Servers

 
     [bookmark: pgfId-1053399]The ASA supports Microsoft Windows server operating systems that support NTLM Version 1, collectively referred to as NT servers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1053400]Note Windows NT servers have a maximum length of 14 characters for user passwords. Longer passwords are truncated, which is a limitation of NTLM Version 1.


     
     
 
    

    

 
   
 
    
     [bookmark: pgfId-1053614][bookmark: 38121][bookmark: 77027]Licensing Requirements for Windows NT Servers

 
     [bookmark: pgfId-1234236] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1234229]Model
         
  
        		
          
          [bookmark: pgfId-1234231]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1234233]All models

  
        		 [bookmark: pgfId-1234235]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1053631][bookmark: 54199]Guidelines and Limitations

 
     [bookmark: pgfId-1053632]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1053633]Context Mode Guidelines

 
     [bookmark: pgfId-1053634]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1053635]Firewall Mode Guidelines

 
     [bookmark: pgfId-1053636]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1053637]IPv6 Guidelines

 
     [bookmark: pgfId-1053638]Supports IPv6.

 
     [bookmark: pgfId-1219310]Additional Guidelines

 
     
     		 [bookmark: pgfId-1219311]You can have up to 100 server groups in single mode or 4 server groups per context in multiple mode.

 
     		 [bookmark: pgfId-1219312]Each group can have up to 16 servers in single mode or 4 servers in multiple mode.

 
     		 [bookmark: pgfId-1219315]If you need to configure fallback support using the local database, see the “Fallback Support” and the “How Fallback Works with Multiple Servers in a Group”.

 
    

 
   
 
    
     [bookmark: pgfId-1072335][bookmark: 85665]Configuring Windows NT Servers 

 
     [bookmark: pgfId-1053641]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1217674]Configuring Windows NT Server Groups

 
     		 [bookmark: pgfId-1217678]Adding a Windows NT Server to a Group

 
    

 
     
      [bookmark: pgfId-1217680][bookmark: 88772]Task Flow for Configuring Windows NT Servers

 
     
 
      [bookmark: pgfId-1053677] Step 1[image: ] [bookmark: 24815]Add a AAA server group. See the “Configuring Windows NT Server Groups” section.

 
      [bookmark: pgfId-1210013]Step 2[image: ] For a server group, add a server to the group. See the “Adding a Windows NT Server to a Group” section.

 
      [bookmark: pgfId-1053711]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1053730][bookmark: 23262]Configuring Windows NT Server Groups[bookmark: marker-1053713][bookmark: marker-1053714][bookmark: marker-1053715][bookmark: marker-1053716][bookmark: marker-1053717][bookmark: marker-1053718][bookmark: marker-1053719][bookmark: marker-1053720][bookmark: marker-1053721][bookmark: marker-1053722][bookmark: marker-1053723][bookmark: marker-1053724][bookmark: marker-1053725][bookmark: marker-1053726] 

 
      [bookmark: pgfId-1053731]If you want to use a Windows NT server for authentication, authorization, or accounting, you must first create at least one Windows NT server group and add one or more servers to each group. You identify Windows NT server groups by name.

 
      [bookmark: pgfId-1219215]To add a Windows NT server group, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1053742]Detailed Steps

 
     
 
      [bookmark: pgfId-1229793] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups .

 
      [bookmark: pgfId-1229794]Step 2[image: ] In the AAA Server Groups area, click  Add .

 
      [bookmark: pgfId-1229795]The Add AAA Server Group dialog box appears.

 
      [bookmark: pgfId-1229796]Step 3[image: ] In the Server Group field, enter a name for the group.

 
      [bookmark: pgfId-1229797]Step 4[image: ] From the Protocol drop-down list, choose the NT Domain server type.

 
      [bookmark: pgfId-1229798]Step 5[image: ] In the Reactivation Mode field, click  Depletion or  Timed .

 
      [bookmark: pgfId-1229799]In Depletion mode, failed servers are reactivated only after all of the servers in the group are inactive.

 
      [bookmark: pgfId-1229800]In Timed mode, failed servers are reactivated after 30 seconds of down time.

 
      [bookmark: pgfId-1229801]Step 6[image: ] If you chose the Depletion reactivation mode, enter a time interval in the Dead Time field.

 
      [bookmark: pgfId-1229802]The Dead Time is the duration of time, in minutes, that elapses between the disabling of the last server in a group and the subsequent re-enabling of all servers.

 
      [bookmark: pgfId-1229803]Step 7[image: ] In the Max Failed Attempts field, add the number of failed attempts allowed.

 
      [bookmark: pgfId-1229804]This option sets the number of failed connection attempts allowed before declaring a nonresponsive server to be inactive.

 
      [bookmark: pgfId-1229805]Step 8[image: ] Click  OK .

 
      [bookmark: pgfId-1229806]The Add AAA Server Group dialog box closes, and the new server group is added to the AAA Server Groups table.

 
      [bookmark: pgfId-1229807]Step 9[image: ] In the AAA Server Groups dialog box, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1229808]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1210083][bookmark: 44488]Adding a Windows NT Server to a Group [bookmark: marker-1210081] 

 
      [bookmark: pgfId-1210084]To add a Windows NT server to a group, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1218420]Detailed Steps

 
     
 
      [bookmark: pgfId-1229813] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups , and in the AAA Server Groups area, click the server group to which you want to add a server.

 
      [bookmark: pgfId-1229814]The row is highlighted in the table.

 
      [bookmark: pgfId-1229815]Step 2[image: ] In the Servers in the Selected Group area (lower pane), click  Add .

 
      [bookmark: pgfId-1229816]The Add AAA Server Group dialog box appears for the server group.

 
      [bookmark: pgfId-1229817]Step 3[image: ] From the  Interface Name drop-down list, choose the interface name on which the authentication server resides.

 
      [bookmark: pgfId-1229818]Step 4[image: ] In the Server Name or IP Address field, add either a server name or IP address for the server that you are adding to the group.

 
      [bookmark: pgfId-1229819]Step 5[image: ] In the Timeout field, either add a timeout value or keep the default. The timeout is the duration of time, in seconds, that the ASA waits for a response from the primary server before sending the request to the backup server.

 
      [bookmark: pgfId-1229823]Step 6[image: ] Specify the server port. The server port is either port number 139, or the TCP port number used by the ASA to communicate with the Windows NT server. 

 
      [bookmark: pgfId-1229827]Step 7[image: ] Specify the name of the domain controller. The domain controller is the hostname (no more than 15 characters) of the NT Primary Domain Controller for this server (for example, PDC01). You must enter a name, and it must be the correct hostname for the server whose IP address you added in the Authentication Server Address field. If the name is incorrect, authentication fails.

 
      [bookmark: pgfId-1229828]Step 8[image: ] Click  OK .

 
      [bookmark: pgfId-1229829]The Add AAA Server Group dialog box closes, and the AAA server is added to the AAA server group.

 
      [bookmark: pgfId-1229830]Step 9[image: ] In the AAA Server Groups pane, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1229831]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1229839][bookmark: 97003][bookmark: 89869][bookmark: 93308]Testing Windows NT Server Authentication and Authorization

 
     [bookmark: pgfId-1229843]To determine whether the ASA can contact a Windows NT server and authenticate or authorize a user, perform the following steps:

 
    
 
     [bookmark: pgfId-1229844] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups , and in the AAA Server Groups area, click the server group in which the server resides.

 
     [bookmark: pgfId-1229845]The row is highlighted in the table.

 
     [bookmark: pgfId-1229846]Step 2[image: ] From the Servers in the Selected Group table, click the server that you want to test.

 
     [bookmark: pgfId-1229847]The row is highlighted in the table.

 
     [bookmark: pgfId-1229848]Step 3[image: ] Click  Test .

 
     [bookmark: pgfId-1229849]The Test AAA Server dialog box appears for the selected server.

 
     [bookmark: pgfId-1229850]Step 4[image: ] Click the type of test that you want to perform— Authentication or  Authorization . 

 
     [bookmark: pgfId-1229851]Step 5[image: ] In the Username field, enter a username.

 
     [bookmark: pgfId-1229852]Step 6[image: ] If you are testing authentication, in the Password field, enter the password for the username.

 
     [bookmark: pgfId-1229853]Step 7[image: ] Click  OK .

 
     [bookmark: pgfId-1229860]The ASA sends an authentication or authorization test message to the server. If the test fails, ASDM displays an error message.

 
     [bookmark: pgfId-1229861]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1055556][bookmark: 39586]Monitoring Windows NT Servers

 
     [bookmark: pgfId-1055557]To monitor Windows NT servers, see the following panes:

 
     [bookmark: pgfId-1055592] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1055560]Path
         
  
        		
          
          [bookmark: pgfId-1055562]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1055565]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055567]Shows the configured Windows NT server statistics.

  
       

 
        
        		 [bookmark: pgfId-1055571]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055573]Shows the Windows NT server running configuration.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1055623][bookmark: 89792][bookmark: 21826]Feature History for Windows NT Servers

 
     [bookmark: pgfId-1055627] Table 37-1  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1055667] 

 
     
      
       
        [bookmark: pgfId-1055631]Table 37-1 [bookmark: 67500]Feature History for Windows NT Servers

 
       
      
        
        		
          
          [bookmark: pgfId-1055637]Feature Name
         
  
        		
          
          [bookmark: pgfId-1055639]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1055641]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1055643]Windows NT Servers for AAA

  
        		 [bookmark: pgfId-1055645]7.0(1)

  
        		 [bookmark: pgfId-1055647]Describes support for Windows NT Servers and how to configure them for AAA.

  [bookmark: pgfId-1229891]We introduced the following screen:

  [bookmark: pgfId-1055651]Configuration > Device Management > Users/AAA > AAA Server Groups.

  
       

 
      
     

 
    
 
   
 
  

 
  
   
 

OPS/admin_swconfig-26.jpg





OPS/aaa_ldap-4.jpg
Enterprise LDAP Hisrarohy

[ ———— Roouop

Fon ] [ T ——
 E———

oy [ ] e

Lo I

et e on-serd on-tsord Users





OPS/aaa_tacacs.html
  
   
    
     [bookmark: pgfId-1052814][bookmark: 16034]Configuring TACACS+ Servers for AAA
      
      
 
     
 

 
     [bookmark: pgfId-1052815]This chapter describes how to configure TACACS+ servers used in AAA and includes the following sections: 

 
     
     		 [bookmark: pgfId-1052820]Information About TACACS+ Servers

 
     		 [bookmark: pgfId-1052824]Licensing Requirements for TACACS+ Servers

 
     		 [bookmark: pgfId-1052828]Guidelines and Limitations

 
     		 [bookmark: pgfId-1052832]Configuring TACACS+ Servers

 
     		 [bookmark: pgfId-1232532]Testing TACACS+ Server Authentication and Authorization

 
     		 [bookmark: pgfId-1052840]Monitoring TACACS+ Servers

 
     		 [bookmark: pgfId-1217783]Feature History for TACACS+ Servers

 
    

 
   
 
    
     [bookmark: pgfId-1217786][bookmark: 17790]Information About TACACS+ Servers[bookmark: marker-1217785]

 
     [bookmark: pgfId-1217790]The ASA supports TACACS+ server authentication with the following protocols: ASCII, PAP, CHAP, and MS-CHAPv1.

 
     
      [bookmark: pgfId-1220208]Using TACACS+ Attributes

 
      [bookmark: pgfId-1220213]The ASA [bookmark: marker-1220212]provides support for TACACS+ attributes. TACACS+ attributes separate the functions of authentication, authorization, and accounting. The protocol supports two types of attributes: mandatory and optional. Both the server and client must understand a mandatory attribute, and the mandatory attribute must be applied to the user. An optional attribute may or may not be understood or used. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1220214]Note To use TACACS+ attributes, make sure that you have enabled AAA services on the NAS.


      
      
 
     

     

 
      [bookmark: pgfId-1220218] Table 35-1  lists supported TACACS+ authorization response attributes for cut-through-proxy connections.  Table 35-2  lists supported TACACS+ accounting attributes.

 
      [bookmark: pgfId-1220247] 

 
      
       
        
         [bookmark: pgfId-1220228]Table 35-1 [bookmark: 21634]Supported TACACS+ Authorization Response Attributes 

 
        
       
         
         		
           
           [bookmark: pgfId-1220232] Attribute
          
  
         		
           
           [bookmark: pgfId-1220234]Description
          
  
        

 
         
         		 [bookmark: pgfId-1220236]acl

  
         		 [bookmark: pgfId-1220238]Identifies a locally configured ACL to be applied to the connection.

  
        

 
         
         		 [bookmark: pgfId-1220240]idletime

  
         		 [bookmark: pgfId-1220242]Indicates the amount of inactivity in minutes that is allowed before the authenticated user session is terminated.

  
        

 
         
         		 [bookmark: pgfId-1220244]timeout

  
         		 [bookmark: pgfId-1220246]Specifies the absolute amount of time in minutes that authentication credentials remain active before the authenticated user session is terminated. 

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1220321].

 
      
       
        
         [bookmark: pgfId-1220254]Table 35-2 [bookmark: 11566]Supported TACACS+ Accounting Attributes 

 
        
       
         
         		
           
           [bookmark: pgfId-1220258]Attribute
          
  
         		
           
           [bookmark: pgfId-1220260]Description
          
  
        

 
         
         		 [bookmark: pgfId-1220262]bytes_in

  
         		 [bookmark: pgfId-1220264]Specifies the number of input bytes transferred during this connection (stop records only).

  
        

 
         
         		 [bookmark: pgfId-1220266]bytes_out

  
         		 [bookmark: pgfId-1220268]Specifies the number of output bytes transferred during this connection (stop records only).

  
        

 
         
         		 [bookmark: pgfId-1220270]cmd

  
         		 [bookmark: pgfId-1220272]Defines the command executed (command accounting only).

  
        

 
         
         		 [bookmark: pgfId-1220274]disc-cause

  
         		 [bookmark: pgfId-1220276]Indicates the numeric code that identifies the reason for disconnecting (stop records only).

  
        

 
         
         		 [bookmark: pgfId-1220278]elapsed_time

  
         		 [bookmark: pgfId-1220280]Defines the elapsed time in seconds for the connection (stop records only). 

  
        

 
         
         		 [bookmark: pgfId-1220282]foreign_ip

  
         		 [bookmark: pgfId-1220284]Specifies the IP address of the client for tunnel connections. Defines the address on the lowest security interface for cut-through-proxy connections.

  
        

 
         
         		 [bookmark: pgfId-1220286]local_ip

  
         		 [bookmark: pgfId-1220288]Specifies the IP address that the client connected to for tunnel connections. Defines the address on the highest security interface for cut-through-proxy connections.

  
        

 
         
         		 [bookmark: pgfId-1220290]NAS port

  
         		 [bookmark: pgfId-1220292]Contains a session ID for the connection.

  
        

 
         
         		 [bookmark: pgfId-1220294]packs_in

  
         		 [bookmark: pgfId-1220296]Specifies the number of input packets transferred during this connection.

  
        

 
         
         		 [bookmark: pgfId-1220298]packs_out

  
         		 [bookmark: pgfId-1220300]Specifies the number of output packets transferred during this connection.

  
        

 
         
         		 [bookmark: pgfId-1220302]priv-level

  
         		 [bookmark: pgfId-1220304]Set to the user privilege level for command accounting requests or to 1 otherwise.

  
        

 
         
         		 [bookmark: pgfId-1220306]rem_iddr

  
         		 [bookmark: pgfId-1220308]Indicates the IP address of the client.

  
        

 
         
         		 [bookmark: pgfId-1220310]service

  
         		 [bookmark: pgfId-1220312]Specifies the service used. Always set to “shell” for command accounting only.

  
        

 
         
         		 [bookmark: pgfId-1220314]task_id

  
         		 [bookmark: pgfId-1220316]Specifies a unique task ID for the accounting transaction.

  
        

 
         
         		 [bookmark: pgfId-1220318]username

  
         		 [bookmark: pgfId-1220320]Indicates the name of the user.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1053614][bookmark: 40794][bookmark: 77027]Licensing Requirements for TACACS+ Servers

 
     [bookmark: pgfId-1236892] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1236885]Model
         
  
        		
          
          [bookmark: pgfId-1236887]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1236889]All models

  
        		 [bookmark: pgfId-1236891]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1053631][bookmark: 54199]Guidelines and Limitations

 
     [bookmark: pgfId-1053632]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1053633]Context Mode Guidelines

 
     [bookmark: pgfId-1053634]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1053635]Firewall Mode Guidelines

 
     [bookmark: pgfId-1053636]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1053637]IPv6 Guidelines

 
     [bookmark: pgfId-1053638]Supports IPv6.

 
     [bookmark: pgfId-1219824]Additional Guidelines

 
     
     		 [bookmark: pgfId-1219825]You can have up to 100 server groups in single mode or 4 server groups per context in multiple mode.

 
     		 [bookmark: pgfId-1219826]Each group can have up to 16 servers in single mode or 4 servers in multiple mode.

 
     		 [bookmark: pgfId-1219829]If you need to configure fallback support using the local database, see the “Fallback Support” and the “How Fallback Works with Multiple Servers in a Group”.

 
     		 [bookmark: pgfId-1219992]To prevent lockout from the ASA when using TACACS+ authentication or authorization, see the “Recovering from a Lockout”.

 
    

 
   
 
    
     [bookmark: pgfId-1219194][bookmark: 85665]Configuring TACACS+ Servers

 
     [bookmark: pgfId-1219195]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1219199]Task Flow for Configuring TACACS+ Servers

 
     		 [bookmark: pgfId-1219222]Configuring TACACS+ Server Groups

 
     		 [bookmark: pgfId-1209994]Adding a TACACS+ Server to a Group

 
     		 [bookmark: pgfId-1232540]Adding an Authentication Prompt

 
    

 
     
      [bookmark: pgfId-1053675][bookmark: 88772]Task Flow for Configuring TACACS+ Servers

 
     
 
      [bookmark: pgfId-1053677] Step 1[image: ] Add a TACACS+ server group. See the “Configuring TACACS+ Server Groups” section.

 
      [bookmark: pgfId-1210013]Step 2[image: ] For a server group, add a server to the group. See the “Adding a TACACS+ Server to a Group” section.

 
      [bookmark: pgfId-1232545]Step 3[image: ] (Optional) Specify text to display to the user during the AAA authentication challenge process. See the “Adding an Authentication Prompt” section.

 
      [bookmark: pgfId-1053711]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1053730][bookmark: 23262]Configuring TACACS+ Server Groups

 
      [bookmark: pgfId-1053731]If you want to use a TACACS+ server for authentication, authorization, or accounting, you must first create at least one TACACS+ server group and add one or more servers to each group. You identify TACACS+ server groups by name. 

 
      [bookmark: pgfId-1219943]To add a TACACS+ server group, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1053742]Detailed Steps

 
     
 
      [bookmark: pgfId-1232553] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups .

 
      [bookmark: pgfId-1232554]Step 2[image: ] In the AAA Server Groups area, click  Add .

 
      [bookmark: pgfId-1232555]The Add AAA Server Group dialog box appears.

 
      [bookmark: pgfId-1232556]Step 3[image: ] In the Server Group field, enter a name for the group.

 
      [bookmark: pgfId-1232557]Step 4[image: ] From the Protocol drop-down list, choose the TACACS+ server type:

 
      [bookmark: pgfId-1232558]Step 5[image: ] In the Accounting Mode field, click  Simultaneous or  Single .

 
      [bookmark: pgfId-1232562]In Single mode, the ASA sends accounting data to only one server. 

 
      [bookmark: pgfId-1232566]In Simultaneous mode, the ASA sends accounting data to all servers in the group.

 
      [bookmark: pgfId-1232567]Step 6[image: ] In the Reactivation Mode field, click  Depletion or  Timed .

 
      [bookmark: pgfId-1232568]In Depletion mode, failed servers are reactivated only after all of the servers in the group are inactive.

 
      [bookmark: pgfId-1232569]In Timed mode, failed servers are reactivated after 30 seconds of down time.

 
      [bookmark: pgfId-1232570]Step 7[image: ] If you chose the Depletion reactivation mode, enter a time interval in the Dead Time field.

 
      [bookmark: pgfId-1232571]The Dead Time is the duration of time, in minutes, that elapses between the disabling of the last server in a group and the subsequent re-enabling of all servers.

 
      [bookmark: pgfId-1232572]Step 8[image: ] In the Max Failed Attempts field, add the number of failed attempts allowed.

 
      [bookmark: pgfId-1232573]This option sets the number of failed connection attempts allowed before declaring a nonresponsive server to be inactive.

 
      [bookmark: pgfId-1232574]Step 9[image: ] Click  OK .

 
      [bookmark: pgfId-1232575]The Add AAA Server Group dialog box closes, and the new server group is added to the AAA Server Groups table.

 
      [bookmark: pgfId-1232576]Step 10[image: ] In the AAA Server Groups dialog box, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1232577]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1213986][bookmark: 44488][bookmark: 95778]Adding a TACACS+ Server to a Group

 
      [bookmark: pgfId-1210084]To add a TACACS+ server to a group, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1217859]Detailed Steps

 
      [bookmark: pgfId-1217918] 

 
     
 
      [bookmark: pgfId-1232588] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups , and in the AAA Server Groups area, click the server group to which you want to add a server.

 
      [bookmark: pgfId-1232589]The row is highlighted in the table.

 
      [bookmark: pgfId-1232590]Step 2[image: ] In the Servers in the Selected Group area (lower pane), click  Add .

 
      [bookmark: pgfId-1232591]The Add AAA Server Group dialog box appears for the server group.

 
      [bookmark: pgfId-1232592]Step 3[image: ] From the  Interface Name drop-down list, choose the interface name on which the authentication server resides.

 
      [bookmark: pgfId-1232593]Step 4[image: ] In the Server Name or IP Address field, add either a server name or IP address for the server that you are adding to the group.

 
      [bookmark: pgfId-1232594]Step 5[image: ] In the Timeout field, either add a timeout value or keep the default. The timeout is the duration of time, in seconds, that the ASA waits for a response from the primary server before sending the request to the backup server.

 
      [bookmark: pgfId-1232598]Step 6[image: ] Specify the server port. The server port is either port number 139, or the TCP port number used by the ASA to communicate with the TACACS+ server. 

 
      [bookmark: pgfId-1232602]Step 7[image: ] Specify the server secret key. The shared secret key used to authenticate the TACACS+ server to the ASA. The server secret that you configure here should match the one that is configured on the TACACS+ server. If you do not know the server secret, ask the TACACS+ server administrator. The maximum field length is 64 characters.

 
      [bookmark: pgfId-1232606]Step 8[image: ] Click  OK .

 
      [bookmark: pgfId-1232607]The Add AAA Server Group dialog box closes, and the AAA server is added to the AAA server group.

 
      [bookmark: pgfId-1232608]Step 9[image: ] In the AAA Server Groups pane, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1232609]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1232616][bookmark: 18700][bookmark: 14300]Adding an Authentication Prompt

 
      [bookmark: pgfId-1232617]You can specify text to display to the user during the AAA authentication challenge process. You can specify the AAA challenge text for HTTP, FTP, and Telnet access through the ASA when requiring user authentication from TACACS+ servers. This text is primarily for cosmetic purposes and appears above the username and password prompts that users see when they log in.

 
      [bookmark: pgfId-1232621]If you do not specify an authentication prompt, users see the following when authenticating with a TACACS+ server:

 
      [bookmark: pgfId-1232639] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1232624]Connection Type
          
  
         		
           
           [bookmark: pgfId-1232626]Default Prompt
          
  
        

 
         
         		 [bookmark: pgfId-1232628]FTP

  
         		 [bookmark: pgfId-1232630]FTP authentication

  
        

 
         
         		 [bookmark: pgfId-1232632]HTTP

  
         		 [bookmark: pgfId-1232634]HTTP authentication

  
        

 
         
         		 [bookmark: pgfId-1232636]Telnet

  
         		 [bookmark: pgfId-1232638]None

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1232640]To add an authentication prompt, perform the following steps:

 
     
 
      [bookmark: pgfId-1232641] Step 1[image: ] Choose  Configuration > Device Management > Users/AAA > Authentication Prompt. 

 
      [bookmark: pgfId-1232642]Step 2[image: ] Enter text in the Prompt field to add as a message to appear above the username and password prompts that users see when they log in.

 
      [bookmark: pgfId-1232643]The following table shows the allowed character limits for authentication prompts:

 
      [bookmark: pgfId-1232661] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1232646]Application
          
  
         		
           
           [bookmark: pgfId-1232648]Character Limit for Authentication Prompt
          
  
        

 
         
         		 [bookmark: pgfId-1232650]Microsoft Internet Explorer

  
         		 [bookmark: pgfId-1232652]37

  
        

 
         
         		 [bookmark: pgfId-1232654]Telnet

  
         		 [bookmark: pgfId-1232656]235

  
        

 
         
         		 [bookmark: pgfId-1232658]FTP

  
         		 [bookmark: pgfId-1232660]235

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1232662]Step 3[image: ] In the Messages area, add messages in the User accepted message and User rejected message fields.

 
      [bookmark: pgfId-1232663]If the user authentication occurs from Telnet, you can use the User accepted message and User rejected message options to display different status prompts to indicate that the authentication attempt is accepted or rejected by the AAA server.

 
      [bookmark: pgfId-1232667]If the AAA server authenticates the user, the ASA displays the User accepted message text, if specified, to the user; otherwise, the ASA displays the User rejected message text, if specified. Authentication of HTTP and FTP sessions displays only the challenge text at the prompt. The User accepted message and User rejected message text are not displayed.

 
      [bookmark: pgfId-1232671]Step 4[image: ] Click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1232672]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1232678][bookmark: 93308]Testing TACACS+ Server Authentication and Authorization

 
     [bookmark: pgfId-1232682]To determine whether the ASA can contact a TACACS+ server and authenticate or authorize a user, perform the following steps:

 
    
 
     [bookmark: pgfId-1232683] Step 1[image: ] From the Configuration > Device Management > Users/AAA > AAA Server Groups > AAA Server Groups table, click the server group in which the server resides.

 
     [bookmark: pgfId-1232684]The row is highlighted in the table.

 
     [bookmark: pgfId-1232685]Step 2[image: ] From the Servers in the Selected Group table, click the server that you want to test.

 
     [bookmark: pgfId-1232686]The row is highlighted in the table.

 
     [bookmark: pgfId-1232687]Step 3[image: ] Click  Test .

 
     [bookmark: pgfId-1232688]The Test AAA Server dialog box appears for the selected server.

 
     [bookmark: pgfId-1232689]Step 4[image: ] Click the type of test that you want to perform— Authentication or  Authorization . 

 
     [bookmark: pgfId-1232690]Step 5[image: ] In the Username field, enter a username.

 
     [bookmark: pgfId-1232691]Step 6[image: ] If you are testing authentication, in the Password field, enter the password for the username.

 
     [bookmark: pgfId-1232692]Step 7[image: ] Click  OK .

 
     [bookmark: pgfId-1232699]The ASA sends an authentication or authorization test message to the server. If the test fails, ASDM displays an error message.

 
     [bookmark: pgfId-1232700]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1055556][bookmark: 39586]Monitoring TACACS+ Servers

 
     [bookmark: pgfId-1055557]To monitor TACACS+ servers, see the following panes:

 
     [bookmark: pgfId-1055592] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1055560]Path
         
  
        		
          
          [bookmark: pgfId-1055562]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1055565]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055567]Shows the configured TACACS+ server statistics.

  
       

 
        
        		 [bookmark: pgfId-1055571]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055573]Shows the TACACS+ server running configuration.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1055623][bookmark: 89792][bookmark: 21826]Feature History for TACACS+ Servers

 
     [bookmark: pgfId-1055627] Table 35-3  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1055667] 

 
     
      
       
        [bookmark: pgfId-1055631]Table 35-3 [bookmark: 67500]Feature History for TACACS+ Servers

 
       
      
        
        		
          
          [bookmark: pgfId-1055637]Feature Name
         
  
        		
          
          [bookmark: pgfId-1055639]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1055641]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1055643]TACACS+ Servers

  
        		 [bookmark: pgfId-1055645]7.0(1)

  
        		 [bookmark: pgfId-1055647]Describes how to configure TACACS+ servers for AAA.

  [bookmark: pgfId-1232730], We introduced the following screens:

  [bookmark: pgfId-1055651]Configuration > Device Management > Users/AAA > AAA Server Groups
 Configuration > Device Management > Users/AAA > Authentication Prompt.
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     [bookmark: pgfId-1214024][bookmark: 16034]Configuring LDAP Servers for AAA
      
      
 
     
 

 
     [bookmark: pgfId-1215668]This chapter describes how to configure LDAP servers used in AAA and includes the following sections:

 
     
     		 [bookmark: pgfId-1215672]Information About LDAP and the ASA

 
     		 [bookmark: pgfId-1215687]Licensing Requirements for LDAP Servers

 
     		 [bookmark: pgfId-1215676]Guidelines and Limitations

 
     		 [bookmark: pgfId-1052832]Configuring LDAP Servers

 
     		 [bookmark: pgfId-1265709]Testing LDAP Server Authentication and Authorization

 
     		 [bookmark: pgfId-1052840]Monitoring LDAP Servers

 
     		 [bookmark: pgfId-1215592]Feature History for LDAP Servers

 
    

 
   
 
    
     [bookmark: pgfId-1215501][bookmark: 17790][bookmark: 77317][bookmark: 88106]Information About LDAP and the ASA

 
     [bookmark: pgfId-1215505]The ASA is compatible with the most LDAPv3 directory servers, including:

 
     
     		 [bookmark: pgfId-1234336]Sun Microsystems JAVA System Directory Server, now part of Oracle Directory Server Enterprise Edition, and formerly named the Sun ONE Directory Server

 
     		 [bookmark: pgfId-1234337]Microsoft Active Directory

 
     		 [bookmark: pgfId-1234338]Novell

 
     		 [bookmark: pgfId-1234381]OpenLDAP

 
    

 
     [bookmark: pgfId-1053482]By default, the ASA autodetects whether it is connected to Microsoft Active Directory, Sun LDAP, Novell, OpenLDAP, or a generic LDAPv3 directory server. However, if autodetection fails to determine the LDAP server type, you can manually configure it.

 
     
      [bookmark: pgfId-1233587]LDAP Server Guidelines

 
      [bookmark: pgfId-1231662]When configuring the LDAP server, note the following guidelines:

 
      
      		 [bookmark: pgfId-1053487]The DN configured on the ASA to access a Sun directory server must be able to access the default password policy on that server. We recommend using the directory administrator, or a user with directory administrator privileges, as the DN. Alternatively, you can place an ACL on the default password policy.

 
      		 [bookmark: pgfId-1053488]You must configure LDAP over SSL to enable password management with Microsoft Active Directory and Sun servers.

 
      		 [bookmark: pgfId-1053492]The ASA does not support password management with Novell, OpenLDAP, and other LDAPv3 directory servers.

 
      		 [bookmark: pgfId-1237568]The VPN 3000 concentrator and the ASA/PIX 7.0 software required a Cisco LDAP schema for authorization operations. Beginning with Version 7.1.x, the ASA performs authentication and authorization using the native LDAP schema, and the Cisco schema is no longer needed. 

 
     

 
    
 
     
      [bookmark: pgfId-1215858][bookmark: 73341]How Authentication Works with LDAP

 
      [bookmark: pgfId-1215862]During authentication, the ASA acts as a client proxy to the LDAP server for the user, and authenticates to the LDAP server in either plain text or by using the SASL protocol. By default, the ASA passes authentication parameters, usually a username and password, to the LDAP server in plain text.

 
      [bookmark: pgfId-1215870]The ASA supports the following SA[bookmark: marker-1215869]SL mechanisms, listed in order of increasing strength:

 
      
      		 [bookmark: pgfId-1215874]Digest-MD5—The ASA responds to the LDAP server with an MD5 value computed from the username and password.

 
      		 [bookmark: pgfId-1215878]Kerberos—The ASA responds to the LDAP server by sending the username and realm using the GSSAPI Kerberos mechanism.

 
     

 
      [bookmark: pgfId-1215882]The ASA and LDAP server supports any combination of these SASL mechanisms. If you configure multiple mechanisms, the ASA retrieves the list of SASL mechanisms that are configured on the server, and sets the authentication mechanism to the strongest one configured on both the ASA and the server. For example, if both the LDAP server and the ASA support both mechanisms, the ASA selects Kerberos, the stronger of the two.

 
      [bookmark: pgfId-1235861]When user LDAP authentication has succeeded, the LDAP server returns the attributes for the authenticated user. For VPN authentication, these attributes generally include authorization data that is applied to the VPN session. In this case, using LDAP accomplishes authentication and authorization in a single step.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1236204]Note For more information about the LDAP protocol, see RFCs 1777, 2251, and 2849.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1236209][bookmark: 90217]About the LDAP Hierarchy

 
      [bookmark: pgfId-1236219]Your LDAP configuration should reflect the logical hierarchy of your organization. For example, suppose an employee at your company, Example Corporation, is named Employee1. Employee1 works in the Engineering group. Your LDAP hierarchy could have one or many levels. You might decide to set up a single-level hierarchy in which Employee1 is considered a member of Example Corporation. Or you could set up a multi-level hierarchy in which Employee1 is considered to be a member of the department Engineering, which is a member of an organizational unit called People, which is itself a member of Example Corporation. See Figure 36-1 for an example of a multi-level hierarchy.

 
      [bookmark: pgfId-1236224]A multi-level hi[bookmark: marker-1236223]erarchy has more detail, but searches return results more quickly in a single-level hierarchy.

 
      [bookmark: pgfId-1236226]Figure 36-1 [bookmark: 52815]A Multi-Level LDAP Hierarchy

 
      [bookmark: pgfId-1236230] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1236232][bookmark: 3H_Head3 Searching the Hierarchy]Searching the LDAP Hierarchy 

 
      [bookmark: pgfId-1236236]The ASA lets you tailor the search within the LDAP hierarchy. You configure the following three fields on the ASA to [bookmark: marker-1236240]define where in the LDAP hierarchy that your search begins, the extent, and the type of information you are looking for. Together, these fields limit the search of the hierarchy to only the part that includes the user permissions.

 
      
      		 [bookmark: pgfId-1236241]LDAP Base DN defines where in the LDAP hierarchy that the server should begin searching for user information when it receives an authorization request from the ASA.

 
      		 [bookmark: pgfId-1236245]Search Scope defines the extent of the search in the LDAP hierarchy. The search proceeds this many levels in the hierarchy below the LDAP Base DN. You can choose to have the server search only the level immediately below it, or it can search the entire subtree. A single level search is quicker, but a subtree search is more extensive.

 
      		 [bookmark: pgfId-1236246]Naming Attribute(s) defines the RDN that uniquely identifies an entry in the LDAP server. Common naming attributes can include cn (Common Name), sAMAccountName, and userPrincipalName.

 
     

 
      [bookmark: pgfId-1236250]Figure 36-1 shows a sample LDAP hierarchy for Example Corporation. Given this hierarchy, you could define your search in different ways.  Table 36-1  shows two sample search configurations. 

 
      [bookmark: pgfId-1236254]In the first example configuration, when Employee1 establishes the IPsec tunnel with LDAP authorization required, the ASA sends a search request to the LDAP server, indicating it should search for Employee1 in the Engineering group. This search is quick. 

 
      [bookmark: pgfId-1236261]In the second example configuration, the ASA sends a search request indicating that the server should search for Employee1 within Example Corporation. This search takes longer.

 
      [bookmark: pgfId-1236304] 

 
      
       
        
         [bookmark: pgfId-1236265]Table 36-1 [bookmark: 76911]Example Search Configurations

 
        
       
         
         		
           
           [bookmark: pgfId-1236275]No.
          
  
         		
           
           [bookmark: pgfId-1236277]LDAP Base DN
          
  
         		
           
           [bookmark: pgfId-1236279]Search Scope
          
  
         		
           
           [bookmark: pgfId-1236281]Naming Attribute
          
  
         		
           
           [bookmark: pgfId-1236283]Result
          
  
        

 
         
         		 [bookmark: pgfId-1236285]1

  
         		 [bookmark: pgfId-1236287]group= Engineering,ou=People,dc=ExampleCorporation, dc=com

  
         		 [bookmark: pgfId-1236289]One Level

  
         		 [bookmark: pgfId-1236291]cn=Employee1

  
         		 [bookmark: pgfId-1236293]Quicker search

  
        

 
         
         		 [bookmark: pgfId-1236295]2

  
         		 [bookmark: pgfId-1236297]dc=ExampleCorporation,dc=com

  
         		 [bookmark: pgfId-1236299]Subtree

  
         		 [bookmark: pgfId-1236301]cn=Employee1

  
         		 [bookmark: pgfId-1236303]Longer search

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-1237383]About Binding to an LDAP Server

 
      [bookmark: pgfId-1237387]The ASA uses the login DN and login password to establish trust (bind) with an LDAP server. When performing a Microsoft Active Directory read-only operation (such as authentication, authorization, or group search), the ASA can bind using a login DN with fewer privileges. For example, the login DN can be a user whose AD “Member Of” designation is part of Domain Users. For VPN password management operations, the login DN needs elevated privileges, and must be part of the Account Operators AD group.

 
      [bookmark: pgfId-1237395]The following is an example of a login DN:

 
     
      [bookmark: pgfId-1237396]cn=Binduser1,ou=Admins,ou=Users,dc=company_A,dc=com
     

     
      [bookmark: pgfId-1237397] 
     

      [bookmark: pgfId-1237401]The ASA supports the following authentication methods:

 
      
      		 [bookmark: pgfId-1237402]Simple LDAP authentication with an unencrypted password on port 389

 
      		 [bookmark: pgfId-1237403]Secure LDAP (LDAP-S) on port 636

 
      		 [bookmark: pgfId-1237404]Simple Authentication and Security Layer (SASL) MD5

 
      		 [bookmark: pgfId-1237405]SASL Kerberos

 
     

 
      [bookmark: pgfId-1237409]The ASA does not support anonymous authentication. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1237413]Note As an LDAP client, the ASA does not support the transmission of anonymous binds or requests.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1235867][bookmark: 3H_Head3 Binding the Security Appliance to the LDAP Server][bookmark: 28695][bookmark: 64095][bookmark: 29939][bookmark: 77027]Licensing Requirements for LDAP Servers

 
      [bookmark: pgfId-1272149] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1272142]Model
          
  
         		
           
           [bookmark: pgfId-1272144]License Requirement
          
  
        

 
         
         		 [bookmark: pgfId-1272146]All models

  
         		 [bookmark: pgfId-1272148]Base License.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-1053631][bookmark: 54199]Guidelines and Limitations

 
      [bookmark: pgfId-1053632]This section includes the guidelines and limitations for this feature.

 
      [bookmark: pgfId-1053633]Context Mode Guidelines

 
      [bookmark: pgfId-1053634]Supported in single and multiple context mode.

 
      [bookmark: pgfId-1053635]Firewall Mode Guidelines

 
      [bookmark: pgfId-1053636]Supported in routed and transparent firewall mode.

 
      [bookmark: pgfId-1053637]IPv6 Guidelines

 
      [bookmark: pgfId-1053638]Supports IPv6.

 
    
 
   
 
    
     [bookmark: pgfId-1072335][bookmark: 85665]Configuring LDAP Servers

 
     [bookmark: pgfId-1053641]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1235275]Task Flow for Configuring LDAP Servers

 
     		 [bookmark: pgfId-1053645]Configuring LDAP Attribute Maps

 
     		 [bookmark: pgfId-1265714]Configuring LDAP Server Groups

 
     		 [bookmark: pgfId-1265718]Adding an LDAP Server to a Group

 
    

 
     
      [bookmark: pgfId-1053675][bookmark: 88772]Task Flow for Configuring LDAP Servers

 
     
 
      [bookmark: pgfId-1053677] Step 1[image: ] [bookmark: 24815]Add an LDAP server group. See the “Configuring LDAP Server Groups” section.

 
      [bookmark: pgfId-1265725]Step 2[image: ] Add a server to the group, then configure server parameters. See the “Adding an LDAP Server to a Group” section.

 
      [bookmark: pgfId-1053701]Step 3[image: ] [bookmark: 49092]Configure LDAP attribute maps. See the “Configuring LDAP Attribute Maps” section.
 You must add an attribute map before adding an LDAP server to an LDAP server group.

 
      [bookmark: pgfId-1053711]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1234952][bookmark: 66307]Configuring LDAP Attribute M[bookmark: marker-1234946]aps 

 
      [bookmark: pgfId-1234958]The ASA can use an LDAP directory for authenticating users for:

 
      
      		 [bookmark: pgfId-1237740]VPN remote access users

 
      		 [bookmark: pgfId-1237744]firewall network access/cut-through-proxy sessions

 
      		 [bookmark: pgfId-1237745]setting policy permissions (also called authorization attributes), such as ACLs, bookmark lists, DNS or WINS settings, and session timers. 

 
      		 [bookmark: pgfId-1237750]setting the key attributes in a local group policy

 
     

 
      [bookmark: pgfId-1234959]The ASA uses LDAP attribute maps to translate native LDAP user attributes to Cisco ASA attributes. You can bind these attribute maps to LDAP servers or remove them. You can also show or clear attribute maps.

 
    
 
     
      [bookmark: pgfId-1234963]Guidelines

 
      [bookmark: pgfId-1234964]The LDAP attribute map does not support multi-valued attributes. For example, if a user is a member of several AD groups, and the LDAP attribute map matches more than one group, the value chosen is based on the alphabetization of the matched entries. 

 
      [bookmark: pgfId-1234965]To use the attribute mapping features correctly, you need to understand LDAP attribute names and values, as well as the user-defined attribute names and values. 

 
      [bookmark: pgfId-1234973][bookmark: marker-1234972]The names of frequently mapped LDAP attributes and the type of user-defined attributes that they would commonly be mapped to include the following:

 
      
      		 [bookmark: pgfId-1234977]IETF-Radius-Class (Group_Policy in ASA version 8.2 and later)—Sets the group policy based on the directory department or user group (for example, Microsoft Active Directory memberOf) attribute value. The group policy attribute replaced the IETF-Radius-Class attribute with ASDM version 6.2/ASA version 8.2 or later.

 
      		 [bookmark: pgfId-1234978]IETF-Radius-Filter-Id—Applies an access control list or ACL to VPN clients, IPsec, and SSL.

 
      		 [bookmark: pgfId-1234979]IETF-Radius-Framed-IP-Address—Assigns a static IP address assigned to a VPN remote access client, IPsec, and SSL.

 
      		 [bookmark: pgfId-1234980]Banner1—Displays a text banner when the VPN remote access user logs in.

 
      		 [bookmark: pgfId-1234981]Tunneling-Protocols—Allows or denies the VPN remote access session based on the access type.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1234982]Note A single LDAP attribute map may contain one or many attributes. You can only map one LDAP attribute from a specific LDAP server.


      
      
 
     

     

 
      [bookmark: pgfId-1234983]To map LDAP features, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1234984]Detailed Steps

 
     
 
      [bookmark: pgfId-1265732] Step 1[image: ] [bookmark: 19071]Choose  Configuration > Remote Access VPN > AAA Local Users > LDAP Attribute Map (for local users), or  Configuration > Device Management > Users/AAA > LDAP Attribute Map (for all other users) , then click  Add .

 
      [bookmark: pgfId-1265734]The Add LDAP Attribute Map dialog box appears with the Map Name tab active.

 
      [bookmark: pgfId-1265735]Step 2[image: ] In the Name field, create a name for this attribute map. 

 
      [bookmark: pgfId-1265736]Step 3[image: ] In the LDAP Attribute Name field, add the name of on of the LDAP attributes to be mapped.

 
      [bookmark: pgfId-1265737]Step 4[image: ] From the Cisco Attribute Name drop-down list, choose a Cisco attribute.

 
      [bookmark: pgfId-1265739]Step 5[image: ] [bookmark: 11724]Click  Add .

 
      [bookmark: pgfId-1265746]Step 6[image: ] The attributes are mapped. To map more attributes, repeat Steps  1  through  5 .

 
      [bookmark: pgfId-1265747]Step 7[image: ] If you want to map the value of any of the LDAP attributes to a new value in the mapped Cisco attribute, click the  Map Value tab.

 
      [bookmark: pgfId-1265749]Step 8[image: ] [bookmark: 97049]Click  Add .

 
      [bookmark: pgfId-1265750]The Add Mapping of Attribute Name dialog box appears.

 
      [bookmark: pgfId-1265751]Step 9[image: ] Choose an LDAP attribute from the drop-down list.

 
      [bookmark: pgfId-1265752]Step 10[image: ] In the LDAP Attribute Value field, enter the value for this LDAP attribute that you expect to be returned from the LDAP server.

 
      [bookmark: pgfId-1265753]Step 11[image: ] In the Cisco Attribute Value field, enter the value you want to use in the Cisco attribute when this LDAP attribute contains the previous LDAP Attribute Value.

 
      [bookmark: pgfId-1265755]Step 12[image: ] [bookmark: 43988]Click  Add .

 
      [bookmark: pgfId-1265756]The values are mapped.

 
      [bookmark: pgfId-1265763]Step 13[image: ] To map more values, repeat Steps  8  through  12 .

 
      [bookmark: pgfId-1265764]Step 14[image: ] Click  OK to return to the Map Value tab,  and then click  OK again to close the dialog box.

 
      [bookmark: pgfId-1265765]Step 15[image: ] In the LDAP Attribute Map pane, click  Apply to save the value mappings to the running configuration.

 
      [bookmark: pgfId-1265766]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1053730][bookmark: 23262]Configuring LDAP Server Groups[bookmark: marker-1053713][bookmark: marker-1053714][bookmark: marker-1053715][bookmark: marker-1053716][bookmark: marker-1053717][bookmark: marker-1053718][bookmark: marker-1053719][bookmark: marker-1053720][bookmark: marker-1053721][bookmark: marker-1053722][bookmark: marker-1053723][bookmark: marker-1053724][bookmark: marker-1053725][bookmark: marker-1053726] 

 
      [bookmark: pgfId-1053731]To use an external LDAP server for authentication, authorization, and/or accounting, you must first create at least one LDAP server group, and add one or more servers to each group. You identify LDAP server groups by name. Each server group is specific to one type of server.

 
    
 
     
      [bookmark: pgfId-1053732]Guidelines

 
      
      		 [bookmark: pgfId-1053733]You can have up to 100 LDAP server groups in single mode or 4 LDAP server groups per context in multiple mode.

 
      		 [bookmark: pgfId-1053734]Each group can have up to 16 LDAP servers in single mode or 4 LDAP servers in multiple mode.

 
      		 [bookmark: pgfId-1053735]When a user logs in, the LDAP servers are accessed one at a time, starting with the first server that you specify in the configuration, until a server responds. If all servers in the group are unavailable, the ASA tries the local database if you configured it as a fallback method (management authentication and authorization only). If you do not have a fallback method, the ASA continues to try the LDAP servers.

 
     

 
    
 
     
      [bookmark: pgfId-1053742]Detailed Steps

 
      [bookmark: pgfId-1233720]The following steps show how to create and configure an LDAP server group, and add an LDAP server to that group.

 
     
 
      [bookmark: pgfId-1265772] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups,  or  Configuration > Remote Access VPN > AAA/Local Users > AAA Server Groups for VPN users.

 
      [bookmark: pgfId-1265773]Step 2[image: ] In the AAA Server Groups area, click  Add .

 
      [bookmark: pgfId-1265774]The Add AAA Server Group dialog box appears.

 
      [bookmark: pgfId-1265775]Step 3[image: ] In the AAA Server Group field, name this AAA server group.

 
      [bookmark: pgfId-1265776]Step 4[image: ] From the Protocol drop-down list, choose the LDAP server type.

 
      [bookmark: pgfId-1265777]Step 5[image: ] In the Reactivation Mode field, click the radio button for the mode you want to use ( Depletion or  Timed ).

 
      [bookmark: pgfId-1265778]In Depletion mode, failed servers are reactivated only after all of the servers in the group are inactive.

 
      [bookmark: pgfId-1265779]In Timed mode, failed servers are reactivated after 30 seconds of down time.

 
      [bookmark: pgfId-1265780] a.[image: ] If you chose the Depletion reactivation mode, enter a time interval in the Dead Time field.

 
      [bookmark: pgfId-1265781]The Dead Time is the duration of time, in minutes, that elapses between the disabling of the last server in a group and the subsequent re-enabling of all servers.

 
      [bookmark: pgfId-1265782]Step 6[image: ] In the Max Failed Attempts field, add the number of failed attempts to connect to the server to allow.

 
      [bookmark: pgfId-1265783]This option sets the number of failed connection attempts allowed before declaring a nonresponsive server to be inactive.

 
      [bookmark: pgfId-1265784]Step 7[image: ] Click  OK .

 
      [bookmark: pgfId-1265785]The Add AAA Server Group dialog box closes, and the new server group is added to the AAA Server Groups table.

 
      [bookmark: pgfId-1265786]Step 8[image: ] In the AAA Server Groups dialog box, click  Apply to save the changes.

 
      [bookmark: pgfId-1265787]The changes are saved to the running configuration. 

 
      [bookmark: pgfId-1265788]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1265796][bookmark: 44488]Adding an LDAP Server to a Group [bookmark: marker-1265794] 

 
     
 
      [bookmark: pgfId-1265797] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups , or  Configuration > Remote Access VPN > AAA/Local Users > AAA Server Groups for VPN users, and in the AAA Server Groups area, select the server group to which you want to add a server.

 
      [bookmark: pgfId-1265798]Step 2[image: ] Next to the list of Servers in Selected Grous, click  Add .

 
      [bookmark: pgfId-1265799]The Add AAA Server dialog box appears for the selected server group.

 
      [bookmark: pgfId-1265800]Step 3[image: ] From the  Interface Name drop-down list, choose the name of the interface that connects to the LDAP server.

 
      [bookmark: pgfId-1265801]Step 4[image: ] In the Server Name or IP Address field, add either the server name or IP address of the LDAP server.

 
      [bookmark: pgfId-1265802]Step 5[image: ] In the Timeout field, either add a timeout value or keep the default. The timeout is the duration of time, in seconds, that the ASA waits for a response from the primary server before sending the request to the backup server.

 
      [bookmark: pgfId-1265806]Step 6[image: ] In the LDAP Parameters for authentication/authorization area, configure the following fields:

 
      
      		 [bookmark: pgfId-1265807] Enable LDAP over SSL (also called secure LDAP or LDAP-S)—Check this if you want to use SSL to secure communications between the ASA and the LDAP server. 

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1265811]Note If you do not configure the SASL protocol, we strongly recommend that you secure LDAP communications with SSL.


      
      
 
     

     

 
      
      		 [bookmark: pgfId-1265815] Server Port —Enter TCP port number 389, the port which the ASA uses to access the LDAP server for simple (non-secure) authentication, or TCP port 636 for secure authentication (LDAP-S). All LDAP servers support authentication and authorization. Only Microsoft AD and Sun LDAP servers additionally provide a VPN remote access password management capability, which requires LDAP-S.

 
      		 [bookmark: pgfId-1265816] Server Type —Specify the LDAP server type from the drop-down list. The available options include the following:

 
     

 
      [bookmark: pgfId-1265817]–[image: ] Detect Automatically/Use Generic Type

 
      [bookmark: pgfId-1265818]–[image: ] Microsoft

 
      [bookmark: pgfId-1265819]–[image: ] Novell

 
      [bookmark: pgfId-1265820]–[image: ] OpenLDAP

 
      [bookmark: pgfId-1265821]–[image: ] Sun, now part of Oracle Directory Server Enterprise Edition

 
      
      		 [bookmark: pgfId-1265822] Base DN —Enter the Base Distinguished Name, or location in the LDAP hierarchy where the server should begin searching when it receives an LDAP request (for example, OU=people, dc=cisco, dc=com).

 
      		 [bookmark: pgfId-1265823] Scope —Specify the extent of the search that the server should perform in the LDAP hierarchy when it receives an authorization request from the drop-down list. The following options are available:

 
     

 
      [bookmark: pgfId-1265824]–[image: ] One Level—Searches only one level beneath the Base DN. This option is quicker. 

 
      [bookmark: pgfId-1265825]–[image: ] All Levels—Searches all levels beneath the Base DN (that is, searches the entire subtree hierarchy). This option takes more time.

 
      
      		 [bookmark: pgfId-1265826] Naming Attribute(s) —Enter the Relative Distinguished Name attribute(s) that uniquely identify an entry on the LDAP server. Common naming attributes are Common Name (CN), sAMAccountName, userPrincipalName, and User ID (uid).

 
      		 [bookmark: pgfId-1265830] Login DN and Login Password —The ASA uses the login DN and login password to establish trust (bind) with an LDAP server. Specify the login password, which is the password for the login DN user account. The characters that you type are replaced with asterisks.

 
      		 [bookmark: pgfId-1265831] LDAP Attribute Map —Select one of the attribute maps that you created for this LDAP server to use. These attribute maps map LDAP attribute names to Cisco attribute names and values. 

 
      		 [bookmark: pgfId-1265832] SASL MD5 authentication This enables the MD5 mechanism of the SASL to authenticate communications between the ASA and the LDAP server.

 
      		 [bookmark: pgfId-1265836] SASL Kerberos authentication —Enables the Kerberos mechanism of the SASL to secure authentication communications between the ASA and the LDAP server. You must have defined a Kerberos server in order to enable this option.

 
      		 [bookmark: pgfId-1265840] LDAP Parameters for Group Search —The fields in this area configure how the ASA requests AD groups.

 
     

 
      [bookmark: pgfId-1265841]–[image: ]  Group Base DN —Specifies the location in the LDAP hierarchy to begin searching for the AD groups (that is, the list of memberOf enumerations). If this field is not configured, the ASA uses the base DN for AD group retrieval. ASDM uses the list of retrieved AD groups to define AAA selection criteria for dynamic access policies. For more information, see the  show ad-groups command.

 
      [bookmark: pgfId-1265845]–[image: ]  Group Search Timeout —Specifiy the maximum time to wait for a response from an AD server that was queried for available groups.

 
      [bookmark: pgfId-1265846]Step 7[image: ] Click  OK .

 
      [bookmark: pgfId-1265847]The Add AAA Server dialog box closes, and the AAA server is added to the AAA server group.

 
      [bookmark: pgfId-1265848]Step 8[image: ] In the AAA Server Groups pane, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1265849]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1265854][bookmark: 93308]Testing LDAP Server Authentication and Authorization

 
     [bookmark: pgfId-1265858]To determine whether the ASA can contact an LDAP server and authenticate or authorize a user, perform the following steps:

 
    
 
     [bookmark: pgfId-1265859] Step 1[image: ] In the Configuration > Device Management > Users/AAA > AAA Server Groups pane, select the server group in which the server resides.

 
     [bookmark: pgfId-1265860]Step 2[image: ] From the Servers in the Selected Group area, select the server that you want to test.

 
     [bookmark: pgfId-1265861]Step 3[image: ] Click  Test .

 
     [bookmark: pgfId-1265862]The Test AAA Server dialog box appears for the selected server.

 
     [bookmark: pgfId-1265863]Step 4[image: ] Click the type of test that you want to perform— Authentication or  Authorization . 

 
     [bookmark: pgfId-1265864]Step 5[image: ] Enter a username.

 
     [bookmark: pgfId-1265865]Step 6[image: ] If you are testing authentication, enter the password for the username.

 
     [bookmark: pgfId-1265866]Step 7[image: ] Click  OK .

 
     [bookmark: pgfId-1265870]The ASA sends either an authentication or authorization test message to the server. If the test fails, ASDM displays an error message.

 
     [bookmark: pgfId-1265874]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1220704][bookmark: 91389]Monitoring LDAP Servers

 
     [bookmark: pgfId-1212405]To monitor LDAP servers, perform the following steps:

 
    
 
     [bookmark: pgfId-1265884] Step 1[image: ] In ASDM, choose  Monitoring > Properties > AAA Servers .

 
     [bookmark: pgfId-1265885]Step 2[image: ] To update an LDAP server status, select it then click  Update Server Statistics .

 
     [bookmark: pgfId-1265886]The Update AAA Server Status dialog box appears with the LDAP server selected in the drop-down list.

 
     [bookmark: pgfId-1265887]Step 3[image: ] Click  OK .

 
     [bookmark: pgfId-1265888]Step 4[image: ] To update the currently displayed statistics, click  Clear Server Statistics .

 
     [bookmark: pgfId-1265889]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1055623][bookmark: 89792][bookmark: 21826]Feature History for LDAP Servers

 
     [bookmark: pgfId-1055627] Table 36-2  lists each feature change and the platform release in which it was implemented. ASDM is backward-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1055667] 

 
     
      
       
        [bookmark: pgfId-1055631]Table 36-2 [bookmark: 67500]Feature History for AAA Servers

 
       
      
        
        		
          
          [bookmark: pgfId-1055637]Feature Name
         
  
        		
          
          [bookmark: pgfId-1055639]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1055641]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1055643]LDAP Servers for AAA

  
        		 [bookmark: pgfId-1055645]7.0(1)

  
        		 [bookmark: pgfId-1055647]LDAP Servers describe support for AAA and how to configure LDAP servers.

  [bookmark: pgfId-1265899]We introduced the following screens:

  [bookmark: pgfId-1055651]Configuration > Device Management > Users/AAA > AAA Server Groups
 Configuration > Remote Access VPN > AAA Local Users > LDAP Attribute Map
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     [bookmark: pgfId-1043201][bookmark: 48616]Adding a Webtype Access Control List
      
      
 
     
 

 
     [bookmark: pgfId-1043202]Webtype ACLs are added to a configuration that supports filtering for clientless SSL VPN. This chapter describes how to add an ACLto the configuration that supports filtering for WebVPN.

 
     [bookmark: pgfId-1057260]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1057268]Licensing Requirements for Webtype ACLs

 
     		 [bookmark: pgfId-1046652]Guidelines and Limitations

 
     		 [bookmark: pgfId-1068149]Default Settings

 
     		 [bookmark: pgfId-1046685]Using Webtype ACLs

 
     		 [bookmark: pgfId-1081257]Feature History for Webtype ACLs

 
     		 [bookmark: pgfId-1068119]Feature History for Webtype ACLs

 
    

 
   
 
    
     [bookmark: pgfId-1046838][bookmark: 29596]Licensing Requirements for Webtype ACLs

 
     [bookmark: pgfId-1067555]The following table shows the licensing requirements for this feature:

 
     [bookmark: pgfId-1172135] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1172128]Model
         
  
        		
          
          [bookmark: pgfId-1172130]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1172132]All models

  
        		 [bookmark: pgfId-1172134]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1057302][bookmark: 16098][bookmark: 58316]Guidelines and Limitations

 
     [bookmark: pgfId-1071208]This section includes the guidelines and limitations for this feature:

 
     
     		 [bookmark: pgfId-1071212]Context Mode Guidelines

 
     		 [bookmark: pgfId-1071216]Firewall Mode Guidelines

 
     		 [bookmark: pgfId-1071228]Additional Guidelines and Limitations

 
    

 
     [bookmark: pgfId-1071231][bookmark: 87419]Context Mode Guidelines

 
     [bookmark: pgfId-1071232]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1071235][bookmark: 16807]Firewall Mode Guidelines

 
     [bookmark: pgfId-1071236]Supported in routed and transparent firewall mode. 

 
     [bookmark: pgfId-1081591]IPv6 Guidelines

 
     [bookmark: pgfId-1081596]Supports IPv6.

 
     [bookmark: pgfId-1071249][bookmark: 23253]Additional Guidelines and Limitations

 
     [bookmark: pgfId-1071250]The following guidelines and limitations apply to Webtype ACLs: 

 
     
     		 [bookmark: pgfId-1161383]There are two types of webtype ACLs; URL based ACLs and TCP based ACLs. URL based ACLs are used to allow or deny URLs with the format -protocol://ip-address/path, these ACLs are for filtering based on clientless features. TCP based ACLs are used to allow or deny ip-address and port.

 
     		 [bookmark: pgfId-1166886]Permitting one type of an ACL creates an implicit deny for the other type of ACL.

 
     		 [bookmark: pgfId-1171867]A duplicate ACE refers to ACEs with URLs that are equivalent after normalization. A duplicate ACE found during upgrade, will be removed after the upgrade.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1171868]Note URL normalization is an additional security feature that includes path normalization, case normalization and scheme normalization. URLs specified in an ACE and portal address bar are normalized before comparison; for making decisions on webvpn traffic filtering.


     
     
 
    

    

 
     
     		 [bookmark: pgfId-1171869]If an upgrade is followed by a downgrade, duplicate ACEs will not be present in the downgraded version, if a write memory operation is performed after upgrade. To preserve the old configuration, you must save the running configuration to a disk, before the upgrade.

 
     		 [bookmark: pgfId-1171870]To permit any http/https based website and all the paths within the site,  www.cisco.com use the format: 

 
    

 
    
     [bookmark: pgfId-1171871]access-list <ACL-NAME> webtype permit url http://www.cisco.com/*
    

    
     [bookmark: pgfId-1171872] 
    

     
     		 [bookmark: pgfId-1171873]To permit RDP plugin protocol over clientless VPN use the format:

 
    

 
    
     [bookmark: pgfId-1171874]access-list <ACL-NAME> webtype permit url rdp://<host-name>/*
    

    
     [bookmark: pgfId-1171875] 
    

     
     		 [bookmark: pgfId-1171876]To permit SSH plugin protocol over clientless VPN use the format: 

 
    

 
    
     [bookmark: pgfId-1171877]access-list <ACL-NAME> webtype permit url ssh://<host-name>/*
    

    
     [bookmark: pgfId-1171878] 
    

     
     		 [bookmark: pgfId-1171879]To permit telnet plugin protocol over clientless VPN use the format: 

 
    

 
    
     [bookmark: pgfId-1171880]access-list <ACL-NAME> webtype permit url telnet://<host-name>/*
    

    
     [bookmark: pgfId-1171881] 
    

     
     		 [bookmark: pgfId-1171882]To permit ica plugin protocol over clientless VPN use: 

 
    

 
    
     [bookmark: pgfId-1168420]access-list <ACL-NAME> webtype permit url ica://<host-name>/*
    

     
     		 [bookmark: pgfId-1167573]Smart tunnel ACEs filter on a per-server basis only, so you cannot create smart tunnel ACEs to permit or deny access to directories or to permit or deny access to specific smart tunnel-enabled applications.

 
     		 [bookmark: pgfId-1167574]If you add descriptive remarks about your ACL with non-English characters on one platform (such as Windows) then try to remove them from another platform (such as Linux), you might not be able to edit or delete them because the original characters might not be correctly recognized. This limitation is due to an underlying platform dependency that encodes different language characters in different ways.

 
     		 [bookmark: pgfId-1161632]Smart tunnel and ica plug-ins are not affected by an ACL with ‘permit url any’ because they match smart-tunnel:// and ica:// types. 

 
     		 [bookmark: pgfId-1161633]‘Permit url any' will allow all the urls that have format protocol://server-ip/path and will block traffic that does not match any of the protocol://address/path such as port-forwarding; the ASA admin should explicitly set an ACE to allow connection to the required port (port 1494 in case of citrix) so that an implicit deny does not occur.

 
    

 
   
 
    
     [bookmark: pgfId-1161589][bookmark: 60355]Default [bookmark: marker-1161588]Settings

 
     [bookmark: pgfId-1074563] Table 23-1  lists the default settings for Webtype ACLs parameters.

 
     [bookmark: pgfId-1077778] 

 
     
      
       
        [bookmark: pgfId-1077759]Table 23-1 [bookmark: 39947]Default Webtype ACL Parameters 

 
       
      
        
        		
          
          [bookmark: pgfId-1077763]Parameters
         
  
        		
          
          [bookmark: pgfId-1077765]Default
         
  
       

 
        
        		 [bookmark: pgfId-1077767] deny 

  
        		 [bookmark: pgfId-1077769]The ASA denies all packets on the originating interface unless you specifically permit access.

  
       

 
        
        		 [bookmark: pgfId-1077771] log 

  
        		 [bookmark: pgfId-1077773]ACL logging generates system log message 106023 for denied packets. Deny packets must be present to log denied packets.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1077780][bookmark: 12754]Using Webtype ACLs

 
     [bookmark: pgfId-1055477]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1167582]Adding a Webtype ACL and ACE

 
     		 [bookmark: pgfId-1167586]Editing Webtype ACLs and ACEs

 
     		 [bookmark: pgfId-1167590]Deleting Webtype ACLs and ACEs 

 
    

 
     
      [bookmark: pgfId-1080716][bookmark: 67641]Task Flow for Configuring Webtype ACLs

 
      [bookmark: pgfId-1078931]Use the following guidelines to create and implement an ACL:

 
      
      		 [bookmark: pgfId-1078934]Create an ACL by adding an ACE and applying an ACL name. See the “Using Webtype ACLs” section.

 
      		 [bookmark: pgfId-1078938]Apply the ACL to an interface. See the Configuring Access Rules section in the firewall configuration guide for more information.

 
     

 
    
 
     
      [bookmark: pgfId-1167597][bookmark: 17944][bookmark: 99604]Adding a Webtype ACL and ACE[bookmark: marker-1167596]

 
      [bookmark: pgfId-1167598]You must first create the webtype ACL and then add an ACE to the ACL.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1167599]Note Smart tunnel ACEs filter on a per-server basis only, so you cannot create smart tunnel ACEs to permit or deny access to directories or to permit or deny access to specific smart tunnel-enabled applications.


      
      
 
     

     

 
      [bookmark: pgfId-1167600]To configure a webtype ACL, perform the following steps:

 
      [bookmark: pgfId-1167601]


      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > Remote Access VPN > Clientless SSL VPN Access > Advanced > Web ACLs .
     

 
      [bookmark: pgfId-1167602]Step 2[image: ] Click  Add , and choose one of the following ACL types to add:

 
      
       
       		 [bookmark: pgfId-1167603] Add ACL 

 
       		 [bookmark: pgfId-1167604] Add IPv6 ACL 

 
      

 
     

 
      [bookmark: pgfId-1167605]The Add ACL dialog box appears.

 
      [bookmark: pgfId-1167606]Step 3[image: ] Enter a name for the ACL (with no spaces), and click  OK .

 
      [bookmark: pgfId-1167607]Step 4[image: ] To add an entry to the list that you just created, click  Add , and choose  Add ACE from the drop-down list.

 
      [bookmark: pgfId-1167608]Step 5[image: ] In the Action field, click the radio button next to the desired action:

 
      
       
       		 [bookmark: pgfId-1167609]Permit—Permits access if the conditions are matched.

 
       		 [bookmark: pgfId-1167610]Deny—Denies access if the conditions are matched.

 
      

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1167611]Note The end of every ACL has an implicit deny rule.


      
      
 
     

     

 
      [bookmark: pgfId-1167612]Step 6[image: ] In the filter field, you can either filter on a URL or filter on an address and Service.

 
      [bookmark: pgfId-1167613] a.[image: ] To filter on a URL, choose the URL prefix from the drop-down list, and enter the URL>

 
      [bookmark: pgfId-1167614]Wildcard characters can be used in the URL field:

 
      [bookmark: pgfId-1167615]–[image: ] An asterisk * matches none or any number of characters.

 
      [bookmark: pgfId-1167616]–[image: ] A question mark ? matches any one character exactly.

 
      [bookmark: pgfId-1167617]–[image: ] Square brackets [] are range operators, matching any character in the range. For example, to match both http://www.cisco.com:80/ and http://www.cisco.com:81/, enter the following:
  http://www.cisco.com:8[01]/ 

 
      [bookmark: pgfId-1167618] b.[image: ] To filter on an address and service, click the  Filter address and service radio button, and enter the appropriate values.

 
      [bookmark: pgfId-1167619]Wildcard characters can be used in the with regular expression in the address field:

 
      [bookmark: pgfId-1167620]–[image: ] An asterisk * matches none or any number of characters.

 
      [bookmark: pgfId-1167621]–[image: ] A question mark ? matches any one character exactly.

 
      [bookmark: pgfId-1167622]–[image: ] Square brackets [] are range operators, matching any character in the range. For example to permit a range of IP addresses from 10.2.2.20 through 10.2.2.31, enter the following:
  10.2.2.[20-31] 

 
      [bookmark: pgfId-1167623]You can also browse for the address and service by clicking the browse buttons at the end of the fields.

 
      [bookmark: pgfId-1167624]Step 7[image: ] (Optional) Logging is enabled by default. You can disable logging by unchecking the check box, or you can change the logging level from the drop-down list. The default logging level is Informational.

 
      [bookmark: pgfId-1167625]For more information about logging options, see the Log Options section on page 21-29.

 
      [bookmark: pgfId-1167626]Step 8[image: ] (Optional) If you changed the logging level from the default setting, you can specify the logging interval by clicking  More Options to expand the list.

 
      [bookmark: pgfId-1167627]Valid values are from 1 through 6000 seconds. The default is 300 seconds.

 
      [bookmark: pgfId-1167628]Step 9[image: ] (Optional) To add a time range to your access rule that specifies when traffic can be allowed or denied, click  More Options to expand the list.

 
      [bookmark: pgfId-1167629] a.[image: ] To the right of the Time Range drop-down list, click the browse button.

 
      [bookmark: pgfId-1167630] b.[image: ] The Browse Time Range dialog box appears.

 
      [bookmark: pgfId-1167631] c.[image: ] Click  Add .

 
      [bookmark: pgfId-1167632] d.[image: ] The Add Time Range dialog box appears.

 
      [bookmark: pgfId-1167633] e.[image: ] In the Time Range Name field, enter a time range name, with no spaces.

 
      [bookmark: pgfId-1167634] f.[image: ] Enter the Start Time and the End Time.

 
      [bookmark: pgfId-1167635] g.[image: ] To specify additional time constraints for the time range, such as specifying the days of the week or the recurring weekly interval in which the time range will be active, click  Add , and specify the desired values.

 
      [bookmark: pgfId-1167636]Step 10[image: ] Click  OK to apply the optional time range specifications.

 
      [bookmark: pgfId-1167637]Step 11[image: ] Click  Apply to save the configuration.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1167638]Note After you add ACLs, you can click the following radio buttons to filter which ACLs appear in the main pane: IPv4 andIPv6, IPv4 only, or IPv6 Only.


      
      
 
     

     

 
      [bookmark: pgfId-1167639]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1167641][bookmark: 78202]Editing Webtype ACLs and ACEs

 
      [bookmark: pgfId-1167642]To edit a webtype ACL or ACT, perform the following steps:

 
      [bookmark: pgfId-1167643]


      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > 
      Remote Access VPN > 
      Clientless SSL VPN Access > 
      Advanced > 
      Web ACLs .
     

 
      [bookmark: pgfId-1167644]Step 2[image: ] Choose the ACL type to edit by clicking one of the following radio buttons:

 
      
       
       		 [bookmark: pgfId-1167645] IPv4 and IPv6 — Shows ACLs that have both IPv4 and IPv6 addresses only.

 
       		 [bookmark: pgfId-1167646] IPv4 Only —Shows ACLs that have IPv4 type addresses only.

 
       		 [bookmark: pgfId-1167647] IPv6 Only —Shows access rules that have IPv6 type addresses only.

 
      

 
     

 
      [bookmark: pgfId-1167648]The main Access Rule Pane displays the available interfaces for the chosen rule type.

 
      [bookmark: pgfId-1167649]Step 3[image: ] Select the ACE to edit, and make any changes to the values.

 
      [bookmark: pgfId-1167652]For more information about specific values, see the “Adding a Webtype ACL and ACE” section. 

 
      [bookmark: pgfId-1167654]Step 4[image: ] Click  OK .

 
      [bookmark: pgfId-1167655]Step 5[image: ] Click  Apply to save the changes to your configuration.

 
      [bookmark: pgfId-1167656]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1167658][bookmark: 34798]Deleting Webtype ACLs and ACEs

 
      [bookmark: pgfId-1167659]To delete a webtype ACE, perform the following steps:

 
      [bookmark: pgfId-1167660]


      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > 
      Remote Access VPN > 
      Clientless SSL VPN Access > 
      Advanced > 
      Web ACLs .
     

 
      [bookmark: pgfId-1167661]Step 2[image: ] Choose the ACL type to edit by clicking one of the following radio buttons:

 
      
       
       		 [bookmark: pgfId-1167662] IPv4 and IPv6 — Shows ACLs that have both IPv4 and IPv6 addresses only.

 
       		 [bookmark: pgfId-1167663] IPv4 Only —Shows ACLs that have IPv4 type addresses only.

 
       		 [bookmark: pgfId-1167664] IPv6 Only —Shows access rules that have IPv6 type addresses only.

 
      

 
     

 
      [bookmark: pgfId-1167665]The main Access Rule Pane displays the available interfaces for the chosen rule type.

 
      [bookmark: pgfId-1167666]Step 3[image: ] Select the ACE to delete.

 
      [bookmark: pgfId-1167667]If you select a specific ACE, only that ACE is deleted. If you select an ACL, that ACL and all of the ACEs under it are deleted.

 
      [bookmark: pgfId-1167668]Step 4[image: ] Click  Delete .

 
      [bookmark: pgfId-1167669]The selected items are removed from the viewing pane.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1167670]Note If you deleted an item in error and want to restore it to your configuration, click Reset before you click Apply. The deleted item reappears in the viewing pane.


      
      
 
     

     

 
      [bookmark: pgfId-1167671]Step 5[image: ] Click  Apply to save the change to the configuration.

 
      [bookmark: pgfId-1167672]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1087113][bookmark: 17021][bookmark: 47786][bookmark: 85708][bookmark: 62233][bookmark: 56721][bookmark: 96108][bookmark: 92503]Feature History for Webtype ACLs

 
     [bookmark: pgfId-1068790] Table 23-2  lists the release history for this feature.

 
     [bookmark: pgfId-1068794] 

 
     
      
       
        [bookmark: pgfId-1068883]Table 23-2 [bookmark: 50557]Feature History for Webtype ACLs 

 
       
      
        
        		
          
          [bookmark: pgfId-1068889]Feature Name
         
  
        		
          
          [bookmark: pgfId-1068891]Releases
         
  
        		
          
          [bookmark: pgfId-1068893]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1068895]Webtype ACLs

  
        		 [bookmark: pgfId-1068897]7.0(1)

  
        		 [bookmark: pgfId-1068907]Webtyp ACLs are ACLs that are added to a configuration that supports filtering for clientless SSL VPN.

  [bookmark: pgfId-1084779]We introduced the feature.

  
       

 
        
        		 [bookmark: pgfId-1126862]Unified ACL for IPv4 and IPv6

  
        		 [bookmark: pgfId-1126864]9.0(1)

  
        		 [bookmark: pgfId-1126866]ACLs now support IPv4 and IPv6 addresses. You can even specify a mix of IPv4 and IPv6 addresses for the source and destination. The IPv6-specific ACLs are deprecated. Existing IPv6 ACLs are migrated to extended ACLs. See the release notes for more information about migration.

  [bookmark: pgfId-1167683]We modified the following screens:

  [bookmark: pgfId-1126870]Configuration > Firewall > Access Rules
 Configuration > Remote Access VPN > Network (Client) Access > Group Policies > General > More Options 

  
       

 
        
        		 [bookmark: pgfId-1167899]Webtype ACL enhancements

  
        		 [bookmark: pgfId-1167901]9.1(5)

  
        		
          
          		 [bookmark: pgfId-1167903]A duplicate ACE found during upgrade, will be removed after the upgrade.

 
          		 [bookmark: pgfId-1167904]If an upgrade is followed by a downgrade, duplicate ACEs will not be present in the downgraded version, if a write memory operation is performed after upgrade. To preserve the old configuration, you must save the running configuration to a disk, before the upgrade.

 
         

 [bookmark: pgfId-1167905]Note A duplicate ACE refers to ACEs with URLs that are equivalent after normalization.

  [bookmark: pgfId-1167907]We did not modify any ASDM screens.
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     [bookmark: pgfId-1002608][bookmark: 97923]Configuring Dynamic DNS
      
      
 
     
 

 
     [bookmark: pgfId-1091911]This chapter describes how to configure DDNS update methods and includes the following topics: 

 
     
     		 [bookmark: pgfId-1133930]Information About DDNS

 
     		 [bookmark: pgfId-1133932]Licensing Requirements for DDNS

 
     		 [bookmark: pgfId-1125796]Guidelines and Limitations

 
     		 [bookmark: pgfId-1224969]Configuring Dynamic DNS

 
     		 [bookmark: pgfId-1136290]DDNS Monitoring

 
     		 [bookmark: pgfId-1125808]Feature History for DDNS

 
    

 
   
 
    
     [bookmark: pgfId-1125810][bookmark: 15233]Information About DDNS

 
     [bookmark: pgfId-1125811]DDNS update integrates DNS with DHCP. The two protocols are complementary: DHCP centralizes and automates IP address allocation; DDNS update automatically records the association between assigned addresses and hostnames at predefined intervals. DDNS allows frequently changing address-hostname associations to be updated frequently. Mobile hosts, for example, can then move freely on a network without user or administrator intervention. DDNS provides the necessary dynamic update and synchronization of the name-to-address mapping and address-to-name mapping on the DNS server. To configure the DNS server for other uses, see the “Configuring the DNS Server” section. To configure DHCP, see the “Configuring the DHCP Server” section.

 
     [bookmark: pgfId-1155416]EDNS allows DNS requesters to advertise the size of their UDP packets and facilitates the transfer of packets larger than 512 octets. When a DNS server receives a request over UDP, it identifies the size of the UDP packet from the OPT resource record (RR) and scales its response to contain as many resource records as are allowed in the maximum UDP packet size specified by the requester. The size of the DNS packets can be up to 4096 bytes for BIND or 1280 bytes for the Windows 2003 DNS Server. Several additional  message-length maximum commands are available: 

 
     
     		 [bookmark: pgfId-1155417]The existing global limit:  message-length maximum 512 

 
     		 [bookmark: pgfId-1155418]A client or server specific limit: message-length maximum client 4096 

 
     		 [bookmark: pgfId-1155419]The dynamic value specified in the OPT RR field:  message-length maximum client auto 

 
    

 
     [bookmark: pgfId-1155423]If the three commands are present at the same time, the ASA enforces the minimum of the three specified values.

 
   
 
    
     [bookmark: pgfId-1133298][bookmark: 1H_Head1. Licensing Requriements for DDNS]Licensing Requirements for DDNS

 
     [bookmark: pgfId-1134165]The following table shows the licensing requirements for DDNS:

 
     [bookmark: pgfId-1229079] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1229072]Model
         
  
        		
          
          [bookmark: pgfId-1229074]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1229076]All models

  
        		 [bookmark: pgfId-1229078]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1134076][bookmark: 1H_Head1. Guidelines and Limitations]Guidelines and Limitations

 
     [bookmark: pgfId-1134217]Failover Guidelines

 
     [bookmark: pgfId-1134218]Supports Active/Active and Active/Standby failover.

 
     [bookmark: pgfId-1134219]Firewall Mode Guidelines

 
     [bookmark: pgfId-1134220]Supported in routed firewall mode.

 
     [bookmark: pgfId-1134221]Context Mode Guidelines

 
     [bookmark: pgfId-1134222]Supported in single and multiple context modes.

 
     [bookmark: pgfId-1135097]Supported in transparent mode for the DNS Client pane.

 
     [bookmark: pgfId-1134223]IPv6 Guidelines

 
     [bookmark: pgfId-1134224]Supports IPv6.

 
   
 
    
     [bookmark: pgfId-1224984][bookmark: 34733]Configuring Dynamic DNS

 
     
      
      
        
        		  
        		 
          
          [bookmark: pgfId-1220677]Command
         
  
        		 
          
          [bookmark: pgfId-1220679]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1220681]Step 1

  
        		
          
          [bookmark: pgfId-1220683]
           ddns update method  name
         
 
          
          [bookmark: pgfId-1220684] 
         
  [bookmark: pgfId-1220688]ciscoasa(config)# ddns update method ddns-2

  
        		 [bookmark: pgfId-1220690]Creates a DDNS update method ddns-2 that dynamically updates DNS resource records (RRs).

  
       

 
        
        		 [bookmark: pgfId-1220692]Step 2

  
        		
          
          [bookmark: pgfId-1220694]
           ddns both 
         
 
          
          [bookmark: pgfId-1220695] 
         
  [bookmark: pgfId-1220699]ciscoasa(DDNS-update-method)#  ddns both 

  
        		 [bookmark: pgfId-1220701]Specifies that the client updates both the DNS A and PTR resource records (RRs ).

  
       

 
        
        		 [bookmark: pgfId-1220703]Step 3

  
        		
          
          [bookmark: pgfId-1220705]
           interface 
           mapped_name 
         
 
          
          [bookmark: pgfId-1220706] 
         
  [bookmark: pgfId-1220710]ciscoasa(DDNS-update-method)#  interface Ethernet0 

  
        		 [bookmark: pgfId-1220712]Configures an interface Ethernet 0and enters interface configuration mode.

  
       

 
        
        		 [bookmark: pgfId-1220714]Step 4

  
        		
          
          [bookmark: pgfId-1220716]
           ddns update [ 
           method-name | hostname hostname] 
         
 
          
          [bookmark: pgfId-1220717] 
         
  [bookmark: pgfId-1220721]ciscoasa(config-if)#  ddns update ddns-2 

  [bookmark: pgfId-1220725]ciscoasa(config-if)#  ddns update hostname asa.example.com 

  
        		 [bookmark: pgfId-1220727]Associates the the DDNS method ddns-2 with the Ethernet0 interface and an update hostname.

  
       

 
        
        		 [bookmark: pgfId-1220729]Step 5

  
        		
          
          [bookmark: pgfId-1220731]
           dhcp-client update dns [server {both | none}] 
         
 
          
          [bookmark: pgfId-1220732] 
         
  [bookmark: pgfId-1220736]ciscoasa(config)#  dhcp-client update dns server none 

  
        		 [bookmark: pgfId-1220738]Configures the DHCP client to request that the DHCP server perform no updates.

  
       

 
        
        		 [bookmark: pgfId-1220740]Step 6

  
        		
          
          [bookmark: pgfId-1220742]
           ip address dhcp 
         
 
          
          [bookmark: pgfId-1220743] 
         
  [bookmark: pgfId-1220747]ciscoasa(if-config)#  ip address dhcp 

  
        		 [bookmark: pgfId-1220749]Uses DHCP to obtain an IP address for the interface.

  
       

 
        
        		 [bookmark: pgfId-1220752]Step 7

  
        		
          
          [bookmark: pgfId-1220754]dhcpd update dns [both] [override] [interface srv_ifc_name]
         
 
          
          [bookmark: pgfId-1220755] 
         
  [bookmark: pgfId-1220759]ciscoasa(if-config)#  dhcpd update dns both override 

  
        		 [bookmark: pgfId-1220761]Configures DHCP server to override the client update requests.

  
       

 
      
     

 
    
 
     
      
      
        
        		  
        		 
          
          [bookmark: pgfId-1216585]Command
         
  
        		 
          
          [bookmark: pgfId-1216587]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1216589]Step 1

  
        		
          
          [bookmark: pgfId-1216760]
           interface 
           mapped_name 
         
 
          
          [bookmark: pgfId-1216761] 
         
  [bookmark: pgfId-1216765]ciscoasa(config)#  interface Ethernet0 

  
        		 [bookmark: pgfId-1216767]Configures an interface Ethernet 0.

  
       

 
        
        		 [bookmark: pgfId-1216600]Step 2

  
        		
          
          [bookmark: pgfId-1216830]
           dhcp-client update dns [server {both | none}] 
         
 
          
          [bookmark: pgfId-1216831] 
         
  [bookmark: pgfId-1216835]ciscoasa(config-if)#  dhcp-client update dns both 

  
        		 [bookmark: pgfId-1216837]DHCP client requests that the DHCP server update both the DNS A and PTR resource records.

  
       

 
        
        		 [bookmark: pgfId-1216611]Step 3

  
        		
          
          [bookmark: pgfId-1216895]
           ddns update [ 
           method-name | hostname hostname] 
         
 
          
          [bookmark: pgfId-1216896] 
         
  [bookmark: pgfId-1216900]ciscoasa(config-if)#  ddns update hostname asa 

  
        		 [bookmark: pgfId-1216902]Configures the DHCP client on interface Ethernet 0.

  
       

 
        
        		 [bookmark: pgfId-1216622]Step 4

  
        		
          
          [bookmark: pgfId-1216965]dhcpd update dns [both] [override] [interface srv_ifc_name]
         
 
          
          [bookmark: pgfId-1216966] 
         
  [bookmark: pgfId-1216970]ciscoasa(config-if)#  dhcpd update dns  

  
        		 [bookmark: pgfId-1216972]Configures DHCP server to perform DDNS updates.

  
       

 
        
        		 [bookmark: pgfId-1216637]Step 5

  
        		
          
          [bookmark: pgfId-1217053]dhcpd domain domain_name [interface if_name]
         
 
          
          [bookmark: pgfId-1217054] 
         
  [bookmark: pgfId-1217058]ciscoasa(config-if)#  dhcpd domain example.com 

  
        		 [bookmark: pgfId-1216646]Defines the DNS domain name for DHCP clients. 

  
       

 
      
     

 
    
 
     
      
      
        
        		  
        		 
          
          [bookmark: pgfId-1221186]Command
         
  
        		 
          
          [bookmark: pgfId-1221188]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1221190]Step 1

  
        		
          
          [bookmark: pgfId-1221192]
           ddns update method  name
         
 
          
          [bookmark: pgfId-1221193] 
         
  [bookmark: pgfId-1221197]ciscoasa(config)# ddns update method ddns-2

  
        		 [bookmark: pgfId-1221199]Creates a DDNS update method ddns-2 that dynamically updates DNS resource records (RRs).

  
       

 
        
        		 [bookmark: pgfId-1221201]Step 2

  
        		
          
          [bookmark: pgfId-1221203]
           ddns [both] 
         
 
          
          [bookmark: pgfId-1221204] 
         
  [bookmark: pgfId-1221208]ciscoasa(DDNS-update-method)#  ddns  

  
        		 [bookmark: pgfId-1221210]Specifies a dynamic DNS (DDNS) update method.

  
       

 
        
        		 [bookmark: pgfId-1221212]Step 3

  
        		
          
          [bookmark: pgfId-1221214]
           interface 
           mapped_name 
         
 
          
          [bookmark: pgfId-1221215] 
         
  [bookmark: pgfId-1221219]ciscoasa(DDNS-update-method)#  interface Ethernet0 

  
        		 [bookmark: pgfId-1221221]Configures an interface Ethernet 0.

  
       

 
        
        		 [bookmark: pgfId-1221223]Step 4

  
        		
          
          [bookmark: pgfId-1221225]
           dhcp-client update dns [server {both | none}] 
         
 
          
          [bookmark: pgfId-1221226] 
         
  [bookmark: pgfId-1221230]ciscoasa(config-if)#  dhcp-client update dns 

  
        		 [bookmark: pgfId-1221232]Configures the update parameters that the DHCP client passes to the DHCP server. 

  
       

 
        
        		 [bookmark: pgfId-1221234]Step 5

  
        		
          
          [bookmark: pgfId-1221236]
           ddns update [ 
           method-name | hostname hostname] 
         
 
          
          [bookmark: pgfId-1221237] 
         
  [bookmark: pgfId-1221241]ciscoasa(config-if)#  ddns update ddns-2 

  [bookmark: pgfId-1221245]ciscoasa(config-if)#  ddns update hostname asa 

  
        		 [bookmark: pgfId-1221247]Associates the the DDNS method ddns-2 with the Ethernet0 interface and an update hostname.

  
       

 
        
        		 [bookmark: pgfId-1221249]Step 6

  
        		
          
          [bookmark: pgfId-1221251]dhcpd update dns [both] [override] [interface srv_ifc_name]
         
 
          
          [bookmark: pgfId-1221252] 
         
  [bookmark: pgfId-1221256]ciscoasa(if-config)#  dhcpd update dns 

  
        		 [bookmark: pgfId-1221258]Configures DHCP server to perform DDNS updates.

  
       

 
        
        		 [bookmark: pgfId-1221261]Step 7

  
        		
          
          [bookmark: pgfId-1221263]dhcpd domain domain_name [interface if_name]
         
 
          
          [bookmark: pgfId-1221264] 
         
  [bookmark: pgfId-1221268]ciscoasa(config-if)#  dhcpd domain example.com 

  
        		 [bookmark: pgfId-1221270]Defines the DNS domain name for DHCP clients. 

  
       

 
      
     

 
    
 
     [bookmark: pgfId-1224985]Dynamic DNS provides address and domain name mapping so that hosts can find each other, even though their DHCP-assigned IP addresses change frequently. The DDNS name and address mapping are stored on the DHCP server in two resource records: the A RR includes the name-to-IP address mapping, while the PTR RR maps addresses to names. Of the two methods for performing DDNS updates—the IETF standard defined by RFC 2136 and a generic HTTP method—the ASA supports the IETF method in this release.

 
     [bookmark: pgfId-1224989]The Dynamic DNS pane shows the configured DDNS update methods and the interfaces that have been configured for DDNS. By automatically recording the association between assigned addresses and hostnames at pre-defined intervals, DDNS allows frequently changing address-hostname associations to be updated regularly. Mobile hosts, for example, can then move freely on a network without user or administrator intervention.

 
     [bookmark: pgfId-1224990]To configure dynamic DNS client settings for updating the DNS server, perform the following steps:

 
    
 
     [bookmark: pgfId-1224991] Step 1[image: ] In the ASDM main application window, choose  Configuration > Device Management > DNS > Dynamic DNS .

 
     [bookmark: pgfId-1224993]Step 2[image: ] Click  Add to display the Add Dynamic DNS Update Method dialog box.

 
     [bookmark: pgfId-1224994]Step 3[image: ] Enter the name for the DDNS update method.

 
     [bookmark: pgfId-1224995]Step 4[image: ] Specify the update interval between DNS update attempts configured for the update method in days, hours, minutes, and seconds.

 
     
      
      		 [bookmark: pgfId-1224996]Choose the number of days between update attempts from 0 to 364.

 
      		 [bookmark: pgfId-1224997]Choose the number of hours (in whole numbers) between update attempts from 0 to 23.

 
      		 [bookmark: pgfId-1224998]Choose the number of minutes (in whole numbers) between update attempts from 0 to 59.

 
      		 [bookmark: pgfId-1224999]Choose the number of seconds (in whole numbers) between update attempts from 0 to 59. 

 
     

 
    

 
     [bookmark: pgfId-1225000]These units are additive. That is, if you enter 0 days, 0 hours, 5 minutes and 15 seconds, the update method tries an update every 5 minutes and 15 seconds for as long as the method is active.

 
     [bookmark: pgfId-1225001]Step 5[image: ] To store server resource record updates that the DNS client updates, choose one of the following options: 

 
     
      
      		 [bookmark: pgfId-1225002]Both the A resource record and the PTR resource record.

 
      		 [bookmark: pgfId-1225003]The A resource records only.

 
     

 
    

 
     [bookmark: pgfId-1225004]Step 6[image: ] Click  OK to close the Add Dynamic DNS Update Method dialog box. 

 
     [bookmark: pgfId-1225005]The new dynamic DNS client settings appear.

 
     [bookmark: pgfId-1225006]Step 7[image: ] To change these settings, click  Edit to display the Edit Dynamic DDNS Update Method dialog box. When you edit an existing method, the Name field is  display-only and shows the name of the selected method for editing

 
     [bookmark: pgfId-1225007]Step 8[image: ] Make your desired changes, and then click OK to close the Edit Dynamic DDNS Update Method dialog box.

 
     [bookmark: pgfId-1225008]The revised dynamic DNS client settings appear.

 
     [bookmark: pgfId-1225009]Step 9[image: ] To remove configured settings, choose the settings from the list, and then click  Delete .

 
     [bookmark: pgfId-1225010]Step 10[image: ] To add DDNS settings for each interface configured for DDNS, click  Add to display the Add Dynamic DNS Interface Settings dialog box.

 
     [bookmark: pgfId-1225012]Step 11[image: ] Choose the interface from the drop-down list. 

 
     [bookmark: pgfId-1225013]Step 12[image: ] Choose the update method assigned to the interface from the drop-down list.

 
     [bookmark: pgfId-1225014]Step 13[image: ] Enter the hostname of the DDNS client.

 
     [bookmark: pgfId-1225015]Step 14[image: ] To store resource record updates, choose one of the following options: 

 
     
      
      		 [bookmark: pgfId-1225016]Default (PTR Records) to specify that the client request PTR record updating by the server.

 
      		 [bookmark: pgfId-1225017]Both (PTR Records and A Records) to specify that the client request both the A and PTR DNS resource records by the server.

 
      		 [bookmark: pgfId-1225018]None to specify that the client request no updates by the server.

 
     

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1225019]Note DHCP must be enabled on the selected interface for this action to take effect.


     
     
 
    

    

 
     [bookmark: pgfId-1225020]Step 15[image: ] Click  OK to close the Add Dynamic DNS Interface Settings dialog box.

 
     [bookmark: pgfId-1225021]The new dynamic DNS interface settings appear.

 
     [bookmark: pgfId-1225022]Step 16[image: ] To change these settings, click  Edit to display the Edit Dynamic DNS Interface Settings dialog box. 

 
     [bookmark: pgfId-1225023]Step 17[image: ] Make your desired changes, and then click  OK to close the Edit Dynamic DNS Interface Settings dialog box.

 
     [bookmark: pgfId-1225024]The revised dynamic DNS interface settings appear.

 
     [bookmark: pgfId-1225025]Step 18[image: ] To remove configured settings, choose the settings from the list, and then click  Delete .

 
     [bookmark: pgfId-1225026]Step 19[image: ] Click  Apply to save your changes, or click  Reset to discard them and enter new ones.

 
     [bookmark: pgfId-1225027]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1126065][bookmark: marker-1135903][bookmark: 1H_Head1. DDNS Monitoring Commands]DDNS Monitoring 

 
     [bookmark: pgfId-1136119]To monitor DDNS, perform the following steps:

 
     [bookmark: pgfId-1136215] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1136122]Path
         
  
        		
          
          [bookmark: pgfId-1136124]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1225053] Tools > Command Line Interface 

  [bookmark: pgfId-1136128]Enter the  show running-config ddns command, then click  Send .

  
        		 [bookmark: pgfId-1136130]Shows the current DDNS configuration.

  
       

 
        
        		 [bookmark: pgfId-1225059] Tools > Command Line Interface 

  [bookmark: pgfId-1136134]Enter the  show running-config dns server-group command, then click  Send .

  
        		 [bookmark: pgfId-1136136]Shows the current DNS server group status.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1136107][bookmark: 69315]Feature History for DDNS

 
     [bookmark: pgfId-1137568] Table 18-1  lists each feature change and the platform release in which it was implemented. 

 
     [bookmark: pgfId-1225037]ASDM is backward-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1135735] 

 
     
      
       
        [bookmark: pgfId-1135718]Table 18-1 [bookmark: 50557]Feature History for DDNS

 
       
      
        
        		
          
          [bookmark: pgfId-1135724]Feature Name
         
  
        		
          
          [bookmark: pgfId-1135726]Releases
         
  
        		
          
          [bookmark: pgfId-1135728]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1135730]DDNS

  
        		 [bookmark: pgfId-1135732]7.0(1)

  
        		 [bookmark: pgfId-1135734]We introduced this feature.

  [bookmark: pgfId-1225042]We introduced the following screens: 

  [bookmark: pgfId-1175452]Configuration > Device Management> DNS > DNS Client. 
 Configuration > Device Management > DNS > Dynamic DNS.
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     [bookmark: pgfId-1002608][bookmark: 36611]Configuring Digital Certificates
      
      
 
     
 

 
     [bookmark: pgfId-1091132]This chapter describes how to configure digital certificates and includes the following sections:

 
     
     		 [bookmark: pgfId-1393741]Information About Digital Certificates

 
     		 [bookmark: pgfId-1416190]Licensing Requirements for Digital Certificates

 
     		 [bookmark: pgfId-1416195]Prerequisites for Local Certificates

 
     		 [bookmark: pgfId-1420401]Guidelines and Limitations

 
     		 [bookmark: pgfId-1427456]Configuring Digital Certificates

 
     		 [bookmark: pgfId-1760125]Configuring CA Certificate Authentication

 
     		 [bookmark: pgfId-1760129]Monitoring CRLs

 
     		 [bookmark: pgfId-1760133]Configuring Identity Certificates Authentication

 
     		 [bookmark: pgfId-1760137]Configuring Code Signer Certificates

 
     		 [bookmark: pgfId-1760141]Authenticating Using the Local CA

 
     		 [bookmark: pgfId-1760145]Managing the User Database

 
     		 [bookmark: pgfId-1760149]Managing User Certificates

 
     		 [bookmark: pgfId-1760153]Monitoring CRLs

 
     		 [bookmark: pgfId-1394281]Feature History for Certificate Management

 
    

 
   
 
    
     [bookmark: pgfId-1393958][bookmark: 46592]Information About Digital Certificates

 
     [bookmark: pgfId-1760158]Digital certificates provide digital identification for authentication. A digital certificate includes information that identifies a device or user, such as the name, serial number, company, department, or IP address. CAs are trusted authorities that “sign” certificates to verify their authenticity, thereby guaranteeing the identity of the device or user. CAs issue digital certificates in the context of a PKI, which uses public-key or private-key encryption to ensure security. [bookmark: marker-1760159]

 
     [bookmark: pgfId-1760160]For authentication using digital certificates, at least one identity certificate and its issuing CA certificate must exist on an ASA. This configuration allows multiple identities, roots, and certificate hierarchies. The ASA evaluates third-party certificates against CRLs, also called authority revocation lists, all the way from the identity certificate up the chain of subordinate certificate authorities.

 
     [bookmark: pgfId-1760164]Descriptions of several different types of available digital certificates follow:

 
     
     		 [bookmark: pgfId-1760166]A [bookmark: marker-1760165] CA certificate is used to sign other certificates. It is self-signed and called a  root certificate . A certificate that is issued by another CA certificate is called a  subordinate certificate [bookmark: marker-1760167]. For more information, see the “Configuring CA Certificate Authentication” section. 

 
     		 [bookmark: pgfId-1760171]CAs also issue  identity  certificates , which are certificates for specific systems or hosts. For more information, see the “Configuring Identity Certificates Authentication” section.

 
     		 [bookmark: pgfId-1760175] Code-signer certificates are special certificates that are used to create digital signatures to sign code, with the signed code itself revealing the certificate origin. For more information, see the “Configuring Code Signer Certificates” section.

 
    

 
     [bookmark: pgfId-1760182]The local CA integrates an independent certificate authority feature on the ASA, deploys certificates, and provides secure revocation checking of issued certificates. The local CA provides a secure, configurable, in-house authority for certificate authentication with user enrollment through a website login page. 

 
     [bookmark: pgfId-1760186]For more information, see the “Authenticating Using the Local CA” section, the “Managing the User Database” section, and the “Managing User Certificates” section.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1760193]Note CA certificates and identity certificates apply to both site-to-site VPN connections and remote access VPN connections. Procedures in this document refer to remote access VPN use in the ASDM GUI.


     
     
 
    

    

 
     [bookmark: pgfId-1760194]Digital certificates provide digital identification for authentication. A digital certificate includes information that identifies a device or user, such as the name, serial number, company, department, or IP address. CAs are trusted authorities that “sign” certificates to verify their authenticity, thereby guaranteeing the identity of the device or user. CAs issue digital certificates in the context of a PKI, which uses public-key or private-key encryption to ensure security. [bookmark: marker-1760195]

 
     [bookmark: pgfId-1760196]For authentication using digital certificates, at least one identity certificate and its issuing CA certificate must exist on an ASA. This configuration allows multiple identities, roots, and certificate hierarchies. Descriptions of several different types of available digital certificates follow:

 
     
     		 [bookmark: pgfId-1760201]A [bookmark: marker-1760200] CA certificate is used to sign other certificates. It is self-signed and called a  root certificate . 

 
     		 [bookmark: pgfId-1760203]A certificate that is issued by another CA certificate is called a  subordinate certificate [bookmark: marker-1760202]. For more information, see the “Configuring CA Certificate Authentication” section. 

 
    

 
     [bookmark: pgfId-1125092]CAs are responsible for managing certificate requests and issuing digital certificates. A digital certificate includes information that identifies a user or device, such as a name, serial number, company, department, or IP address. A digital certificate also includes a copy of the public key for the user or device. A CA can be a trusted third party, such as VeriSign, or a private (in-house) CA that you establish within your organization.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1348598]Tip For an example of a scenario that includes certificate configuration and load balancing, see the following URL: https://supportforums.cisco.com/docs/DOC-5964.


     
     
 
    

    

 
     [bookmark: pgfId-1125093]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1394451]Public Key Cryptography

 
     		 [bookmark: pgfId-1394483]Certificate Scalability

 
     		 [bookmark: pgfId-1394504]Key Pairs

 
     		 [bookmark: pgfId-1394517]Trustpoints

 
     		 [bookmark: pgfId-1394530]Revocation Checking

 
     		 [bookmark: pgfId-1394618]The Local CA

 
     		 [bookmark: pgfId-1669155]Using Certificates and User Login Credentials

 
    

 
     
      [bookmark: pgfId-1125141][bookmark: 39882]Public Key Cryptography[bookmark: marker-1125140]

 
      [bookmark: pgfId-1125142]Digital signatures, enabled by public key cryptography, provide a way to authenticate devices and users. In public key cryptography, such as the RSA encryption system, each user has a key pair containing both a public and a private key. The keys act as complements, and anything encrypted with one of the keys can be decrypted with the other. 

 
      [bookmark: pgfId-1125143]In simple terms, a signature is formed when data is encrypted with a private key. The signature is attached to the data and sent to the receiver. The receiver applies the public key of the sender to the data. If the signature sent with the data matches the result of applying the public key to the data, the validity of the message is established.

 
      [bookmark: pgfId-1125144]This process relies on the receiver having a copy of the public key of the sender and a high degree of certainty that this key belongs to the sender, not to someone pretending to be the sender.

 
      [bookmark: pgfId-1374704]Obtaining the public key of a sender is normally handled externally or through an operation performed at installation. For example, most web browsers are configured with the root certificates of several CAs by default. For VPN, the IKE protocol, a component of IPsec, can use digital signatures to authenticate peer devices before setting up security associations.

 
    
 
     
      [bookmark: pgfId-1374706][bookmark: 60153]Certificate Scalability

 
      [bookmark: pgfId-1125148]Without digital certificates, you must manually configure each IPsec peer for each peer with which it communicates; as a result, each new peer that you add to a network would require a configuration change on each peer with which it needs to communicate securely.

 
      [bookmark: pgfId-1125149]When you use digital certificates, each peer is enrolled with a CA. When two peers try to communicate, they exchange certificates and digitally sign data to authenticate each other. When a new peer is added to the network, you enroll that peer with a CA and none of the other peers need modification. When the new peer attempts an IPsec connection, certificates are automatically exchanged and the peer can be authenticated.

 
      [bookmark: pgfId-1125150]With a CA, a peer authenticates itself to the remote peer by sending a certificate to the remote peer and performing some public key cryptography. Each peer sends its unique certificate, which was issued by the CA. This process works because each certificate encapsulates the public key for the associated peer, each certificate is authenticated by the CA, and all participating peers recognize the CA as an authenticating authority. The process is called IKE with an RSA signature.

 
      [bookmark: pgfId-1125151]The peer can continue sending its certificate for multiple IPsec sessions, and to multiple IPsec peers, until the certificate expires. When its certificate expires, the peer administrator must obtain a new one from the CA.

 
      [bookmark: pgfId-1125152]CAs can also revoke certificates for peers that no longer participate in IPsec. Revoked certificates are not recognized as valid by other peers. [bookmark: marker-1125153]Revoked certificates are listed in a [bookmark: marker-1125154]CRL, which each peer may check before accepting a certificate from another peer.

 
      [bookmark: pgfId-1125156]Some CAs have an RA [bookmark: marker-1125155]as part of their implementation. An RA is a server that acts as a proxy for the CA, so that CA functions can continue when the CA is unavailable.

 
    
 
     
      [bookmark: pgfId-1125158][bookmark: 34583]Key Pairs

 
      [bookmark: pgfId-1125159]Key pairs are RSA keys, which have the following characteristics:

 
      
      		 [bookmark: pgfId-1125160]RSA keys can be used for SSH or SSL. 

 
      		 [bookmark: pgfId-1125161]SCEP enrollment supports the certification of RSA keys.

 
      		 [bookmark: pgfId-1125162]For the purposes of generating keys, the maximum key modulus for RSA keys is 2048 bits. The default size is 1024. Many SSL connections using identity certificates with RSA key pairs that exceed 1024 bits can cause a high CPU usage on the ASA and rejected clientless logins.

 
      		 [bookmark: pgfId-1125166]For signature operations, the supported maximum key size is 4096 bits. We recommend using a key size of at least 2048.

 
      		 [bookmark: pgfId-1125167]You can generate a general purpose RSA key pair, used for both signing and encryption, or you can generate separate RSA key pairs for each purpose. Separate signing and encryption keys help to reduce exposure of the keys, because SSL uses a key for encryption but not signing. However, IKE uses a key for signing but not encryption. By using separate keys for each, exposure of the keys is minimized.

 
     

 
    
 
     
      [bookmark: pgfId-1125169][bookmark: 55200]Trustpoints

 
      [bookmark: pgfId-1125170]Trustpoints let you manage and track CAs and certificates. A trustpoint is a representation of a CA or identity pair. A trustpoint includes the identity of the CA, CA-specific configuration parameters, and an association with one, enrolled identity certificate.[bookmark: marker-1125171]

 
      [bookmark: pgfId-1125172]After you have defined a trustpoint, you can reference it by name in commands requiring that you specify a CA. You can configure many trustpoints.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1125176]Note If an ASA has multiple trustpoints that share the same CA, only one of these trustpoints sharing the CA can be used to validate user certificates. To control which trustpoint sharing a CA is used for validation of user certificates issued by that CA, use the support-user-cert-validation command.


      
      
 
     

     

 
      [bookmark: pgfId-1125177]For automatic enrollment, a trustpoint must be configured with an enrollment URL, and the CA that the trustpoint represents must be available on the network and must support SCEP.

 
      [bookmark: pgfId-1313338]You can export and import the keypair and issued certificates associated with a trustpoint in PKCS12 format. This format is useful to manually duplicate a trustpoint configuration on a different ASA.

 
    
 
     
      [bookmark: pgfId-1318559]Certificate Enrollment

 
      [bookmark: pgfId-1318563]The ASA needs a CA certificate for each trustpoint and one or two certificates for itself, depending upon the configuration of the keys used by the trustpoint. If the trustpoint uses separate RSA keys for signing and encryption, the ASA needs two certificates, one for each purpose. In other key configurations, only one certificate is needed.

 
      [bookmark: pgfId-1318570]The ASA supports automatic enrollment with SCEP and with manual enrollment, which lets you paste a base-64-encoded certificate directly into the terminal. For site-to-site VPNs, you must enroll each ASA. For remote access VPNs, you must enroll each ASA and each remote access VPN client.

 
    
 
     
      [bookmark: pgfId-1318578]Proxy for SCEP Requests

 
      [bookmark: pgfId-1318582]The ASA can proxy SCEP requests between AnyConnect and a third-party CA. The CA only needs to be accessible to the ASA if it is acting as the proxy. For the ASA to provide this service, the user must authenticate using any of the methods supported by AAA before the ASA sends an enrollment request. You can also use host scan and dynamic access policies to enforce rules of eligibility to enroll.

 
      [bookmark: pgfId-1318589]The ASA supports this feature only with an AnyConnect SSL or IKEv2 VPN session. It supports all SCEP-compliant CAs, including IOS CS, Windows Server 2003 CA, and Windows Server 2008 CA.

 
      [bookmark: pgfId-1318590]Clientless (browser-based) access does not support SCEP proxy, although WebLaunch—clientless-initiated AnyConnect—does support it.

 
      [bookmark: pgfId-1318594]The ASA does not support polling for certificates.

 
      [bookmark: pgfId-1318598]The ASA supports load balancing for this feature.

 
    
 
     
      [bookmark: pgfId-1313343][bookmark: 96274]Revocation Checking

 
      [bookmark: pgfId-1313344]When a certificate is issued, it is valid for a fixed period of time. Sometimes a CA revokes a certificate before this time period expires; for example, because of security concerns or a change of name or association. CAs periodically issue a signed list of revoked certificates. Enabling revocation checking forces the ASA to check that the CA has not revoked a certificate each time that it uses the certificate for authentication.

 
      [bookmark: pgfId-1125191]When you enable revocation checking, the ASA checks certificate revocation status during the PKI certificate validation process, which can use either CRL checking, OCSP, or both. OCSP is only used when the first method returns an error (for example, indicating that the server is unavailable).

 
      [bookmark: pgfId-1216961]With CRL checking, the ASA retrieves, parses, and caches CRLs, which provide a complete list of revoked (and unrevoked) certificates with their certificate serial numbers. The ASA evaluates certificates according to CRLs, also called authority revocation lists, from the identity certificate up the chain of subordinate certificate authorities.

 
      [bookmark: pgfId-1216962]OCSP offers a more scalable method of checking revocation status in that it localizes certificate status through a validation authority, which it queries for status of a specific certificate. 

 
    
 
     
      [bookmark: pgfId-1347551]Supported CA Servers[bookmark: marker-1347550]

 
      [bookmark: pgfId-1347555]The ASA supports the following CA servers:

 
      [bookmark: pgfId-1347557][bookmark: marker-1347556]Cisco IOS CS, ASA Local CA, and third-party X.509 compliant CA vendors including, but not limited to: 

 
      
      		 [bookmark: pgfId-1347559][bookmark: marker-1347558]Baltimore Technologies

 
      		 [bookmark: pgfId-1347561][bookmark: marker-1347560]Entrust

 
      		 [bookmark: pgfId-1348960][bookmark: marker-1374709]Digicert

 
      		 [bookmark: pgfId-1348997][bookmark: marker-1374710]Geotrust

 
      		 [bookmark: pgfId-1348969][bookmark: marker-1374711]GoDaddy

 
      		 [bookmark: pgfId-1348974][bookmark: marker-1374715]iPlanet/Netscape

 
      		 [bookmark: pgfId-1347563][bookmark: marker-1347562]Microsoft Certificate Services

 
      		 [bookmark: pgfId-1347565][bookmark: marker-1349008]RSA Keon

 
      		 [bookmark: pgfId-1347567][bookmark: marker-1374727]Thawte

 
      		 [bookmark: pgfId-1347569][bookmark: marker-1347568]VeriSign

 
     

 
    
 
     
      [bookmark: pgfId-1125197]CRLs

 
      [bookmark: pgfId-1125201]CRLs provide the ASA with one way of determining whether a certificate that is within its valid time range has been revoked by the issuing CA. CRL configuration is part of configuration of a trustpoint. 

 
      [bookmark: pgfId-1125205]You can configure the ASA to make CRL checks mandatory when authenticating a certificate by using the  revocation-check crl  command. You can also make the CRL check optional by using the  revocation-check crl none command, which allows the certificate authentication to succeed when the CA is unavailable to provide updated CRL data.

 
      [bookmark: pgfId-1125209]The ASA can retrieve CRLs from CAs using HTTP, SCEP, or LDAP. CRLs retrieved for each trustpoint are cached for a configurable amount of time for each trustpoint.

 
      [bookmark: pgfId-1125213]When the ASA has cached a CRL for longer than the amount of time it is configured to cache CRLs, the ASA considers the CRL too old to be reliable, or “stale.” The ASA tries to retrieve a newer version of the CRL the next time that a certificate authentication requires a check of the stale CRL.

 
      [bookmark: pgfId-1125223]The ASA caches CRLs for an amount of time determined by the following two factors:

 
      
      		 [bookmark: pgfId-1125224]The number of minutes specified with the  cache-time command. The default value is 60 minutes.

 
      		 [bookmark: pgfId-1125225]The NextUpdate field in the CRLs retrieved, which may be absent from CRLs. You control whether the ASA requires and uses the NextUpdate field with the  enforcenextupdate command.

 
     

 
      [bookmark: pgfId-1125232]The ASA uses these two factors in the following ways:

 
      
      		 [bookmark: pgfId-1125236]If the NextUpdate field is not required, the ASA marks CRLs as stale after the length of time defined by the  cache-time command.

 
      		 [bookmark: pgfId-1125240]If the NextUpdate field is required, the ASA marks CRLs as stale at the sooner of the two times specified by the  cache-time command and the NextUpdate field. For example, if the  cache-time command is set to 100 minutes and the NextUpdate field specifies that the next update is 70 minutes away, the ASA marks CRLs as stale in 70 minutes.

 
     

 
      [bookmark: pgfId-1125247]If the ASA has insufficient memory to store all CRLs cached for a given trustpoint, it deletes the least recently used CRL to make room for a newly retrieved CRL. 

 
    
 
     
      [bookmark: pgfId-1125252]OCSP

 
      [bookmark: pgfId-1125256]OCSP provides the ASA with a way of determining whether a certificate that is within its valid time range has been revoked by the issuing CA. OCSP configuration is part of trustpoint configuration.

 
      [bookmark: pgfId-1125257]OCSP localizes certificate status on a validation authority (an OCSP server, also called the  responder ) which the ASA queries for the status of a specific certificate. This method provides better scalability and more up-to-date revocation status than does CRL checking, and helps organizations with large PKI installations deploy and expand secure networks.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1198988]Note The ASA allows a five-second time skew for OCSP responses.


      
      
 
     

     

 
      [bookmark: pgfId-1125264]You can configure the ASA to make OCSP checks mandatory when authenticating a certificate by using the  revocation-check ocsp  command. You can also make the OCSP check optional by using the  revocation-check ocsp none command, which allows the certificate authentication to succeed when the validation authority is unavailable to provide updated OCSP data.

 
      [bookmark: pgfId-1125268]OCSP provides three ways to define the OCSP server URL. The ASA uses these servers in the following order:

 
      [bookmark: pgfId-1125269] 1.[image: ] The OCSP URL defined in a match certificate override rule by using the  match certificate command).

 
      [bookmark: pgfId-1125270] 2.[image: ] The OCSP URL configured by using the  ocsp url command.

 
      [bookmark: pgfId-1125271] 3.[image: ] The AIA field of the client certificate.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1125272]Note To configure a trustpoint to validate a self-signed OCSP responder certificate, you import the self-signed responder certificate into its own trustpoint as a trusted CA certificate. Then you configure the match certificate command in the client certificate validating trustpoint to use the trustpoint that includes the self-signed OCSP responder certificate to validate the responder certificate. Use the same procedure for configuring validating responder certificates external to the validation path of the client certificate. 

The OCSP server (responder) certificate usually signs the OCSP response. After receiving the response, the ASA tries to verify the responder certificate. The CA normally sets the lifetime of the OCSP responder certificate to a relatively short period to minimize the chance of being compromised. The CA usually also includes an ocsp-no-check extension in the responder certificate, which indicates that this certificate does not need revocation status checking. However, if this extension is not present, the ASA tries to check revocation status using the same method specified in the trustpoint. If the responder certificate is not verifiable, revocation checks fail. To avoid this possibility, use the revocation-check none command to configure the responder certificate validating trustpoint, and use the revocation-check ocsp command to configure the client certificate. 


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1125280][bookmark: 32223]The Local CA 

 
      [bookmark: pgfId-1125281]The local CA performs the following tasks:

 
      
      		 [bookmark: pgfId-1125285]Integrates basic certificate authority operation on the ASA.

 
      		 [bookmark: pgfId-1125286]Deploys certificates.

 
      		 [bookmark: pgfId-1125287]Provides secure revocation checking of issued certificates.

 
      		 [bookmark: pgfId-1125288]Provides a certificate authority on the ASA for use with browser-based and client-based SSL VPN connections. 

 
      		 [bookmark: pgfId-1125289]Provides trusted digital certificates to users, without the need to rely on external certificate authorization. 

 
      		 [bookmark: pgfId-1125290]Provides a secure, in-house authority for certificate authentication and offers straightforward user enrollment by means of a website login. 

 
     

 
    
 
     
      [bookmark: pgfId-1347355]Storage for Local CA Files

 
      [bookmark: pgfId-1347359]The ASA accesses and implements user information, issued certificates, and revocation lists using a local CA database. This database resides in local flash memory by default, or can be configured to reside on an external file system that is mounted and accessible to the ASA.

 
      [bookmark: pgfId-1347363]No limits exist on the number of users that can be stored in the local CA user database; however, if flash memory storage issues arise, syslogs are generated to alert the administrator to take action, and the local CA could be disabled until the storage issues are resolved. Flash memory can store a database with 3500 users or less; however, a database of more than 3500 users requires external storage.

 
    
 
     
      [bookmark: pgfId-1125294]The Local CA Server

 
      [bookmark: pgfId-1311949]After you configure a local CA server on the ASA, users can enroll for a certificate by logging into a website and entering a username and a one-time password that is provided by the local CA administrator to validate their eligibility for enrollment. 

 
      [bookmark: pgfId-1125301]As shown in Figure 40-1, the local CA server resides on the ASA and handles enrollment requests from website users and CRL inquiries coming from other certificate validating devices and ASAs. Local CA database and configuration files are maintained either on the ASA flash memory (default storage) or on a separate storage device.

 
      [bookmark: pgfId-1313101]Figure 40-1 [bookmark: 81470]The Local CA

 
      [bookmark: pgfId-1313105] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1668854][bookmark: 17519]Using Certificates and User Login Credentials

 
      [bookmark: pgfId-1668855]The following section describes the different methods of using certificates and user login credentials (username and password) for authentication and authorization. These methods apply to IPsec, AnyConnect, and Clientless SSL VPN.

 
      [bookmark: pgfId-1668856]In all cases, LDAP authorization does not use the password as a credential. RADIUS authorization uses either a common password for all users or the username as a password.

 
      [bookmark: pgfId-1668857]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1668861]Using User Login Credentials

 
      		 [bookmark: pgfId-1668865]Using Certificates

 
     

 
    
 
     
      [bookmark: pgfId-1668867][bookmark: 65429]Using User Login Credentials

 
      [bookmark: pgfId-1668868]The default method for authentication and authorization uses the user login credentials.

 
      
      		 [bookmark: pgfId-1668869]Authentication

 
     

 
      [bookmark: pgfId-1668870]–[image: ] Enabled by the authentication server group setting in the tunnel group (also called ASDM Connection Profile)

 
      [bookmark: pgfId-1668871]–[image: ] Uses the username and password as credentials

 
      
      		 [bookmark: pgfId-1668872]Authorization

 
     

 
      [bookmark: pgfId-1668873]–[image: ] Enabled by the authorization server group setting in the tunnel group (also called ASDM Connection Profile)

 
      [bookmark: pgfId-1668874]–[image: ] Uses the username as a credential

 
    
 
     
      [bookmark: pgfId-1668876][bookmark: 87972]Using Certificates

 
      [bookmark: pgfId-1668880]If user digital certificates are configured, the ASA first validates the certificate. It does not, however, use any of the DNs from certificates as a username for the authentication. 

 
      [bookmark: pgfId-1668884]If both authentication and authorization are enabled, the ASA uses the user login credentials for both user authentication and authorization.

 
      
      		 [bookmark: pgfId-1668885]Authentication

 
     

 
      [bookmark: pgfId-1668886]–[image: ] Enabled by the authentication server group setting

 
      [bookmark: pgfId-1668887]–[image: ] Uses the username and password as credentials

 
      
      		 [bookmark: pgfId-1668888]Authorization

 
     

 
      [bookmark: pgfId-1668889]–[image: ] Enabled by the authorization server group setting

 
      [bookmark: pgfId-1668890]–[image: ] Uses the username as a credential

 
      [bookmark: pgfId-1668894]If authentication is disabled and authorization is enabled, the ASA uses the primary DN field for authorization.

 
      
      		 [bookmark: pgfId-1668895]Authentication

 
     

 
      [bookmark: pgfId-1668896]–[image: ] DISABLED (set to None) by the authentication server group setting

 
      [bookmark: pgfId-1668897]–[image: ] No credentials used

 
      
      		 [bookmark: pgfId-1668898]Authorization

 
     

 
      [bookmark: pgfId-1668899]–[image: ] Enabled by the authorization server group setting

 
      [bookmark: pgfId-1668900]–[image: ] Uses the username value of the certificate primary DN field as a credential

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1668904]Note If the primary DN field is not present in the certificate, the ASA uses the secondary DN field value as the username for the authorization request.


      
      
 
     

     

 
      [bookmark: pgfId-1668905]For example, consider a user certificate that includes the following Subject DN fields and values:

 
     
      [bookmark: pgfId-1668906]Cn=anyuser,OU=sales;O=XYZCorporation;L=boston;S=mass;C=us;ea=anyuser@example.com
     

     
      [bookmark: pgfId-1668907] 
     

      [bookmark: pgfId-1668908]If the Primary DN = EA (E-mail Address) and the Secondary DN = CN (Common Name), then the username used in the authorization request would be anyuser@example.com.

 
    
 
   
 
    
     [bookmark: pgfId-1098824][bookmark: 99650]Licensing Requirements for Digital Certificates

 
     [bookmark: pgfId-1789087] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1789080]Model
         
  
        		
          
          [bookmark: pgfId-1789082]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1789084]All models

  
        		 [bookmark: pgfId-1789086]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1780095][bookmark: 16726]Prerequisites for Local Certificates

 
     [bookmark: pgfId-1420539]Local certificates have the following prerequisites:

 
     
     		 [bookmark: pgfId-1420543]Make sure that the ASA is configured correctly to support certificates. An incorrectly configured ASA can cause enrollment to fail or request a certificate that includes inaccurate information.

 
     		 [bookmark: pgfId-1420550]Make sure that the hostname and domain name of the ASA are configured correctly. To view the currently configured hostname and domain name, enter the  show running-config command. For information about configuring the hostname and domain name, see the “Configuring the Hostname, Domain Name, and Passwords” section. 

 
     		 [bookmark: pgfId-1420557]Make sure that the ASA clock is set accurately before configuring the CA. Certificates have a date and time that they become valid and expire. When the ASA enrolls with a CA and obtains a certificate, the ASA checks that the current time is within the valid range for the certificate. If it is outside that range, enrollment fails. For information about setting the clock, see the “Setting the Date and Time” section.

 
    

 
     
      [bookmark: pgfId-1233280][bookmark: 69379]Prerequisites for SCEP Proxy Support

 
      [bookmark: pgfId-1233281]Configuring the ASA as a proxy to submit requests for third-party certificates has the following requirements:

 
      
      		 [bookmark: pgfId-1217277]AnyConnect Secure Mobility Client 3.0 or later must be running at the endpoint.

 
      		 [bookmark: pgfId-1511388]The authentication method, configured in the connection profile for your group policy, must be set to use both AAA and certificate authentication.

 
      		 [bookmark: pgfId-1217855]An SSL port must be open for IKEv2 VPN connections.

 
      		 [bookmark: pgfId-1217797]The CA must be in auto-grant mode.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1217800][bookmark: 93713]Guidelines and Limitations

 
     [bookmark: pgfId-1217801]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1091226]Context Mode Guidelines

 
     
     		 [bookmark: pgfId-1091227]Supported in single and multiple context mode for a local CA.

 
     		 [bookmark: pgfId-1217525]Supported in single context mode only for third-party CAs.

 
    

 
     [bookmark: pgfId-1091229]Firewall Mode Guidelines

 
     [bookmark: pgfId-1091230]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1091232]Failover Guidelines

 
     
     		 [bookmark: pgfId-1091233]Does not support replicating sessions in Stateful Failover.

 
     		 [bookmark: pgfId-1752356]Does not support failover for local CAs. 

 
    

 
     [bookmark: pgfId-1091234]IPv6 Guidelines

 
     [bookmark: pgfId-1100829]Does not support IPv6.

 
     [bookmark: pgfId-1198670]Additional Guidelines

 
     
     		 [bookmark: pgfId-1532047]For ASAs that are configured as CA servers or clients, limit the validity period of the certificate to less than the recommended end date of 03:14:08 UTC, January 19, 2038. This guideline also applies to imported certificates from third-party vendors.

 
     		 [bookmark: pgfId-1532048]You cannot configure the local CA when failover is enabled. You can only configure the local CA server for standalone ASAs without failover. For more information, see CSCty43366.

 
     		 [bookmark: pgfId-1532052]When a certificate enrollment is completed, the ASA stores a PKCS12 file containing the user's keypair and certificate chain, which requires about 2 KB of flash memory or disk space per enrollment. The actual amount of disk space depends on the configured RSA key size and certificate fields. Keep this guideline in mind when adding a large number of pending certificate enrollments on an ASA with a limited amount of available flash memory, because these PKCS12 files are stored in flash memory for the duration of the configured enrollment retrieval timeout. We recommend using a key size of at least 2048.

 
     		 [bookmark: pgfId-1532449]The  lifetime ca-certificate command takes effect when the local CA server certificate is first generated (that is, when you initially configure the local CA server and issue the  no shutdown command). When the CA certificate expires, the configured lifetime value is used to generate the new CA certificate. You cannot change the lifetime value for existing CA certificates.

 
     		 [bookmark: pgfId-1532812]You should configure the ASA to use an identity certificate to protect ASDM traffic and HTTPS traffic to the management interface. Identity certificates that are automatically generated with SCEP are regenerated after each reboot, so make sure that you manually install your own identity certificates. For an example of this procedure that applies only to SSL, see the following URL:  http://www.cisco.com/en/US/products/ps6120/products_configuration_example09186a00809fcf91.shtml .

 
     		 [bookmark: pgfId-1533980]The ASA and the AnyConnect clients can only validate certificates in which the X520Serialnumber field (the serial number in the Subject Name) is in PrintableString format. If the serial number format uses encoding such as UTF8, the certificate authorization will fail. 

 
     		 [bookmark: pgfId-1768740]Use only valid characters and values for certificate parameters when you import them on the ASA.

 
     		 [bookmark: pgfId-1768883]To use a wildcard (*) symbol, make sure that you use encoding on the CA server that allows this character in the string value. Although RFC 5280 recommends using either a UTF8String or PrintableString, you should use UTF8String because PrintableString does not recognize the wildcard as a valid character. The ASA rejects the imported certificate if an invalid character or value is found during the import. For example:

 
    

 
    
     [bookmark: pgfId-1768887]ERROR: Failed to parse or verify imported certificate ciscoasa(config)# Read 162*H÷ytes as CA certificate:0U0= \Ivr"phÕV°3é¼þ0 CRYPTO_PKI(make trustedCerts list)
    

    
     [bookmark: pgfId-1768888]CERT-C: E ../cert-c/source/certlist.c(302) : Error #711h
    

    
     [bookmark: pgfId-1768889]CRYPTO_PKI: Failed to verify the ID certificate using the CA certificate in trustpoint mm.
    

    
     [bookmark: pgfId-1768890]CERT-C: E ../cert-c/source/p7contnt.c(169) : Error #703h crypto_certc_pkcs7_extract_certs_and_crls failed (1795):
    

    
     [bookmark: pgfId-1768891]crypto_certc_pkcs7_extract_certs_and_crls failed
    

    
     [bookmark: pgfId-1768892]CRYPTO_PKI: status = 1795: failed to verify or insert the cert into storage
    

   
 
    
     [bookmark: pgfId-1427490][bookmark: 98320]Configuring Digital Certificates 

 
     [bookmark: pgfId-1765699]This section describes how to configure local CA certificates. Make sure that you follow the sequence of tasks listed to correctly configure this type of digital certificate. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1760219]Configuring CA Certificate Authentication

 
     		 [bookmark: pgfId-1760223]Configuring CA Certificates for Revocation

 
     		 [bookmark: pgfId-1760227]Configuring CRL Retrieval Policy

 
     		 [bookmark: pgfId-1760231]Configuring CRL Retrieval Methods

 
     		 [bookmark: pgfId-1760235]Configuring OCSP Rules

 
     		 [bookmark: pgfId-1760239]Configuring Advanced CRL and OCSP Settings

 
    

 
     [bookmark: pgfId-1760243]This section describes how to configure digital certificates for the ASA Services Module and includes the following topics:

 
     
     		 [bookmark: pgfId-1760247]Configuring CA Certificate Authentication

 
     		 [bookmark: pgfId-1760251]Adding or Installing a CA Certificate

 
     		 [bookmark: pgfId-1760255]Editing or Removing a CA Certificate Configuration

 
     		 [bookmark: pgfId-1760259]Showing CA Certificate Details

 
     		 [bookmark: pgfId-1760263]Configuring CA Certificates for Revocation

 
     		 [bookmark: pgfId-1760267]Configuring CRL Retrieval Policy

 
     		 [bookmark: pgfId-1760271]Configuring CRL Retrieval Methods

 
     		 [bookmark: pgfId-1760275]Configuring OCSP Rules

 
     		 [bookmark: pgfId-1760279]Configuring Advanced CRL and OCSP Settings

 
    

 
   
 
    
     [bookmark: pgfId-1760283][bookmark: 93314]Configuring CA Certificate Authentication[bookmark: marker-1760282]

 
     [bookmark: pgfId-1760284]The CA Certificates pane displays the available certificates, identified by the issued to and issued by CA server, the date that the certificate expires, the associated trustpoints, and the certificate usage or purpose. In the CA Certificates pane, you can perform the following tasks:

 
     
     		 [bookmark: pgfId-1760285]Authenticate self-signed or subordinate CA certificates.

 
     		 [bookmark: pgfId-1760289]Install CA certificates on the ASA. 

 
     		 [bookmark: pgfId-1760290]Create a new certificate configuration.

 
     		 [bookmark: pgfId-1760292]Edit an existing certificate configuration.[bookmark: marker-1760291] 

 
     		 [bookmark: pgfId-1760293]Obtain a CA certificate manually and import it.

 
     		 [bookmark: pgfId-1760297]Have the ASA use SCEP to contact the CA, and then automatically obtain and install the certificate.

 
     		 [bookmark: pgfId-1760298]Display details and issuer information for a selected certificate. 

 
     		 [bookmark: pgfId-1760299]Access the CRL for an existing CA certificate. 

 
     		 [bookmark: pgfId-1760300]Remove the configuration of an existing CA certificate. 

 
     		 [bookmark: pgfId-1760301]Save the new or modified CA certificate configuration.

 
     		 [bookmark: pgfId-1760302]Discard any changes and return the certificate configuration to the original settings.

 
    

 
     [bookmark: pgfId-1760303]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1760307]Adding or Installing a CA Certificate

 
     		 [bookmark: pgfId-1760311]Editing or Removing a CA Certificate Configuration

 
     		 [bookmark: pgfId-1760315]Showing CA Certificate Details

 
    

 
     
      [bookmark: pgfId-1760319][bookmark: 95823]Adding or Installing a CA Certificate[bookmark: marker-1760318]

 
      [bookmark: pgfId-1760320]You can add a new certificate configuration from an existing file, by manually pasting a certificate in PEM format, or by automatic enrollment using SCEP. SCEP is a secure messaging protocol that requires minimal user intervention and lets you enroll and install certificates using only the VPN Concentrator Manager. 

 
      [bookmark: pgfId-1760321]To add or install a CA certificate, perform the following steps:

 
     
 
      [bookmark: pgfId-1760322] Step 1[image: ] In the main ASDM application window, choose  Configuration > Remote Access VPN > Certificate Management > CA Certificates .

 
      [bookmark: pgfId-1760323]Step 2[image: ] Click  Add .

 
      [bookmark: pgfId-1760324]The Install Certificate dialog box appears. The selected trustpoint name appears in read-only format.

 
      [bookmark: pgfId-1760325]Step 3[image: ] To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting).

 
      [bookmark: pgfId-1760326]Step 4[image: ] Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
      [bookmark: pgfId-1760327]Step 5[image: ] The Certificate Installation dialog box appears with a confirmation message indicating that the certificate was successfully installed. Click  OK to close this dialog box.

 
      [bookmark: pgfId-1760328]Step 6[image: ] To enroll manually, click the  Paste [image: ]certificate in PEM format radio button.

 
      [bookmark: pgfId-1760329]Step 7[image: ] Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided, then click Install Certificate .

 
      [bookmark: pgfId-1760330]Step 8[image: ] The Certificate Installation dialog box appears with a confirmation message indicating that the certificate was successfully installed. Click  OK to close this dialog box.

 
      [bookmark: pgfId-1760334]Step 9[image: ] To enroll automatically, click the  Use SCEP radio button. The ASA contacts the CA using SCEP, obtains the certificates, and installs them on the device. To use SCEP, you must enroll with a CA that supports SCEP, and you must enroll via the Internet. Automatic enrollment using SCEP requires that you provide the following information:

 
      
       
       		 [bookmark: pgfId-1760335]The path and file name of the certificate to be automatically installed.

 
       		 [bookmark: pgfId-1760336]The maximum number of minutes to retry certificate installation. The default is one minute.

 
       		 [bookmark: pgfId-1760337]The number of retries for installing a certificate. The default is zero, which indicates unlimited retries within the retry period.

 
      

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760341]Note See Prerequisites for SCEP Proxy Support when choosing to use the SCEP method to install certficates.


      
      
 
     

     

 
      [bookmark: pgfId-1760342]Step 10[image: ] To display additional configuration options for new and existing certificates, click  More Options . 

 
      [bookmark: pgfId-1760343]The Configuration Options for CA Certificates pane appears. 

 
      [bookmark: pgfId-1760346]Step 11[image: ] To continue, see the “Editing or Removing a CA Certificate Configuration” section.

 
      [bookmark: pgfId-1760348]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760351][bookmark: 55246]Editing or Removing a CA Certificate Configuration

 
      [bookmark: pgfId-1760352]To change or remove an existing CA certificate configuration, perform the following steps:

 
     
 
      [bookmark: pgfId-1760353] Step 1[image: ] To change an existing CA certificate configuration, select it, and then click  Edit .

 
      [bookmark: pgfId-1760354]The Edit Options for CA Certificates pane appears. To change any of these settings, see the following sections for procedures:

 
      
       
       		 [bookmark: pgfId-1760358]“Configuring CRL Retrieval Policy” section

 
       		 [bookmark: pgfId-1760362]“Configuring CRL Retrieval Methods” section

 
       		 [bookmark: pgfId-1760366]“Configuring OCSP Rules” section

 
       		 [bookmark: pgfId-1760370]“Configuring Advanced CRL and OCSP Settings” section

 
      

 
     

 
      [bookmark: pgfId-1760371]Step 2[image: ] To remove a CA certificate configuration, select it, and then click  Delete . 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760372]Note After you delete a certificate configuration, it cannot be restored. To recreate the deleted certificate, click Add to reenter all of the certificate configuration information.


      
      
 
     

     

 
      [bookmark: pgfId-1760373]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760376][bookmark: 15634]Showing CA Certificate Details

 
      [bookmark: pgfId-1760377]To show detailed information about the selected CA certificate, click  Show Details to display the Certificate Details dialog box, which includes the following three  display-only tabs:

 
      
      		 [bookmark: pgfId-1760378]The General tab displays the values for type, serial number, status, usage, public key type, CRL distribution point, the times within which the certificate is valid, and associated trustpoints. The values apply to both available and pending status.

 
      		 [bookmark: pgfId-1760379]The Issued to tab displays the X.500 fields of the subject DN or certificate owner and their values. The values apply only to available status.

 
      		 [bookmark: pgfId-1760380]The Issued by tab displays the X.500 fields of the entity granting the certificate. The values apply only to available status.

 
     

 
    
 
     
      [bookmark: pgfId-1760384][bookmark: 52928]Configuring CA Certificate Authentication[bookmark: marker-1760383]

 
      [bookmark: pgfId-1760385]The CA Certificates pane displays the available certificates, identified by the issued to and issued by CA server, the date that the certificate expires, the associated trustpoints, and the certificate usage or purpose. In the CA Certificates pane, you can perform the following tasks:

 
      
      		 [bookmark: pgfId-1760386]Authenticate self-signed or subordinate CA certificates.

 
      		 [bookmark: pgfId-1760390]Install CA certificates on the ASA. 

 
      		 [bookmark: pgfId-1760391]Create a new certificate configuration.

 
      		 [bookmark: pgfId-1760393]Edit an existing certificate configuration.[bookmark: marker-1760392] 

 
      		 [bookmark: pgfId-1760394]Obtain a CA certificate manually and import it.

 
      		 [bookmark: pgfId-1760395]Display details and issuer information for a selected certificate. 

 
      		 [bookmark: pgfId-1760396]Access the CRL for an existing CA certificate. 

 
      		 [bookmark: pgfId-1760397]Remove the configuration of an existing CA certificate. 

 
      		 [bookmark: pgfId-1760398]Save the new or modified CA certificate configuration.

 
      		 [bookmark: pgfId-1760399]Discard any changes and return the certificate configuration to the original settings.

 
     

 
    
 
     
      [bookmark: pgfId-1760403][bookmark: 11134]Adding or Installing a CA Certificate[bookmark: marker-1760402]

 
      [bookmark: pgfId-1760404]You can add a new certificate configuration from an existing file, by manually pasting a certificate in PEM format.

 
      [bookmark: pgfId-1760405]To add or install a CA certificate, perform the following steps:

 
     
 
      [bookmark: pgfId-1760406] Step 1[image: ] In the main ASDM application window, choose  Configuration > Device Management > Certificate Management > CA Certificates .

 
      [bookmark: pgfId-1760407]Step 2[image: ] Click  Add .

 
      [bookmark: pgfId-1760408]The Install Certificate dialog box appears. The selected trustpoint name appears in read-only format.

 
      [bookmark: pgfId-1760409]Step 3[image: ] To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting).

 
      [bookmark: pgfId-1760410]Step 4[image: ] Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
      [bookmark: pgfId-1760411]Step 5[image: ] To enroll manually, click the  Paste [image: ]certificate in PEM format radio button.

 
      [bookmark: pgfId-1760412]Step 6[image: ] Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided, then click Install Certificate .

 
      [bookmark: pgfId-1760413]Step 7[image: ] To display additional configuration options for new and existing certificates, click  More Options . 

 
      [bookmark: pgfId-1760414]The Configuration Options for CA Certificates pane appears. 

 
      [bookmark: pgfId-1760417]Step 8[image: ] Make your selections, and then click OK. To continue, see the “Editing or Removing a CA Certificate Configuration” section.

 
      [bookmark: pgfId-1760419]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760422][bookmark: 77018]Editing or Removing a CA Certificate Configuration

 
      [bookmark: pgfId-1760423]To change or remove an existing CA certificate configuration, perform the following steps:

 
     
 
      [bookmark: pgfId-1760424] Step 1[image: ] To change an existing CA certificate configuration, select it, and then click  Edit .

 
      [bookmark: pgfId-1760425]The Edit Options for CA Certificates pane appears. To change any of these settings, see the following sections for procedures:

 
      
       
       		 [bookmark: pgfId-1760429]“Configuring CRL Retrieval Policy” section

 
       		 [bookmark: pgfId-1760433]“Configuring CRL Retrieval Methods” section

 
       		 [bookmark: pgfId-1760437]“Configuring OCSP Rules” section

 
       		 [bookmark: pgfId-1760441]“Configuring Advanced CRL and OCSP Settings” section

 
      

 
     

 
      [bookmark: pgfId-1760442]Step 2[image: ] To remove a CA certificate configuration, select it, and then click  Delete . 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760443]Note After you delete a certificate configuration, it cannot be restored. To recreate the deleted certificate, click Add to reenter all of the certificate configuration information.


      
      
 
     

     

 
      [bookmark: pgfId-1760444]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760447][bookmark: 93622]Showing CA Certificate Details

 
      [bookmark: pgfId-1760448]To show detailed information about the selected CA certificate, click  Show Details to display the Certificate Details dialog box, which includes the following three  display-only tabs:

 
      
      		 [bookmark: pgfId-1760449]The General tab displays the values for type, serial number, status, usage, public key type, CRL distribution point, the times within which the certificate is valid, and associated trustpoints. The values apply to both available and pending status.

 
      		 [bookmark: pgfId-1760450]The Issued to tab displays the X.500 fields of the subject DN or certificate owner and their values. The values apply only to available status.

 
      		 [bookmark: pgfId-1760451]The Issued by tab displays the X.500 fields of the entity granting the certificate. The values apply only to available status.

 
     

 
    
 
     
      [bookmark: pgfId-1760458][bookmark: 71413]Configuring CA Certificates for Revocation

 
      [bookmark: pgfId-1760459]To configure CA certificates for revocation, perform the following site-to-site task in either single or muliple context mode:

 
     
 
      [bookmark: pgfId-1760460] Step 1[image: ] In the ASDM application window, choose  Configuration > Site-to-Site VPN > Certificate Management > CA Certificates > Add to display the Install Certificates dialog box. Then click  More Options .

 
      [bookmark: pgfId-1760461]Step 2[image: ] In the Configuration Options for CA Certificates pane, click the  Revocation Check tab.

 
      [bookmark: pgfId-1760462]Step 3[image: ] To disable revocation checking of certificates, click the  Do not check certificates for revocation  radio button.

 
      [bookmark: pgfId-1760463]Step 4[image: ] To select one or more revocation checking methods (CRL or OCSP), click the  Check certificates for revocation  radio button. 

 
      [bookmark: pgfId-1760464]Step 5[image: ] In the Revocation Methods area,  available methods appear on the left. Click  Add to move a method to the right and make it available. Click  Move Up or  Move Down to change the method order.

 
      [bookmark: pgfId-1760465]The methods you choose are implemented in the order in which you add them. If a method returns an error, the next revocation checking method activates.

 
      [bookmark: pgfId-1760466]Step 6[image: ] Check the  Consider certificate valid if revocation checking returns errors  check box to ignore revocation checking errors during certificate validation. 

 
      [bookmark: pgfId-1760467]Step 7[image: ] Click  OK to close the Revocation Check tab. Alternatively, to continue, see the “Configuring CRL Retrieval Policy” section.

 
      [bookmark: pgfId-1760471]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760474] Configuring CRL Retrieval Policy [bookmark: 72444]

 
      [bookmark: pgfId-1760475]To configure the CRL retrieval policy, perform the following steps: 

 
     
 
      [bookmark: pgfId-1760476] Step 1[image: ] In the ASDM application window, choose  Configuration > Site-to-Site VPN > Certificate Management > CA Certificates > Add to display the Install Certificates dialog box. Then click  More Options .

 
      [bookmark: pgfId-1760477]Step 2[image: ] Check the  Use CRL Distribution Point from the certificate  check box to direct revocation checking to the CRL distribution point from the certificate being checked. 

 
      [bookmark: pgfId-1760478]Step 3[image: ] Check the  Use Static URLs configured below check box to list specific URLs to be used for CRL retrieval. The URLs you select are implemented in the order in which you add them. If an error occurs with the specified URL, the next URL in order is taken.

 
      [bookmark: pgfId-1760479]Step 4[image: ] In the Static Configuration area, click  Add . 

 
      [bookmark: pgfId-1760481]The Add Static URL dialog box appears.

 
      [bookmark: pgfId-1760482]Step 5[image: ] In the URL field, enter the static URL to use for distributing the CRLs, and then click  OK .

 
      [bookmark: pgfId-1760483]The URL that you entered appears in the Static URLs list.

 
      [bookmark: pgfId-1760484]Step 6[image: ] To change the static URL, select it, and then click  Edit .

 
      [bookmark: pgfId-1760485]Step 7[image: ] To remove an existing static URL, select it, and then click  Delete .

 
      [bookmark: pgfId-1760486]Step 8[image: ] To change the order in which the static URLs appear, click  Move Up or  Move Down .

 
      [bookmark: pgfId-1760489]Step 9[image: ] Click  OK to close this tab. Alternatively, to continue, see the “Configuring CRL Retrieval Methods” section.

 
      [bookmark: pgfId-1760491]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760494][bookmark: 65128]Configuring CRL Retrieval Methods

 
      [bookmark: pgfId-1760495]To configure CRL retrieval methods, perform the following steps:

 
     
 
      [bookmark: pgfId-1760496] Step 1[image: ] In the ASDM application window, choose  Configuration > Site-to-Site VPN > Certificate Management > CA Certificates > Add to display the Install Certificates dialog box. Then click  More Options .

 
      [bookmark: pgfId-1760497]Step 2[image: ] In the Configuration Options for CA Certificates pane, click the  CRL Retrieval Methods  tab.

 
      [bookmark: pgfId-1760498]Step 3[image: ] Choose one of the following three retrieval methods:

 
      
       
       		 [bookmark: pgfId-1760499]To enable LDAP for CRL retrieval, check the  Enable Lightweight Directory Access Protocol (LDAP) check box. With LDAP, CRL retrieval starts an LDAP session by connecting to a named LDAP server, accessed by a password. The connection is on TCP port 389 by default. Enter the following required parameters:

 
      

 
     

 
      [bookmark: pgfId-1760500]–[image: ] Name

 
      [bookmark: pgfId-1760501]–[image: ] Password

 
      [bookmark: pgfId-1760502]–[image: ] Confirm Password

 
      [bookmark: pgfId-1760503]–[image: ] Default Server (server name)

 
      [bookmark: pgfId-1760504]–[image: ] Default Port (389) 

 
      
       
       		 [bookmark: pgfId-1760505]To enable HTTP for CRL retrieval, check the  Enable HTTP  check box.

 
      

 
     

 
      [bookmark: pgfId-1760508]Step 4[image: ] Click  OK to close this tab. Alternatively, to continue, see the “Configuring OCSP Rules” section.

 
      [bookmark: pgfId-1760510]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760513][bookmark: 49775]Configuring OCSP Rules

 
      [bookmark: pgfId-1760517]The ASA examines OCSP rules in priority order, and applies the first one that matches. X.509 digital certificates are an alternative to using CRLs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760518]Note Make sure that you have configured a certificate map before you try to add OCSP rules. If a certificate map has not been configured, an error message appears. To configure a certificate map, choose Configuration > Site-to-Site VPN > Advanced > Certificate to Connection Profile Maps > Rules > Add.


      
      
 
     

     

 
      [bookmark: pgfId-1760519]To configure OCSP rules for obtaining revocation status of an X.509 digital certificate, perform the following steps: 

 
     
 
      [bookmark: pgfId-1760520] Step 1[image: ] In the ASDM application window, choose  Configuration > Site-to-Site VPN > Certificate Management > CA Certificates > Add to display the Install Certificates dialog box. Then click  More Options .

 
      [bookmark: pgfId-1760521]Step 2[image: ] In the Configuration Options for CA Certificates pane, click the  OCSP Rules  tab.

 
      [bookmark: pgfId-1760522]Step 3[image: ] Choose the certificate map t o match to this OCSP rule. Certificate maps match user permissions to specific fields in a certificate.  The name of the CA that the ASA uses to validate responder certificates appears in the Certificate field. The priority number for the rule appears in the Index field. The URL of the OCSP server for this certificate appears in the URL field.

 
      [bookmark: pgfId-1760526]Step 4[image: ] To add a new OCSP rule, click  Add .

 
      [bookmark: pgfId-1760527]The Add OCSP Rule dialog box appears.

 
      [bookmark: pgfId-1760528]Step 5[image: ] Choose the certificate map to use from the drop-down list.

 
      [bookmark: pgfId-1760529]Step 6[image: ] Choose the certificate to use from the drop-down list. 

 
      [bookmark: pgfId-1760530]Step 7[image: ] Enter the priority number for the rule.

 
      [bookmark: pgfId-1760531]Step 8[image: ] Enter the URL of the OCSP server for this certificate.

 
      [bookmark: pgfId-1760532]Step 9[image: ] When you are done, click  OK to close this dialog box.

 
      [bookmark: pgfId-1760533]The newly added OCSP rule appears in the list.

 
      [bookmark: pgfId-1760534]Step 10[image: ] To edit an existing OCSP rule, select it, and then click  Edit .

 
      [bookmark: pgfId-1760535]Step 11[image: ] To delete an OCSP rule, select it, and then click  Delete .

 
      [bookmark: pgfId-1760538]Step 12[image: ] Click  OK to close this tab. Alternatively, to continue, see the “Configuring Advanced CRL and OCSP Settings” section.

 
      [bookmark: pgfId-1760540]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760543] Configuring Advanced CRL and OCSP Settings [bookmark: 81286]

 
      [bookmark: pgfId-1760544] When a certificate is issued, it is valid for a fixed period of time. Sometimes a CA revokes a certificate before this time period expires; for example, because of security concerns or a change of name or association. CAs periodically issue a signed list of revoked certificates. Enabling revocation checking forces the ASA to check that the CA has not revoked the certificate being verified.  The ASA supports two methods of checking revocation status: CRL and OCSP.

 
      [bookmark: pgfId-1760551]To configure additional CRL and OCSP settings, perform the following steps:

 
     
 
      [bookmark: pgfId-1760552] Step 1[image: ] In the ASDM application window, choose  Configuration > Site-to-Site VPN > Certificate Management > CA Certificates > Add to display the Install Certificates dialog box. Then click  More Options .

 
      [bookmark: pgfId-1760553]Step 2[image: ] In the Configuration Options for CA Certificates pane, click the  Advanced  tab.

 
      [bookmark: pgfId-1760554]Step 3[image: ] In the CRL Options area,  enter the number of minutes between cache refreshes. The default is 60 minutes. The range is 1-1440 minutes.   [bookmark: marker-1760555]To avoid having to retrieve the same CRL from a CA repeatedly, the ASA can store retrieved CRLs locally, which is called CRL caching. The CRL cache capacity varies by platform and is cumulative across all contexts. If an attempt to cache a newly retrieved CRL would exceed its storage limits, the ASA removes the least recently used CRL until more space becomes available.

 
      [bookmark: pgfId-1760562]Step 4[image: ] Check the Enforce next CRL update check box to require valid CRLs to have a Next Update value that has not expired. Uncheck the  Enforce next CRL update check box to let valid CRLs with no Next Update value or a Next Update value that has expired.

 
      [bookmark: pgfId-1760566]Step 5[image: ] In the OCSP Options area, enter the URL for the OCSP server. The  ASA uses OCSP servers according to the following order:

 
      [bookmark: pgfId-1760567] 1.[image: ] OCSP URL in a match certificate override rule 

 
      [bookmark: pgfId-1760568] 2.[image: ] OCSP URL configured in the selected OCSP Options attribute

 
      [bookmark: pgfId-1760569] 3.[image: ] AIA field of a user certificate

 
      [bookmark: pgfId-1760570]Step 6[image: ] By default, the  Disable nonce extension check box is checked, which cryptographically binds requests with responses to avoid replay attacks. This process works by matching the extension in the request to that in the response, ensuring that they are the same. Uncheck the  Disable nonce extension check box if the OCSP server you are using sends pregenerated responses that do not include this matching nonce extension. 

 
      [bookmark: pgfId-1760571]Step 7[image: ] In the Other Options area, choose one of the following options:

 
      
      		 [bookmark: pgfId-1760575]Check the  Accept certificates issued by this CA check box to indicate that the ASA should accept certificates from the specified CA.

 
      		 [bookmark: pgfId-1760576]Check the  Accept certificates issued by the subordinate CAs of this CA check box to indicate that the ASA should accept certificates from the subordinate CA.

 
     

 
      [bookmark: pgfId-1760580]Step 8[image: ] Click  OK to close this tab, and then click  Apply to save your configuration changes.

 
      [bookmark: pgfId-1760581]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760582]What to Do Next

 
      [bookmark: pgfId-1760586]See the “Monitoring CRLs” section.

 
    
 
   
 
    
     [bookmark: pgfId-1760589][bookmark: 12038]Monitoring CRLs

 
     [bookmark: pgfId-1760590]To monitor CRLs, perform the following steps:

 
    
 
     [bookmark: pgfId-1760591] Step 1[image: ] In the ASDM main application window, choose  Monitoring > Properties > CRL .

 
     [bookmark: pgfId-1760592]Step 2[image: ] In the CRL area, choose the CA certificate name from the drop-down list.

 
     [bookmark: pgfId-1760593]Step 3[image: ] To display CRL details, click  View CRL . For example:

 
    
     [bookmark: pgfId-1760594]CRL Issuer Name: 
    

    
     [bookmark: pgfId-1760595] cn=asa4.cisco.com
    

    
     [bookmark: pgfId-1760596] LastUpdate: 09:58:34 UTC Nov 11 2009
    

    
     [bookmark: pgfId-1760597] NextUpdate: 15:58:34 UTC Nov 11 2009
    

    
     [bookmark: pgfId-1760598] Cached Until: 15:58:34 UTC Nov 11 2009
    

    
     [bookmark: pgfId-1760599] Retrieved from CRL Distribution Point: 
    

    
     [bookmark: pgfId-1760600] ** CDP Not Published - Retrieved via SCEP
    

    
     [bookmark: pgfId-1760601] Size (bytes): 224
    

    
     [bookmark: pgfId-1760602] Associated Trustpoints: LOCAL-CA-SERVER 
    

    
     [bookmark: pgfId-1760603] 
    

     [bookmark: pgfId-1760604]Step 4[image: ] When you are done, click  Clear CRL to remove the CRL details and choose another CA certificate to view.

 
     [bookmark: pgfId-1760605]


     
     
 
    
  
    

 
     
      [bookmark: pgfId-1760608][bookmark: 81688]Configuring CA Certificates for Revocation

 
      [bookmark: pgfId-1760609]To configure CA certificates for revocation, perform the following steps:

 
     
 
      [bookmark: pgfId-1760610] Step 1[image: ] In the Configuration Options for CA Certificates pane, click the  Revocation Check tab.

 
      [bookmark: pgfId-1760611]Step 2[image: ] To disable revocation checking of certificates, click the  Do not check certificates for revocation  radio button.

 
      [bookmark: pgfId-1760612]Step 3[image: ] To select one or more revocation checking methods (CRL or OCSP), click the  Check certificates for revocation  radio button. 

 
      [bookmark: pgfId-1760613]Step 4[image: ] In the Revocation Methods area,  available methods appear on the left. Click  Add to move a method to the right and make it available. Click  Move Up or  Move Down to change the method order.

 
      [bookmark: pgfId-1760614]The methods that you choose are implemented in the order in which you add them. If a method returns an error, the next revocation checking method activates.

 
      [bookmark: pgfId-1760615]Step 5[image: ] Check the  Consider certificate valid if revocation checking returns errors  check box to ignore revocation checking errors during certificate validation. 

 
      [bookmark: pgfId-1760616]Step 6[image: ] Click  OK to close the Revocation Check tab. Alternatively, to continue, see the “Configuring CRL Retrieval Policy” section.

 
      [bookmark: pgfId-1760620]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760623] Configuring CRL Retrieval Policy [bookmark: 16219]

 
      [bookmark: pgfId-1760624]To configure the CRL retrieval policy, perform the following steps: 

 
     
 
      [bookmark: pgfId-1760625] Step 1[image: ] In the Configuration Options for CA Certificates pane, click the  CRL Retrieval Policy  tab.

 
      [bookmark: pgfId-1760626]Step 2[image: ] Check the  Use CRL Distribution Point from the certificate  check box to direct revocation checking to the CRL distribution point from the certificate being checked. 

 
      [bookmark: pgfId-1760627]Step 3[image: ] Check the  Use Static URLs configured below check box to list specific URLs to be used for CRL retrieval. The URLs you select are implemented in the order in which you add them. If an error occurs with the specified URL, the next URL in order is taken.

 
      [bookmark: pgfId-1760628]Step 4[image: ] In the Static Configuration area, click  Add . 

 
      [bookmark: pgfId-1760630]The Add Static URL dialog box appears.

 
      [bookmark: pgfId-1760631]Step 5[image: ] In the URL field, enter the static URL to use for distributing the CRLs, and then click  OK .

 
      [bookmark: pgfId-1760632]The URL that you entered appears in the Static URLs list.

 
      [bookmark: pgfId-1760633]Step 6[image: ] To change the static URL, select it, and then click  Edit .

 
      [bookmark: pgfId-1760634]Step 7[image: ] To remove an existing static URL, select it, and then click  Delete .

 
      [bookmark: pgfId-1760635]Step 8[image: ] To change the order in which the static URLs appear, click  Move Up or  Move Down .

 
      [bookmark: pgfId-1760638]Step 9[image: ] Click  OK to close this tab. Alternatively, to continue, see the “Configuring CRL Retrieval Methods” section.

 
      [bookmark: pgfId-1760640]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760643][bookmark: 10222]Configuring CRL Retrieval Methods

 
      [bookmark: pgfId-1760644]To configure CRL retrieval methods, perform the following steps:

 
     
 
      [bookmark: pgfId-1760645] Step 1[image: ] In the Configuration Options for CA Certificates pane, click the  CRL Retrieval Methods  tab.

 
      [bookmark: pgfId-1760646]Step 2[image: ] Choose one of the following three retrieval methods:

 
      
       
       		 [bookmark: pgfId-1760647]To enable LDAP for CRL retrieval, check the  Enable Lightweight Directory Access Protocol (LDAP) check box. With LDAP, CRL retrieval starts an LDAP session by connecting to a named LDAP server, accessed by a password. The connection is on TCP port 389 by default. Enter the following required parameters:

 
      

 
     

 
      [bookmark: pgfId-1760648]–[image: ] Name

 
      [bookmark: pgfId-1760649]–[image: ] Password

 
      [bookmark: pgfId-1760650]–[image: ] Confirm Password

 
      [bookmark: pgfId-1760651]–[image: ] Default Server (server name)

 
      [bookmark: pgfId-1760652]–[image: ] Default Port (389) 

 
      
       
       		 [bookmark: pgfId-1760653]To enable HTTP for CRL retrieval, check the  Enable HTTP  check box.

 
       		 [bookmark: pgfId-1760654]To enable SCEP for CRL retrieval, check the  Enable Simple Certificate Enrollment Protocol (SCEP) check box.

 
      

 
     

 
      [bookmark: pgfId-1760657]Step 3[image: ] Click  OK to close this tab. Alternatively, to continue, see the “Configuring OCSP Rules” section.

 
      [bookmark: pgfId-1760659]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760662][bookmark: 73335]Configuring OCSP Rules

 
      [bookmark: pgfId-1760666]The ASA examines OCSP rules in priority order, and applies the first one that matches. X.509 digital certificates are an alternative to using CRLs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760667]Note Make sure that you have configured a certificate map before you try to add OCSP rules. If a certificate map has not been configured, an error message appears. To configure a certificate map, choose Configuration > Network (Client) Access, Advanced > IPsec > Certificate to Connection Profile Maps > Rules > Add. 


      
      
 
     

     

 
      [bookmark: pgfId-1760668]To configure OCSP rules for obtaining revocation status of an X.509 digital certificate, perform the following steps: 

 
     
 
      [bookmark: pgfId-1760669] Step 1[image: ] In the Configuration Options for CA Certificates pane, click the  OCSP Rules  tab.

 
      [bookmark: pgfId-1760670]Step 2[image: ] Choose the certificate map t o match to this OCSP rule. Certificate maps match user permissions to specific fields in a certificate.  The name of the CA that the ASA uses to validate responder certificates appears in the Certificate field. The priority number for the rule appears in the Index field. The URL of the OCSP server for this certificate appears in the URL field.

 
      [bookmark: pgfId-1760674]Step 3[image: ] To add a new OCSP rule, click  Add .

 
      [bookmark: pgfId-1760675]The Add OCSP Rule dialog box appears.

 
      [bookmark: pgfId-1760676]Step 4[image: ] Choose the certificate map to use from the drop-down list.

 
      [bookmark: pgfId-1760677]Step 5[image: ] Choose the certificate to use from the drop-down list. 

 
      [bookmark: pgfId-1760678]Step 6[image: ] Enter the priority number for the rule.

 
      [bookmark: pgfId-1760679]Step 7[image: ] Enter the URL of the OCSP server for this certificate.

 
      [bookmark: pgfId-1760680]Step 8[image: ] When you are done, click  OK to close this dialog box.

 
      [bookmark: pgfId-1760681]The newly added OCSP rule appears in the list.

 
      [bookmark: pgfId-1760682]Step 9[image: ] To edit an existing OCSP rule, select it, and then click  Edit .

 
      [bookmark: pgfId-1760683]Step 10[image: ] To delete an OCSP rule, select it, and then click  Delete .

 
      [bookmark: pgfId-1760686]Step 11[image: ] Click  OK to close this tab. Alternatively, to continue, see the “Configuring Advanced CRL and OCSP Settings” section.

 
      [bookmark: pgfId-1760688]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760691] Configuring Advanced CRL and OCSP Settings [bookmark: 92582]

 
      [bookmark: pgfId-1760692] When a certificate is issued, it is valid for a fixed period of time. Sometimes a CA revokes a certificate before this time period expires; for example, because of security concerns or a change of name or association. CAs periodically issue a signed list of revoked certificates. Enabling revocation checking forces the ASA to check that the CA has not revoked the certificate being verified.  The ASA supports two methods of checking revocation status: CRL and OCSP.

 
      [bookmark: pgfId-1760699]To configure additional CRL and OCSP settings, perform the following steps:

 
     
 
      [bookmark: pgfId-1760700] Step 1[image: ] In the Configuration Options for CA Certificates pane, click the  Advanced  tab.

 
      [bookmark: pgfId-1760701]Step 2[image: ] In the CRL Options area,  enter the number of minutes between cache refreshes. The default is 60 minutes. The range is 1-1440 minutes.   [bookmark: marker-1760702]To avoid having to retrieve the same CRL from a CA repeatedly, the ASA can store retrieved CRLs locally, which is called CRL caching. The CRL cache capacity varies by platform and is cumulative across all contexts. If an attempt to cache a newly retrieved CRL would exceed its storage limits, the ASA removes the least recently used CRL until more space becomes available.

 
      [bookmark: pgfId-1760709]Step 3[image: ] Check the Enforce next CRL update check box to require valid CRLs to have a Next Update value that has not expired. Uncheck the  Enforce next CRL update check box to let valid CRLs with no Next Update value or a Next Update value that has expired.

 
      [bookmark: pgfId-1760713]Step 4[image: ] In the OCSP Options area, enter the URL for the OCSP server. The  ASA uses OCSP servers according to the following order:

 
      [bookmark: pgfId-1760714] 1.[image: ] OCSP URL in a match certificate override rule 

 
      [bookmark: pgfId-1760715] 2.[image: ] OCSP URL configured in the selected OCSP Options attribute

 
      [bookmark: pgfId-1760716] 3.[image: ] AIA field of a remote user certificate

 
      [bookmark: pgfId-1760717]Step 5[image: ] By default, the  Disable nonce extension check box is checked, which cryptographically binds requests with responses to avoid replay attacks. This process works by matching the extension in the request to that in the response, ensuring that they are the same. Uncheck the  Disable nonce extension check box if the OCSP server you are using sends pregenerated responses that do not include this matching nonce extension. 

 
      [bookmark: pgfId-1760718]Step 6[image: ] In the Validation Policy area, choose one of the following options:

 
      
       
       		 [bookmark: pgfId-1760719]Click the  SSL radio button or the  IPsec radio button to restrict the type of remote session that this CA can be used to validate.

 
       		 [bookmark: pgfId-1760720]Click the  SSL and IPsec radio buttons to let the CA validate both types of sessions .  

 
      

 
     

 
      [bookmark: pgfId-1760721]Step 7[image: ] In the Other Options area, choose one of the following options:

 
      
       
       		 [bookmark: pgfId-1760725]Check the  Accept certificates issued by this CA check box to indicate that the ASA should accept certificates from the specified CA.

 
       		 [bookmark: pgfId-1760726]Check the  Accept certificates issued by the subordinate CAs of this CA check box to indicate that the ASA should accept certificates from the subordinate CA.

 
      

 
     

 
      [bookmark: pgfId-1760730]Step 8[image: ] Click  OK to close this tab, and then click  Apply to save your configuration changes.

 
      [bookmark: pgfId-1760731]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760732]What to Do Next

 
      [bookmark: pgfId-1760736]See the “Configuring Identity Certificates Authentication” section.

 
    
 
   
 
    
     [bookmark: pgfId-1760740][bookmark: 68891]Configuring Identity Certificates Authentication[bookmark: marker-1760739]

 
     [bookmark: pgfId-1760744]An identity certificate can be used to authenticate VPN access through the ASA. In the Identity Certificates Authentication pane, you can perform the following tasks:

 
     
     		 [bookmark: pgfId-1760745]Add or import a new identity certificate. 

 
     		 [bookmark: pgfId-1760746]Display details of an identity certificate. 

 
     		 [bookmark: pgfId-1760747]Delete an existing identity certificate. 

 
     		 [bookmark: pgfId-1760748]Export an existing identity certificate. 

 
     		 [bookmark: pgfId-1760749]Install an existing identity certificate. 

 
     		 [bookmark: pgfId-1760750]Enroll for an identity certificate with Entrust. 

 
    

 
     [bookmark: pgfId-1760751]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1760755]Adding or Importing an Identity Certificate

 
     		 [bookmark: pgfId-1760759]Showing Identity Certificate Details

 
     		 [bookmark: pgfId-1760763]Deleting an Identity Certificate

 
     		 [bookmark: pgfId-1760767]Exporting an Identity Certificate

 
     		 [bookmark: pgfId-1760771]Generating a Certificate Signing Request

 
     		 [bookmark: pgfId-1760775]Installing Identity Certificates

 
    

 
     
      [bookmark: pgfId-1760778][bookmark: 55093]Adding or Importing an Identity Certificate

 
      [bookmark: pgfId-1760779]To add or import a new identity certificate configuration, perform the following:

 
     
 
      [bookmark: pgfId-1760780] Step 1[image: ] In the main ASDM application window, choose  Configuration > Remote Access VPN > Certificate Management > Identity Certificates .

 
      [bookmark: pgfId-1760781]Step 2[image: ] Click  Add .

 
      [bookmark: pgfId-1760782]The Add Identity Certificate dialog box appears, with the selected trustpoint name displayed at the top.

 
      [bookmark: pgfId-1760783]Step 3[image: ] To import an identity certificate from an existing file, click the  Import the identity certificate from a file (PKCS12 format with Certificate(s) + Private Key)  radio button.

 
      [bookmark: pgfId-1760784]Step 4[image: ] Enter the passphrase used to decrypt the PKCS12 file.

 
      [bookmark: pgfId-1760785]Step 5[image: ] Enter the path name of the file, or click  Browse to display the Import ID Certificate File dialog box. Find the certificate file, and then click  Import ID Certificate File .

 
      [bookmark: pgfId-1760786]Step 6[image: ] To add a new identity certificate, click the  Add a new identity certificate radio button.

 
      [bookmark: pgfId-1760788]Step 7[image: ] Click  New to display the Add Key Pair dialog box.

 
      [bookmark: pgfId-1760789]Step 8[image: ] Choose the  RSA or  ECDSA key type.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1532244]Note The 4096-bit RSA keys are only supported on the 5580, 5585, or later platforms. If you are configuring a cryptography map to use an RSA or ECDSA trustpoint for authentication, you must first generate the key set. You can then create the trustpoint and reference it in the tunnel group configuration.


      
      
 
     

     

 
      [bookmark: pgfId-1760795]Step 9[image: ] To use the default key pair name, click the  Use default keypair name radio button. 

 
      [bookmark: pgfId-1760796]Step 10[image: ] To use a new key pair name, click the  Enter a new key pair name radio button, and type the new name. The ASA supports multiple key pairs. [bookmark: marker-1760800]

 
      [bookmark: pgfId-1760801]Step 11[image: ] Choose the modulus size from the drop-down list. If you are notsure of the modulus size, consult Entrust.

 
      [bookmark: pgfId-1760802]Step 12[image: ] Choose the key pair usage by clicking the  General purpose radio button (default) or  Special radio button. When you choose the  Special radio button, the ASA generates two key pairs, one for signature use and one for encryption use. This selection indicates that two certificates are required for the corresponding identity.

 
      [bookmark: pgfId-1760806]Step 13[image: ] Click  Generate Now to create new key pairs, and then click  Show to display the Key Pair Details dialog box, which includes the following  display-only information:

 
      
       
       		 [bookmark: pgfId-1760807]The name of the key pair whose public key is to be certified.

 
       		 [bookmark: pgfId-1760808]The time of day and the date when the key pair is generated.

 
       		 [bookmark: pgfId-1760809]The usage of an RSA key pair. 

 
       		 [bookmark: pgfId-1760810]The modulus size (bits) of the key pairs: 512, 768, 1024, and 2048. The default is 1024.

 
       		 [bookmark: pgfId-1760811]The key data, which includes the specific key data in text format.

 
      

 
     

 
      [bookmark: pgfId-1760812]Step 14[image: ] Click  OK when you are done to close the Key Pair Details dialog box.

 
      [bookmark: pgfId-1760813]Step 15[image: ] Choose a certificate subject DN to form the DN in the identity certificate. and then click  Select to display the Certificate Subject DN dialog box.

 
      [bookmark: pgfId-1760814]Step 16[image: ] Choose one or more DN attributes that you want to add from the drop-down list, enter a value, and then click  Add . Available X.500 attributes for the Certificate Subject DN are the following:

 
      
       
       		 [bookmark: pgfId-1760815]Common Name (CN)

 
       		 [bookmark: pgfId-1760816]Department (OU)

 
       		 [bookmark: pgfId-1760817]Company Name (O)

 
       		 [bookmark: pgfId-1760818]Country (C)

 
       		 [bookmark: pgfId-1760819]State/Province (ST)

 
       		 [bookmark: pgfId-1760820]Location (L)

 
       		 [bookmark: pgfId-1760821]E-mail Address (EA)

 
      

 
     

 
      [bookmark: pgfId-1760822]Step 17[image: ] Click  OK when you are done to close the Certificate Subject DN dialog box.

 
      [bookmark: pgfId-1760823]Step 18[image: ] To create self-signed certificates, check the  Generate self-signed certificate check box.

 
      [bookmark: pgfId-1760824]Step 19[image: ] To have the identity certificate act as the local CA, check the  Act as local certificate authority and issue dynamic certificates to TLS proxy  check box.

 
      [bookmark: pgfId-1760826]Step 20[image: ] To establish additional identity certificate settings, click  Advanced .

 
      [bookmark: pgfId-1760827]The Advanced Options dialog box appears, with the following three tabs: Certificate Parameters, Enrollment Mode, and SCEP Challenge Password.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760828]Note Enrollment mode settings and the SCEP challenge password are not available for self-signed certificates.


      
      
 
     

     

 
      [bookmark: pgfId-1760829]Step 21[image: ] Click the  Certificate Parameters tab, and then enter the following information:

 
      
       
       		 [bookmark: pgfId-1760830]The FQDN, an unambiguous domain name, to indicate the position of the node in the DNS tree hierarchy.

 
       		 [bookmark: pgfId-1760831]The e-mail address associated with the identity certificate.

 
       		 [bookmark: pgfId-1760835]The ASA IP address on the network in four-part, dotted-decimal notation.

 
       		 [bookmark: pgfId-1760839]To add the ASA serial number to the certificate parameters, check the  Include serial number of the device check box.

 
      

 
     

 
      [bookmark: pgfId-1760840]Step 22[image: ] Click the  Enrollment Mode tab, and then enter the following information:

 
      
       
       		 [bookmark: pgfId-1760841]Choose the enrollment method by clicking the  Request by manual enrollment radio button or the  Request from a CA radio button.

 
       		 [bookmark: pgfId-1760842]The enrollment URL of the certificate to be automatically installed through SCEP.

 
       		 [bookmark: pgfId-1760843]The maximum number of minutes allowed to retry installing an identity certificate. The default is one minute.

 
       		 [bookmark: pgfId-1760844]The maximum number of retries allowed for installing an identity certificate. The default is zero, which indicates an unlimited number of retries within the retry period.

 
      

 
     

 
      [bookmark: pgfId-1760845]Step 23[image: ] Click the  SCEP Challenge Password tab, and then enter the following information:

 
      
       
       		 [bookmark: pgfId-1760846]The SCEP password

 
       		 [bookmark: pgfId-1760847]The SCEP password confirmation

 
      

 
     

 
      [bookmark: pgfId-1760848]Step 24[image: ] Click  OK when you are done to close the Advanced Options dialog box.

 
      [bookmark: pgfId-1760849]Step 25[image: ] Click  Add Certificate in the Add Identity Certificate dialog box.

 
      [bookmark: pgfId-1760850]The new identity certificate appears in the Identity Certificates list.

 
      [bookmark: pgfId-1760851]Step 26[image: ] Click  Apply to save the new identity certificate configuration. 

 
      [bookmark: pgfId-1760852]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760855][bookmark: 54494]Showing Identity Certificate Details

 
      [bookmark: pgfId-1760856]To show detailed information about the selected identity certificate, click  Show Details to display the Certificate Details dialog box, which includes the following three  display-only tabs:

 
      
      		 [bookmark: pgfId-1760857]The General tab displays the values for type, serial number, status, usage, public key type, CRL distribution point, the times within which the certificate is valid, and associated trustpoints. The values apply to both available and pending status.

 
      		 [bookmark: pgfId-1760858]The Issued to tab displays the X.500 fields of the subject DN or certificate owner and their values. The values apply only to available status.

 
      		 [bookmark: pgfId-1760859]The Issued by tab displays the X.500 fields of the entity granting the certificate. The values apply only to available status.

 
     

 
    
 
     
      [bookmark: pgfId-1760861][bookmark: 93627]Deleting an Identity Certificate

 
      [bookmark: pgfId-1760862]To remove an identity certificate configuration, select it, and then click  Delete . 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1760863]Note After you delete a certificate configuration, it cannot be restored. To recreate the deleted certificate, click Add to reenter all of the certificate configuration information.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1760866][bookmark: 98383]Exporting an Identity Certificate

 
      [bookmark: pgfId-1760867]You can export a certificate configuration with all associated keys and certificates in PKCS12 format, which is the public key cryptography standard, and can be base64 encoded or in hexadecimal format. A complete configuration includes the entire chain (root CA certificate, identity certificate, key pair) but not enrollment settings (subject name, FQDN and so on). This feature is commonly used in a failover or load-balancing configuration to replicate certificates across a group of ASAs; for example, remote access clients calling in to a central organization that has several units to service the calls. These units must have equivalent certificate configurations. In this case, an administrator can export a certificate configuration and then import it across the group of ASAs.

 
      [bookmark: pgfId-1760874]To export an identity certificate, perform the following steps:

 
     
 
      [bookmark: pgfId-1760875] Step 1[image: ] Click  Export to display the Export Certificate dialog box.

 
      [bookmark: pgfId-1760876]Step 2[image: ] Enter the name of the PKCS12 format file to use in exporting the certificate configuration. Alternatively, click  Browse to display the Export ID Certificate File dialog box to find the file to which you want to export the certificate configuration.

 
      [bookmark: pgfId-1760877]Step 3[image: ] Choose the certificate format by clicking the  PKCS12 Format radio button or the  PEM Format radio button.

 
      [bookmark: pgfId-1760878]Step 4[image: ] Enter the passphrase used to encrypt the PKCS12 file for export.

 
      [bookmark: pgfId-1760879]Step 5[image: ] Confirm the encryption passphrase.

 
      [bookmark: pgfId-1760880]Step 6[image: ] Click  Export Certificate to export the certificate configuration.

 
      [bookmark: pgfId-1760881]An information dialog box appears, informing you that the certificate configuration file has been successfully exported to the location that you specified.

 
      [bookmark: pgfId-1760882]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760885][bookmark: 23374]Generating a Certificate Signing Request

 
      [bookmark: pgfId-1760886]To generate a certificate signing request to send to Entrust, perform the following steps:

 
     
 
      [bookmark: pgfId-1760887] Step 1[image: ]  Click   Enroll ASA SSL VPN with Entrust  to display the Generate Certificate Signing Request dialog box. 

 
      [bookmark: pgfId-1760888]Step 2[image: ]  In the Key Pair area, perform the following steps[image: ]: 

 
      [bookmark: pgfId-1760889] a.[image: ]  Choose one of the configured key pairs from the drop-down list. 

 
      [bookmark: pgfId-1760890] b.[image: ]  Click   Show   to display the Key Details dialog box, which provides information about the selected key pair, including date and time generated, usage (general or special purpose), modulus size, and key data. 

 
      [bookmark: pgfId-1760891] c.[image: ] Click  OK when you are done to close  Key Details dialog box.

 
      [bookmark: pgfId-1760894] d.[image: ]  Click   New   to display the Add Key Pair dialog box. To continue, go to Step 8 of the “Adding or Importing an Identity Certificate” section. When you generate the key pair, you can send it to the ASA or save it to a file. 

 
      [bookmark: pgfId-1760899]Step 3[image: ] In the Certificate Subject DN area, enter the following information:

 
      [bookmark: pgfId-1760903] a.[image: ]  The FQDN or IP address of the ASA. 

 
      [bookmark: pgfId-1760904] b.[image: ]  The name of the company. 

 
      [bookmark: pgfId-1760905] c.[image: ]  The two-letter country code. 

 
      [bookmark: pgfId-1760906]Step 4[image: ] In the Optional Parameters area,  perform the following steps[image: ] :

 
      [bookmark: pgfId-1760908] a.[image: ]  Click   Select  to display the Additional DN Attributes dialog box.  

 
      [bookmark: pgfId-1760909] b.[image: ]  Choose the attribute to add from the drop-down list, and then enter a value. 

 
      [bookmark: pgfId-1760910] c.[image: ]  Click   Add  to add each attribute to the attribute table. 

 
      [bookmark: pgfId-1760911] d.[image: ] Click  Delete to remove an attribute from the attribute table.

 
      [bookmark: pgfId-1760912] e.[image: ] Click  OK when you are done to close the  Additional DN Attributes dialog box. 

 
      [bookmark: pgfId-1760913] The added attributes appear in the Additional DN Attributes field. 

 
      [bookmark: pgfId-1760914]Step 5[image: ]  Enter additional fully qualified domain name information if the CA requires it. 

 
      [bookmark: pgfId-1760915]Step 6[image: ]  Click   Generate Request   to generate the certificate signing request, which you can then  send   to Entrust, or save to a file and send later.  

 
      [bookmark: pgfId-1760916]The Enroll with Entrust dialog box appears, with the CSR displayed. 

 
      [bookmark: pgfId-1760917]Step 7[image: ] To complete the enrollment process, click the  request a certificate from Entrust link by copying and pasting the CSR provided and submitting it through the Entrust web form, provided at http://www.entrust.net/cisco/. Alternatively, to enroll at a later time, save the generated CSR to a file, then click the  enroll with Entrust link on the Identity Certificates pane to complete the enrollment process.

 
      [bookmark: pgfId-1760918]Step 8[image: ] Entrust issues a certificate after verifying the authenticity of your request. which may take several days. You then need to install the certificate by selecting the pending request in the Identity Certificate pane and clicking  Install . Click  Close to close the Enroll with Entrust dialog box.

 
      [bookmark: pgfId-1760919]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760922][bookmark: 72637]Installing Identity Certificates

 
      [bookmark: pgfId-1760923]The Install  button on the Identity Certificates pane is dimmed unless an enrollment is pending. Whenever the ASA receives a CSR, the Identity Certificates pane displays the pending ID certificate. When you select the pending Identity Certificate, the Install button activates. 

 
      [bookmark: pgfId-1760930]When you transmit the pending request to a CA, the CA enrolls it and returns a certificate to the ASA. After you have received the certificate, click  Install and highlight the appropriate identity certificate to complete the operation. 

 
      [bookmark: pgfId-1760931]To installing a pending identity certificate, perform the following steps:

 
     
 
      [bookmark: pgfId-1760932] Step 1[image: ] In the Identity Certificates pane, click  Add to display the Add Identity Certificate dialog box.

 
      [bookmark: pgfId-1760933]Step 2[image: ] In the Add Identity Certificate dialog box, click the  Add a new identity certificate radio button.

 
      [bookmark: pgfId-1760934]Step 3[image: ] (Optional) Change the key pair or create a new key pair. A key pair is required.

 
      [bookmark: pgfId-1760935]Step 4[image: ] Enter the Certificate Subject DN information, and then click  Select  to display the Certificate Subject DN dialog box.

 
      [bookmark: pgfId-1760936]Step 5[image: ] Specify all of the subject DN attributes required by the CA involved, and then click  OK to close the Certificate Subject DN dialog box.

 
      [bookmark: pgfId-1760937]Step 6[image: ] In the Add Identity Certificate dialog box, click  Advanced to display the Advanced Options dialog box.

 
      [bookmark: pgfId-1760940]Step 7[image: ] To continue, see Steps 17 through 23 of the “Configuring Identity Certificates Authentication” section.

 
      [bookmark: pgfId-1760942]Step 8[image: ] In the Add Identity Certificate dialog box, click  Add Certificate .

 
      [bookmark: pgfId-1760943]The Identity Certificate Request dialog box appears.

 
      [bookmark: pgfId-1760944]Step 9[image: ] Enter the CSR file name of type, text, such as c:\verisign-csr.txt, and then click  OK .

 
      [bookmark: pgfId-1760945]Step 10[image: ] Send the CSR text file to the CA. Alternatively, you can paste the text file into the CSR enrollment page on the CA website.

 
      [bookmark: pgfId-1760946]Step 11[image: ] When the CA returns the Identity Certificate to you, go to the Identity Certificates pane, select the pending certificate entry, and click  Install .

 
      [bookmark: pgfId-1760947]The Install Identity Certificate dialog box appears. 

 
      [bookmark: pgfId-1760948]Step 12[image: ] Choose one of the following options by clicking the applicable radio button: 

 
      
       
       		 [bookmark: pgfId-1760949] Install from a file . 

 
      

 
     

 
      [bookmark: pgfId-1760950]Alternatively, click  Browse to search for the file.

 
      
       
       		 [bookmark: pgfId-1760951] Paste the certificate data in base-64 format .

 
      

 
     

 
      [bookmark: pgfId-1760952]Paste the copied certificate data into the area provided.

 
      [bookmark: pgfId-1760953]Step 13[image: ] Click  Install Certificate .

 
      [bookmark: pgfId-1760957]Step 14[image: ] Click  Apply to save the newly installed certificate with the ASA configuration.

 
      [bookmark: pgfId-1760958]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1760959]What to Do Next

 
      [bookmark: pgfId-1760963]See the “Configuring Code Signer Certificates” section.

 
    
 
   
 
    
     [bookmark: pgfId-1760967][bookmark: 46552]Configuring Code Signer Certificates[bookmark: marker-1760966]

 
     [bookmark: pgfId-1760968]Code signing appends a digital signature to the actual executable code. This digital signature provides enough information to authenticate the signer, and ensure that the code has not been modified after being signed. 

 
     [bookmark: pgfId-1760969]Code signer certificates are special certificates whose associated private keys are used to create digital signatures. The certificates used to sign code are obtained from a CA, in which the signed code reveals the certificate origin. You can import code signer certificates on the Code Signer pane, or choose  Configuration > Remote Access VPN > Clientless SSL VPN Access > Advanced > Java Code Signe r. 

 
     [bookmark: pgfId-1760970]In the Code Signer pane, you can perform the following tasks:

 
     
     		 [bookmark: pgfId-1760971]Display details of a code signer certificate.

 
     		 [bookmark: pgfId-1760972]Delete an existing code signer certificate.

 
     		 [bookmark: pgfId-1760973]Import an existing code signer certificate.

 
     		 [bookmark: pgfId-1760974]Export an existing code signer certificate. 

 
     		 [bookmark: pgfId-1760975]Enroll for a code signer certificate with Entrust. 

 
    

 
     [bookmark: pgfId-1760976]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1760980]Showing Code Signer Certificate Details

 
     		 [bookmark: pgfId-1760984]Deleting a Code Signer Certificate

 
     		 [bookmark: pgfId-1760988]Importing a Code Signer Certificate

 
     		 [bookmark: pgfId-1760992]Exporting a Code Signer Certificate

 
    

 
     
      [bookmark: pgfId-1760994][bookmark: 63632]Showing Code Signer Certificate Details

 
      [bookmark: pgfId-1760995]To show detailed information about the selected identity certificate, click  Show Details to display the Certificate Details dialog box, which includes the following three  display-only tabs:

 
      
      		 [bookmark: pgfId-1760997]The General tab displays the values for type, serial number, status, usage, public key type, CRL distribution point, the times within which the certificate is valid, and associated trustpoints. The values apply to both available and pending status.

 
      		 [bookmark: pgfId-1760998]The Issued to tab displays the X.500 fields of the subject DN or certificate owner and their values. The values apply only to available status.

 
      		 [bookmark: pgfId-1760999]The Issued by tab displays the X.500 fields of the entity granting the certificate. The values apply only to available status.

 
     

 
    
 
     
      [bookmark: pgfId-1761001][bookmark: 80306]Deleting a Code Signer Certificate

 
      [bookmark: pgfId-1761002]To remove a code signer certificate configuration, select it, and then click  Delete . 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761003]Note After you delete a certificate configuration, it cannot be restored. To recreate the deleted certificate, click Import to reenter all of the certificate configuration information.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1761006][bookmark: 40350]Importing a Code Signer Certificate

 
      [bookmark: pgfId-1761007]To import a code signer certificate, perform the following steps:

 
     
 
      [bookmark: pgfId-1761008] Step 1[image: ] In the Code Signer pane, click  Import to display the Import Certificate dialog box.

 
      [bookmark: pgfId-1761009]Step 2[image: ] Enter the passphrase used to decrypt the PKCS12-format file.

 
      [bookmark: pgfId-1761010]Step 3[image: ] Enter the name of the file to import, or click  Browse to display the Import ID Certificate File dialog box and search for the file. 

 
      [bookmark: pgfId-1761011]Step 4[image: ] Select the file to import and click  Import ID Certificate File .

 
      [bookmark: pgfId-1761012]The selected certificate file appears in the Import Certificate dialog box.

 
      [bookmark: pgfId-1761013]Step 5[image: ] Click  Import Certificate .

 
      [bookmark: pgfId-1761014]The imported certificate appears in the Code Signer pane.

 
      [bookmark: pgfId-1761015]Step 6[image: ] Click  Apply to save the newly imported code signer certificate configuration.

 
      [bookmark: pgfId-1761016]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761019][bookmark: 68568]Exporting a Code Signer Certificate

 
      [bookmark: pgfId-1761020]To export a code signer certificate, perform the following steps:

 
     
 
      [bookmark: pgfId-1761021] Step 1[image: ] In the Code Signer pane, click  Export to display the Export Certificate dialog box.

 
      [bookmark: pgfId-1761022]Step 2[image: ] Enter the name of the PKCS12 format file to use in exporting the certificate configuration. 

 
      [bookmark: pgfId-1761023]Step 3[image: ] In the Certificate Format area, to use the public key cryptography standard, which can be base64 encoded or in hexadecimal format, click the  PKCS12 format  radio button. Otherwise, click the  PEM format radio button.

 
      [bookmark: pgfId-1761024]Step 4[image: ] Click Browse to display the  Export ID Certificate File  dialog box to find the file to which you want to export the certificate configuration.

 
      [bookmark: pgfId-1761025]Step 5[image: ] Select the file and click  Export ID Certificate File .

 
      [bookmark: pgfId-1761026]The selected certificate file appears in the Export Certificate dialog box.

 
      [bookmark: pgfId-1761027]Step 6[image: ] Enter the passphrase used to decrypt the PKCS12 format file for export.

 
      [bookmark: pgfId-1761028]Step 7[image: ] Confirm the decryption passphrase.

 
      [bookmark: pgfId-1761029]Step 8[image: ] Click  Export Certificate to export the certificate configuration.

 
      [bookmark: pgfId-1761030]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761031]What to Do Next

 
      [bookmark: pgfId-1761035]See the “Authenticating Using the Local CA” section.

 
    
 
   
 
    
     [bookmark: pgfId-1761039][bookmark: 48567]Authenticating Using the Local CA[bookmark: marker-1761038]

 
     [bookmark: pgfId-1761043]The local CA provides a secure, configurable in-house authority that resides on the ASA for certificate authentication to use with browser-based and client-based SSL VPN connections. 

 
     [bookmark: pgfId-1761044]Users enroll by logging in to a specified website. The local CA integrates basic certificate authority operations on the ASA, deploys certificates, and provides secure revocation checking of issued certificates. 

 
     [bookmark: pgfId-1761048]The local CA lets you perform the following tasks:

 
     
     		 [bookmark: pgfId-1761049]Configure the local CA server. 

 
     		 [bookmark: pgfId-1761050]Revoke and unrevoke local CA certificates. 

 
     		 [bookmark: pgfId-1761051]Update CRLs. 

 
     		 [bookmark: pgfId-1761052]Add, edit, and delete local CA users. 

 
    

 
     [bookmark: pgfId-1761053]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1761057]Configuring the Local CA Server

 
     		 [bookmark: pgfId-1761061]Deleting the Local CA Server

 
    

 
     
      [bookmark: pgfId-1761063][bookmark: 21213]Configuring the Local CA Server

 
      [bookmark: pgfId-1761068]To configure a local CA server on the ASA, perform the following steps:

 
     
 
      [bookmark: pgfId-1761069] Step 1[image: ] Choose  Configuration > Remote Access VPN > Certificate Management > Local Certificate Authority > CA Server .

 
      [bookmark: pgfId-1761070]Step 2[image: ] To activate the local CA server, check the  Enable Certificate Authority Server  check box. The default setting is disabled (unchecked). After you enable the local CA server, the ASA generates the local CA server certificate, key pair, and necessary database files, then archives the local CA server certificate and key pair in a PKCS12 file. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761074]Note Be sure to review all optional settings carefully before you enable the configured local CA. After you enable it, the certificate issuer name and key size server values cannot be changed. 


      
      
 
     

     

 
      [bookmark: pgfId-1761075]The self-signed certificate key usage extension enables key encryption, key signature, CRL signature, and certificate signature. 

 
      [bookmark: pgfId-1761076]Step 3[image: ] When you enable the local CA for the first time, you must enter and confirm an alphanumeric Enable passphrase, which must have a minimum of seven, alphanumeric characters. The passphrase protects the local CA certificate and the local CA certificate key pair archived in storage, and secures the local CA server from unauthorized or accidental shutdown. The passphrase is required to unlock the PKCS12 archive if the local CA certificate or key pair is lost and must be restored.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761077]Note The Enable passphrase is required to enable the local CA server. Be sure to keep a record of the Enable passphrase in a safe location.


      
      
 
     

     

 
      [bookmark: pgfId-1761078]Step 4[image: ] Click  Apply to save the local CA certificate and key pair, so the configuration is not lost if you reboot the ASA.

 
      [bookmark: pgfId-1761082]Step 5[image: ] To change or reconfigure the local CA after the local CA has been configured for the first time, you must shut down the local CA server on the ASA by unchecking the  Enable Certificate Authority Server  check box. In this state, the configuration and all associated files remain in storage and enrollment is disabled. 

 
      [bookmark: pgfId-1761086]After the configured local CA has been enabled, the following two settings are  display-only :

 
      
       
       		 [bookmark: pgfId-1761087]The Issuer Name field, which lists the issuer subject name and domain name, and is formed using the username and the subject-name-default DN setting as cn=FQDN. The local CA server is the entity that grants the certificate. The default certificate name is provided in the format, cn=hostname.domainname.

 
       		 [bookmark: pgfId-1761088]The CA Server Key Size setting, which is used for the server certificate generated for the local CA server. Key sizes can be 512, 768, 1024, or 2048 bits per key. The default is 1024 bits per key. We recommend that you use a key size of at least 2048.

 
      

 
     

 
      [bookmark: pgfId-1761089]Step 6[image: ] From the drop-down list, choose the client key size of the key pair to be generated for each user certificate issued by the local CA server. Key sizes can be 512, 768, 1024, or 2048 bits per key. The default is 1024 bits per key. We recommend that you use a key size of at least 2048.

 
      [bookmark: pgfId-1761090]Step 7[image: ] Enter the CA certificate lifetime value, which specifies the number of days that the CA server certificate is valid. The default is 3650 days (10 years). Make sure that you limit the validity period of the certificate to less than the recommended end date of 03:14:08 UTC, January 19, 2038.

 
      [bookmark: pgfId-1761091]The local CA server automatically generates a replacement CA certificate 30 days before expiration, which enables the replacement certificate to be exported and imported onto any other devices for local CA certificate validation of user certificates that have been issued by the local CA after they have expired. 

 
      [bookmark: pgfId-1761092]To notify users of the upcoming expiration, the following syslog message appears in the Latest ASDM Syslog Messages pane:

 
     
      [bookmark: pgfId-1761093]%ASA-1-717049: Local CA Server certificate is due to expire in days days and a replacement certificate is available for export.
     

      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761094]Note When notified of this automatic rollover, the administrator must take action to make sure that the new local CA certificate is imported to all necessary devices before it expires.


      
      
 
     

     

 
      [bookmark: pgfId-1761095]Step 8[image: ] Enter the client certificate lifetime value, which specifies the number of days that a user certificate issued by the CA server is valid. The default is 365 days (one year). Make sure that you limit the validity period of the certificate to less than the recommended end date of 03:14:08 UTC, January 19, 2038.

 
      [bookmark: pgfId-1761096]In the SMTP Server & Email Settings area, you set up e-mail access for the local CA server by specifying the following settings:

 
      [bookmark: pgfId-1761097] a.[image: ] Enter the SMTP mail server name or IP address. Alternatively, click the ellipses (...) to display the Browse Server Name/IP Address dialog box, where you can choose the server name or IP address. Click  OK when you are done to close the Browse Server Name/IP Address dialog box.

 
      [bookmark: pgfId-1761098] b.[image: ] Enter the from address, from which to send e-mail messages to local CA users, in the format “adminname@hostname.com.” Automatic e-mail messages carry one-time passwords to newly enrolled users and issue e-mail messages when certificates need to be renewed or updated. 

 
      [bookmark: pgfId-1761099] c.[image: ] Enter the subject, which specifies the subject line in all messages that are sent to users by the local CA server. If you do not specify a subject, the default is “Certificate Enrollment Invitation.”

 
      [bookmark: pgfId-1761100]Step 9[image: ] To configure additional options, click the  More Options  drop-down arrow.

 
      [bookmark: pgfId-1761104]Step 10[image: ] Enter the CRL distribution point, which is the CRL location on the ASA. The default location is http://hostname.domain/+CSCOCA+/asa_ca.crl. 

 
      [bookmark: pgfId-1761105]Step 11[image: ] To make the CRL available for HTTP download on a given interface and port, choose a publish-CRL interface from the drop-down list. Then enter the port number, which can be any port number from 1-65535. The default port number is TCP port 80. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761106]Note You cannot rename the CRL; it always has the name, LOCAL-CA-SERVER.crl.


      
      
 
     

     

 
      [bookmark: pgfId-1761107]For example, enter the URL, http://10.10.10.100/user8/my_crl_file.  In this case, only the interface with the specified IP address works and when the request comes in, the ASA matches the path, /user8/my_crl_file to the configured URL. When the path matches, the ASA returns the stored CRL file. 

 
      [bookmark: pgfId-1761114]Step 12[image: ] Enter the CRL lifetime in hours that the CRL is valid. The default for the CA certificate is six hours. 

 
      [bookmark: pgfId-1761115]The local CA updates and reissues the CRL each time that a user certificate is revoked or unrevoked, but if no revocation changes occur, the CRL is reissued once every CRL lifetime. You can force an immediate CRL update and regeneration by clicking  Request CRL  in the CA Certificates pane.

 
      [bookmark: pgfId-1761116]Step 13[image: ] Enter the database storage location to specify a storage area for the local CA configuration and data files. The ASA accesses and implements user information, issued certificates, and revocation lists using a local CA database. Alternatively, to specify an external file, enter the path name to the external file or click  Browse to display the Database Storage Location dialog box.

 
      [bookmark: pgfId-1761120]Step 14[image: ] Choose the storage location from the list of folders that appears, and click  OK .

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761121]Note Flash memory can store a database with 3500 users or less; a database of more than 3500 users requires external storage.


      
      
 
     

     

 
      [bookmark: pgfId-1761122]Step 15[image: ] Enter a default subject (DN string) to append to a username on issued certificates. The permitted DN attributes are provided in the following list:

 
      
       
       		 [bookmark: pgfId-1761123]CN (Common Name)

 
       		 [bookmark: pgfId-1761124]SN (Surname)

 
       		 [bookmark: pgfId-1761125]O (Organization Name)

 
       		 [bookmark: pgfId-1761126]L (Locality)

 
       		 [bookmark: pgfId-1761127]C (Country)

 
       		 [bookmark: pgfId-1761128]OU (Organization Unit)

 
       		 [bookmark: pgfId-1761129]EA (E-mail Address)

 
       		 [bookmark: pgfId-1761130]ST (State/Province)

 
       		 [bookmark: pgfId-1761131]T (Title)

 
      

 
     

 
      [bookmark: pgfId-1761132]Step 16[image: ] Enter the number of hours for which an enrolled user can retrieve a PKCS12 enrollment file to enroll and retrieve a user certificate. The enrollment period is independent of the OTP expiration period. The default is 24 hours.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761133]Note Certificate enrollment for the local CA is supported only for clientless SSL VPN connections. For this type of connection, communications between the client and the ASA is through a web browser that uses standard HTML.


      
      
 
     

     

 
      [bookmark: pgfId-1761137]Step 17[image: ] Enter the length of time that a one-time password e-mailed to an enrolling user is valid. The default is 72 hours.

 
      [bookmark: pgfId-1761138]Step 18[image: ] Enter the number of days before expiration reminders are e-mailed to users. The default is 14 days.

 
      [bookmark: pgfId-1761139]Step 19[image: ] Click  Apply to save the new or modified CA certificate configuration. Alternatively, click  Rese t to remove any changes and return to the original settings.

 
      [bookmark: pgfId-1761140]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761142][bookmark: 55202]Deleting the Local CA Server

 
      [bookmark: pgfId-1761146]To remove the local CA server from the ASA, perform the following steps:

 
     
 
      [bookmark: pgfId-1761147] Step 1[image: ] In the CA Server pane, click  Delete Certificate Authority Serve r. 

 
      [bookmark: pgfId-1761148]The Delete Certificate Authority dialog box appears.

 
      [bookmark: pgfId-1761149]Step 2[image: ] To delete the CA server, click  OK . To retain the CA server, click  Cancel .

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761150]Note After you delete the local CA server, it cannot be restored or recovered. To recreate the deleted CA server configuration, you must reenter all of the CA server configuration information.


      
      
 
     

     

 
      [bookmark: pgfId-1761151]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761152]What to Do Next

 
      [bookmark: pgfId-1761156]See the “Managing the User Database” section.

 
    
 
   
 
    
     [bookmark: pgfId-1761160][bookmark: 26845]Managing the User Database[bookmark: marker-1761159]

 
     [bookmark: pgfId-1761161]The local CA user database includes user identification information and user status (enrolled, allowed, revoked, and so on). In the Manage User Database pane, you can perform the following tasks:

 
     
     		 [bookmark: pgfId-1761162]Add a user to the local CA database.

 
     		 [bookmark: pgfId-1761163]Change existing user identification information. 

 
     		 [bookmark: pgfId-1761164]Remove a user from the local CA database.

 
     		 [bookmark: pgfId-1761165]Enroll a user. 

 
     		 [bookmark: pgfId-1761166]Update CRLs.

 
     		 [bookmark: pgfId-1761167]E-mail OTPs to a user.

 
     		 [bookmark: pgfId-1761168]View or regenerate (replace) an OTP. 

 
    

 
     [bookmark: pgfId-1761169]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1761173]Adding a Local CA User

 
     		 [bookmark: pgfId-1761177]Sending an Initial OTP or Replacing OTPs

 
     		 [bookmark: pgfId-1761181]Editing a Local CA User

 
     		 [bookmark: pgfId-1761185]Deleting a Local CA User

 
     		 [bookmark: pgfId-1761189]Allowing User Enrollment

 
     		 [bookmark: pgfId-1761193]Viewing or Regenerating an OTP

 
    

 
     
      [bookmark: pgfId-1761196][bookmark: 46924]Adding a Local CA User 

 
      [bookmark: pgfId-1761197]To add a local CA user, perform the following steps:

 
     
 
      [bookmark: pgfId-1761198] Step 1[image: ] To enter a new user into the local CA database, click  Add to display the  Add User dialog box. 

 
      [bookmark: pgfId-1761199]Step 2[image: ] Enter a valid username.

 
      [bookmark: pgfId-1761200]Step 3[image: ] Enter an existing valid e-mail address.

 
      [bookmark: pgfId-1761201]Step 4[image: ] Enter the subject (DN string). Alternatively, click  Select to display the Certificate Subject DN dialog box. 

 
      [bookmark: pgfId-1761202]Step 5[image: ] Choose one or more DN attributes that you want to add from the drop-down list, enter a value, and then click  Add . Available X.500 attributes for the Certificate Subject DN are the following:

 
      
       
       		 [bookmark: pgfId-1761203]Common Name (CN)

 
       		 [bookmark: pgfId-1761204]Department (OU)

 
       		 [bookmark: pgfId-1761205]Company Name (O)

 
       		 [bookmark: pgfId-1761206]Country (C)

 
       		 [bookmark: pgfId-1761207]State/Province (ST)

 
       		 [bookmark: pgfId-1761208]Location (L)

 
       		 [bookmark: pgfId-1761209]E-mail Address (EA)

 
      

 
     

 
      [bookmark: pgfId-1761210]Step 6[image: ] Click  OK when you are done to close the Certificate Subject DN dialog box.

 
      [bookmark: pgfId-1761211]Step 7[image: ] Check the  Allow enrollment check box to enroll the user, and then click  Add User .

 
      [bookmark: pgfId-1761212]The new user appears in the Manage User Database pane.

 
      [bookmark: pgfId-1761213]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761215][bookmark: 11336]Sending an Initial OTP or Replacing OTPs

 
      [bookmark: pgfId-1761216]To automatically send an e-mail notice of enrollment permission with a unique OTP and the local CA enrollment URL to the newly added user, click  Email OTP .

 
      [bookmark: pgfId-1761217]An Information dialog box appears indicating that the OTP was sent to the new user. 

 
      [bookmark: pgfId-1761218]To automatically reissue a new OTP and send an e-mail notice with the new password to an existing or new user, click  Replace OTP .

 
    
 
     
      [bookmark: pgfId-1761221][bookmark: 58354]Editing a Local CA User

 
      [bookmark: pgfId-1761222]To modify information about an existing local CA user in the database, perform the following steps:

 
     
 
      [bookmark: pgfId-1761223] Step 1[image: ] Select the specific user and click  Edit to display the Edit User dialog box.

 
      [bookmark: pgfId-1761224]Step 2[image: ] Enter a valid username.

 
      [bookmark: pgfId-1761225]Step 3[image: ] Enter an existing valid e-mail address.

 
      [bookmark: pgfId-1761226]Step 4[image: ] Enter the subject (DN string). Alternatively, click  Select to display the Certificate Subject DN dialog box. 

 
      [bookmark: pgfId-1761227]Step 5[image: ] Choose one or more DN attributes that you want to change from the drop-down list, enter a value, and then click  Add  or Delete . Available X.500 attributes for the Certificate Subject DN are the following:

 
      
       
       		 [bookmark: pgfId-1761228]Common Name (CN)

 
       		 [bookmark: pgfId-1761229]Department (OU)

 
       		 [bookmark: pgfId-1761230]Company Name (O)

 
       		 [bookmark: pgfId-1761231]Country (C)

 
       		 [bookmark: pgfId-1761232]State/Province (ST)

 
       		 [bookmark: pgfId-1761233]Location (L)

 
       		 [bookmark: pgfId-1761234]E-mail Address (EA)

 
      

 
     

 
      [bookmark: pgfId-1761235]Step 6[image: ] Click  OK when you are done to close the Certificate Subject DN dialog box.

 
      [bookmark: pgfId-1761236]Step 7[image: ] Check the  Allow enrollment check box to reenroll the user, and then click  Edit User .

 
      [bookmark: pgfId-1761237]The updated user details appear in the Manage User Database pane.

 
      [bookmark: pgfId-1761238]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761240][bookmark: 49315]Deleting a Local CA User

 
      [bookmark: pgfId-1761241]To remove the user from the database and any certificates issued to that user from the local CA database, select the user, and then click  Delete . 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761242]Note A deleted user cannot be restored. To recreate the deleted user record, click Add to reenter all of the user information.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1761244][bookmark: 55263]Allowing User Enrollment

 
      [bookmark: pgfId-1761245]To enroll the selected user, click A llow Enrollment .

 
      [bookmark: pgfId-1761246]The status of the user changes to “enrolled” in the Manage User Database pane.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1761247]Note If the user is already enrolled, an error message appears.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1761250][bookmark: 91028]Viewing or Regenerating an OTP

 
      [bookmark: pgfId-1761251]To view or regenerate the OTP of the selected user, perform the following steps:

 
     
 
      [bookmark: pgfId-1761252] Step 1[image: ] Click View/Regenerate OTP to display the View & Regenerate OTP dialog box.

 
      [bookmark: pgfId-1761253]The current OTP appears. 

 
      [bookmark: pgfId-1761254]Step 2[image: ] After you are done, click  OK to close the View & Regenerate OTP dialog box.

 
      [bookmark: pgfId-1761255]Step 3[image: ] To regenerate the OTP, click  Regenerate OTP .

 
      [bookmark: pgfId-1761256]The newly generated OTP appears.

 
      [bookmark: pgfId-1761257]Step 4[image: ] Click  OK to close the View & Regenerate OTP dialog box.

 
      [bookmark: pgfId-1761258]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1761259]What to Do Next

 
      [bookmark: pgfId-1761263]See the “Managing User Certificates” section.

 
    
 
   
 
    
     [bookmark: pgfId-1761266][bookmark: 38366]Managing User Certificates

 
     [bookmark: pgfId-1761267]To change the certificate status, perform the following steps:

 
    
 
     [bookmark: pgfId-1761268] Step 1[image: ] In the Manage User Certificates pane, select specific certificates by username or by certificate serial number. 

 
     [bookmark: pgfId-1761269]Step 2[image: ] Choose one of the following options:

 
     
      
      		 [bookmark: pgfId-1761270]If the user certificate lifetime period runs out, to remove user access, click  Revoke . The local CA also marks the certificate as revoked in the certificate database, automatically updates the information, and reissues the CRL.

 
      		 [bookmark: pgfId-1761271]To restore access, select a revoked certificate and click  Unrevoke . The local CA also marks the certificate as unrevoked in the certificate database, automatically updates the certificate information, and reissues an updated CRL. 

 
     

 
    

 
     [bookmark: pgfId-1761272]Step 3[image: ] Click  Apply when you are done to save your changes.

 
     [bookmark: pgfId-1761273]


     
     
 
    
  
    

 
     
      [bookmark: pgfId-1761274]What to Do Next

 
      [bookmark: pgfId-1761278]See the “Monitoring CRLs” section.

 
    
 
   
 
    
     [bookmark: pgfId-1761281][bookmark: 58073]Monitoring CRLs

 
     [bookmark: pgfId-1761282]To monitor CRLs, perform the following steps:

 
    
 
     [bookmark: pgfId-1761283] Step 1[image: ] In the ASDM main application window, choose  Monitoring > Properties > CRL .

 
     [bookmark: pgfId-1761284]Step 2[image: ] In the CRL area, choose the CA certificate name from the drop-down list.

 
     [bookmark: pgfId-1761285]Step 3[image: ] To display CRL details, click  View CRL . For example:

 
    
     [bookmark: pgfId-1761286]CRL Issuer Name: 
    

    
     [bookmark: pgfId-1761287] cn=asa4.cisco.com
    

    
     [bookmark: pgfId-1761288] LastUpdate: 09:58:34 UTC Nov 11 2010
    

    
     [bookmark: pgfId-1761289] NextUpdate: 15:58:34 UTC Nov 11 2010
    

    
     [bookmark: pgfId-1761290] Cached Until: 15:58:34 UTC Nov 11 2010
    

    
     [bookmark: pgfId-1761291] Retrieved from CRL Distribution Point: 
    

    
     [bookmark: pgfId-1761292] ** CDP Not Published - Retrieved via SCEP
    

    
     [bookmark: pgfId-1761293] Size (bytes): 224
    

    
     [bookmark: pgfId-1761294] Associated Trustpoints: LOCAL-CA-SERVER 
    

    
     [bookmark: pgfId-1761295] 
    

     [bookmark: pgfId-1761296]Step 4[image: ] When you are done, click  Clear CRL to remove the CRL details and choose another CA certificate to view.

 
     [bookmark: pgfId-1761297]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1092052][bookmark: 74663]Feature History for Certificate Management

 
     [bookmark: pgfId-1356641] Table 40-1  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1356691] 

 
     
      
       
        [bookmark: pgfId-1356648]Table 40-1 [bookmark: 94847]Feature History for Certificate Management 

 
       
      
        
        		
          
          [bookmark: pgfId-1356654]Feature Name
         
  
        		
          
          [bookmark: pgfId-1356656]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1356658]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1356660]Certificate management

  
        		 [bookmark: pgfId-1356662]7.0(1)

  
        		 [bookmark: pgfId-1356664]Digital certificates (including CA certificates, identity certificates, and code signer certificates) provide digital identification for authentication. A digital certificate includes information that identifies a device or user, such as the name, serial number, company, department, or IP address. CAs are trusted authorities that “sign” certificates to verify their authenticity, thereby guaranteeing the identity of the device or user. CAs issue digital certificates in the context of a PKI, which uses public-key or private-key encryption to ensure security.

  [bookmark: pgfId-1761307]We introduced the following screens: 

  [bookmark: pgfId-1761308]Configuration > Remote Access VPN > Certificate Management
 Configuration > Site-to-Site VPN > Certificate Management.

  [bookmark: pgfId-1761309]We introduced or modified the following screens: 

  [bookmark: pgfId-1356668]Configuration > Firewall > Advanced > Certificate Management > CA Certificates
 Configuration > Device Management > Certificate Management > CA Certificates.

  
       

 
        
        		 [bookmark: pgfId-1356684]SCEP proxy

  
        		 [bookmark: pgfId-1356686]8.4(1)

  
        		 [bookmark: pgfId-1356688]We introduced this feature, which provides secure deployment of device certificates from third-party CAs.

  
       

 
      
     

 
    
 
   
 
  

 
  
   
 

OPS/admin_swconfig-21.jpg
—
!






OPS/admin_swconfig.html
  
   
    
     [bookmark: pgfId-1044108][bookmark: 98789]Managing Software and Configurations
      
      
 
     
 

 
     [bookmark: pgfId-1198261] This chapter describes how to manage the  ASA software and configurations and includes the following sections: 

 
     
     		 [bookmark: pgfId-1385608]Upgrading the Software

 
     		 [bookmark: pgfId-1396684]Managing Files

 
     		 [bookmark: pgfId-1410019]Configuring the Images and Startup Configuration to Use

 
     		 [bookmark: pgfId-1398510]Backing Up and Restoring Configurations or Other Files

 
     		 [bookmark: pgfId-1660497]Saving the Running Configuration to a TFTP Server

 
     		 [bookmark: pgfId-1660501]Scheduling a System Restart

 
     		 [bookmark: pgfId-1200598]Downgrading Your Software

 
     		 [bookmark: pgfId-1396712]Configuring Auto Update

 
    

 
   
 
    
     [bookmark: pgfId-1691720][bookmark: 35223]Upgrading the Software

 
     [bookmark: pgfId-1689585]This section describes how to upgrade to the latest version and includes the following topics:

 
     
     		 [bookmark: pgfId-1689588]Upgrade Path and Migrations

 
     		 [bookmark: pgfId-1689592]Viewing Your Current Version

 
     		 [bookmark: pgfId-1689596]Downloading the Software from Cisco.com

 
     		 [bookmark: pgfId-1689600]Upgrading a Standalone Unit

 
     		 [bookmark: pgfId-1689604]Upgrading a Failover Pair or ASA Cluster

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1689606]Note For CLI procedures, see the ASA documentation.


     
     
 
    

    

 
     
      [bookmark: pgfId-1689608][bookmark: 93962]Upgrade Path and Migrations

 
      
      		 [bookmark: pgfId-1689609]If you are upgrading from a pre-8.3 release:

 
     

 
      [bookmark: pgfId-1689611]–[image: ] See the  Cisco ASA 5500 Migration Guide to Version 8.3 and Later  for important information about migrating your configuration.

 
      [bookmark: pgfId-1689612]–[image: ] You cannot upgrade directly to 9.0 or later. You must first upgrade to Version 8.3 or 8.4 for a successful migration.

 
      
      		 [bookmark: pgfId-1689613]If you are upgrading from a pre-9.0 release, because of ACL migration, you cannot later perform a downgrade; be sure to back up your configuration file in case you want to downgrade. See the ACL migration section in the 9.0 release notes for more information.

 
      		 [bookmark: pgfId-1689614]If you are upgrading from one of the following versions, you can successfully upgrade to 9.1(2.8) and 9.1(3) or later:

 
     

 
      [bookmark: pgfId-1689615]–[image: ] 8.4(5) or later

 
      [bookmark: pgfId-1689616]–[image: ] 9.0(2) or later

 
      [bookmark: pgfId-1689617]–[image: ] 9.1(2)

 
      [bookmark: pgfId-1689618]However, if you are running any earlier versions, you cannot upgrade directly to 9.1(2.8) or 9.1(3) or later without  first upgrading to one of the above versions. For example:

 
      [bookmark: pgfId-1689650] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1689621]ASA Version
          
  
         		
           
           [bookmark: pgfId-1689623]First Upgrade to:
          
  
         		
           
           [bookmark: pgfId-1689625]Then Upgrade to:
          
  
        

 
         
         		 [bookmark: pgfId-1689627]8.2(1)

  
         		 [bookmark: pgfId-1689629]8.4(6)

  
         		 [bookmark: pgfId-1689631]9.1(2.8) or 9.1(3) or later

  
        

 
         
         		 [bookmark: pgfId-1689633]8.4(4)

  
         		 [bookmark: pgfId-1689635]8.4(6)

  
         		 [bookmark: pgfId-1689637]9.1(2.8) or 9.1(3) or later

  
        

 
         
         		 [bookmark: pgfId-1689639]9.0(1)

  
         		 [bookmark: pgfId-1689641]9.0(3)

  
         		 [bookmark: pgfId-1689643]9.1(2.8) or 9.1(3) or later

  
        

 
         
         		 [bookmark: pgfId-1689645]9.1(1)

  
         		 [bookmark: pgfId-1689647]9.1(2)

  
         		 [bookmark: pgfId-1689649]9.1(2.8) or 9.1(3) or later

  
        

 
       
      

 
     
 
      
      		 [bookmark: pgfId-1689652][bookmark: 68119]Software Version Requirements for Zero Downtime Upgrading:

 
     

 
      [bookmark: pgfId-1689653]The units in a failover configuration or ASA cluster should have the same major (first number) and minor (second number) software version. However, you do not need to maintain version parity on the units during the upgrade process; you can have different versions on the software running on each unit and still maintain failover support. To ensure long-term compatibility and stability, we recommend upgrading all units to the same version as soon as possible.

 
      [bookmark: pgfId-1689657] Table 46-1  shows the supported scenarios for performing zero-downtime upgrades.

 
      [bookmark: pgfId-1689688] 

 
      
       
        
         [bookmark: pgfId-1689664]Table 46-1 [bookmark: 72913]Zero-Downtime Upgrade Support 

 
        
       
         
         		
           
           [bookmark: pgfId-1689668]Type of Upgrade
          
  
         		
           
           [bookmark: pgfId-1689670]Support
          
  
        

 
         
         		 [bookmark: pgfId-1689672]Maintenance Release

  
         		 [bookmark: pgfId-1689674]You can upgrade from any maintenance release to any other maintenance release within a minor release.

  [bookmark: pgfId-1689675]For example, you can upgrade from 8.4(1) to 8.4(6) without first installing the maintenance releases in between.

  
        

 
         
         		 [bookmark: pgfId-1689677]Minor Release

  
         		 [bookmark: pgfId-1689679]You can upgrade from a minor release to the next minor release. You cannot skip a minor release.

  [bookmark: pgfId-1689680]For example, you can upgrade from 8.2 to 8.3. Upgrading from 8.2 directly to 8.4 is not supported for zero-downtime upgrades; you must first upgrade to 8.3. For models that are not supported on a minor release, you can skip the minor release; for example, for the ASA 5585-X, you can upgrade from 8.2 to 8.4 (the model is not supported on 8.3).

 
           
           [image: ] 
          
 
          
 [bookmark: pgfId-1689681]Note Zero-downtime upgrades are possible, even when feature configuration is migrated, for example, from 8.2 to 8.3.


           
           
 
          


  
        

 
         
         		 [bookmark: pgfId-1689683]Major Release

  
         		 [bookmark: pgfId-1689685]You can upgrade from the last minor release of the previous version to the next major release.

  [bookmark: pgfId-1689686]For example, you can upgrade from 8.6 to 9.0, assuming that 8.6 is the last minor version in the 8.x release series for your model. Upgrading from 8.6 directly to 9.1 is not supported for zero-downtime upgrades; you must first upgrade to 9.0. For models that are not supported on a minor release, you can skip the minor release; for example, for the ASA 5585-X, you can upgrade from 8.4 to 9.0 (the model is not supported on 8.5 or 8.6).

 
           
           [image: ] 
          
 
          
 [bookmark: pgfId-1689687]Note Zero-downtime upgrades are possible, even when feature configuration is migrated, for example, from 8.4 to 9.0.


           
           
 
          


  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-1689692][bookmark: 44078][bookmark: 15858][bookmark: 11882]Viewing Your Current Version

 
      [bookmark: pgfId-1689695]The software version appears on the ASDM home page; view the home page to verify the software version of your ASA.

 
    
 
     
      [bookmark: pgfId-1689701][bookmark: 11354]Downloading the Software from Cisco.com

 
      [bookmark: pgfId-1689702] If you are using the ASDM Upgrade Wizard, you do not have to pre-download the software. If you are manually upgrading, for example for a failover upgrade,  download the images to your local computer.

 
      [bookmark: pgfId-1689703] If you have a Cisco.com login, you can obtain the OS and ASDM images from the following website: 

 
      [bookmark: pgfId-1689705] http://www.cisco.com/go/asa-software 

 
    
 
     
      [bookmark: pgfId-1689708][bookmark: 48453]Upgrading a Standalone Unit

 
      [bookmark: pgfId-1689709]This section describes how to install the ASDM and operating system (OS) images.

 
      
      		 [bookmark: pgfId-1689712]Upgrading from Your Local Computer

 
      		 [bookmark: pgfId-1689716]Upgrading Using the Cisco.com Wizard

 
     

 
    
 
     
      [bookmark: pgfId-1689867][bookmark: 28934]Upgrading from Your Local Computer

 
      [bookmark: pgfId-1689868]The Upgrade Software from Local Computer tool lets you upload an image file from your computer to the flash file system to upgrade the ASA. 

 
    
 
     
      [bookmark: pgfId-1689872]Detailed Steps

 
     
 
      [bookmark: pgfId-1689873] Step 1[image: ] (If there is a configuration migration) In ASDM, back up your existing configuration using the  Tools > Backup Configurations tool.

 
      [bookmark: pgfId-1689875]Step 2[image: ] [bookmark: 17892]In the main ASDM application window, choose  Tools > Upgrade Software from Local Computer .

 
      [bookmark: pgfId-1689876]The Upgrade Software dialog box appears.

 
      [bookmark: pgfId-1689880] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1689881]Step 3[image: ] From the Image to Upload drop-down list, choose  ASDM .

 
      [bookmark: pgfId-1689882]Step 4[image: ] In the Local File Path field, enter the local path to the file on your computer or click  Browse Local  Files to find the file on your PC.

 
      [bookmark: pgfId-1689883]Step 5[image: ] In the Flash File System Path field, enter the path to the flash file system or click  Browse Flash to find the directory or file in the flash file system[image: ].

 
      [bookmark: pgfId-1689884]Step 6[image: ] Click  Upload Image . The uploading process might take a few minutes.

 
      [bookmark: pgfId-1689885]Step 7[image: ] You are prompted to set this image as the ASDM image. Click  Yes .

 
      [bookmark: pgfId-1689889] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1689891]Step 8[image: ] [bookmark: 59136]You are reminded to exit ASDM and save the configuration. Click  OK . You exit the Upgrade tool.  Note:  You will save the configuration and reload ASDM  after you upgrade the ASA software.

 
      [bookmark: pgfId-1689895] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1689899]Step 9[image: ] [bookmark: 40424]Repeat Step 2 through Step 8, choosing  ASA from the Image to Upload drop-down list. You can also use this procedure to upload other file types.

 
      [bookmark: pgfId-1689906]Step 10[image: ] Choose  Tools > System[image: ] Reload to reload the ASA.

 
      [bookmark: pgfId-1689908]A new window appears that asks you to verify the details of the reload.

 
      [bookmark: pgfId-1689909] a.[image: ] Click the  Save the running configuration at the time of reload radio button (the default).

 
      [bookmark: pgfId-1689910] b.[image: ] Choose a time to reload (for example,  Now , the default).

 
      [bookmark: pgfId-1689911] c.[image: ] Click  Schedule Reload .

 
      [bookmark: pgfId-1689912]Once the reload is in progress, a Reload Status window appears that indicates that a reload is being performed. An option to exit ASDM is also provided.

 
      [bookmark: pgfId-1689915]Step 11[image: ] After the ASA reloads, restart ASDM.

 
      [bookmark: pgfId-1689917]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1689920][bookmark: 25091]Upgrading Using the Cisco.com Wizard

 
      [bookmark: pgfId-1689924][bookmark: 85613]The Upgrade Software from Cisco.com Wizard lets you automatically upgrade the ASDM and ASA to more current versions.

 
      [bookmark: pgfId-1689926]In this wizard, you can do the following:

 
      
      		 [bookmark: pgfId-1689927]Choose an ASA image file and/or ASDM image file to upgrade.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1689928]Note ASDM downloads the latest image version, which includes the build number. For example, if you are downloading 9.1(4), the download might be 9.1(4.2). This behavior is expected, so you may proceed with the planned upgrade.


      
      
 
     

     

 
      
      		 [bookmark: pgfId-1689929]Review the upgrade changes that you have made.

 
      		 [bookmark: pgfId-1689930]Download the image or images and install them.

 
      		 [bookmark: pgfId-1689931]Review the status of the installation.

 
      		 [bookmark: pgfId-1689934]If the installation completed successfully, restart the ASA to save the configuration and complete the upgrade.

 
     

 
    
 
     
      [bookmark: pgfId-1689936]Detailed Steps

 
     
 
      [bookmark: pgfId-1689937] Step 1[image: ] (If there is a configuration migration) In ASDM, back up your existing configuration using the  Tools > Backup Configurations tool.

 
      [bookmark: pgfId-1689938]Step 2[image: ] Choose  Tools > Check for ASA/ASDM Updates .

 
      [bookmark: pgfId-1689939]In multiple context mode, access this menu from the System.

 
      [bookmark: pgfId-1689940]The Cisco.com Authentication dialog box appears.

 
      [bookmark: pgfId-1689941]Step 3[image: ] Enter your assigned Cisco.com username and the Cisco.com password, and then click  Login .

 
      [bookmark: pgfId-1689942]The Cisco.com Upgrade Wizard appears.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1689943]Note If there is no upgrade available, a dialog box appears. Click OK to exit the wizard.


      
      
 
     

     

 
      [bookmark: pgfId-1689944]Step 4[image: ] Click  Next to display the Select Software screen. 

 
      [bookmark: pgfId-1689945]The current ASA version and ASDM version appear.

 
      [bookmark: pgfId-1689946]Step 5[image: ] To upgrade the ASA version and ASDM version, perform the following steps:

 
      [bookmark: pgfId-1689947] a.[image: ] In the ASA area, check the  Upgrade to check box, and then choose an ASA version to which you want to upgrade from the drop-down list. 

 
      [bookmark: pgfId-1689948] b.[image: ] In the ASDM area, check the  Upgrade to check box, and then choose an ASDM version to which you want to upgrade from the drop-down list. 

 
      [bookmark: pgfId-1689949]Step 6[image: ] Click  Next to display the Review Changes screen.

 
      [bookmark: pgfId-1689950]Step 7[image: ] Verify the following items: 

 
      
       
       		 [bookmark: pgfId-1689953]The ASA image file and/or ASDM image file that you have downloaded are the correct ones.

 
       		 [bookmark: pgfId-1689957]The ASA image file and/or ASDM image file that you want to upload are the correct ones.

 
       		 [bookmark: pgfId-1689961]The correct ASA boot image has been selected.

 
      

 
     

 
      [bookmark: pgfId-1689963]Step 8[image: ] Click  Next to start the upgrade installation.

 
      [bookmark: pgfId-1689964]You can then view the status of the upgrade installation as it progresses.

 
      [bookmark: pgfId-1689965]The Results screen appears, which provides additional details, such as the upgrade installation status (success or failure). 

 
      [bookmark: pgfId-1689966]Step 9[image: ] If the upgrade installation succeeded, for the upgrade versions to take effect, check the  Save configuration and reload device now check box to restart the ASA, and restart ASDM.

 
      [bookmark: pgfId-1689970]Step 10[image: ] Click  Finish to exit the wizard and save the configuration changes that you have made.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1689972]Note To upgrade to the next higher version, if any, you must restart the wizard.[bookmark: 39028]


      
      
 
     

     

 
      [bookmark: pgfId-1689973]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1689975][bookmark: 73860]Upgrading a Failover Pair or ASA Cluster

 
      
      		 [bookmark: pgfId-1689978]Upgrading an Active/Standby Failover Pair

 
      		 [bookmark: pgfId-1689982]Upgrading an Active/Active Failover Pair

 
      		 [bookmark: pgfId-1689986]Upgrading an ASA Cluster

 
     

 
    
 
     
      [bookmark: pgfId-1689990][bookmark: 34831][bookmark: 79050]Upgrading an Active/Standby Failover Pair

 
      [bookmark: pgfId-1689991]To upgrade the Active/Standby failover pair, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1689994]Detailed Steps

 
     
 
      [bookmark: pgfId-1690153] Step 1[image: ] (If there is a configuration migration) In ASDM, back up your existing configuration using the  Tools > Backup Configurations tool.

 
      [bookmark: pgfId-1690155]Step 2[image: ] [bookmark: 35471]On the active unit, in the main ASDM application window, choose  Tools > Upgrade Software from Local Computer .

 
      [bookmark: pgfId-1690156]The Upgrade Software dialog box appears.

 
      [bookmark: pgfId-1690160] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690161]Step 3[image: ] From the Image to Upload drop-down list, choose  ASDM .

 
      [bookmark: pgfId-1690162]Step 4[image: ] In the Local File Path field, enter the local path to the file on your computer or click  Browse Local  Files to find the file on your PC.

 
      [bookmark: pgfId-1690163]Step 5[image: ] In the Flash File System Path field, enter the path to the flash file system or click  Browse Flash to find the directory or file in the flash file system[image: ].

 
      [bookmark: pgfId-1690164]Step 6[image: ] Click  Upload Image . The uploading process might take a few minutes.

 
      [bookmark: pgfId-1690165]Step 7[image: ] You are prompted to set this image as the ASDM image. Click  Yes .

 
      [bookmark: pgfId-1690169] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690171]Step 8[image: ] [bookmark: 63014]You are reminded to exit ASDM and save the configuration. Click  OK . You exit the Upgrade tool.  Note:  You will save the configuration and reload ASDM  after you upgrade the ASA software.

 
      [bookmark: pgfId-1690179]Step 9[image: ] [bookmark: 68461]Repeat Step 2 through Step 8, choosing  ASA from the Image to Upload drop-down list.

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690184]Step 10[image: ] Click the  Save icon on the toolbar to save your configuration changes.

 
      [bookmark: pgfId-1690187]Step 11[image: ] Connect ASDM to the  standby unit, and upload the ASA and ASDM software according to Step 2[image: ] through Step 9, using the same file locations you used on the active unit.

 
      [bookmark: pgfId-1690194]Step 12[image: ] Choose  Tools > System[image: ] Reload to reload the standby ASA.

 
      [bookmark: pgfId-1690196]A new window appears that asks you to verify the details of the reload. 

 
      [bookmark: pgfId-1690197] a.[image: ] Click the  Save the running configuration at the time of reload radio button (the default).

 
      [bookmark: pgfId-1690198] b.[image: ] Choose a time to reload (for example,  Now , the default).

 
      [bookmark: pgfId-1690199] c.[image: ] Click  Schedule Reload .

 
      [bookmark: pgfId-1690200]Once the reload is in progress, a Reload Status window appears that indicates that a reload is being performed. An option to exit ASDM is also provided.

 
      [bookmark: pgfId-1690203]Step 13[image: ] After the standby ASA reloads, restart ASDM and connect to the standby unit to make sure it is running.

 
      [bookmark: pgfId-1690205]Step 14[image: ] Connect ASDM to the  active unit again.

 
      [bookmark: pgfId-1690206]Step 15[image: ] Force the active unit to fail over to the standby unit by choosing  Monitoring > Properties > Failover > Status , and clicking  Make Standby .

 
      [bookmark: pgfId-1690209]Step 16[image: ] Choose  Tools > System[image: ] Reload to reload the (formerly) active ASA.

 
      [bookmark: pgfId-1690211]A new window appears that asks you to verify the details of the reload.

 
      [bookmark: pgfId-1690212] a.[image: ] Click the  Save the running configuration at the time of reload radio button (the default).

 
      [bookmark: pgfId-1690213] b.[image: ] Choose a time to reload (for example,  Now , the default).

 
      [bookmark: pgfId-1690214] c.[image: ] Click  Schedule Reload .

 
      [bookmark: pgfId-1690215]Once the reload is in progress, a Reload Status window appears that indicates that a reload is being performed. An option to exit ASDM is also provided.

 
      [bookmark: pgfId-1690218]After the ASA comes up, it will now be the standby unit.

 
      [bookmark: pgfId-1690220]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1690222][bookmark: 99438]Upgrading an Active/Active Failover Pair

 
      [bookmark: pgfId-1690223]To upgrade two units in an Active/Active failover configuration, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1690224]Requirements

 
      [bookmark: pgfId-1690225]Perform these steps in the system execution space.

 
    
 
     
      [bookmark: pgfId-1690226]Detailed Steps

 
     
 
      [bookmark: pgfId-1690397] Step 1[image: ] (If there is a configuration migration) In ASDM, back up your existing configuration using the  Tools > Backup Configurations tool.

 
      [bookmark: pgfId-1690399]Step 2[image: ] [bookmark: 35709]On the primary unit, in the main ASDM application window, choose  Tools > Upgrade Software from Local Computer .

 
      [bookmark: pgfId-1690400]The Upgrade Software dialog box appears.

 
      [bookmark: pgfId-1690404] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690405]Step 3[image: ] From the Image to Upload drop-down list, choose  ASDM .

 
      [bookmark: pgfId-1690406]Step 4[image: ] In the Local File Path field, enter the local path to the file on your computer or click  Browse Local  Files to find the file on your PC.

 
      [bookmark: pgfId-1690407]Step 5[image: ] In the Flash File System Path field, enter the path to the flash file system or click  Browse Flash to find the directory or file in the flash file system[image: ].

 
      [bookmark: pgfId-1690408]Step 6[image: ] Click  Upload Image . The uploading process might take a few minutes.

 
      [bookmark: pgfId-1690409]Step 7[image: ] You are prompted to set this image as the ASDM image. Click  Yes .

 
      [bookmark: pgfId-1690413] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690415]Step 8[image: ] [bookmark: 51276]You are reminded to exit ASDM and save the configuration. Click  OK . You exit the Upgrade tool.  Note:  You will save the configuration and reload ASDM  after you upgrade the ASA software.

 
      [bookmark: pgfId-1690423]Step 9[image: ] [bookmark: 78026]Repeat Step 2 through Step 8, choosing  ASA from the Image to Upload drop-down list.

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690428]Step 10[image: ] Click the  Save icon on the toolbar to save your configuration changes.

 
      [bookmark: pgfId-1690429]Step 11[image: ] Make both failover groups active on the primary unit by choosing  Monitoring > Failover > Failover Group # , where  # is the number of the failover group you want to move to the primary unit, and clicking  Make Active .

 
      [bookmark: pgfId-1690432]Step 12[image: ] Connect ASDM to the  secondary  unit, and upload the ASA and ASDM software according to Step 2[image: ] through Step 9, using the same file locations you used on the active unit.

 
      [bookmark: pgfId-1690439]Step 13[image: ] Choose  Tools > System[image: ] Reload to reload the secondary ASA.

 
      [bookmark: pgfId-1690441]A new window appears that asks you to verify the details of the reload.

 
      [bookmark: pgfId-1690442] a.[image: ] Click the  Save the running configuration at the time of reload radio button (the default).

 
      [bookmark: pgfId-1690443] b.[image: ] Choose a time to reload (for example,  Now , the default).

 
      [bookmark: pgfId-1690444] c.[image: ] Click  Schedule Reload .

 
      [bookmark: pgfId-1690445]Once the reload is in progress, a Reload Status window appears that indicates that a reload is being performed. An option to exit ASDM is also provided.

 
      [bookmark: pgfId-1690446]Step 14[image: ] Connect ASDM to the  primary unit, and check when the secondary unit reloads by choosing  Monitoring > Failover > System[image: ] .

 
      [bookmark: pgfId-1690447]Step 15[image: ] After the secondary unit comes up, force the primary unit to fail over to the secondary unit by choosing  Monitoring > Properties > Failover > System[image: ] , and clicking  Make Standby .

 
      [bookmark: pgfId-1690450]Step 16[image: ] Choose  Tools > System[image: ] Reload to reload the (formerly) active ASA.

 
      [bookmark: pgfId-1690452]A new window appears that asks you to verify the details of the reload.

 
      [bookmark: pgfId-1690453] a.[image: ] Click the  Save the running configuration at the time of reload radio button (the default).

 
      [bookmark: pgfId-1690454] b.[image: ] Choose a time to reload (for example,  Now , the default).

 
      [bookmark: pgfId-1690455] c.[image: ] Click  Schedule Reload .

 
      [bookmark: pgfId-1690456]Once the reload is in progress, a Reload Status window appears that indicates that a reload is being performed. An option to exit ASDM is also provided.

 
      [bookmark: pgfId-1690457]If the failover groups are configured with Preempt Enabled, they automatically become active on their designated unit after the preempt delay has passed. If the failover groups are not configured with Preempt Enabled, you can return them to active status on their designated units using the   Monitoring > Failover > Failover Group # pane.

 
      [bookmark: pgfId-1690458]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1690460][bookmark: 73685]Upgrading an ASA Cluster

 
      [bookmark: pgfId-1690461]To upgrade all units in an ASA cluster, perform the following steps on the master unit. For multiple context mode, perform these steps in the system execution space.

 
    
 
     
      [bookmark: pgfId-1690462]Detailed Steps

 
     
 
      [bookmark: pgfId-1690606] Step 1[image: ] Launch ASDM on the master unit.

 
      [bookmark: pgfId-1690607]Step 2[image: ] (If there is a configuration migration) In ASDM, back up your existing configuration using the  Tools > Backup Configurations tool.

 
      [bookmark: pgfId-1690609]Step 3[image: ] [bookmark: 46372]In the main ASDM application window, choose  Tools > Upgrade Software from Local Computer .

 
      [bookmark: pgfId-1690610]The Upgrade Software from Local Computer dialog box appears.

 
      [bookmark: pgfId-1690611]Step 4[image: ] Click the  All devices in the cluster[image: ]  radio button.

 
      [bookmark: pgfId-1690612]The Upgrade Software dialog box appears.

 
      [bookmark: pgfId-1690616] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690617]Step 5[image: ] From the Image to Upload drop-down list, choose  ASDM .

 
      [bookmark: pgfId-1690618]Step 6[image: ] In the Local File Path field, enter the local path to the file on your computer or click  Browse Local  Files to find the file on your PC.

 
      [bookmark: pgfId-1690619]Step 7[image: ] In the Flash File System Path field, enter the path to the flash file system or click  Browse Flash to find the directory or file in the flash file system[image: ].

 
      [bookmark: pgfId-1690620]Step 8[image: ] Click  Upload Image . The uploading process might take a few minutes.

 
      [bookmark: pgfId-1690621]Step 9[image: ] You are prompted to set this image as the ASDM image. Click  Yes .

 
      [bookmark: pgfId-1690625] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690627]Step 10[image: ] [bookmark: 75405]You are reminded to exit ASDM and save the configuration. Click  OK . You exit the Upgrade tool.  Note:  You will save the configuration and reload ASDM  after you upgrade the ASA software.

 
      [bookmark: pgfId-1690635]Step 11[image: ] Repeat Step 3 through Step 10, choosing  ASA from the Image to Upload drop-down list.

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690640]Step 12[image: ] Click the  Save icon on the toolbar to save your configuration changes.

 
      [bookmark: pgfId-1690641]Step 13[image: ] Choose  Tools > System[image: ] Reload .

 
      [bookmark: pgfId-1690642]The System Reload dialog box appears.

 
      [bookmark: pgfId-1690643]Step 14[image: ] Reload each slave unit one at a time by choosing a slave unit name from the Device drop-down list, and then clicking  Schedule Reload to reload the unit now.

 
      [bookmark: pgfId-1690647] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1690648]To avoid connection loss and allow traffic to stabilize, wait for each unit to come back up (approximately 5 minutes) before reloading the next unit. To view when a unit rejoins the cluster, see the Monitoring > ASA Cluster > Cluster Summary pane.

 
      [bookmark: pgfId-1690649]Step 15[image: ] After all slave units have reloaded, disable clustering on the master unit by choosing  Configuration > Device Management > High Availability and Scalability > ASA Cluster[image: ] , uncheck the  Participate in ASA cluster[image: ] check box, and click  Apply .

 
      [bookmark: pgfId-1690650]Wait for 5 minutes for a new master to be selected and traffic to stabilize. When the former master unit rejoins the cluster, it will be a slave.

 
      [bookmark: pgfId-1690651]Do not save the configuration; when the master unit reloads, you want clustering to be enabled on it.

 
      [bookmark: pgfId-1690652]Step 16[image: ] Choose  Tools > System[image: ] Reload and reload the master[image: ] unit from the System Reload dialog box by choosing  --This Device-- from the Device drop-down list.

 
      [bookmark: pgfId-1690653]Step 17[image: ] Quit and restart ASDM; you will reconnect to the new master unit.

 
      [bookmark: pgfId-1690654]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1385646][bookmark: 85612][bookmark: 30160]Managing Files

 
     [bookmark: pgfId-1661653]ASDM provides a set of file management tools to help you perform basic file management tasks. The File Management tool lets you view, move, copy, and delete files stored in flash memory, transfer files, and to manage files on remote storage devices (mount points).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1661654]Note In multiple context mode, this tool is only available in the system security context.


     
     
 
    

    

 
     
     		 [bookmark: pgfId-1653882]Configuring File Access

 
     		 [bookmark: pgfId-1661686]Accessing the File Management Tool

 
     		 [bookmark: pgfId-1661690]Transferring Files

 
    

 
     
      [bookmark: pgfId-1647411]  [bookmark: 20081]Configuring File Access

 
      
      		 [bookmark: pgfId-1647415]Configuring the FTP Client Mode

 
      		 [bookmark: pgfId-1647419]Configuring the ASA as a Secure Copy Server

 
      		 [bookmark: pgfId-1688154]Customizing the ASA Secure Copy Client

 
      		 [bookmark: pgfId-1647423]Configuring the ASA TFTP Client Path

 
      		 [bookmark: pgfId-1661795]Adding Mount Points

 
     

 
    
 
     
      [bookmark: pgfId-1647431][bookmark: 38678][bookmark: 77483]Configuring the FTP Client Mode

 
      [bookmark: pgfId-1647435]The ASA can use FTP to upload or download image files or configuration files to or from an FTP server. In passive FTP, the client initiates both the control connection and the data connection. The server, which is the recipient of the data connection in passive mode, responds with the port number to which it is listening for the specific connection.

 
    
 
     
      [bookmark: pgfId-1647436]Detailed Steps

 
     
 
      [bookmark: pgfId-1661800] Step 1[image: ] From the Configuration > Device Management > Management Access > File Access > FTP Client pane, check the  Specify FTP mode as passive check box.

 
      [bookmark: pgfId-1661801]Step 2[image: ] Click  Apply .

 
      [bookmark: pgfId-1661802]The FTP client configuration is changed and the change is saved to the running configuration.

 
      [bookmark: pgfId-1661803]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1647447][bookmark: 47482]Configuring the ASA as a Secure Copy Server [bookmark: marker-1647446]

 
      [bookmark: pgfId-1647454]You can enable the secure copy (SCP) server on the ASA. Only clients that are allowed to access the ASA using SSH can establish a secure copy connection.

 
    
 
     
      [bookmark: pgfId-1647455]Restrictions

 
      
      		 [bookmark: pgfId-1647458]The server does not have directory support. The lack of directory support limits remote client access to the ASA internal files. 

 
      		 [bookmark: pgfId-1647462]The server does not support banners.

 
      		 [bookmark: pgfId-1647463]The server does not support wildcards.

 
     

 
    
 
     
      [bookmark: pgfId-1651536]Prerequisites

 
      
      		 [bookmark: pgfId-1651633]Enable SSH on the ASA according to the “Configuring ASA Access for ASDM, Telnet, or SSH” section.

 
      		 [bookmark: pgfId-1653150]The ASA license must have the strong encryption (3DES/AES) license to support SSH Version 2 connections.

 
     

 
    
 
     
      [bookmark: pgfId-1647472]Detailed Steps

 
     
 
      [bookmark: pgfId-1661835] Step 1[image: ] Choose  Configuration > Device Management > Management Access > File Access > Secure Copy (SCP) Server , and check the  Enable secure copy server check box.

 
      [bookmark: pgfId-1661836]Step 2[image: ] Click  Apply .

 
      [bookmark: pgfId-1661837]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1652364]Example

 
      [bookmark: pgfId-1652731]From a client on the external host, perform an SCP file transfer. For example, in Linux enter the following command:

 
     
      [bookmark: pgfId-1652732]scp -v -pw password source_filename username@asa_address:{disk0|disk1}:/dest_filename
     

     
      [bookmark: pgfId-1652733] 
     

      [bookmark: pgfId-1652734]The  -v is for verbose, and if  -pw is not specified, you will be prompted for a password.

 
    
 
     
      [bookmark: pgfId-1688163][bookmark: 31898]Customizing the ASA Secure Copy Client

 
      [bookmark: pgfId-1653295]You can copy files to and from the ASA using the on-board SCP client (see the “Accessing the File Management Tool” section). This section lets you customize the SCP client operation.

 
    
 
     
      [bookmark: pgfId-1688194]Prerequisites

 
      [bookmark: pgfId-1688195]For multiple context mode, complete this procedure in the system execution space. If you are not already in the System configuration mode, in the Configuration > Device List pane, double-click  System under the active device IP address.

 
    
 
     
      [bookmark: pgfId-1688196]Detailed Steps

 
     
 
      [bookmark: pgfId-1676407] Step 1[image: ] Depending on your context mode:

 
      
      		 [bookmark: pgfId-1676408]For single mode, choose  Configuration > Device Management > Management Access > File Access > Secure Copy (SCP) .

 
      		 [bookmark: pgfId-1676409]For multiple mode in the System, choose  Configuration > Device Management > Device Administration > Secure Copy 

 
     

 
      [bookmark: pgfId-1688413]Step 2[image: ] The ASA stores the SSH host key for each SCP server to which it connects. You can manually add or delete servers and their keys from the ASA database if desired.

 
      [bookmark: pgfId-1688417]To add a key:

 
      [bookmark: pgfId-1688418] a.[image: ] Click  Add for a new server, or select the server from the Trusted SSH Hosts table, and click  Edit .

 
      [bookmark: pgfId-1688419] b.[image: ] For a new server, in the Host field, enter the server IP address.

 
      [bookmark: pgfId-1688420] c.[image: ] Check the  Add public key for the trusted SSH host check box.

 
      [bookmark: pgfId-1688421] d.[image: ] Specify one of the following keys:

 
      [bookmark: pgfId-1688422]–[image: ] Fingerprint—Enter the already hashed key; for example, a key that you copied from  show command output.

 
      [bookmark: pgfId-1688423]–[image: ] Key—Enter the public key or hashed value of the SSH host. The key string is the Base64 encoded RSA public key of the remote peer. You can obtain the public key value from an open SSH client; that is, from the .ssh/id_rsa.pub file. After you submit the Base64 encoded public key, that key is then hashed via SHA-256.

 
      [bookmark: pgfId-1688424]To delete a key:

 
      [bookmark: pgfId-1688425] a.[image: ] Select the server from the Trusted SSH Hosts table, and click  Delete .

 
      [bookmark: pgfId-1688426]Step 3[image: ] To be informed when a new host key is detected, check the  Inform me when a new host key is detected check box.

 
      [bookmark: pgfId-1688427]By default, this option is enabled. When this option is enabled, you are prompted to accept or reject the host key if it is not already stored on the ASA. When this option is disabled, the ASA accepts the host key automatically if it was not stored before.

 
      [bookmark: pgfId-1688434]Step 4[image: ] Click  Apply .

 
      [bookmark: pgfId-1668607]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1647577][bookmark: 15883]Configuring the ASA TFTP Client Path

 
      [bookmark: pgfId-1647578]TFTP is a simple client/server file transfer protocol, which is described in RFC 783 and RFC 1350 Rev. 2. You can configure the ASA as a TFTP  client so that it can copy files to or from a TFTP  server (see the “Transferring Files” section. In this way, you can back up and propagate configuration files to multiple ASAs.

 
      [bookmark: pgfId-1647588]This section lets you pre-define the path to a TFTP server so you do not need to enter it in commands such as  copy and  configure net .

 
    
 
     
      [bookmark: pgfId-1647595]Detailed Steps

 
     
 
      [bookmark: pgfId-1662035] Step 1[image: ] Choose Configuration > Device Management > Management Access > File Access > TFTP Client , and check the  Enable check box.

 
      [bookmark: pgfId-1662036]Step 2[image: ] From the Interface Name drop-down list, choose the interface to use as a TFTP client.

 
      [bookmark: pgfId-1662037]Step 3[image: ] In the IP Address field, enter the IP address of the TFTP server on which configuration files will be saved.

 
      [bookmark: pgfId-1662038]Step 4[image: ] In the Path field, enter the path to the TFTP server on which configuration files will be saved.

 
      [bookmark: pgfId-1662039]For example: / tftpboot / asa / config3

 
      [bookmark: pgfId-1662040]Step 5[image: ] Click  Apply .

 
      [bookmark: pgfId-1662041]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1662047][bookmark: 33373]Adding Mount Points 

 
      [bookmark: pgfId-1662048]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1662052]Adding a CIFS Mount Point

 
      		 [bookmark: pgfId-1662056]Adding an FTP Mount Point

 
     

 
    
 
     
      [bookmark: pgfId-1662058][bookmark: 11397]Adding a CIFS Mount Point

 
      [bookmark: pgfId-1662059]To define a Common Internet File System (CIFS) mount point, perform the following steps:

 
     
 
      [bookmark: pgfId-1662060] Step 1[image: ] From the Configuration > Device Management > Management Access > File Access > Mount-Points pane, click  Add > CIFS Mount Point .

 
      [bookmark: pgfId-1662061]The Add CIFS Mount Point dialog box appears.

 
      [bookmark: pgfId-1662062]Step 2[image: ] Check the  Enable  mount point  check box.

 
      [bookmark: pgfId-1662066]This option attaches the CIFS file system on the ASA to the UNIX file tree. 

 
      [bookmark: pgfId-1662067]Step 3[image: ] In the Mount Point Name field, enter the name of an existing CIFS location.

 
      [bookmark: pgfId-1662068]Step 4[image: ] In the Server Name or IP Address field, enter the name or IP address of the server in which the mount point is located.

 
      [bookmark: pgfId-1662069]Step 5[image: ] In the Share Name field, enter the name of the folder on the CIFS server.

 
      [bookmark: pgfId-1662070]Step 6[image: ] In the NT Domain Name field, enter the name of the NT Domain in which the server resides.

 
      [bookmark: pgfId-1662071]Step 7[image: ] In the User Name field, enter the name of the user authorized for file system mounting on the server.

 
      [bookmark: pgfId-1662072]Step 8[image: ] In the Password field, enter the password for the user authorized for file system mounting on the server.

 
      [bookmark: pgfId-1662073]Step 9[image: ] In the Confirm Password field, reenter the password.

 
      [bookmark: pgfId-1662074]Step 10[image: ] Click  OK .

 
      [bookmark: pgfId-1662075]The Add CIFS Mount Point dialog box closes.

 
      [bookmark: pgfId-1662076]Step 11[image: ] Click  Apply .

 
      [bookmark: pgfId-1662080]The mount point is added to the ASA, and the change is saved to the running configuration. 

 
      [bookmark: pgfId-1662081]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1662083][bookmark: 71059]Adding an FTP Mount Point 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1662084]Note For an FTP mount point, the FTP server must have a UNIX directory listing style. Microsoft FTP servers have a default of the MS-DOS directory listing style.


      
      
 
     

     

 
      [bookmark: pgfId-1662085]To define an FTP mount point, perform the following steps:

 
     
 
      [bookmark: pgfId-1662086] Step 1[image: ] From the Configuration > Device Management > Management Access > File Access > Mount-Points pane, click  Add > FTP Mount Point .

 
      [bookmark: pgfId-1662087]The Add FTP Mount Point dialog box appears.

 
      [bookmark: pgfId-1662088]Step 2[image: ] Check the  Enable check box.

 
      [bookmark: pgfId-1662092]This option attaches the FTP file system on the ASA to the UNIX file tree.

 
      [bookmark: pgfId-1662093]Step 3[image: ] In the Mount Point Name field, enter the name of an existing FTP location.

 
      [bookmark: pgfId-1662094]Step 4[image: ] In the Server Name or IP Address field, enter the name or IP address of the server where the mount point is located.

 
      [bookmark: pgfId-1662095]Step 5[image: ] In the Mode field, click the radio button for the FTP mode ( Active or  Passive ). When you choose Passive mode, the client initiates both the FTP control connection and the data connection. The server responds with the number of its listen[image: ]ing port for this connection.

 
      [bookmark: pgfId-1662096]Step 6[image: ] In the Path to Mount field, enter the directory path name to the FTP file server.

 
      [bookmark: pgfId-1662097]Step 7[image: ] In the User Name field, enter the name of the user authorized for file system mounting on the server.

 
      [bookmark: pgfId-1662098]Step 8[image: ] In the Password field, enter the password for the user authorized for file system mounting on the server.

 
      [bookmark: pgfId-1662099]Step 9[image: ] In the Confirm Password field, reenter the password.

 
      [bookmark: pgfId-1662100]Step 10[image: ] Click  OK .

 
      [bookmark: pgfId-1662101]The Add FTP Mount Point dialog box closes.

 
      [bookmark: pgfId-1662102]Step 11[image: ] Click  Apply .

 
      [bookmark: pgfId-1662106]The mount point is added to the ASA, and the change is saved to the running configuration. 

 
      [bookmark: pgfId-1647675]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1662152][bookmark: 26505]Accessing the File Management Tool

 
      [bookmark: pgfId-1662153]To use the file management tools, perform the following steps:

 
     
 
      [bookmark: pgfId-1662154] Step 1[image: ] In the main ASDM application window, choose  Tools > File Management .

 
      [bookmark: pgfId-1662155]The File Management dialog box appears.

 
      
       
       		 [bookmark: pgfId-1662156]The Folders pane displays the available folders on disk.

 
       		 [bookmark: pgfId-1662157]Flash Space shows the total amount of flash memory and how much memory is available.

 
       		 [bookmark: pgfId-1662158]The Files area displays the following information about files in the selected folder:

 
      

 
     

 
      [bookmark: pgfId-1662159]–[image: ] Path

 
      [bookmark: pgfId-1662160]–[image: ] Filename

 
      [bookmark: pgfId-1662161]–[image: ] Size (bytes)

 
      [bookmark: pgfId-1662162]–[image: ] Time Modified

 
      [bookmark: pgfId-1662163]–[image: ] Status, which indicates whether a selected file is designated as a boot configuration file, boot image file, ASDM image file, SVC image file, CSD image file, or APCF image file.

 
      [bookmark: pgfId-1662164]Step 2[image: ] Click  View to display the selected file in your browser.

 
      [bookmark: pgfId-1662165]Step 3[image: ] Click  Cut to cut the selected file for pasting to another directory.

 
      [bookmark: pgfId-1662166]Step 4[image: ] Click  Copy to copy the selected file for pasting to another directory.

 
      [bookmark: pgfId-1662167]Step 5[image: ] Click  Paste<[image: ]/B> to paste [image: ]the copied file to the selected destination.


       [bookmark: pgfId-1662168]Step 6[image: ] Click  Delete to remove the selected file from flash memory.

  [bookmark: pgfId-1662169]Step 7[image: ] Click  Rename to rename a file.

  [bookmark: pgfId-1662170]Step 8[image: ] Click  New Directory to create a new directory for storing files.

  [bookmark: pgfId-1662173]Step 9[image: ] Click  File Transfer to open the File Transfer dialog box. See the  “Transferring Files” section  for more information.

  [bookmark: pgfId-1662175]Step 10[image: ] Click  Mount Points to open the Manage Mount Points dialog box. See the “Adding Mount Points” section for more information.

  [bookmark: pgfId-1662179]


       
       
 
      
  

 
    

     
      
       [bookmark: pgfId-1662182][bookmark: 92406]Transferring Files

 
       [bookmark: pgfId-1662183]The File Transfer tool lets you transfer files from either a local or remote location. You can transfer a local file on your computer or a flash file system to and from the ASA. You can transfer a remote file to and from the ASA using HTTP, HTTPS, TFTP, FTP, SMB, or SCP.

 
       
       [image: ] 
      
 
      
 
      [bookmark: pgfId-1662190]Note For the IPS SSP software module, before you download the IPS software to disk0, make sure at least 50% of the flash memory is free. When you install IPS, IPS reserves 50% of the internal flash memory for its file system.


       
       
 
      

      

 
       
       		 [bookmark: pgfId-1662194]Transferring Files Between Local PC and Flash

 
       		 [bookmark: pgfId-1662198]Transferring Files Between Remote Server and Flash

 
      

 
     
 
      
       [bookmark: pgfId-1662200][bookmark: 74964]Transferring Files Between Local PC and Flash

 
       [bookmark: pgfId-1662201]To transfer files between your local computer and a flash file system, perform the following steps:

 
      
 
       [bookmark: pgfId-1662202] Step 1[image: ] In the main ASDM application window, choose  Tools > File Management .  

 
       [bookmark: pgfId-1662203]The File Management dialog box appears.

 
       [bookmark: pgfId-1662204]Step 2[image: ] Click the down arrow next to  File Transfer , and then click  Between Local PC and Flash .

 
       [bookmark: pgfId-1662205]The File Transfer dialog box appears.

 
       [bookmark: pgfId-1662206]Step 3[image: ] Select and  drag the file(s) from either your local computer or the flash file system[image: ] that you want to upload or download to the desired location. Alternatively, select the file(s) from either your local computer or the flash file system that you want to upload or download, and click the right arrow or left arrow to transfer the file(s) to the desired location. 

 
       [bookmark: pgfId-1662207]Step 4[image: ] Click  Close when you are done. 

 
       [bookmark: pgfId-1662208]


       
       
 
      
  
      

 
     
 
      
       [bookmark: pgfId-1662210][bookmark: 61050]Transferring Files Between Remote Server and Flash

 
       [bookmark: pgfId-1662211]To transfer files between a remote server and a flash file system, perform the following steps:

 
      
 
       [bookmark: pgfId-1662212] Step 1[image: ] In the main ASDM application window, choose  Tools > File Management . 

 
       [bookmark: pgfId-1662213]The File Management dialog box appears.

 
       [bookmark: pgfId-1662214]Step 2[image: ] Click the down arrow from the File Transfer drop-down list, and then click  Between Remote Server and Flash .

 
       [bookmark: pgfId-1662215]The File Transfer dialog box appears.

 
       [bookmark: pgfId-1662216]Step 3[image: ] To transfer a file from a remote server, click the  Remote server option. 

 
       [bookmark: pgfId-1662217]Step 4[image: ] Define the source file to be transferred.

 
       [bookmark: pgfId-1662218] a.[image: ] Choose the path to the location of the file, including the IP address of the server.

 
       
       [image: ] 
      
 
      
 
      [bookmark: pgfId-1662219]Note File transfer supports IPv4 and IPv6 addresses. 


       
       
 
      

      

 
       [bookmark: pgfId-1662220] b.[image: ] Enter the type (if the path is FTP) or the port number (if the path is HTTP or HTTPS) of the remote server. Valid FTP types are the following:

 
       [bookmark: pgfId-1662221]–[image: ] ap—ASCII files in passive mode

 
       [bookmark: pgfId-1662222]–[image: ] an—ASCII files in non-passive mode

 
       [bookmark: pgfId-1662223]–[image: ] ip—Binary image files in passive mode

 
       [bookmark: pgfId-1662224]–[image: ] in—Binary image files in non-passive mode

 
       [bookmark: pgfId-1662225]Step 5[image: ] To transfer the file from the flash file system, click the  Flash file system[image: ] option.

 
       [bookmark: pgfId-1662226]Step 6[image: ] Enter the path to the location of the file or click  Browse Flash to find the file location.

 
       [bookmark: pgfId-1662227]Step 7[image: ] In addition, you can copy a file from your startup configuration, running configuration, or an SMB file system through the CLI. For instructions about using the  copy command, see the CLI configuration guide.

 
       [bookmark: pgfId-1662231]Step 8[image: ] Define the destination of the file to be transferred.

 
       [bookmark: pgfId-1662232] a.[image: ] To transfer the file to the flash file system, choose the  Flash file system option.

 
       [bookmark: pgfId-1662233] b.[image: ] Enter the path to the location of the file or click  Browse Flash to find the file location.

 
       [bookmark: pgfId-1662234]Step 9[image: ] To transfer a file to a remote server, choose the  Remote server option.

 
       [bookmark: pgfId-1662235] a.[image: ] Enter the path to the location of the file.

 
       [bookmark: pgfId-1662236] b.[image: ] For FTP transfers, enter the type. Valid types are the following:

 
       [bookmark: pgfId-1662237]–[image: ] ap—ASCII files in passive mode

 
       [bookmark: pgfId-1662238]–[image: ] an—ASCII files in non-passive mode

 
       [bookmark: pgfId-1662239]–[image: ] ip—Binary image files in passive mode

 
       [bookmark: pgfId-1662240]–[image: ] in—Binary image files in non-passive mode

 
       [bookmark: pgfId-1662241]Step 10[image: ] Click  Transfer  to start the file transfer. 

 
       [bookmark: pgfId-1662242]The Enter Username and Password dialog box appears.

 
       [bookmark: pgfId-1662243]Step 11[image: ] Enter the username, password, and domain (if required) for the remote server. 

 
       [bookmark: pgfId-1662244]Step 12[image: ] Click  OK to continue the file transfer.

 
       [bookmark: pgfId-1662245]The file transfer process might take a few minutes; make sure that you wait until it is finished. 

 
       [bookmark: pgfId-1662246]Step 13[image: ] Click  Close when the file transfer is finished.

 
       [bookmark: pgfId-1662247]


       
       
 
      
  
      

 
     
 
   

    
     
      [bookmark: pgfId-1385858][bookmark: 77650]Configuring the Images and Startup Configuration to Use

 
      [bookmark: pgfId-1385862]By default, the ASA boots the first application image that it finds in internal flash memory. It also boots the first ASDM image it finds in internal flash memory, or if one does not exist in this location, then in external flash memory. If you have more than one image, you should specify the image that you want to boot. For the ASDM image, if you do not specify the image to boot, even if you have only one image installed, then the ASA defines the image in the running configuration. To avoid problems with Auto Update (if configured), and to avoid the image search at each startup, you should specify the ASDM image that you want to boot in the startup configuration.

 
      [bookmark: pgfId-1662503]Choose  Configuration > Device Management > System Image/Configuration > Boot Image/Configuration .

 
      [bookmark: pgfId-1662504]You can specify up to four local binary image files for use as the startup image, and one image located on a TFTP server for the device to boot from. If you specify an image located on a TFTP server, it must be first in the list. If the device cannot reach the TFTP server to load the image, it tries to load the next image file in the list located in flash.

 
      [bookmark: pgfId-1662505]If you do not specify any boot variable, the first valid image on internal flash will be chosen to boot the system. The Boot Image/Configuration pane includes the following fields:

 
      
      		 [bookmark: pgfId-1662506]Boot Order—Displays the order in which binary image files will be used to boot. 

 
      		 [bookmark: pgfId-1662507]Boot Image Location—Displays the physical location and path of the boot file.

 
      		 [bookmark: pgfId-1662508]Boot Configuration File Path—Displays the location of the configuration file.

 
      		 [bookmark: pgfId-1662509]Add—Lets you add a flash or TFTP boot image entry to be used in the boot process. For more information, see the “Adding a Boot Image” section.

 
      		 [bookmark: pgfId-1662513]Edit—Lets you edit a flash or TFTP boot image entry.

 
      		 [bookmark: pgfId-1662514]Delete—Deletes the selected flash or TFTP boot image entry.

 
      		 [bookmark: pgfId-1662515]Move Up—Moves the selected flash or TFTP boot image entry up in the boot order.

 
      		 [bookmark: pgfId-1662516]Move Down—Moves the selected flash or TFTP boot image entry down in the boot order.

 
      		 [bookmark: pgfId-1662517]Browse Flash—Lets you specify the location of a boot image or configuration file.

 
      		 [bookmark: pgfId-1662518]ASDM Image File Path—Displays the location of the configuration file to use at startup.

 
     

 
      
       [bookmark: pgfId-1662521][bookmark: 28402]Adding a Boot Image

 
       [bookmark: pgfId-1662522]To add a boot image entry to the boot order list, click  Add in the Boot Image/Configuration pane. 

 
       [bookmark: pgfId-1662523]You can select a flash or TFTP image to add a boot image to the boot order list. 

 
       [bookmark: pgfId-1662524]Either type the path of the image, or click  Browse Flash to specify the image location. You must type the path of the image location if you are using TFTP.

 
       
       		 [bookmark: pgfId-1662525]Flash Image—Select to add a boot image located in the flash file system.

 
      

 
       [bookmark: pgfId-1662526]–[image: ] Path—Specify the path of the boot image in the flash file system.

 
       
       		 [bookmark: pgfId-1662527]TFTP Image—Select to add a boot image located on a TFTP server.

 
      

 
       [bookmark: pgfId-1662528]–[image: ]  [ Path ] —Enter the path of the boot image file on the TFTP server, including the IP address of the server.

 
       
       		 [bookmark: pgfId-1662529]OK—Accepts changes and returns to the previous pane. 

 
       		 [bookmark: pgfId-1662530]Cancel—Discards changes and returns to the previous pane. 

 
       		 [bookmark: pgfId-1662531]Help—Provides more information. 

 
      

 
     
 
    
 
     
      [bookmark: pgfId-1386175] Backing Up  [bookmark: 51626][bookmark: marker-1386173]and Restoring  Configurations or Other Files [bookmark: marker-1386174]

 
      [bookmark: pgfId-1662803][bookmark: 54765]The Backup and Restore features options on the Tools menu let you back up and restore the ASA running configuration, startup configuration, installed add-on images, and SSL VPN Client images and profiles.

 
      [bookmark: pgfId-1662804]The Backup Configurations screen on the ASDM lets you choose the file types to back up, compresses them into a single zip file, then transfer the zip file to the directory that you choose on your computer. Similarly, to restore files, you choose the source zip file on your computer and then choose the file types to be restored.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1662805]Note These tools are only available for single context mode.


      
      
 
     

     

 
      
      		 [bookmark: pgfId-1662813]Backing Up Configurations

 
      		 [bookmark: pgfId-1662817]Backing Up the Local CA Server

 
      		 [bookmark: pgfId-1662821]Restoring Configurations

 
      		 [bookmark: pgfId-1662825]Saving the Running Configuration to a TFTP Server

 
     

 
      
       [bookmark: pgfId-1662870][bookmark: 75872][bookmark: 2H_Head2. Backing Up Configurations]Backing Up Configurations[bookmark: marker-1662869]

 
       [bookmark: pgfId-1662871]This procedure explains how to back up configurations and images to a .zip file and transfer it to your local computer.

 
       
       [image: ] 
      
 
      
 
      
       [bookmark: pgfId-1662872]
       Caution If you have set a master passphrase for the ASA, then you will need that master passphrase to restore the backup configuration that you create with this procedure. If you do not know the master passphrase for the ASA, see the 
       “Configuring the Master Passphrase” section to learn how to reset it before continuing with the backup. 
        
        
 
       

      
 
      
 
       [bookmark: pgfId-1662876] Step 1[image: ] Create a folder on your computer to store backup files so they will be easy to find in case you need to restore them later.

 
       [bookmark: pgfId-1662877]Step 2[image: ] Choose  Tools > Backup Configurations .

 
       [bookmark: pgfId-1662878]The Backup Configurations dialog box appears. Click the down arrow in the SSL VPN Configuration area to view the backup options for SSL VPN configurations. By default, all configuration files are checked and will be backed up if they are available. If you want to back up all of the files in the list, go to Step  5 .

 
       [bookmark: pgfId-1662885] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1662886] 

 
       [bookmark: pgfId-1662887]Step 3[image: ] Uncheck the  Backup All check box if you want to select the configurations to back up.

 
       [bookmark: pgfId-1662888]Step 4[image: ] Check the check box next to the option that you want to back up.

 
       [bookmark: pgfId-1662890]Step 5[image: ] [bookmark: 71398]Click  Browse Local to specify a directory and file name for the backup .zip file. 

 
       [bookmark: pgfId-1662891]Step 6[image: ] In the Select dialog box, choose the directory in which you want to store the backup file.

 
       [bookmark: pgfId-1662892]Step 7[image: ] Click  Select . The path appears in the Backup File field.

 
       [bookmark: pgfId-1662893]Step 8[image: ] Enter the name of the destination backup file after the directory path. The backup file name must be between 3 and 232 characters long.

 
       [bookmark: pgfId-1662894]Step 9[image: ] Click  Backup . The backup proceeds immediately unless you are backing up certificates or the ASA is using a master[image: ] passphrase.

 
       [bookmark: pgfId-1662895]Step 10[image: ] If you have configured and enabled a master passphrase on your ASA, you receive a warning message with a suggestion to change the master passphrase, if you do not know it, before proceeding with the backup. Click Yes to proceed with the backup if you know the master passphrase. The backup proceeds immediately unless you are backing up identity certificates.

 
       [bookmark: pgfId-1662899] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1662900]Step 11[image: ] If you are backing up an identity certificate, you are asked to enter a separate passphrase to be used for encoding the certificates in PKCS12 format. You can enter a passphrase or skip this step.

 
       
       [image: ] 
      
 
      
 
      [bookmark: pgfId-1662901]Note Identify certificates are backed up by this process; however, certificate authority certificates are not backed up. For instructions on backing up CA certificates, see “Backing Up the Local CA Server” section.


       
       
 
      

      

 
       [bookmark: pgfId-1662908] 

 
       
       [image: ] 
      
 
       
        
        		 [bookmark: pgfId-1662909]To encrypt certificates, enter and confirm your certificate passphrase in the Certificate Passphrase dialog box and click OK. You will need to remember the password you enter in this dialog box when restoring the certificates.

 
        		 [bookmark: pgfId-1662910]Clicking  Cancel  skips the step and does not back up certificates. 

 
       

 
      

 
       [bookmark: pgfId-1662911]After clicking OK or cancel, the backup begins immediately.

 
       [bookmark: pgfId-1662912]Step 12[image: ] After the backup is complete, the status window closes and the Backup Statistics dialog box appears to provide success and failure messages.

 
       
       [image: ] 
      
 
      
 
      [bookmark: pgfId-1662913]Note Backup “failure messages” are most likely caused by the lack of an existing configuration for the types indicated.


       
       
 
      

      

 
       [bookmark: pgfId-1662917] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1662918]Step 13[image: ] Click  OK to close the Backup Statistics dialog box.

 
       [bookmark: pgfId-1662919]


       
       
 
      
  
      

 
     
 
      
       [bookmark: pgfId-1662922][bookmark: 60606][bookmark: marker-1662921]Backing Up the Local CA Server

 
       [bookmark: pgfId-1662923]When you do a ASDM backup, it does not include the local CA server database, so you are not backing up the CA certificates stored on the server. If you want to back up the local CA server, use this manual process with the ASA CLI:

 
      
 
       [bookmark: pgfId-1662924] Step 1[image: ] Enter the show run crypto ca server command.

 
      
       [bookmark: pgfId-1662925]crypto ca server 
      

      
       [bookmark: pgfId-1662926] keysize server 2048
      

      
       [bookmark: pgfId-1662927] subject-name-default OU=aa,O=Cisco,ST=ca, 
      

      
       [bookmark: pgfId-1662928] issuer-name CN=xxx,OU=yyy,O=Cisco,L=Bxb,St=Mass
      

      
       [bookmark: pgfId-1662929] smtp from-address abcd@cisco.com
      

      
       [bookmark: pgfId-1662930] publish-crl inside 80
      

      
       [bookmark: pgfId-1662931] publish-crl outside 80
      

       [bookmark: pgfId-1662932] 

 
       [bookmark: pgfId-1662933]Step 2[image: ] Use the crypto ca import command to import the local CA PKCS12 file to create the LOCAL-CA-SERVER trustpoint and to restore the keypair. 

 
      
       [bookmark: pgfId-1662934]crypto ca import LOCAL-CA-SERVER pkcs12 <passphrase> (paste the pkcs12
      

      
       [bookmark: pgfId-1662935]base64 data here) 
      

       
       [image: ] 
      
 
      
 
      [bookmark: pgfId-1662936]Note Be sure to use the exact name “LOCAL-CA-SERVER” for this step. 


       
       
 
      

      

 
       [bookmark: pgfId-1662937]Step 3[image: ] If the LOCAL-CA-SERVER directory does not exist, you need to create it by entering mkdir  LOCAL-CA-SERVER . 

 
       [bookmark: pgfId-1662938]Step 4[image: ] Copy the local CA files into the LOCAL-CA-SERVER directory.

 
      
       [bookmark: pgfId-1662939]copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.ser
      

      
       [bookmark: pgfId-1662940]disk0:/LOCAL-CA-SERVER/ 
      

      
       [bookmark: pgfId-1662941] 
      

      
       [bookmark: pgfId-1662942]copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.cdb
      

      
       [bookmark: pgfId-1662943]disk0:/LOCAL-CA-SERVER/ 
      

      
       [bookmark: pgfId-1662944] 
      

      
       [bookmark: pgfId-1662945]copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.udb
      

      
       [bookmark: pgfId-1662946]disk0:/LOCAL-CA-SERVER/ 
      

      
       [bookmark: pgfId-1662947] 
      

      
       [bookmark: pgfId-1662948]copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.crl
      

      
       [bookmark: pgfId-1662949]disk0:/LOCAL-CA-SERVER/ 
      

      
       [bookmark: pgfId-1662950] 
      

      
       [bookmark: pgfId-1662951]copy ftp://10.10.1.1/CA-backup/LOCAL-CA-SERVER.p12
      

      
       [bookmark: pgfId-1662952]disk0:/LOCAL-CA-SERVER/ 
      

      
       [bookmark: pgfId-1662953] 
      

       [bookmark: pgfId-1662954]Step 5[image: ] Enter the  crypto ca server command to enable the local CA server 

 
      
       [bookmark: pgfId-1662955] 
      

      
       [bookmark: pgfId-1662956]crypto ca server
      

      
       [bookmark: pgfId-1662957] no shutdown
      

      
       [bookmark: pgfId-1662958] 
      

       [bookmark: pgfId-1662959]Step 6[image: ] Enter the  show crypto ca server command to check that the local CA server is up and running.

 
       [bookmark: pgfId-1662960]Step 7[image: ] Save the configuration. 

 
       [bookmark: pgfId-1662961]


       
       
 
      
  
      

 
     
 
      
       [bookmark: pgfId-1662965][bookmark: 3H_Head3. Restoring Configurations]Restoring Configurations[bookmark: marker-1662964]

 
       [bookmark: pgfId-1662966]You can specify configurations and images to restore from a zip file on your local computer. 

 
       [bookmark: pgfId-1662967]Before proceeding, note these other restrictions:

 
       
       		 [bookmark: pgfId-1662968]The zip file that you restore must be created by choosing the Tools > Backup Configurations option.

 
       		 [bookmark: pgfId-1662969]If you performed the backup with the master passphrase enabled, then you will need that master passphrase in order to restore the running configuration, start-up configuration, and VPN pre-shared keys from the backup you created. If you do not know the master passphrase for the ASA, those items will not be restored during the restore process. See the “Configuring the Master Passphrase” section for more information on master passphrases.

 
       		 [bookmark: pgfId-1662973]If you specified a certificate passphrase during the backup, you will be asked to provide that passphrase in order to restore the certificates. The default passphrase is  cisco .

 
       		 [bookmark: pgfId-1662974]The DAP configuration may depend on a specific running configuration, URL list, and CSD configuration.

 
       		 [bookmark: pgfId-1662975]The CSD configuration may depend on the version of the CSD image.

 
       		 [bookmark: pgfId-1662979]You can restore components, images, and configurations using backups made from the same ASA type. You must start with a basic configuration that allows ASDM access. 

 
       		 [bookmark: pgfId-1662980]If you import PKCS12 data (with the  crypto ca trustpoint command) and the trustpoint uses RSA keys, the imported key pair is assigned the same name as the trustpoint. Because of this limitation, if you specify a different name for the trustpoint and its key pair after you have restored an ASDM configuration, the startup configuration will be the same as the original configuration, but the running configuration will include a different key pair name. This means that if you use different names for the key pair and trustpoint, you cannot restore the original configuration. To work around this issue, make sure that you use the same name for the trustpoint and its key pair.

 
      

 
       [bookmark: pgfId-1662984]To restore selected elements of the ASA configuration, Cisco Secure Desktop image, or SSL VPN Client images and profiles, perform the following steps:

 
      
 
       [bookmark: pgfId-1662985] Step 1[image: ] Choose  Tools > Restore Configurations .

 
       [bookmark: pgfId-1662986]Step 2[image: ] In the Restore Configurations dialog box, click  Browse Local Directory , choose the zip file on your local computer that contains the configuration to restore, then click  Select . The path and the zip filename appear in the Local File field.

 
       [bookmark: pgfId-1662990] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1662991]Step 3[image: ] Click  Next . The second Restore Configuration dialog box appears. Check the check boxes next to the configurations that you want to restore. All available SSL VPN configurations are selected by default. 

 
       [bookmark: pgfId-1662995] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1662996]Step 4[image: ] Click  Restore .

 
       [bookmark: pgfId-1662997]Step 5[image: ] If you specified a certificate passphrase with which to encrypt the certificates when you created the backup file, ASDM prompts you to enter the passphrase.

 
       [bookmark: pgfId-1663001] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1663002]Step 6[image: ] If you chose to restore the running configuration, you are asked if you want to merge the running configuration, replace the running configuration, or skip this part of the restoration process.

 
       
        
        		 [bookmark: pgfId-1663003]Merging configurations combines the current running configuration and the backed-up running configuration.

 
        		 [bookmark: pgfId-1663004]Replacing the running configuration uses the backed-up running configuration only.

 
        		 [bookmark: pgfId-1663005]Skipping the step does not restore the backed-up running configuration.

 
       

 
      

 
       [bookmark: pgfId-1663006]ASDM displays a status dialog box until the restore operation is finished.

 
       [bookmark: pgfId-1663007]Step 7[image: ] If you replaced or merged the running configuration, close ASDM and restart it. If you did not restore the running configuration or the running configuration, refresh the ASDM session for the changes to take effect.

 
       [bookmark: pgfId-1663008]


       
       
 
      
  
      

 
     
 
      
       [bookmark: pgfId-1663011][bookmark: 57410]Saving the Running Configuration to a TFTP Server

 
       [bookmark: pgfId-1663012]This feature stores a copy of the current running configuration file on a TFTP server.

 
       [bookmark: pgfId-1663013]To save the running configuration to a TFTP server, perform the following steps:

 
      
 
       [bookmark: pgfId-1663014] Step 1[image: ] In the main ASDM application window, choose  File > Save Running Configuration to TFTP Server .

 
       [bookmark: pgfId-1663015]The Save Running Configuration to TFTP Server dialog box appears.

 
       [bookmark: pgfId-1663016]Step 2[image: ] Enter the TFTP server IP address and file path on the TFTP server in which the configuration file will be saved, and then click  Save Configuration . 

 
       
       [image: ] 
      
 
      
 
      [bookmark: pgfId-1663017]Note To configure default TFTP settings, choose Configuration > Device Management > Management Access > File Access > TFTP Client. After you have configured this setting, the TFTP server IP address and file path on the TFTP server appear automatically in this dialog box. 


       
       
 
      

      

 
       [bookmark: pgfId-1663018]


       
       
 
      
  
      

 
     
 
    
 
     
      [bookmark: pgfId-1663021][bookmark: 26827]Scheduling a System Restart

 
      [bookmark: pgfId-1663022]The System Reload tool lets you schedule a system restart or cancel a pending restart.

 
      [bookmark: pgfId-1663023]To schedule a system restart, perform the following steps:

 
     
 
      [bookmark: pgfId-1663024] Step 1[image: ] In the main ASDM application window, choose  Tools > System[image: ] Reload .

 
      [bookmark: pgfId-1663025]Step 2[image: ] In the Reload Scheduling area, define the following settings:

 
      [bookmark: pgfId-1663026] a.[image: ] For the Configuration State, choose either to save or discard the running configuration at restart time.

 
      [bookmark: pgfId-1663027] b.[image: ] For the Reload Start Time, choose from the following options:

 
      [bookmark: pgfId-1663028]–[image: ] Click  Now to perform an immediate restart.

 
      [bookmark: pgfId-1663029]–[image: ] Click  Delay by to delay the restart by a specified amount of time. Enter the time before the restart begins in hours and minutes or only minutes.

 
      [bookmark: pgfId-1663030]–[image: ] Click  Schedule at to schedule the restart to occur at a specific time and date. Enter the time of day the restart is to occur, and select the date of the scheduled restart.

 
      [bookmark: pgfId-1663034] c.[image: ] In the Reload Message field, enter a message to send to open instances of ASDM at restart time.

 
      [bookmark: pgfId-1663035] d.[image: ] Check the  On reload failure force immediate reload after check box to show the amount of time elapsed in hours and minutes or only minutes before a restart is attempted again.

 
      [bookmark: pgfId-1663036] e.[image: ] Click  Schedule Reload to schedule the restart as configured.

 
      [bookmark: pgfId-1663037]The Reload Status area displays the status of the restart.

 
      [bookmark: pgfId-1663038]Step 3[image: ] Choose one of the following:

 
      
       
       		 [bookmark: pgfId-1663039]Click  Cancel Reload to stop a scheduled restart.

 
       		 [bookmark: pgfId-1663040]Click  Refresh to refresh the Reload Status display after a scheduled restart is finished.

 
       		 [bookmark: pgfId-1663041]Click  Details to display the results of a scheduled restart.

 
      

 
     

 
      [bookmark: pgfId-1663042]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1172799][bookmark: 62025]Downgrading Your Software

 
      [bookmark: pgfId-1172800]When you upgrade to Version 8.3, your configuration is migrated. The old configuration is automatically stored in flash memory. For example, when you upgrade from Version 8.2(1) to 8.3(1), the old 8.2(1) configuration is stored in flash memory in a file called 8_2_1_0_startup_cfg.sav. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1268777]Note You must manually restore the old configuration before downgrading.


      
      
 
     

     

 
      [bookmark: pgfId-1172801]This section describes how to downgrade and includes the following topics:

 
      
      		 [bookmark: pgfId-1172805]Information About Activation Key Compatibility

 
      		 [bookmark: pgfId-1172809]Performing the Downgrade

 
     

 
      
       [bookmark: pgfId-1172811][bookmark: 99373]Information About Activation Key Compatibility

 
       [bookmark: pgfId-1172812]Your activation key remains compatible if you upgrade to the latest version from any previous version. However, you might have issues if you want to maintain downgrade capability:

 
       
       		 [bookmark: pgfId-1172813]Downgrading to Version 8.1 or earlier versions—After you upgrade, if you activate additional feature licenses that were introduced  before 8.2 , the activation key continues to be compatible with earlier versions if you downgrade. However if you activate feature licenses that were introduced in Version 8.2 or later versions, the activation key is not backwards compatible. If you have an incompatible license key, see the following guidelines:

 
      

 
       [bookmark: pgfId-1172816]–[image: ] If you previously entered an activation key in an earlier version, the ASA uses that key (without any of the new licenses you activated in Version 8.2 or later versions).

 
       [bookmark: pgfId-1172818]–[image: ] If you have a new system and do not have an earlier activation key, you need to request a new activation key compatible with the earlier version.

 
       
       		 [bookmark: pgfId-1172819]Downgrading to Version 8.2 or earlier versions—Version 8.3 introduced more robust time-based key usage as well as failover license changes:

 
      

 
       [bookmark: pgfId-1172820]–[image: ] If you have more than one time-based activation key active, when you downgrade, only the most recently activated time-based key can be active. Any other keys are made inactive.

 
       [bookmark: pgfId-1176599]–[image: ] If you have mismatched licenses on a failover pair, downgrading will disable failover. Even if the keys are matching, the license used will no longer be a combined license.

 
     
 
      
       [bookmark: pgfId-1176602][bookmark: 28632]Performing the Downgrade

 
       [bookmark: pgfId-1663589]See the “The Backup and Restore features options on the Tools menu let you back up and restore the ASA running configuration, startup configuration, installed add-on images, and SSL VPN Client images and profiles.” section for more information about configuration migration. 

 
       [bookmark: pgfId-1259165]To downgrade from Version 8.3, perform the following steps: 

 
     
 
      
       [bookmark: pgfId-1172825]Detailed Steps

 
      
 
       [bookmark: pgfId-1663595] Step 1[image: ] Choose  Tools > Downgrade Software .

 
       [bookmark: pgfId-1663596]The Downgrade Software dialog box appears.

 
       [bookmark: pgfId-1663597]Figure 46-1 Downgrade Software

 
       [bookmark: pgfId-1663601] 

 
       
       [image: ] 
      
 
       [bookmark: pgfId-1663602]Step 2[image: ] For the ASA Image, click  Select Image File .

 
       [bookmark: pgfId-1663603]The Browse File Locations dialog box appears. 

 
       [bookmark: pgfId-1663604]Step 3[image: ] Click one of the following radio buttons:

 
       
       		 [bookmark: pgfId-1663605] Remote Server —Choose  ftp ,  smb , or  http from the drop-down list, and type the path to the old image file.

 
       		 [bookmark: pgfId-1663606] Flash File System —Click  Browse Flash to choose the old image file on the local flash file system.

 
      

 
       [bookmark: pgfId-1663607]Step 4[image: ] For the Configuration, click  Browse Flash  to choose the pre-migration configuration file. (By default this was saved on disk0).

 
       [bookmark: pgfId-1663608]Step 5[image: ] (Optional) In the Activation Key field, enter the old activation key if you need to revert to a pre-8.3 activation key.

 
       [bookmark: pgfId-1663612]See the “Information About Activation Key Compatibility” section for more information.

 
       [bookmark: pgfId-1663613]Step 6[image: ] Click  Downgrade .

 
       [bookmark: pgfId-1663614]This tool is a shortcut for completing the following functions:

 
       [bookmark: pgfId-1663615] 1.[image: ] Clearing the boot image configuration ( clear configure boot ).

 
       [bookmark: pgfId-1663616] 2.[image: ] Setting the boot image to be the old image ( boot system ).

 
       [bookmark: pgfId-1663617] 3.[image: ] (Optional) Entering a new activation key ( activation-key ).

 
       [bookmark: pgfId-1663618] 4.[image: ] Saving the running configuration to startup ( write memory ). This sets the BOOT environment variable to the old image, so when you reload, the old image is loaded.

 
       [bookmark: pgfId-1663619] 5.[image: ] Copying the old configuration to the startup configuration ( copy  old_config_url  startup-config ).

 
       [bookmark: pgfId-1663620] 6.[image: ] Reloading ( reload ).

 
       [bookmark: pgfId-1663621]


       
       
 
      
  
      

 
     
 
    
 
     
      [bookmark: pgfId-1391111][bookmark: 1H_Head1. Configuring Auto Update]Configuring [bookmark: 97486][bookmark: 49498][bookmark: 81331]Auto Update 

 
      [bookmark: pgfId-1391112]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1392599]Information About Auto Update

 
      		 [bookmark: pgfId-1546876]Guidelines and Limitations

 
      		 [bookmark: pgfId-1392622]Configuring Communication with an Auto Update Server

 
     

 
      
       [bookmark: pgfId-1391295][bookmark: 40480]Information About Auto Update

 
       [bookmark: pgfId-1392381][bookmark: marker-1392380]Auto Update is a protocol specification that allows an Auto Update Server to download configurations and software images to many ASAs and can provide basic monitoring of the ASAs from a central location.

 
       
       		 [bookmark: pgfId-1547123]Auto Update Client or Server

 
       		 [bookmark: pgfId-1547143]Auto Update Benefits

 
       		 [bookmark: pgfId-1547164]Auto Update Server Support in Failover Configurations

 
      

 
     
 
      
       [bookmark: pgfId-1547085][bookmark: 90296]Auto Update Client or Server

 
       [bookmark: pgfId-1392391]The ASA can be configured as either a client or a server. As an Auto Update client, it periodically polls the Auto Update Server for updates to software images and configuration files. As an Auto Update Server, it issues updates for ASAs configured as Auto Update clients.

 
     
 
      
       [bookmark: pgfId-1547099][bookmark: 57747]Auto Update Benefits

 
       [bookmark: pgfId-1391131]Auto Update is useful in solving many issues facing administrators for ASA management, such as:

 
       
       		 [bookmark: pgfId-1391132]Overcoming dynamic addressing and NAT challenges.

 
       		 [bookmark: pgfId-1391133]Committing configuration changes in one action.

 
       		 [bookmark: pgfId-1391134]Providing a reliable method for updating software.

 
       		 [bookmark: pgfId-1391135]Leveraging well-understood methods for high availability (failover).

 
       		 [bookmark: pgfId-1391136]Providing flexibility with an open interface.

 
       		 [bookmark: pgfId-1391137]Simplifying security solutions for Service Provider environments.

 
      

 
       [bookmark: pgfId-1391138]The Auto Update specification provides the infrastructure necessary for remote management applications to download ASA configurations, software images, and to perform basic monitoring from a centralized location or multiple locations.

 
       [bookmark: pgfId-1391142]The Auto Update specification allows the Auto Update server to either push configuration information and send requests for information to the ASA, or to pull configuration information by having the ASA periodically poll the Auto Update server. The Auto Update server can also send a command to the ASA to send an immediate polling request at any time. Communication between the Auto Update server and the ASA requires a communications path and local CLI configuration on each ASA.

 
     
 
      
       [bookmark: pgfId-1546888][bookmark: 79243]Auto Update Server Support in Failover Configurations

 
       [bookmark: pgfId-1546892]You can use the Auto Update Server to deploy software images and configuration files to ASAs in an Active/Standby failover configuration. To enable Auto Update on an Active/Standby failover configuration, enter the Auto Update Server configuration on the primary unit in the failover pair.

 
       [bookmark: pgfId-1546896]The following restrictions and behaviors apply to Auto Update Server support in failover configurations:

 
       
       		 [bookmark: pgfId-1546897]Only single mode, Active/Standby configurations are supported.

 
       		 [bookmark: pgfId-1546898]When loading a new platform software image, the failover pair stops passing traffic.

 
       		 [bookmark: pgfId-1546899]When using LAN-based failover, new configurations must not change the failover link configuration. If they do, communication between the units will fail.

 
       		 [bookmark: pgfId-1546900]Only the primary unit will perform the call home to the Auto Update Server. The primary unit must be in the active state to call home. If it is not, the ASA automatically fails over to the primary unit.

 
       		 [bookmark: pgfId-1546904]Only the primary unit downloads the software image or configuration file. The software image or configuration is then copied to the secondary unit.

 
       		 [bookmark: pgfId-1546905]The interface MAC address and hardware-serial ID is from the primary unit.

 
       		 [bookmark: pgfId-1546906]The configuration file stored on the Auto Update Server or HTTP server is for the primary unit only.

 
      

 
     
 
      
       [bookmark: pgfId-1546907]Auto Update Process Overview

 
       [bookmark: pgfId-1546908]The following is an overview of the Auto Update process in failover configurations. This process assumes that failover is enabled and operational. The Auto Update process cannot occur if the units are synchronizing configurations, if the standby unit is in the failed state for any reason other than SSM card failure, or if the failover link is down.

 
       [bookmark: pgfId-1546909] 1.[image: ] Both units exchange the platform and ASDM software checksum and version information.

 
       [bookmark: pgfId-1546910] 2.[image: ] The primary unit contacts the Auto Update Server. If the primary unit is not in the active state, the ASA first fails over to the primary unit and then contacts the Auto Update Server.

 
       [bookmark: pgfId-1546914] 3.[image: ] The Auto Update Server replies with software checksum and URL information.

 
       [bookmark: pgfId-1546915] 4.[image: ] If the primary unit determines that the platform image file needs to be updated for either the active or standby unit, the following occurs:

 
       [bookmark: pgfId-1546916] a.[image: ] The primary unit retrieves the appropriate files from the HTTP server using the URL from the Auto Update Server.

 
       [bookmark: pgfId-1546917] b.[image: ] The primary unit copies the image to the standby unit and then updates the image on itself.

 
       [bookmark: pgfId-1546918] c.[image: ] If both units have new image, the secondary (standby) unit is reloaded first. 

 
       [bookmark: pgfId-1546919]–[image: ] If hitless upgrade can be performed when secondary unit boots, then the secondary unit becomes the active unit and the primary unit reloads. The primary unit becomes the active unit when it has finished loading.

 
       [bookmark: pgfId-1546920]–[image: ] If hitless upgrade cannot be performed when the standby unit boots, then both units reload at the same time. 

 
       [bookmark: pgfId-1546921] d.[image: ] If only the secondary (standby) unit has new image, then only the secondary unit reloads. The primary unit waits until the secondary unit finishes reloading.

 
       [bookmark: pgfId-1546922] e.[image: ] If only the primary (active) unit has new image, the secondary unit becomes the active unit, and the primary unit reloads.

 
       [bookmark: pgfId-1546923] f.[image: ] The update process starts again at Step 1.

 
       [bookmark: pgfId-1546927] 5.[image: ] If the ASA determines that the ASDM file needs to be updated for either the primary or secondary unit, the following occurs:

 
       [bookmark: pgfId-1546928] a.[image: ] The primary unit retrieves the ASDM image file from the HTTP server using the URL provided by the Auto Update Server.

 
       [bookmark: pgfId-1546929] b.[image: ] The primary unit copies the ASDM image to the standby unit, if needed.

 
       [bookmark: pgfId-1546930] c.[image: ] The primary unit updates the ASDM image on itself.

 
       [bookmark: pgfId-1546931] d.[image: ] The update process starts again at Step 1.

 
       [bookmark: pgfId-1546932] 6.[image: ] If the primary unit determines that the configuration needs to be updated, the following occurs: 

 
       [bookmark: pgfId-1546933] a.[image: ] The primary unit retrieves the configuration file from the using the specified URL. 

 
       [bookmark: pgfId-1546934] b.[image: ] The new configuration replaces the old configuration on both units simultaneously. 

 
       [bookmark: pgfId-1546935] c.[image: ] The update process begins again at Step 1.

 
       [bookmark: pgfId-1546936] 7.[image: ] If the checksums match for all image and configuration files, no updates are required. The process ends until the next poll time.

 
     
 
      
       [bookmark: pgfId-1546937]Monitoring the Auto Update Process

 
       [bookmark: pgfId-1546938]You can use the  debug auto-update client or  debug fover cmd-exe commands to display the actions performed during the Auto Update process. The following is sample output from the  debug auto-update client command. Run  debug commands from a terminal session.

 
      
       [bookmark: pgfId-1546939]Auto-update client: Sent DeviceDetails to /cgi-bin/dda.pl of server 192.168.0.21
      

      
       [bookmark: pgfId-1546940]Auto-update client: Processing UpdateInfo from server 192.168.0.21
      

      
       [bookmark: pgfId-1546941] Component: asdm, URL: http://192.168.0.21/asdm.bint, checksum: 0x94bced0261cc992ae710faf8d244cf32
      

      
       [bookmark: pgfId-1546942] Component: config, URL: http://192.168.0.21/config-rms.xml, checksum: 0x67358553572688a805a155af312f6898
      

      
       [bookmark: pgfId-1546943] Component: image, URL: http://192.168.0.21/cdisk73.bin, checksum: 0x6d091b43ce96243e29a62f2330139419
      

      
       [bookmark: pgfId-1546944]Auto-update client: need to update img, act: yes, stby yes
      

      
       [bookmark: pgfId-1546945]name
      

      
       [bookmark: pgfId-1546946]ciscoasa(config)# Auto-update client: update img on stby unit...
      

      
       [bookmark: pgfId-1546947]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1, len = 1024
      

      
       [bookmark: pgfId-1546948]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 501, len = 1024
      

      
       [bookmark: pgfId-1546949]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1001, len = 1024
      

      
       [bookmark: pgfId-1546950]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 1501, len = 1024
      

      
       [bookmark: pgfId-1546951]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 2001, len = 1024
      

      
       [bookmark: pgfId-1546952]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 2501, len = 1024
      

      
       [bookmark: pgfId-1546953]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 3001, len = 1024
      

      
       [bookmark: pgfId-1546954]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 3501, len = 1024
      

      
       [bookmark: pgfId-1546955]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 4001, len = 1024
      

      
       [bookmark: pgfId-1546956]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 4501, len = 1024
      

      
       [bookmark: pgfId-1546957]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 5001, len = 1024
      

      
       [bookmark: pgfId-1546958]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 5501, len = 1024
      

      
       [bookmark: pgfId-1546959]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 6001, len = 1024
      

      
       [bookmark: pgfId-1546960]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 6501, len = 1024
      

      
       [bookmark: pgfId-1546961]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 7001, len = 1024
      

      
       [bookmark: pgfId-1546962]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 7501, len = 1024
      

      
       [bookmark: pgfId-1546963]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 8001, len = 1024
      

      
       [bookmark: pgfId-1546964]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 8501, len = 1024
      

      
       [bookmark: pgfId-1546965]auto-update: Fover copyfile, seq = 4 type = 1, pseq = 9001, len = 1024
      

      
       [bookmark: pgfId-1546966]auto-update: Fover file copy waiting at clock tick 6129280
      

      
       [bookmark: pgfId-1546967]fover_parse: Rcvd file copy ack, ret = 0, seq = 4
      

      
       [bookmark: pgfId-1546968]auto-update: Fover filecopy returns value: 0 at clock tick 6150260, upd time 145980 msecs
      

      
       [bookmark: pgfId-1546969]Auto-update client: update img on active unit...
      

      
       [bookmark: pgfId-1546970]fover_parse: Rcvd image info from mate
      

      
       [bookmark: pgfId-1546971]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546972]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546973]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546974]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546975]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546976]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546977]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546978]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546979]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546980]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546981]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546982]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546983]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546984]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546985]auto-update: HA safe reload: reload active waiting with mate state: 20
      

      
       [bookmark: pgfId-1546986]Beginning configuration replication: Sending to mate.
      

      
       [bookmark: pgfId-1546987]auto-update: HA safe reload: reload active waiting with mate state: 50
      

      
       [bookmark: pgfId-1546988]auto-update: HA safe reload: reload active waiting with mate state: 50
      

      
       [bookmark: pgfId-1546989] 
      

      
       [bookmark: pgfId-1546990]auto-update: HA safe reload: reload active waiting with mate state: 80
      

      
       [bookmark: pgfId-1546991] Sauto-update: HA safe reload: reload active unit at clock tick: 6266860
      

      
       [bookmark: pgfId-1546992]Auto-update client: Succeeded: Image, version: 0x6d091b43ce96243e29a62f2330139419
      

      
       [bookmark: pgfId-1546993] 
      

       [bookmark: pgfId-1546994]The following syslog message is generated if the Auto Update process fails:

 
      
       [bookmark: pgfId-1546995]%ASA4-612002: Auto Update failed: file version: version reason: reason
      

      
       [bookmark: pgfId-1546996] 
      

       [bookmark: pgfId-1546997]The  file is “image”, “asdm”, or “configuration”, depending on which update failed. The  version is the version number of the update. And the  reason is the reason that the update failed.

 
     
 
      
       [bookmark: pgfId-1391158][bookmark: 39143]Guidelines and Limitations

 
       
       		 [bookmark: pgfId-1663692]If the ASA configuration is updated from an Auto Update server, ASDM is not notified. You must choose  Refresh or  File > Refresh    ASDM    with the Running Configuration on the Device   to obtain the latest configuration, and any changes to the configuration made in ASDM will be lost.

 
       		 [bookmark: pgfId-1391175]If HTTPS is chosen as the protocol to communicate with the Auto Update server, the ASA uses SSL, which requires the ASA to have a DES or 3DES license.

 
       		 [bookmark: pgfId-1392974]Auto Update is supported in single context mode only.

 
      

 
     
 
      
       [bookmark: pgfId-1393027][bookmark: 64752][bookmark: 38906]Configuring Communication with an Auto Update Server

 
     
 
      
       [bookmark: pgfId-1392977]Detailed Steps

 
       [bookmark: pgfId-1663703]To configure the Auto Update feature, choose  Configuration > Device Management > System Image/Configuration > Auto Update . The Auto Update pane consists of an Auto Update Servers table and two areas: the Timeout area and the Polling area.

 
       [bookmark: pgfId-1663704]The Auto Update Servers table lets you view the parameters of previously configured Auto Update servers. The ASA polls the server listed at the top of the table first. To change the order of the servers in the table, click  Move Up or  Move Down . The Auto Update Servers table includes the following columns:

 
       
       		 [bookmark: pgfId-1663708]Server—The name or IP address of the Auto Update server.

 
       		 [bookmark: pgfId-1663709]User Name—The user name used to access the Auto Update server. 

 
       		 [bookmark: pgfId-1663710]Interface—The interface used when sending requests to the Auto Update server.

 
       		 [bookmark: pgfId-1663714]Verify Certificate—Indicates whether the ASA checks the certificate returned by the Auto Update server with the CA root certificates. The Auto Update server and the ASA must use the same CA. 

 
      

 
       [bookmark: pgfId-1663718]Double-clicking any of the rows in the Auto Update Server table opens the Edit Auto Update Server dialog box, in which you can modify the Auto Update server parameters. These changes are immediately reflected in the table, but you must click  Apply to save them to the configuration.

 
       [bookmark: pgfId-1663722]The Timeout area lets you set the amount of time the ASA waits for the Auto Update server to time out. The Timeout area includes the following fields:

 
       
       		 [bookmark: pgfId-1663726]Enable Timeout Period—Check to enable the ASA to time out if no response is received from the Auto Update server.

 
       		 [bookmark: pgfId-1663730]Timeout Period (Minutes)—Enter the number of minutes the ASA will wait to time out if no response is received from the Auto Update server. 

 
      

 
       [bookmark: pgfId-1663734]The Polling area lets you configure how often the ASA will poll for information from the Auto Update server. The Polling area includes the following fields:

 
       
       		 [bookmark: pgfId-1663738]Polling Period (minutes)—The number of minutes the ASA will wait to poll the Auto Update server for new information.

 
       		 [bookmark: pgfId-1663739]Poll on Specified Days—Allows you to specify a polling schedule.

 
       		 [bookmark: pgfId-1663740]Set Polling Schedule—Displays the Set Polling Schedule dialog box where you can configure the days and time-of-day to poll the Auto Update server.

 
       		 [bookmark: pgfId-1663744]Retry Period (minutes)—The number of minutes the ASA will wait to poll the Auto Update server for new information if the attempt to poll the server fails.

 
       		 [bookmark: pgfId-1663748]Retry Count—The number of times the ASA will attempt to retry to poll the Auto Update server for new information.

 
      

 
     
 
      
       [bookmark: pgfId-1663751][bookmark: 2H_Head2. Adding or Editing an Auto Update Server]Adding or Editing an Auto Update Server

 
       [bookmark: pgfId-1663752]The Add/Edit Auto Update Server dialog box includes the following fields:

 
       
       		 [bookmark: pgfId-1663756]URL—The protocol that the Auto Update server uses to communicate with the ASA, either HTTP or HTTPS, and the path to the Auto Update server.

 
       		 [bookmark: pgfId-1663757]Interface—The interface to use when sending requests to the Auto Update server.

 
       		 [bookmark: pgfId-1663761]Verify Certificate—Click to enable the ASA to verify the certificate returned by the Auto Update server with the CA root certificates. The Auto Update server and the ASA must use the same CA. 

 
      

 
       [bookmark: pgfId-1663765]The User area includes the following fields:

 
       
       		 [bookmark: pgfId-1663766]User Name (Optional)—Enter the user name needed to access the Auto Update server. 

 
       		 [bookmark: pgfId-1663767]Password—Enter the user password for the Auto Update server. 

 
       		 [bookmark: pgfId-1663768]Confirm Password—Reenter the user password for the Auto Update server. 

 
       		 [bookmark: pgfId-1663769]Use Device ID to uniquely identify the ASA—Enables authentication using a device ID. The device ID is used to uniquely identify the ASA to the Auto Update server. 

 
       		 [bookmark: pgfId-1663773]Device ID—Type of device ID to use.

 
      

 
       [bookmark: pgfId-1663774]–[image: ] Hostname—The name of the host.

 
       [bookmark: pgfId-1663775]–[image: ] Serial Number—The device serial number.

 
       [bookmark: pgfId-1663776]–[image: ] IP Address on interface—The IP address of the selected interface, used to uniquely identify the ASA to the Auto Update server.

 
       [bookmark: pgfId-1663780]–[image: ] MAC Address on interface—The MAC address of the selected interface, used to uniquely identify the ASA to the Auto Update server.

 
       [bookmark: pgfId-1392790]–[image: ] User-defined value—A unique user ID.

 
     
 
      
       [bookmark: pgfId-1663791][bookmark: 2H_Head2. Setting the Polling Schedule]Setting the Polling Schedule

 
       [bookmark: pgfId-1663795]The Set Polling Schedule dialog box lets you configure specific days and the time-of-day for the ASA to poll the Auto Update server.

 
       [bookmark: pgfId-1663796]The Set Polling Schedule dialog box includes the following fields:

 
       [bookmark: pgfId-1663800]Days of the Week—Check the days of the week that you want the ASA to poll the Auto Update server.

 
       [bookmark: pgfId-1663804]The Daily Update pane group lets you configure the time of day when you want the ASA to poll the Auto Update server, and includes the following fields:

 
       
       		 [bookmark: pgfId-1663805]Start Time—Enter the hour and minute to begin the Auto Update poll.

 
       		 [bookmark: pgfId-1663809]Enable randomization—Check to enable the ASA to randomly choose a time to poll the Auto Update server.

 
      

 
     
 
    
 
     
      [bookmark: pgfId-1688630]Feature History for Software and Configurations

 
      [bookmark: pgfId-1688634] Table 46-2  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
      [bookmark: pgfId-1657874] 

 
      
       
        
         [bookmark: pgfId-1688641]Table 46-2 [bookmark: 50557]Feature History for Software and Configurations 

 
        
       
         
         		
           
           [bookmark: pgfId-1688647]Feature Name
          
  
         		
           
           [bookmark: pgfId-1688649]Platform Releases
          
  
         		
           
           [bookmark: pgfId-1688651]Feature Information
          
  
        

 
         
         		 [bookmark: pgfId-1688653]Secure Copy client

  
         		 [bookmark: pgfId-1688655]9.1(5)

  
         		 [bookmark: pgfId-1688660]The ASA now supports the Secure Copy (SCP) client to transfer files to and from a SCP server.

  [bookmark: pgfId-1688663]We modified the following screens:

  [bookmark: pgfId-1688664]Tools > File Management > File Transfer > Between Remote Server and Flash
  Configuration > Device Management > Management Access > File Access > Secure Copy (SCP) Server 
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     [bookmark: pgfId-1052814][bookmark: 16034]Configuring RADIUS Servers for AAA
      
      
 
     
 

 
     [bookmark: pgfId-1052815]This chapter describes how to configure RADIUS servers for AAA and includes the following sections:

 
     
     		 [bookmark: pgfId-1052820]Information About RADIUS Servers

 
     		 [bookmark: pgfId-1052824]Licensing Requirements for RADIUS Servers

 
     		 [bookmark: pgfId-1234014]Guidelines and Limitations

 
     		 [bookmark: pgfId-1234018]Configuring RADIUS Servers

 
     		 [bookmark: pgfId-1259463]Testing RADIUS Server Authentication and Authorization

 
     		 [bookmark: pgfId-1052840]Monitoring RADIUS Servers

 
     		 [bookmark: pgfId-1052844]Additional References

 
     		 [bookmark: pgfId-1052848]Feature History for RADIUS Servers

 
    

 
   
 
    
     [bookmark: pgfId-1052852][bookmark: 17790]Information About RADIUS Servers[bookmark: marker-1052851]

 
     [bookmark: pgfId-1232366]The ASA supports the following RFC-compliant RADIUS servers for AAA: 

 
     
     		 [bookmark: pgfId-1222055]Cisco Secure ACS 3.2, 4.0, 4.1, 4.2, and 5.x

 
     		 [bookmark: pgfId-1222056]Cisco Identity Services Engine (ISE)

 
     		 [bookmark: pgfId-1222057]RSA RADIUS in RSA Authentication Manager 5.2, 6.1, and 7.x

 
     		 [bookmark: pgfId-1222058]Microsoft

 
    

 
     [bookmark: pgfId-1232557]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1232577]Supported Authentication Methods

 
     		 [bookmark: pgfId-1232592]User Authorization of VPN Connections

 
     		 [bookmark: pgfId-1232597]Supported Sets of RADIUS Attributes

 
     		 [bookmark: pgfId-1232606]Supported RADIUS Authorization Attributes

 
     		 [bookmark: pgfId-1232610]Supported IETF RADIUS Authorization Attributes

 
     		 [bookmark: pgfId-1232622]RADIUS Accounting Disconnect Reason Codes

 
    

 
     
      [bookmark: pgfId-1222120][bookmark: 77318]Supported Authentication Methods

 
      [bookmark: pgfId-1232386]The ASA supports the following authentication methods with RADIUS servers:[bookmark: marker-1222154]

 
      
      		 [bookmark: pgfId-1222121]PAP—For all connection types.

 
      		 [bookmark: pgfId-1222122]CHAP and MS-CHAPv1—For L2TP-over-IPsec connections.

 
      		 [bookmark: pgfId-1222123]MS-CHAPv2—For L2TP-over-IPsec connections, and for regular IPsec remote access connections when the password management feature is enabled. You can also use MS-CHAPv2 with clientless connections.

 
      		 [bookmark: pgfId-1238059]Authentication Proxy modes—For RADIUS-to Active-Directory, RADIUS-to-RSA/SDI, RADIUS- to-Token server, and RSA/SDI-to-RADIUS connections,

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1238063]Note To enable MS-CHAPv2 as the protocol used between the ASA and the RADIUS server for a VPN connection, password management must be enabled in the tunnel group general attributes. Enabling password management generates an MS-CHAPv2 authentication request from the ASA to the RADIUS server. See the description of the password-management command for details.

If you use double authentication and enable password management in the tunnel group, then the primary and secondary authentication requests include MS-CHAPv2 request attributes. If a RADIUS server does not support MS-CHAPv2, then you can configure that server to send a non-MS-CHAPv2 authentication request by using the no mschapv2-capable command.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1222184][bookmark: 61269]User Authorization of VPN Connections

 
      [bookmark: pgfId-1232397]The ASA can use RADIUS servers for user authorization of VPN remote access and firewall cut-through-proxy sessions using dynamic ACLs or ACL names per user. To implement dynamic ACLs, you must configure the RADIUS server to support them. When the user authenticates, the RADIUS server sends a downloadable ACL or ACL name to the ASA. Access to a given service is either permitted or denied by the ACL. The ASA deletes the ACL when the authentication session expires.

 
      [bookmark: pgfId-1222194]In addition to ACLs, the ASA supports many other attributes for authorization and setting of permissions for VPN remote access and firewall cut-through proxy sessions.

 
    
 
     
      [bookmark: pgfId-1223669][bookmark: 39991]Supported Sets of RADIUS Attributes

 
      [bookmark: pgfId-1232417]The ASA supports the following sets of RADIUS attributes:

 
      
      		 [bookmark: pgfId-1223670]Authentication attributes defined in RFC 2138.

 
      		 [bookmark: pgfId-1223671]Accounting attributes defined in RFC 2139.

 
      		 [bookmark: pgfId-1223672]RADIUS attributes for tunneled protocol support, defined in RFC 2868.

 
      		 [bookmark: pgfId-1223673]Cisco IOS Vendor-Specific Attributes (VSAs), identified by RADIUS vendor ID 9.

 
      		 [bookmark: pgfId-1223674]Cisco VPN-related VSAs, identified by RADIUS vendor ID 3076. 

 
      		 [bookmark: pgfId-1223675]Microsoft VSAs, defined in RFC 2548.

 
      		 [bookmark: pgfId-1223676]Cisco VSA (Cisco-Priv-Level), which provides a standard 0-15 numeric ranking of privileges, with 1 being the lowest level and 15 being the highest level. A zero level indicates no privileges. The first level (login) allows privileged EXEC access for the commands available at this level. The second level (enable) allows CLI configuration privileges.

 
     

 
    
 
     
      [bookmark: pgfId-1211697][bookmark: 71397][bookmark: 50902]Supported RADIUS Authorization Attributes

 
      [bookmark: pgfId-1211698]Authorization refers to the process of enforcing permissions or attributes. A RADIUS server defined as an authentication server enforces permissions or attributes if they are configured. These attributes have vendor ID 3076.

 
      [bookmark: pgfId-1211706] Table 34-1  lists the supported RADIUS [bookmark: marker-1211705]attributes that can be used for user authorization. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1211707]Note RADIUS attribute names do not contain the cVPN3000 prefix. Cisco Secure ACS 4.x supports this new nomenclature, but attribute names in pre-4.0 ACS releases still include the cVPN3000 prefix. The ASAs enforce the RADIUS attributes based on attribute numeric ID, not attribute name. 

All attributes listed in Table 34-1 are downstream attributes that are sent from the RADIUS server to the ASA except for the following attribute numbers: 146, 150, 151, and 152. These attribute numbers are upstream attributes that are sent from the ASA to the RADIUS server. RADIUS attributes 146 and 150 are sent from the ASA to the RADIUS server for authentication and authorization requests. All four previously listed attributes are sent from the ASA to the RADIUS server for accounting start, interim-update, and stop requests. Upstream RADIUS attributes 146, 150, 151, and 152 were introduced in Version 8.4(3).

Cisco ACS 5.x and Cisco ISE do not support IPv6 framed IP addresses for IP address assignment using RADIUS authentication in Version 9.0(1).


      
      
 
     

     

 
      [bookmark: pgfId-1213660] 

 
      
       
        
         [bookmark: pgfId-1219516]Table 34-1 [bookmark: 32985]Supported RADIUS Authorization Attributes 

 
        
       
         
         		
           
           [bookmark: pgfId-1219528]Attribute Name
          
  
         		
           
           [bookmark: pgfId-1219530]ASA
          
  
         		
           
           [bookmark: pgfId-1219532]Attr. No.
          
  
         		
           
           [bookmark: pgfId-1219534]Syntax/Type
          
  
         		
           
           [bookmark: pgfId-1219536]Single or Multi-
           
 Valued
          
  
         		
           
           [bookmark: pgfId-1219538]Description or Value
          
  
        

 
         
         		 [bookmark: pgfId-1235023]Access-Hours

  
         		 [bookmark: pgfId-1235025]Y

  
         		 [bookmark: pgfId-1235027]1

  
         		 [bookmark: pgfId-1235029]String

  
         		 [bookmark: pgfId-1235031]Single

  
         		 [bookmark: pgfId-1235033]Name of the time range, for example, Business-hours

  
        

 
         
         		 [bookmark: pgfId-1235047]Access-List-Inbound

  
         		 [bookmark: pgfId-1235049]Y

  
         		 [bookmark: pgfId-1235051]86

  
         		 [bookmark: pgfId-1235053]String

  
         		 [bookmark: pgfId-1235055]Single

  
         		 [bookmark: pgfId-1235057]ACL ID

  
        

 
         
         		 [bookmark: pgfId-1235035]Access-List-Outbound

  
         		 [bookmark: pgfId-1235037]Y

  
         		 [bookmark: pgfId-1235039]87

  
         		 [bookmark: pgfId-1235041]String

  
         		 [bookmark: pgfId-1235043]Single

  
         		 [bookmark: pgfId-1235045]ACL ID

  
        

 
         
         		 [bookmark: pgfId-1235059]Address-Pools

  
         		 [bookmark: pgfId-1235061]Y

  
         		 [bookmark: pgfId-1235063]217

  
         		 [bookmark: pgfId-1235065]String

  
         		 [bookmark: pgfId-1235067]Single

  
         		 [bookmark: pgfId-1235069]Name of IP local pool

  
        

 
         
         		 [bookmark: pgfId-1235071]Allow-Network-Extension-Mode

  
         		 [bookmark: pgfId-1235073]Y

  
         		 [bookmark: pgfId-1235075]64

  
         		 [bookmark: pgfId-1235077]Boolean

  
         		 [bookmark: pgfId-1235079]Single

  
         		 [bookmark: pgfId-1235081]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235083]Authenticated-User-Idle-Timeout

  
         		 [bookmark: pgfId-1235085]Y

  
         		 [bookmark: pgfId-1235087]50

  
         		 [bookmark: pgfId-1235089]Integer

  
         		 [bookmark: pgfId-1235091]Single

  
         		 [bookmark: pgfId-1235093]1-35791394 minutes

  
        

 
         
         		 [bookmark: pgfId-1235095]Authorization-DN-Field

  
         		 [bookmark: pgfId-1235097]Y

  
         		 [bookmark: pgfId-1235099]67

  
         		 [bookmark: pgfId-1235101]String

  
         		 [bookmark: pgfId-1235103]Single

  
         		 [bookmark: pgfId-1235105]Possible values: UID, OU, O, CN, L, SP, C, EA, T, N, GN, SN, I, GENQ, DNQ, SER, use-entire-name

  
        

 
         
         		 [bookmark: pgfId-1235107]Authorization-Required

  
         		 
         		 [bookmark: pgfId-1235111]66

  
         		 [bookmark: pgfId-1235113]Integer

  
         		 [bookmark: pgfId-1235115]Single

  
         		 [bookmark: pgfId-1235117]0 = No
 1 = Yes

  
        

 
         
         		 [bookmark: pgfId-1235119]Authorization-Type

  
         		 [bookmark: pgfId-1235121]Y

  
         		 [bookmark: pgfId-1235123]65

  
         		 [bookmark: pgfId-1235125]Integer

  
         		 [bookmark: pgfId-1235127]Single

  
         		 [bookmark: pgfId-1235129]0 = None
 1 = RADIUS
 2 = LDAP

  
        

 
         
         		 [bookmark: pgfId-1235131]Banner1

  
         		 [bookmark: pgfId-1235133]Y

  
         		 [bookmark: pgfId-1235135]15

  
         		 [bookmark: pgfId-1235137]String

  
         		 [bookmark: pgfId-1235139]Single

  
         		 [bookmark: pgfId-1235141]Banner string to display for Cisco VPN remote access sessions: IPsec IKEv1, AnyConnect SSL-TLS/DTLS/IKEv2, and Clientless SSL

  
        

 
         
         		 [bookmark: pgfId-1235143]Banner2

  
         		 [bookmark: pgfId-1235145]Y

  
         		 [bookmark: pgfId-1235147]36

  
         		 [bookmark: pgfId-1235149]String

  
         		 [bookmark: pgfId-1235151]Single

  
         		 [bookmark: pgfId-1235153]Banner string to display for Cisco VPN remote access sessions: IPsec IKEv1, AnyConnect SSL-TLS/DTLS/IKEv2, and Clientless SSL. The Banner2 string is concatenated to the Banner1 string , if configured.

  
        

 
         
         		 [bookmark: pgfId-1235155]Cisco-IP-Phone-Bypass

  
         		 [bookmark: pgfId-1235157]Y

  
         		 [bookmark: pgfId-1235159]51

  
         		 [bookmark: pgfId-1235161]Integer

  
         		 [bookmark: pgfId-1235163]Single

  
         		 [bookmark: pgfId-1235165]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235167]Cisco-LEAP-Bypass

  
         		 [bookmark: pgfId-1235169]Y

  
         		 [bookmark: pgfId-1235171]75

  
         		 [bookmark: pgfId-1235173]Integer

  
         		 [bookmark: pgfId-1235175]Single

  
         		 [bookmark: pgfId-1235177]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235179]Client Type

  
         		 [bookmark: pgfId-1235181]Y

  
         		 [bookmark: pgfId-1235183]150

  
         		 [bookmark: pgfId-1235185]Integer

  
         		 [bookmark: pgfId-1235187]Single

  
         		 [bookmark: pgfId-1235189]1 = Cisco VPN Client (IKEv1)
 2 = AnyConnect Client SSL VPN
 3 = Clientless SSL VPN
 4 = Cut-Through-Proxy
 5 = L2TP/IPsec SSL VPN
 6 = AnyConnect Client IPsec VPN (IKEv2)

  
        

 
         
         		 [bookmark: pgfId-1235191]Client-Type-Version-Limiting

  
         		 [bookmark: pgfId-1235193]Y

  
         		 [bookmark: pgfId-1235195]77

  
         		 [bookmark: pgfId-1235197]String

  
         		 [bookmark: pgfId-1235199]Single

  
         		 [bookmark: pgfId-1235201]IPsec VPN version number string

  
        

 
         
         		 [bookmark: pgfId-1235203]DHCP-Network-Scope

  
         		 [bookmark: pgfId-1235205]Y

  
         		 [bookmark: pgfId-1235207]61

  
         		 [bookmark: pgfId-1235209]String

  
         		 [bookmark: pgfId-1235211]Single

  
         		 [bookmark: pgfId-1235213]IP Address

  
        

 
         
         		 [bookmark: pgfId-1235215]Extended-Authentication-On-Rekey

  
         		 [bookmark: pgfId-1235217]Y

  
         		 [bookmark: pgfId-1235219]122

  
         		 [bookmark: pgfId-1235221]Integer

  
         		 [bookmark: pgfId-1235223]Single

  
         		 [bookmark: pgfId-1235225]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235227]Group-Policy

  
         		 [bookmark: pgfId-1235229]Y

  
         		 [bookmark: pgfId-1235231]25

  
         		 [bookmark: pgfId-1235233]String

  
         		 [bookmark: pgfId-1235235]Single

  
         		 [bookmark: pgfId-1235237]Sets the group policy for the remote access VPN session. For Versions 8.2.x and later, use this attribute instead of IETF-Radius-Class. You can use one of the following formats:

 
           
           		 [bookmark: pgfId-1235238] group policy name 

 
           		 [bookmark: pgfId-1235239]OU= group policy name 

 
           		 [bookmark: pgfId-1235240]OU= group policy name ;

 
          

  
        

 
         
         		 [bookmark: pgfId-1235242]IE-Proxy-Bypass-Local

  
         		 
         		 [bookmark: pgfId-1235246]83

  
         		 [bookmark: pgfId-1235248]Integer

  
         		 [bookmark: pgfId-1235250]Single

  
         		 [bookmark: pgfId-1235252]0 = None
 1 = Local

  
        

 
         
         		 [bookmark: pgfId-1235254]IE-Proxy-Exception-List

  
         		 
         		 [bookmark: pgfId-1235258]82

  
         		 [bookmark: pgfId-1235260]String

  
         		 [bookmark: pgfId-1235262]Single

  
         		 [bookmark: pgfId-1235264]New line (\n) separated list of DNS domains

  
        

 
         
         		 [bookmark: pgfId-1235266]IE-Proxy-PAC-URL

  
         		 [bookmark: pgfId-1235268]Y

  
         		 [bookmark: pgfId-1235270]133

  
         		 [bookmark: pgfId-1235272]String

  
         		 [bookmark: pgfId-1235274]Single

  
         		 [bookmark: pgfId-1235276]PAC address string

  
        

 
         
         		 [bookmark: pgfId-1235290]IE-Proxy-Server

  
         		 
         		 [bookmark: pgfId-1235294]80

  
         		 [bookmark: pgfId-1235296]String

  
         		 [bookmark: pgfId-1235298]Single

  
         		 [bookmark: pgfId-1235300]IP address

  
        

 
         
         		 [bookmark: pgfId-1235278]IE-Proxy-Server-Policy

  
         		 
         		 [bookmark: pgfId-1235282]81

  
         		 [bookmark: pgfId-1235284]Integer

  
         		 [bookmark: pgfId-1235286]Single

  
         		 [bookmark: pgfId-1235288]1 = No Modify
 2 = No Proxy
 3 = Auto detect
 4 = Use Concentrator Setting

  
        

 
         
         		 [bookmark: pgfId-1235302]IKE-KeepAlive-Confidence-Interval

  
         		 [bookmark: pgfId-1235304]Y

  
         		 [bookmark: pgfId-1235306]68

  
         		 [bookmark: pgfId-1235308]Integer

  
         		 [bookmark: pgfId-1235310]Single

  
         		 [bookmark: pgfId-1235312]10-300 seconds

  
        

 
         
         		 [bookmark: pgfId-1235314]IKE-Keepalive-Retry-Interval

  
         		 [bookmark: pgfId-1235316]Y

  
         		 [bookmark: pgfId-1235318]84

  
         		 [bookmark: pgfId-1235320]Integer

  
         		 [bookmark: pgfId-1235322]Single

  
         		 [bookmark: pgfId-1235324]2-10 seconds

  
        

 
         
         		 [bookmark: pgfId-1235326]IKE-Keep-Alives

  
         		 [bookmark: pgfId-1235328]Y

  
         		 [bookmark: pgfId-1235330]41

  
         		 [bookmark: pgfId-1235332]Boolean

  
         		 [bookmark: pgfId-1235334]Single

  
         		 [bookmark: pgfId-1235336]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235338]Intercept-DHCP-Configure-Msg

  
         		 [bookmark: pgfId-1235340]Y

  
         		 [bookmark: pgfId-1235342]62

  
         		 [bookmark: pgfId-1235344]Boolean

  
         		 [bookmark: pgfId-1235346]Single

  
         		 [bookmark: pgfId-1235348]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235350]IPsec-Allow-Passwd-Store

  
         		 [bookmark: pgfId-1235352]Y

  
         		 [bookmark: pgfId-1235354]16

  
         		 [bookmark: pgfId-1235356]Boolean

  
         		 [bookmark: pgfId-1235358]Single

  
         		 [bookmark: pgfId-1235360]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235362]IPsec-Authentication

  
         		 
         		 [bookmark: pgfId-1235366]13

  
         		 [bookmark: pgfId-1235368]Integer

  
         		 [bookmark: pgfId-1235370]Single

  
         		 [bookmark: pgfId-1235372]0 = None
 1 = RADIUS
 2 = LDAP (authorization only)
 3 = NT Domain
 4 = SDI
 5 = Internal
 6 = RADIUS with Expiry
 7 = Kerberos/Active Directory

  
        

 
         
         		 [bookmark: pgfId-1235374]IPsec-Auth-On-Rekey

  
         		 [bookmark: pgfId-1235376]Y

  
         		 [bookmark: pgfId-1235378]42

  
         		 [bookmark: pgfId-1235380]Boolean

  
         		 [bookmark: pgfId-1235382]Single

  
         		 [bookmark: pgfId-1235384]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235386]IPsec-Backup-Server-List

  
         		 [bookmark: pgfId-1235388]Y

  
         		 [bookmark: pgfId-1235390]60

  
         		 [bookmark: pgfId-1235392]String

  
         		 [bookmark: pgfId-1235394]Single

  
         		 [bookmark: pgfId-1235396]Server Addresses (space delimited)

  
        

 
         
         		 [bookmark: pgfId-1235398]IPsec-Backup-Servers

  
         		 [bookmark: pgfId-1235400]Y

  
         		 [bookmark: pgfId-1235402]59

  
         		 [bookmark: pgfId-1235404]String

  
         		 [bookmark: pgfId-1235406]Single

  
         		 [bookmark: pgfId-1235408]1 = Use Client-Configured list
 2 = Disable and clear client list
 3 = Use Backup Server list

  
        

 
         
         		 [bookmark: pgfId-1235422]IPsec-Client-Firewall-Filter-Name

  
         		 
         		 [bookmark: pgfId-1235426]57

  
         		 [bookmark: pgfId-1235428]String

  
         		 [bookmark: pgfId-1235430]Single

  
         		 [bookmark: pgfId-1235432]Specifies the name of the filter to be pushed to the client as firewall policy

  
        

 
         
         		 [bookmark: pgfId-1235410]IPsec-Client-Firewall-Filter-Optional

  
         		 [bookmark: pgfId-1235412]Y

  
         		 [bookmark: pgfId-1235414]58

  
         		 [bookmark: pgfId-1235416]Integer

  
         		 [bookmark: pgfId-1235418]Single

  
         		 [bookmark: pgfId-1235420]0 = Required
 1 = Optional

  
        

 
         
         		 [bookmark: pgfId-1235434]IPsec-Default-Domain

  
         		 [bookmark: pgfId-1235436]Y

  
         		 [bookmark: pgfId-1235438]28

  
         		 [bookmark: pgfId-1235440]String

  
         		 [bookmark: pgfId-1235442]Single

  
         		 [bookmark: pgfId-1235444]Specifies the single default domain name to send to the client (1-255 characters).

  
        

 
         
         		 [bookmark: pgfId-1235446]IPsec-IKE-Peer-ID-Check

  
         		 [bookmark: pgfId-1235448]Y

  
         		 [bookmark: pgfId-1235450]40

  
         		 [bookmark: pgfId-1235452]Integer

  
         		 [bookmark: pgfId-1235454]Single

  
         		 [bookmark: pgfId-1235456]1 = Required
 2 = If supported by peer certificate
 3 = Do not check

  
        

 
         
         		 [bookmark: pgfId-1235458]IPsec-IP-Compression

  
         		 [bookmark: pgfId-1235460]Y

  
         		 [bookmark: pgfId-1235462]39

  
         		 [bookmark: pgfId-1235464]Integer

  
         		 [bookmark: pgfId-1235466]Single

  
         		 [bookmark: pgfId-1235468]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235470]IPsec-Mode-Config

  
         		 [bookmark: pgfId-1235472]Y

  
         		 [bookmark: pgfId-1235474]31

  
         		 [bookmark: pgfId-1235476]Boolean

  
         		 [bookmark: pgfId-1235478]Single

  
         		 [bookmark: pgfId-1235480]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235494]IPsec-Over-UDP

  
         		 [bookmark: pgfId-1235496]Y

  
         		 [bookmark: pgfId-1235498]34

  
         		 [bookmark: pgfId-1235500]Boolean

  
         		 [bookmark: pgfId-1235502]Single

  
         		 [bookmark: pgfId-1235504]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235482]IPsec-Over-UDP-Port

  
         		 [bookmark: pgfId-1235484]Y

  
         		 [bookmark: pgfId-1235486]35

  
         		 [bookmark: pgfId-1235488]Integer

  
         		 [bookmark: pgfId-1235490]Single

  
         		 [bookmark: pgfId-1235492]4001- 49151. The default is 10000.

  
        

 
         
         		 [bookmark: pgfId-1235506]IPsec-Required-Client-Firewall-Capability

  
         		 [bookmark: pgfId-1235508]Y

  
         		 [bookmark: pgfId-1235510]56

  
         		 [bookmark: pgfId-1235512]Integer

  
         		 [bookmark: pgfId-1235514]Single

  
         		 [bookmark: pgfId-1235516]0 = None
 1 = Policy defined by remote FW Are-You-There (AYT)
 2 = Policy pushed CPP
 4 = Policy from server

  
        

 
         
         		 [bookmark: pgfId-1235518]IPsec-Sec-Association

  
         		 
         		 [bookmark: pgfId-1235522]12

  
         		 [bookmark: pgfId-1235524]String

  
         		 [bookmark: pgfId-1235526]Single

  
         		 [bookmark: pgfId-1235528]Name of the security association

  
        

 
         
         		 [bookmark: pgfId-1235530]IPsec-Split-DNS-Names

  
         		 [bookmark: pgfId-1235532]Y

  
         		 [bookmark: pgfId-1235534]29

  
         		 [bookmark: pgfId-1235536]String

  
         		 [bookmark: pgfId-1235538]Single

  
         		 [bookmark: pgfId-1235540]Specifies the list of secondary domain names to send to the client (1-255 characters).

  
        

 
         
         		 [bookmark: pgfId-1235542]IPsec-Split-Tunneling-Policy

  
         		 [bookmark: pgfId-1235544]Y

  
         		 [bookmark: pgfId-1235546]55

  
         		 [bookmark: pgfId-1235548]Integer

  
         		 [bookmark: pgfId-1235550]Single

  
         		 [bookmark: pgfId-1235552]0 = No split tunneling
 1 = Split tunneling
 2 = Local LAN permitted

  
        

 
         
         		 [bookmark: pgfId-1235554]IPsec-Split-Tunnel-List

  
         		 [bookmark: pgfId-1235556]Y

  
         		 [bookmark: pgfId-1235558]27

  
         		 [bookmark: pgfId-1235560]String

  
         		 [bookmark: pgfId-1235562]Single

  
         		 [bookmark: pgfId-1235564]Specifies the name of the network or ACL that describes the split tunnel inclusion list.

  
        

 
         
         		 [bookmark: pgfId-1235566]IPsec-Tunnel-Type

  
         		 [bookmark: pgfId-1235568]Y

  
         		 [bookmark: pgfId-1235570]30

  
         		 [bookmark: pgfId-1235572]Integer

  
         		 [bookmark: pgfId-1235574]Single

  
         		 [bookmark: pgfId-1235576]1 = LAN-to-LAN
 2 = Remote access

  
        

 
         
         		 [bookmark: pgfId-1235578]IPsec-User-Group-Lock

  
         		 
         		 [bookmark: pgfId-1235582]33

  
         		 [bookmark: pgfId-1235584]Boolean

  
         		 [bookmark: pgfId-1235586]Single

  
         		 [bookmark: pgfId-1235588]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235602]IPv6-Address-Pools

  
         		 [bookmark: pgfId-1235604]Y

  
         		 [bookmark: pgfId-1235606]218

  
         		 [bookmark: pgfId-1235608]String

  
         		 [bookmark: pgfId-1235610]Single

  
         		 [bookmark: pgfId-1235612]Name of IP local pool-IPv6

  
        

 
         
         		 [bookmark: pgfId-1235590]IPv6-VPN-Filter

  
         		 [bookmark: pgfId-1235592]Y

  
         		 [bookmark: pgfId-1235594]219

  
         		 [bookmark: pgfId-1235596]String

  
         		 [bookmark: pgfId-1235598]Single

  
         		 [bookmark: pgfId-1235600]ACL value

  
        

 
         
         		 [bookmark: pgfId-1235614]L2TP-Encryption

  
         		 
         		 [bookmark: pgfId-1235618]21

  
         		 [bookmark: pgfId-1235620]Integer

  
         		 [bookmark: pgfId-1235622]Single

  
         		 [bookmark: pgfId-1235624]Bitmap:
 1 = Encryption required
 2 = 40 bits
 4 = 128 bits
 8 = Stateless-Req
 15= 40/128-Encr/Stateless-Req

  
        

 
         
         		 [bookmark: pgfId-1235626]L2TP-MPPC-Compression

  
         		 
         		 [bookmark: pgfId-1235630]38

  
         		 [bookmark: pgfId-1235632]Integer

  
         		 [bookmark: pgfId-1235634]Single

  
         		 [bookmark: pgfId-1235636]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235638]Member-Of

  
         		 [bookmark: pgfId-1235640]Y

  
         		 [bookmark: pgfId-1235642]145

  
         		 [bookmark: pgfId-1235644]String

  
         		 [bookmark: pgfId-1235646]Single

  
         		 [bookmark: pgfId-1235648]Comma-delimited string, for example:

 
           
           [bookmark: pgfId-1235649]
            Engineering, Sales 
          
 
           
           [bookmark: pgfId-1235650] 
          
  [bookmark: pgfId-1235651]An administrative attribute that can be used in dynamic access policies. It does not set a group policy.

  
        

 
         
         		 [bookmark: pgfId-1235653]MS-Client-Subnet-Mask

  
         		 [bookmark: pgfId-1235655]Y

  
         		 [bookmark: pgfId-1235657]63

  
         		 [bookmark: pgfId-1235659]Boolean

  
         		 [bookmark: pgfId-1235661]Single

  
         		 [bookmark: pgfId-1235663]An IP address

  
        

 
         
         		 [bookmark: pgfId-1235665]NAC-Default-ACL

  
         		 
         		 [bookmark: pgfId-1235669]92

  
         		 [bookmark: pgfId-1235671]String

  
         		 
         		 [bookmark: pgfId-1235675]ACL

  
        

 
         
         		 [bookmark: pgfId-1235677]NAC-Enable

  
         		 
         		 [bookmark: pgfId-1235681]89

  
         		 [bookmark: pgfId-1235683]Integer

  
         		 [bookmark: pgfId-1235685]Single

  
         		 [bookmark: pgfId-1235687]0 = No
 1 = Yes

  
        

 
         
         		 [bookmark: pgfId-1235689]NAC-Revalidation-Timer

  
         		 
         		 [bookmark: pgfId-1235693]91

  
         		 [bookmark: pgfId-1235695]Integer

  
         		 [bookmark: pgfId-1235697]Single

  
         		 [bookmark: pgfId-1235699]300-86400 seconds

  
        

 
         
         		 [bookmark: pgfId-1235701]NAC-Settings

  
         		 [bookmark: pgfId-1235703]Y

  
         		 [bookmark: pgfId-1235705]141

  
         		 [bookmark: pgfId-1235707]String

  
         		 [bookmark: pgfId-1235709]Single

  
         		 [bookmark: pgfId-1235711]Name of the NAC policy 

  
        

 
         
         		 [bookmark: pgfId-1235713]NAC-Status-Query-Timer

  
         		 
         		 [bookmark: pgfId-1235717]90

  
         		 [bookmark: pgfId-1235719]Integer

  
         		 [bookmark: pgfId-1235721]Single

  
         		 [bookmark: pgfId-1235723]30-1800 seconds

  
        

 
         
         		 [bookmark: pgfId-1235725]Perfect-Forward-Secrecy-Enable

  
         		 [bookmark: pgfId-1235727]Y

  
         		 [bookmark: pgfId-1235729]88

  
         		 [bookmark: pgfId-1235731]Boolean

  
         		 [bookmark: pgfId-1235733]Single

  
         		 [bookmark: pgfId-1235735]0 = No
 1 = Yes

  
        

 
         
         		 [bookmark: pgfId-1235737]PPTP-Encryption

  
         		 
         		 [bookmark: pgfId-1235741]20

  
         		 [bookmark: pgfId-1235743]Integer

  
         		 [bookmark: pgfId-1235745]Single

  
         		 [bookmark: pgfId-1235747]Bitmap:
 1 = Encryption required
 2 = 40 bits
 4 = 128 bits
 8 = Stateless-Required
 15= 40/128-Encr/Stateless-Req

  
        

 
         
         		 [bookmark: pgfId-1235749]PPTP-MPPC-Compression

  
         		 
         		 [bookmark: pgfId-1235753]37

  
         		 [bookmark: pgfId-1235755]Integer

  
         		 [bookmark: pgfId-1235757]Single

  
         		 [bookmark: pgfId-1235759]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235761]Primary-DNS 

  
         		 [bookmark: pgfId-1235763]Y

  
         		 [bookmark: pgfId-1235765]5

  
         		 [bookmark: pgfId-1235767]String

  
         		 [bookmark: pgfId-1235769]Single

  
         		 [bookmark: pgfId-1235771]An IP address

  
        

 
         
         		 [bookmark: pgfId-1235773]Primary-WINS

  
         		 [bookmark: pgfId-1235775]Y

  
         		 [bookmark: pgfId-1235777]7

  
         		 [bookmark: pgfId-1235779]String

  
         		 [bookmark: pgfId-1235781]Single

  
         		 [bookmark: pgfId-1235783]An IP address

  
        

 
         
         		 [bookmark: pgfId-1235785]Privilege-Level

  
         		 [bookmark: pgfId-1235787]Y

  
         		 [bookmark: pgfId-1235789]220

  
         		 [bookmark: pgfId-1235791]Integer

  
         		 [bookmark: pgfId-1235793]Single

  
         		 [bookmark: pgfId-1235795]An integer between 0 and 15.

  
        

 
         
         		 [bookmark: pgfId-1235797]Required-Client- Firewall-Vendor-Code

  
         		 [bookmark: pgfId-1235799]Y

  
         		 [bookmark: pgfId-1235801]45

  
         		 [bookmark: pgfId-1235803]Integer

  
         		 [bookmark: pgfId-1235805]Single

  
         		 [bookmark: pgfId-1235807]1 = Cisco Systems (with Cisco Integrated Client)
 2 = Zone Labs
 3 = NetworkICE
 4 = Sygate
 5 = Cisco Systems (with Cisco Intrusion Prevention Security Agent)

  
        

 
         
         		 [bookmark: pgfId-1235809]Required-Client-Firewall-Description

  
         		 [bookmark: pgfId-1235811]Y

  
         		 [bookmark: pgfId-1235813]47

  
         		 [bookmark: pgfId-1235815]String 

  
         		 [bookmark: pgfId-1235817]Single

  
         		 [bookmark: pgfId-1235819]String

  
        

 
         
         		 [bookmark: pgfId-1235821]Required-Client-Firewall-Product-Code

  
         		 [bookmark: pgfId-1235823]Y

  
         		 [bookmark: pgfId-1235825]46

  
         		 [bookmark: pgfId-1235827]Integer

  
         		 [bookmark: pgfId-1235829]Single

  
         		 [bookmark: pgfId-1235831]Cisco Systems Products:

  [bookmark: pgfId-1235832]1 = Cisco Intrusion Prevention Security Agent or Cisco Integrated Client (CIC)

  [bookmark: pgfId-1235833]Zone Labs Products:
 1 = Zone Alarm
 2 = Zone AlarmPro
 3 = Zone Labs Integrity

  [bookmark: pgfId-1235834]NetworkICE Product:
 1 = BlackIce Defender/Agent

  [bookmark: pgfId-1235835]Sygate Products:
 1 = Personal Firewall
 2 = Personal Firewall Pro
 3 = Security Agent

  
        

 
         
         		 [bookmark: pgfId-1235837]Required-Individual-User-Auth

  
         		 [bookmark: pgfId-1235839]Y

  
         		 [bookmark: pgfId-1235841]49

  
         		 [bookmark: pgfId-1235843]Integer

  
         		 [bookmark: pgfId-1235845]Single

  
         		 [bookmark: pgfId-1235847]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235849]Require-HW-Client-Auth

  
         		 [bookmark: pgfId-1235851]Y

  
         		 [bookmark: pgfId-1235853]48

  
         		 [bookmark: pgfId-1235855]Boolean

  
         		 [bookmark: pgfId-1235857]Single

  
         		 [bookmark: pgfId-1235859]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235861]Secondary-DNS

  
         		 [bookmark: pgfId-1235863]Y

  
         		 [bookmark: pgfId-1235865]6

  
         		 [bookmark: pgfId-1235867]String

  
         		 [bookmark: pgfId-1235869]Single

  
         		 [bookmark: pgfId-1235871]An IP address

  
        

 
         
         		 [bookmark: pgfId-1235885]Secondary-WINS

  
         		 [bookmark: pgfId-1235887]Y

  
         		 [bookmark: pgfId-1235889]8

  
         		 [bookmark: pgfId-1235891]String

  
         		 [bookmark: pgfId-1235893]Single

  
         		 [bookmark: pgfId-1235895]An IP address

  
        

 
         
         		 [bookmark: pgfId-1235873]SEP-Card-Assignment

  
         		 
         		 [bookmark: pgfId-1235877]9

  
         		 [bookmark: pgfId-1235879]Integer

  
         		 [bookmark: pgfId-1235881]Single

  
         		 [bookmark: pgfId-1235883]Not used

  
        

 
         
         		 [bookmark: pgfId-1235897]Session Subtype

  
         		 [bookmark: pgfId-1235899]Y

  
         		 [bookmark: pgfId-1235901]152

  
         		 [bookmark: pgfId-1235903]Integer

  
         		 [bookmark: pgfId-1235905]Single

  
         		 [bookmark: pgfId-1235907]0 = None
 1 = Clientless
 2 = Client
 3 = Client Only

  [bookmark: pgfId-1235908]Session Subtype applies only when the Session Type (151) attribute has the following values: 1, 2, 3, and 4.

  
        

 
         
         		 [bookmark: pgfId-1235910]Session Type

  
         		 [bookmark: pgfId-1235912]Y

  
         		 [bookmark: pgfId-1235914]151

  
         		 [bookmark: pgfId-1235916]Integer

  
         		 [bookmark: pgfId-1235918]Single

  
         		 [bookmark: pgfId-1235920]0 = None
 1 = AnyConnect Client SSL VPN
 2 = AnyConnect Client IPSec VPN (IKEv2)
 3 = Clientless SSL VPN
 4 = Clientless Email Proxy
 5 = Cisco VPN Client (IKEv1)
 6 = IKEv1 LAN-LAN
 7 = IKEv2 LAN-LAN
 8 = VPN Load Balancing

  
        

 
         
         		 [bookmark: pgfId-1235922]Simultaneous-Logins

  
         		 [bookmark: pgfId-1235924]Y

  
         		 [bookmark: pgfId-1235926]2

  
         		 [bookmark: pgfId-1235928]Integer

  
         		 [bookmark: pgfId-1235930]Single

  
         		 [bookmark: pgfId-1235932]0-2147483647

  
        

 
         
         		 [bookmark: pgfId-1235934]Smart-Tunnel

  
         		 [bookmark: pgfId-1235936]Y

  
         		 [bookmark: pgfId-1235938]136

  
         		 [bookmark: pgfId-1235940]String

  
         		 [bookmark: pgfId-1235942]Single

  
         		 [bookmark: pgfId-1235944]Name of a Smart Tunnel

  
        

 
         
         		 [bookmark: pgfId-1235958]Smart-Tunnel-Auto

  
         		 [bookmark: pgfId-1235960]Y

  
         		 [bookmark: pgfId-1235962]138

  
         		 [bookmark: pgfId-1235964]Integer

  
         		 [bookmark: pgfId-1235966]Single

  
         		 [bookmark: pgfId-1235968]0 = Disabled
 1 = Enabled
 2 = AutoStart

  
        

 
         
         		 [bookmark: pgfId-1235946]Smart-Tunnel-Auto-Signon-Enable

  
         		 [bookmark: pgfId-1235948]Y

  
         		 [bookmark: pgfId-1235950]139

  
         		 [bookmark: pgfId-1235952]String

  
         		 [bookmark: pgfId-1235954]Single

  
         		 [bookmark: pgfId-1235956]Name of a Smart Tunnel Auto Signon list appended by the domain name

  
        

 
         
         		 [bookmark: pgfId-1235970]Strip-Realm

  
         		 [bookmark: pgfId-1235972]Y

  
         		 [bookmark: pgfId-1235974]135

  
         		 [bookmark: pgfId-1235976]Boolean

  
         		 [bookmark: pgfId-1235978]Single

  
         		 [bookmark: pgfId-1235980]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1235994]SVC-Ask

  
         		 [bookmark: pgfId-1235996]Y

  
         		 [bookmark: pgfId-1235998]131

  
         		 [bookmark: pgfId-1236000]String

  
         		 [bookmark: pgfId-1236002]Single

  
         		 [bookmark: pgfId-1236004]0 = Disabled
 1 = Enabled
 3 = Enable default service
 5 = Enable default clientless
 (2 and 4 not used)

  
        

 
         
         		 [bookmark: pgfId-1235982]SVC-Ask-Timeout

  
         		 [bookmark: pgfId-1235984]Y

  
         		 [bookmark: pgfId-1235986]132

  
         		 [bookmark: pgfId-1235988]Integer

  
         		 [bookmark: pgfId-1235990]Single

  
         		 [bookmark: pgfId-1235992]5-120 seconds

  
        

 
         
         		 [bookmark: pgfId-1236018]SVC-DPD-Interval-Client

  
         		 [bookmark: pgfId-1236020]Y

  
         		 [bookmark: pgfId-1236022]108

  
         		 [bookmark: pgfId-1236024]Integer

  
         		 [bookmark: pgfId-1236026]Single

  
         		 [bookmark: pgfId-1236028]0 = Off
 5-3600 seconds

  
        

 
         
         		 [bookmark: pgfId-1236006]SVC-DPD-Interval-Gateway

  
         		 [bookmark: pgfId-1236008]Y

  
         		 [bookmark: pgfId-1236010]109

  
         		 [bookmark: pgfId-1236012]Integer

  
         		 [bookmark: pgfId-1236014]Single

  
         		 [bookmark: pgfId-1236016]0 = Off)
 5-3600 seconds

  
        

 
         
         		 [bookmark: pgfId-1236030]SVC-DTLS

  
         		 [bookmark: pgfId-1236032]Y

  
         		 [bookmark: pgfId-1236034]123

  
         		 [bookmark: pgfId-1236036]Integer

  
         		 [bookmark: pgfId-1236038]Single

  
         		 [bookmark: pgfId-1236040]0 = False
 1 = True

  
        

 
         
         		 [bookmark: pgfId-1236042]SVC-Keepalive

  
         		 [bookmark: pgfId-1236044]Y

  
         		 [bookmark: pgfId-1236046]107

  
         		 [bookmark: pgfId-1236048]Integer

  
         		 [bookmark: pgfId-1236050]Single

  
         		 [bookmark: pgfId-1236052]0 = Off 
 15-600 seconds

  
        

 
         
         		 [bookmark: pgfId-1236054]SVC-Modules

  
         		 [bookmark: pgfId-1236056]Y

  
         		 [bookmark: pgfId-1236058]127

  
         		 [bookmark: pgfId-1236060]String

  
         		 [bookmark: pgfId-1236062]Single

  
         		 [bookmark: pgfId-1236064]String (name of a module)

  
        

 
         
         		 [bookmark: pgfId-1236066]SVC-MTU

  
         		 [bookmark: pgfId-1236068]Y

  
         		 [bookmark: pgfId-1236070]125

  
         		 [bookmark: pgfId-1236072]Integer

  
         		 [bookmark: pgfId-1236074]Single

  
         		 [bookmark: pgfId-1236076]MTU value
 256-1406 in bytes

  
        

 
         
         		 [bookmark: pgfId-1236078]SVC-Profiles

  
         		 [bookmark: pgfId-1236080]Y

  
         		 [bookmark: pgfId-1236082]128

  
         		 [bookmark: pgfId-1236084]String

  
         		 [bookmark: pgfId-1236086]Single

  
         		 [bookmark: pgfId-1236088]String (name of a profile)

  
        

 
         
         		 [bookmark: pgfId-1236090]SVC-Rekey-Time

  
         		 [bookmark: pgfId-1236092]Y

  
         		 [bookmark: pgfId-1236094]110

  
         		 [bookmark: pgfId-1236096]Integer

  
         		 [bookmark: pgfId-1236098]Single

  
         		 [bookmark: pgfId-1236100]0 = Disabled
 1-10080 minutes

  
        

 
         
         		 [bookmark: pgfId-1236102]Tunnel Group Name

  
         		 [bookmark: pgfId-1236104]Y

  
         		 [bookmark: pgfId-1236106]146

  
         		 [bookmark: pgfId-1236108]String

  
         		 [bookmark: pgfId-1236110]Single

  
         		 [bookmark: pgfId-1236112]1-253 characters

  
        

 
         
         		 [bookmark: pgfId-1236114]Tunnel-Group-Lock

  
         		 [bookmark: pgfId-1236116]Y

  
         		 [bookmark: pgfId-1236118]85

  
         		 [bookmark: pgfId-1236120]String

  
         		 [bookmark: pgfId-1236122]Single

  
         		 [bookmark: pgfId-1236124]Name of the tunnel group or “none”

  
        

 
         
         		 [bookmark: pgfId-1236126]Tunneling-Protocols

  
         		 [bookmark: pgfId-1236128]Y

  
         		 [bookmark: pgfId-1236130]11

  
         		 [bookmark: pgfId-1236132]Integer

  
         		 [bookmark: pgfId-1236134]Single

  
         		 [bookmark: pgfId-1236136]1 = PPTP
 2 = L2TP
 4 = IPSec (IKEv1)
 8 = L2TP/IPSec
 16 = WebVPN
 32 = SVC
 64 = IPsec (IKEv2)
 8 and 4 are mutually exclusive.
 0 - 11, 16 - 27, 32 - 43, 48 - 59 are legal values.

  
        

 
         
         		 [bookmark: pgfId-1236138]Use-Client-Address 

  
         		 
         		 [bookmark: pgfId-1236142]17

  
         		 [bookmark: pgfId-1236144]Boolean

  
         		 [bookmark: pgfId-1236146]Single

  
         		 [bookmark: pgfId-1236148]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236150]VLAN

  
         		 [bookmark: pgfId-1236152]Y

  
         		 [bookmark: pgfId-1236154]140

  
         		 [bookmark: pgfId-1236156]Integer

  
         		 [bookmark: pgfId-1236158]Single

  
         		 [bookmark: pgfId-1236160]0-4094

  
        

 
         
         		 [bookmark: pgfId-1236162]WebVPN-Access-List

  
         		 [bookmark: pgfId-1236164]Y

  
         		 [bookmark: pgfId-1236166]73

  
         		 [bookmark: pgfId-1236168]String

  
         		 [bookmark: pgfId-1236170]Single

  
         		 [bookmark: pgfId-1236172]Access-List name

  
        

 
         
         		 [bookmark: pgfId-1236459]WebVPN ACL

  
         		 [bookmark: pgfId-1236461]Y

  
         		 [bookmark: pgfId-1236463]73

  
         		 [bookmark: pgfId-1236465]String

  
         		 [bookmark: pgfId-1236467]Single

  
         		 [bookmark: pgfId-1236469]Name of a WebVPN ACL on the device

  
        

 
         
         		 [bookmark: pgfId-1236174]WebVPN-ActiveX-Relay

  
         		 [bookmark: pgfId-1236176]Y

  
         		 [bookmark: pgfId-1236178]137

  
         		 [bookmark: pgfId-1236180]Integer

  
         		 [bookmark: pgfId-1236182]Single

  
         		 [bookmark: pgfId-1236184]0 = Disabled
 Otherwise = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236186]WebVPN-Apply-ACL

  
         		 [bookmark: pgfId-1236188]Y

  
         		 [bookmark: pgfId-1236190]102

  
         		 [bookmark: pgfId-1236192]Integer

  
         		 [bookmark: pgfId-1236194]Single

  
         		 [bookmark: pgfId-1236196]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236210]WebVPN-Auto-HTTP-Signon

  
         		 [bookmark: pgfId-1236212]Y

  
         		 [bookmark: pgfId-1236214]124

  
         		 [bookmark: pgfId-1236216]String

  
         		 [bookmark: pgfId-1236218]Single

  
         		 [bookmark: pgfId-1236220]Reserved

  
        

 
         
         		 [bookmark: pgfId-1236198]WebVPN-Citrix-Metaframe-Enable

  
         		 [bookmark: pgfId-1236200]Y

  
         		 [bookmark: pgfId-1236202]101

  
         		 [bookmark: pgfId-1236204]Integer

  
         		 [bookmark: pgfId-1236206]Single

  
         		 [bookmark: pgfId-1236208]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236222]WebVPN-Content-Filter-Parameters

  
         		 [bookmark: pgfId-1236224]Y

  
         		 [bookmark: pgfId-1236226]69

  
         		 [bookmark: pgfId-1236228]Integer

  
         		 [bookmark: pgfId-1236230]Single

  
         		 [bookmark: pgfId-1236232]1 = Java ActiveX
 2 = Java Script
 4 = Image
 8 = Cookies in images

  
        

 
         
         		 [bookmark: pgfId-1236772]WebVPN-Customization

  
         		 [bookmark: pgfId-1236774]Y

  
         		 [bookmark: pgfId-1236776]113

  
         		 [bookmark: pgfId-1236778]String

  
         		 [bookmark: pgfId-1236780]Single

  
         		 [bookmark: pgfId-1236782]Name of the customization

  
        

 
         
         		 [bookmark: pgfId-1236577]WebVPN-Default-Homepage

  
         		 [bookmark: pgfId-1236579]Y

  
         		 [bookmark: pgfId-1236581]76

  
         		 [bookmark: pgfId-1236583]String

  
         		 [bookmark: pgfId-1236585]Single

  
         		 [bookmark: pgfId-1236587]A URL such as http://example-example.com

  
        

 
         
         		 [bookmark: pgfId-1236234]WebVPN-Deny-Message

  
         		 [bookmark: pgfId-1236236]Y

  
         		 [bookmark: pgfId-1236238]116

  
         		 [bookmark: pgfId-1236240]String

  
         		 [bookmark: pgfId-1236242]Single

  
         		 [bookmark: pgfId-1236244]Valid string (up to 500 characters)

  
        

 
         
         		 [bookmark: pgfId-1237216]WebVPN-Download_Max-Size

  
         		 [bookmark: pgfId-1237218]Y

  
         		 [bookmark: pgfId-1237220]157

  
         		 [bookmark: pgfId-1237222]Integer

  
         		 [bookmark: pgfId-1237224]Single

  
         		 [bookmark: pgfId-1237226]0x7fffffff

  
        

 
         
         		 [bookmark: pgfId-1236246]WebVPN-File-Access-Enable

  
         		 [bookmark: pgfId-1236248]Y

  
         		 [bookmark: pgfId-1236250]94

  
         		 [bookmark: pgfId-1236252]Integer

  
         		 [bookmark: pgfId-1236254]Single

  
         		 [bookmark: pgfId-1236256]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236258]WebVPN-File-Server-Browsing-Enable

  
         		 [bookmark: pgfId-1236260]Y

  
         		 [bookmark: pgfId-1236262]96

  
         		 [bookmark: pgfId-1236264]Integer

  
         		 [bookmark: pgfId-1236266]Single

  
         		 [bookmark: pgfId-1236268]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236270]WebVPN-File-Server-Entry-Enable

  
         		 [bookmark: pgfId-1236272]Y

  
         		 [bookmark: pgfId-1236274]95

  
         		 [bookmark: pgfId-1236276]Integer

  
         		 [bookmark: pgfId-1236278]Single

  
         		 [bookmark: pgfId-1236280]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236589]WebVPN-Group-based-HTTP/HTTPS-Proxy-Exception-List

  
         		 [bookmark: pgfId-1236591]Y

  
         		 [bookmark: pgfId-1236593]78

  
         		 [bookmark: pgfId-1236595]String

  
         		 [bookmark: pgfId-1236597]Single

  
         		 [bookmark: pgfId-1236599]Comma-separated DNS/IP with an optional wildcard (*) (for example *.cisco.com, 192.168.1.*, wwwin.cisco.com)

  
        

 
         
         		 [bookmark: pgfId-1236975]WebVPN-Hidden-Shares

  
         		 [bookmark: pgfId-1236977]Y

  
         		 [bookmark: pgfId-1236979]126

  
         		 [bookmark: pgfId-1236981]Integer

  
         		 [bookmark: pgfId-1236983]Single

  
         		 [bookmark: pgfId-1236985]0 = None
 1 = Visible

  
        

 
         
         		 [bookmark: pgfId-1237550]WebVPN-Home-Page-Use-Smart-Tunnel

  
         		 [bookmark: pgfId-1237552]Y

  
         		 [bookmark: pgfId-1237554]228

  
         		 [bookmark: pgfId-1237556]Boolean

  
         		 [bookmark: pgfId-1237558]Single

  
         		 [bookmark: pgfId-1237560]Enabled if clientless home page is to be rendered through Smart Tunnel.

  
        

 
         
         		 [bookmark: pgfId-1236443]WebVPN-HTML-Filter

  
         		 [bookmark: pgfId-1236445]Y

  
         		 [bookmark: pgfId-1236447]69

  
         		 [bookmark: pgfId-1236449]Bitmap

  
         		 [bookmark: pgfId-1236451]Single

  
         		 [bookmark: pgfId-1236453]1 = Java ActiveX
 2 = Scripts
 4 = Image
 8 = Cookies

  
        

 
         
         		 [bookmark: pgfId-1236857]WebVPN-HTTP-Compression

  
         		 [bookmark: pgfId-1236859]Y

  
         		 [bookmark: pgfId-1236861]120

  
         		 [bookmark: pgfId-1236863]Integer

  
         		 [bookmark: pgfId-1236865]Single

  
         		 [bookmark: pgfId-1236867]0 = Off
 1 = Deflate Compression

  
        

 
         
         		 [bookmark: pgfId-1236475]WebVPN-HTTP-Proxy-IP-Address

  
         		 [bookmark: pgfId-1236477]Y

  
         		 [bookmark: pgfId-1236479]74

  
         		 [bookmark: pgfId-1236481]String

  
         		 [bookmark: pgfId-1236483]Single

  
         		 [bookmark: pgfId-1236485]Comma-separated DNS/IP:port, with http= or https= prefix (for example http=10.10.10.10:80, https=11.11.11.11:443)

  
        

 
         
         		 [bookmark: pgfId-1237165]WebVPN-Idle-Timeout-Alert-Interval

  
         		 [bookmark: pgfId-1237167]Y

  
         		 [bookmark: pgfId-1237169]148

  
         		 [bookmark: pgfId-1237171]Integer

  
         		 [bookmark: pgfId-1237173]Single

  
         		 [bookmark: pgfId-1237175]0-30. 0 = Disabled.

  
        

 
         
         		 [bookmark: pgfId-1236873]WebVPN-Keepalive-Ignore

  
         		 [bookmark: pgfId-1236875]Y

  
         		 [bookmark: pgfId-1236877]121

  
         		 [bookmark: pgfId-1236879]Integer

  
         		 [bookmark: pgfId-1236881]Single

  
         		 [bookmark: pgfId-1236883]0-900

  
        

 
         
         		 [bookmark: pgfId-1236308]WebVPN-Macro-Substitution

  
         		 [bookmark: pgfId-1236310]Y

  
         		 [bookmark: pgfId-1236312]223

  
         		 [bookmark: pgfId-1236314]String

  
         		 [bookmark: pgfId-1236316]Single

  
         		 [bookmark: pgfId-1236318]Unbounded. For examples, see the SSL VPN Deployment Guide at the following URL:

  [bookmark: pgfId-1236320] http://www.cisco.com/en/US/docs/security/asa/asa80/asdm60/ssl_vpn_deployment_guide/deploy.html 

  
        

 
         
         		 [bookmark: pgfId-1236294]WebVPN-Macro-Substitution

  
         		 [bookmark: pgfId-1236296]Y

  
         		 [bookmark: pgfId-1236298]224

  
         		 [bookmark: pgfId-1236300]String

  
         		 [bookmark: pgfId-1236302]Single

  
         		 [bookmark: pgfId-1236304]Unbounded. For examples, see the SSL VPN Deployment Guide at the following URL:

  [bookmark: pgfId-1236306] http://www.cisco.com/en/US/docs/security/asa/asa80/asdm60/ssl_vpn_deployment_guide/deploy.html 

  
        

 
         
         		 [bookmark: pgfId-1236784]WebVPN-Port-Forwarding-Enable

  
         		 [bookmark: pgfId-1236786]Y

  
         		 [bookmark: pgfId-1236788]97

  
         		 [bookmark: pgfId-1236790]Integer

  
         		 [bookmark: pgfId-1236792]Single

  
         		 [bookmark: pgfId-1236794]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236796]WebVPN-Port-Forwarding-Exchange-Proxy-Enable

  
         		 [bookmark: pgfId-1236798]Y

  
         		 [bookmark: pgfId-1236800]98

  
         		 [bookmark: pgfId-1236802]Integer

  
         		 [bookmark: pgfId-1236804]Single

  
         		 [bookmark: pgfId-1236806]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236833]WebVPN-Port-Forwarding-HTTP-Proxy

  
         		 [bookmark: pgfId-1236835]Y

  
         		 [bookmark: pgfId-1236837]99

  
         		 [bookmark: pgfId-1236839]Integer

  
         		 [bookmark: pgfId-1236841]Single

  
         		 [bookmark: pgfId-1236843]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236821]WebVPN-Port-Forwarding-List

  
         		 [bookmark: pgfId-1236823]Y

  
         		 [bookmark: pgfId-1236825]72

  
         		 [bookmark: pgfId-1236827]String

  
         		 [bookmark: pgfId-1236829]Single

  
         		 [bookmark: pgfId-1236831]Port forwarding list name

  
        

 
         
         		 [bookmark: pgfId-1236808]WebVPN-Port-Forwarding-Name

  
         		 [bookmark: pgfId-1236810]Y

  
         		 [bookmark: pgfId-1236812]79

  
         		 [bookmark: pgfId-1236814]String

  
         		 [bookmark: pgfId-1236816]Single

  
         		 [bookmark: pgfId-1236818]String name (example, “Corporate-Apps”).

  [bookmark: pgfId-1236819]This text replaces the default string, “Application Access,” on the clientless portal home page.

  
        

 
         
         		 [bookmark: pgfId-1237261]WebVPN-Post-Max-Size

  
         		 [bookmark: pgfId-1237263]Y

  
         		 [bookmark: pgfId-1237265]159

  
         		 [bookmark: pgfId-1237267]Integer

  
         		 [bookmark: pgfId-1237269]Single

  
         		 [bookmark: pgfId-1237271]0x7fffffff

  
        

 
         
         		 [bookmark: pgfId-1237189]WebVPN-Session-Timeout-Alert-Interval

  
         		 [bookmark: pgfId-1237191]Y

  
         		 [bookmark: pgfId-1237193]149

  
         		 [bookmark: pgfId-1237195]Integer

  
         		 [bookmark: pgfId-1237197]Single

  
         		 [bookmark: pgfId-1237199]0-30. 0 = Disabled.

  
        

 
         
         		 [bookmark: pgfId-1237455]WebVPN Smart-Card-Removal-Disconnect

  
         		 [bookmark: pgfId-1237457]Y

  
         		 [bookmark: pgfId-1237459]225

  
         		 [bookmark: pgfId-1237461]Boolean

  
         		 [bookmark: pgfId-1237463]Single

  
         		 [bookmark: pgfId-1237465]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1237021]WebVPN-Smart-Tunnel

  
         		 [bookmark: pgfId-1237023]Y

  
         		 [bookmark: pgfId-1237025]136

  
         		 [bookmark: pgfId-1237027]String

  
         		 [bookmark: pgfId-1237029]Single

  
         		 [bookmark: pgfId-1237031]Name of a Smart Tunnel

  
        

 
         
         		 [bookmark: pgfId-1237130]WebVPN-Smart-Tunnel-Auto-Sign-On

  
         		 [bookmark: pgfId-1237132]Y

  
         		 [bookmark: pgfId-1237134]139

  
         		 [bookmark: pgfId-1237136]String

  
         		 [bookmark: pgfId-1237138]Single

  
         		 [bookmark: pgfId-1237140]Name of a Smart Tunnel auto sign-on list appended by the domain name

  
        

 
         
         		 [bookmark: pgfId-1237078]WebVPN-Smart-Tunnel-Auto-Start

  
         		 [bookmark: pgfId-1237080]Y

  
         		 [bookmark: pgfId-1237082]138

  
         		 [bookmark: pgfId-1237084]Integer

  
         		 [bookmark: pgfId-1237086]Single

  
         		 [bookmark: pgfId-1237088]0 = Disabled
 1 = Enabled
 2 = Auto Start

  
        

 
         
         		 [bookmark: pgfId-1237489]WebVPN-Smart-Tunnel-Tunnel-Policy

  
         		 [bookmark: pgfId-1237491]Y

  
         		 [bookmark: pgfId-1237493]227

  
         		 [bookmark: pgfId-1237495]String

  
         		 [bookmark: pgfId-1237497]Single

  
         		 [bookmark: pgfId-1237512]One of “e networkname,” “i networkname,” or “a,” where networkname is the name of a Smart Tunnel network list, e indicates the tunnel excluded, i indicates the tunnel specified, and a indicates all tunnels.

  
        

 
         
         		 [bookmark: pgfId-1236383]WebVPN-SSL-VPN-Client-Enable

  
         		 [bookmark: pgfId-1236385]Y

  
         		 [bookmark: pgfId-1236387]103

  
         		 [bookmark: pgfId-1236389]Integer

  
         		 [bookmark: pgfId-1236391]Single

  
         		 [bookmark: pgfId-1236393]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236395]WebVPN-SSL-VPN-Client-Keep- Installation

  
         		 [bookmark: pgfId-1236397]Y

  
         		 [bookmark: pgfId-1236399]105

  
         		 [bookmark: pgfId-1236401]Integer

  
         		 [bookmark: pgfId-1236403]Single

  
         		 [bookmark: pgfId-1236405]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236407]WebVPN-SSL-VPN-Client-Required

  
         		 [bookmark: pgfId-1236409]Y

  
         		 [bookmark: pgfId-1236411]104

  
         		 [bookmark: pgfId-1236413]Integer

  
         		 [bookmark: pgfId-1236415]Single

  
         		 [bookmark: pgfId-1236417]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236845]WebVPN-SSO-Server-Name

  
         		 [bookmark: pgfId-1236847]Y

  
         		 [bookmark: pgfId-1236849]114

  
         		 [bookmark: pgfId-1236851]String

  
         		 [bookmark: pgfId-1236853]Single

  
         		 [bookmark: pgfId-1236855]Valid string

  
        

 
         
         		 [bookmark: pgfId-1237305]WebVPN-Storage-Key

  
         		 [bookmark: pgfId-1237307]Y

  
         		 [bookmark: pgfId-1237309]162

  
         		 [bookmark: pgfId-1237311]String

  
         		 [bookmark: pgfId-1237313]Single

  
         		 
        

 
         
         		 [bookmark: pgfId-1237293]WebVPN-Storage-Objects

  
         		 [bookmark: pgfId-1237295]Y

  
         		 [bookmark: pgfId-1237297]161

  
         		 [bookmark: pgfId-1237299]String

  
         		 [bookmark: pgfId-1237301]Single

  
         		 
        

 
         
         		 [bookmark: pgfId-1236668]WebVPN-SVC-Keepalive-Frequency

  
         		 [bookmark: pgfId-1236670]Y

  
         		 [bookmark: pgfId-1236672]107

  
         		 [bookmark: pgfId-1236674]Integer

  
         		 [bookmark: pgfId-1236676]Single

  
         		 [bookmark: pgfId-1236678]15-600 seconds, 0=Off

  
        

 
         
         		 [bookmark: pgfId-1236680]WebVPN-SVC-Client-DPD-Frequency

  
         		 [bookmark: pgfId-1236682]Y

  
         		 [bookmark: pgfId-1236684]108

  
         		 [bookmark: pgfId-1236686]Integer

  
         		 [bookmark: pgfId-1236688]Single

  
         		 [bookmark: pgfId-1236690]5-3600 seconds, 0=Off

  
        

 
         
         		 [bookmark: pgfId-1236885]WebVPN-SVC-DTLS-Enable

  
         		 [bookmark: pgfId-1236887]Y

  
         		 [bookmark: pgfId-1236889]123

  
         		 [bookmark: pgfId-1236891]Integer

  
         		 [bookmark: pgfId-1236893]Single

  
         		 [bookmark: pgfId-1236895]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236911]WebVPN-SVC-DTLS-MTU

  
         		 [bookmark: pgfId-1236913]Y

  
         		 [bookmark: pgfId-1236915]125

  
         		 [bookmark: pgfId-1236917]Integer

  
         		 [bookmark: pgfId-1236919]Single

  
         		 [bookmark: pgfId-1236921]MTU value is from 256-1406 bytes.

  
        

 
         
         		 [bookmark: pgfId-1236692]WebVPN-SVC-Gateway-DPD-Frequency

  
         		 [bookmark: pgfId-1236694]Y

  
         		 [bookmark: pgfId-1236696]109

  
         		 [bookmark: pgfId-1236698]Integer

  
         		 [bookmark: pgfId-1236700]Single

  
         		 [bookmark: pgfId-1236702]5-3600 seconds, 0=Off

  
        

 
         
         		 [bookmark: pgfId-1236704]WebVPN-SVC-Rekey-Time

  
         		 [bookmark: pgfId-1236706]Y

  
         		 [bookmark: pgfId-1236708]110

  
         		 [bookmark: pgfId-1236710]Integer

  
         		 [bookmark: pgfId-1236712]Single

  
         		 [bookmark: pgfId-1236714]4-10080 minutes, 0=Off

  
        

 
         
         		 [bookmark: pgfId-1236716]WebVPN-SVC-Rekey-Method

  
         		 [bookmark: pgfId-1236718]Y

  
         		 [bookmark: pgfId-1236720]111

  
         		 [bookmark: pgfId-1236722]Integer

  
         		 [bookmark: pgfId-1236724]Single

  
         		 [bookmark: pgfId-1236726]0 (Off), 1 (SSL), 2 (New Tunnel)

  
        

 
         
         		 [bookmark: pgfId-1236728]WebVPN-SVC-Compression

  
         		 [bookmark: pgfId-1236730]Y

  
         		 [bookmark: pgfId-1236732]112

  
         		 [bookmark: pgfId-1236734]Integer

  
         		 [bookmark: pgfId-1236736]Single

  
         		 [bookmark: pgfId-1236738]0 (Off), 1 (Deflate Compression)

  
        

 
         
         		 [bookmark: pgfId-1237427]WebVPN-UNIX-Group-ID (GID)

  
         		 [bookmark: pgfId-1237429]Y

  
         		 [bookmark: pgfId-1237431]222

  
         		 [bookmark: pgfId-1237433]Integer

  
         		 [bookmark: pgfId-1237435]Single

  
         		 [bookmark: pgfId-1237437]Valid UNIX group IDs

  
        

 
         
         		 [bookmark: pgfId-1237345]WebVPN-UNIX-User-ID (UIDs)

  
         		 [bookmark: pgfId-1237347]Y

  
         		 [bookmark: pgfId-1237349]221

  
         		 [bookmark: pgfId-1237351]Integer

  
         		 [bookmark: pgfId-1237353]Single

  
         		 [bookmark: pgfId-1237355]Valid UNIX user IDs

  
        

 
         
         		 [bookmark: pgfId-1237238]WebVPN-Upload-Max-Size

  
         		 [bookmark: pgfId-1237240]Y

  
         		 [bookmark: pgfId-1237242]158

  
         		 [bookmark: pgfId-1237244]Integer

  
         		 [bookmark: pgfId-1237246]Single

  
         		 [bookmark: pgfId-1237248]0x7fffffff

  
        

 
         
         		 [bookmark: pgfId-1236419]WebVPN-URL-Entry-Enable

  
         		 [bookmark: pgfId-1236421]Y

  
         		 [bookmark: pgfId-1236423]93

  
         		 [bookmark: pgfId-1236425]Integer

  
         		 [bookmark: pgfId-1236427]Single

  
         		 [bookmark: pgfId-1236429]0 = Disabled
 1 = Enabled

  
        

 
         
         		 [bookmark: pgfId-1236431]WebVPN-URL-List

  
         		 [bookmark: pgfId-1236433]Y

  
         		 [bookmark: pgfId-1236435]71

  
         		 [bookmark: pgfId-1236437]String

  
         		 [bookmark: pgfId-1236439]Single

  
         		 [bookmark: pgfId-1236441]URL list name

  
        

 
         
         		 [bookmark: pgfId-1237281]WebVPN-User-Storage

  
         		 [bookmark: pgfId-1237283]Y

  
         		 [bookmark: pgfId-1237285]160

  
         		 [bookmark: pgfId-1237287]String

  
         		 [bookmark: pgfId-1237289]Single

  
         		 
        

 
         
         		 [bookmark: pgfId-1237324]WebVPN-VDI

  
         		 [bookmark: pgfId-1237326]Y

  
         		 [bookmark: pgfId-1237328]163

  
         		 [bookmark: pgfId-1237330]String

  
         		 [bookmark: pgfId-1237332]Single

  
         		 [bookmark: pgfId-1237334]List of settings

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-1221826][bookmark: 60104]Supported IETF RADIUS Authorization Attributes

 
      [bookmark: pgfId-1222003] Table 34-2  lists the supported IETF RADIUS attributes.

 
      [bookmark: pgfId-1221990] 

 
      
       
        
         [bookmark: pgfId-1222874]Table 34-2 [bookmark: 56675]Supported IETF RADIUS Attributes 

 
        
       
         
         		
           
           [bookmark: pgfId-1222886]Attribute Name
          
  
         		
           
           [bookmark: pgfId-1222888]ASA
          
  
         		
           
           [bookmark: pgfId-1222890]Attr. No.
          
  
         		
           
           [bookmark: pgfId-1222892]Syntax/Type
          
  
         		
           
           [bookmark: pgfId-1222894]Single or Multi-
           
 Valued
          
  
         		
           
           [bookmark: pgfId-1222896]Description or Value
          
  
        

 
         
         		 [bookmark: pgfId-1222898]IETF-Radius-Class

  
         		 [bookmark: pgfId-1222900]Y

  
         		 [bookmark: pgfId-1222902]25

  
         		 
         		 [bookmark: pgfId-1222906]Single

  
         		 [bookmark: pgfId-1222908]For Versions 8.2.x and later, we recommend that you use the Group-Policy attribute (VSA 3076, #25) as described in  Table 34-1 :

 
           
           		 [bookmark: pgfId-1222912] group policy name 

 
           		 [bookmark: pgfId-1222913]OU= group policy name 

 
           		 [bookmark: pgfId-1222914]OU= group policy name 

 
          

  
        

 
         
         		 [bookmark: pgfId-1222916]IETF-Radius-Filter-Id

  
         		 [bookmark: pgfId-1222918]Y

  
         		 [bookmark: pgfId-1222920]11

  
         		 [bookmark: pgfId-1222922]String

  
         		 [bookmark: pgfId-1222924]Single

  
         		 [bookmark: pgfId-1222929]ACL name that is defined on the ASA, which applies only to full tunnel IPsec and SSL VPN clients.

  
        

 
         
         		 [bookmark: pgfId-1222931]IETF-Radius-Framed-IP-Address

  
         		 [bookmark: pgfId-1222933]Y

  
         		 [bookmark: pgfId-1222935]n/a

  
         		 [bookmark: pgfId-1222937]String

  
         		 [bookmark: pgfId-1222939]Single

  
         		 [bookmark: pgfId-1222941]An IP address

  
        

 
         
         		 [bookmark: pgfId-1222943]IETF-Radius-Framed-IP-Netmask

  
         		 [bookmark: pgfId-1222945]Y

  
         		 [bookmark: pgfId-1222947]n/a

  
         		 [bookmark: pgfId-1222949]String

  
         		 [bookmark: pgfId-1222951]Single

  
         		 [bookmark: pgfId-1222953]An IP address mask

  
        

 
         
         		 [bookmark: pgfId-1222955]IETF-Radius-Idle-Timeout

  
         		 [bookmark: pgfId-1222957]Y

  
         		 [bookmark: pgfId-1222959]28

  
         		 [bookmark: pgfId-1222961]Integer

  
         		 [bookmark: pgfId-1222963]Single

  
         		 [bookmark: pgfId-1222965]Seconds

  
        

 
         
         		 [bookmark: pgfId-1222967]IETF-Radius-Service-Type

  
         		 [bookmark: pgfId-1222969]Y

  
         		 [bookmark: pgfId-1222971]6

  
         		 [bookmark: pgfId-1222973]Integer

  
         		 [bookmark: pgfId-1222975]Single

  
         		 [bookmark: pgfId-1223627]Seconds. Possible Service Type values:

 
           
           		 [bookmark: pgfId-1238360].Administrative—User is allowed access to the configure prompt.

 
           		 [bookmark: pgfId-1223628].NAS-Prompt—User is allowed access to the exec prompt.

 
           		 [bookmark: pgfId-1222979].remote-access—User is allowed network access

 
          

  
        

 
         
         		 [bookmark: pgfId-1222981]IETF-Radius-Session-Timeout

  
         		 [bookmark: pgfId-1222983]Y

  
         		 [bookmark: pgfId-1222985]27

  
         		 [bookmark: pgfId-1222987]Integer

  
         		 [bookmark: pgfId-1222989]Single

  
         		 [bookmark: pgfId-1222991]Seconds

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-1221992][bookmark: 14536]RADIUS Accounting Disconnect Reason Codes

 
      [bookmark: pgfId-1213832]These codes are returned if the ASA encounters a disconnect when sending packets:

 
      [bookmark: pgfId-1213878] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1213835]Disconnect Reason Code 
          
  
        

 
         
         		 [bookmark: pgfId-1213837]ACCT_DISC_USER_REQ = 1

  
        

 
         
         		 [bookmark: pgfId-1213839]ACCT_DISC_LOST_CARRIER = 2

  
        

 
         
         		 [bookmark: pgfId-1213841]ACCT_DISC_LOST_SERVICE = 3

  
        

 
         
         		 [bookmark: pgfId-1213843]ACCT_DISC_IDLE_TIMEOUT = 4

  
        

 
         
         		 [bookmark: pgfId-1213845]ACCT_DISC_SESS_TIMEOUT = 5

  
        

 
         
         		 [bookmark: pgfId-1213847]ACCT_DISC_ADMIN_RESET = 6

  
        

 
         
         		 [bookmark: pgfId-1213849]ACCT_DISC_ADMIN_REBOOT = 7

  
        

 
         
         		 [bookmark: pgfId-1213851]ACCT_DISC_PORT_ERROR = 8

  
        

 
         
         		 [bookmark: pgfId-1213853]ACCT_DISC_NAS_ERROR = 9

  
        

 
         
         		 [bookmark: pgfId-1213855]ACCT_DISC_NAS_REQUEST = 10

  
        

 
         
         		 [bookmark: pgfId-1213857]ACCT_DISC_NAS_REBOOT = 11

  
        

 
         
         		 [bookmark: pgfId-1213859]ACCT_DISC_PORT_UNNEEDED = 12

  
        

 
         
         		 [bookmark: pgfId-1213861]ACCT_DISC_PORT_PREEMPTED = 13

  
        

 
         
         		 [bookmark: pgfId-1213863]ACCT_DISC_PORT_SUSPENDED = 14

  
        

 
         
         		 [bookmark: pgfId-1213865]ACCT_DISC_SERV_UNAVAIL = 15

  
        

 
         
         		 [bookmark: pgfId-1213867]ACCT_DISC_CALLBACK = 16

  
        

 
         
         		 [bookmark: pgfId-1213869]ACCT_DISC_USER_ERROR = 17

  
        

 
         
         		 [bookmark: pgfId-1213871]ACCT_DISC_HOST_REQUEST = 18

  
        

 
         
         		 [bookmark: pgfId-1213873]ACCT_DISC_ADMIN_SHUTDOWN = 19

  
        

 
         
         		 [bookmark: pgfId-1213875]ACCT_DISC_SA_EXPIRED = 21

  
        

 
         
         		 [bookmark: pgfId-1213877]ACCT_DISC_MAX_REASONS = 22

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1053614][bookmark: 15053][bookmark: 36441][bookmark: 77027]Licensing Requirements for RADIUS Servers

 
     [bookmark: pgfId-1265539] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1265532]Model
         
  
        		
          
          [bookmark: pgfId-1265534]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1265536]All models

  
        		 [bookmark: pgfId-1265538]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1053631][bookmark: 54199]Guidelines and Limitations

 
     [bookmark: pgfId-1053632]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1053633]Context Mode Guidelines

 
     [bookmark: pgfId-1053634]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1053635]Firewall Mode Guidelines

 
     [bookmark: pgfId-1053636]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1053637]IPv6 Guidelines

 
     [bookmark: pgfId-1053638]Supports IPv6.

 
     [bookmark: pgfId-1237917]Additional Guidelines

 
     
     		 [bookmark: pgfId-1237918]You can have up to 100 server groups in single mode or 4 server groups per context in multiple mode.

 
     		 [bookmark: pgfId-1237919]Each group can have up to 16 servers in single mode or 4 servers in multiple mode.

 
     		 [bookmark: pgfId-1237922]If you need to configure fallback support using the local database, see the “Fallback Support” and the “How Fallback Works with Multiple Servers in a Group”.

 
     		 [bookmark: pgfId-1238024]To prevent lockout from the ASA when using RADIUS authentication, see the “Recovering from a Lockout”.

 
    

 
   
 
    
     [bookmark: pgfId-1072335][bookmark: 85665]Configuring RADIUS Servers

 
     [bookmark: pgfId-1053641]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1225177]Task Flow for Configuring RADIUS Servers

 
     		 [bookmark: pgfId-1232681]Configuring RADIUS Server Groups

 
     		 [bookmark: pgfId-1209994]Adding a RADIUS Server to a Group

 
     		 [bookmark: pgfId-1259471]Adding an Authentication Prompt

 
    

 
     
      [bookmark: pgfId-1053675][bookmark: 88772]Task Flow for Configuring RADIUS Servers

 
     
 
      [bookmark: pgfId-1228049] Step 1[image: ] Load the ASA attributes into the RADIUS server. The method that you use to load the attributes depends on which type of RADIUS server that you are using:

 
      
       
       		 [bookmark: pgfId-1228050]If you are using Cisco ACS: the server already has these attributes integrated. You can skip this step.

 
       		 [bookmark: pgfId-1228051]For RADIUS servers from other vendors (for example, Microsoft Internet Authentication Service): you must manually define each ASA attribute. To define an attribute, use the attribute name or number, type, value, and vendor code (3076). 

 
      

 
     

 
      [bookmark: pgfId-1228021]Step 2[image: ] [bookmark: 24815]Add a RADIUS server group. See the “Configuring RADIUS Server Groups” section.

 
      [bookmark: pgfId-1210013]Step 3[image: ] For a server group, add a server to the group. See the “Adding a RADIUS Server to a Group” section.

 
      [bookmark: pgfId-1259476]Step 4[image: ] (Optional) Specify text to display to the user during the AAA authentication challenge process. See the “Adding an Authentication Prompt” section.

 
      [bookmark: pgfId-1053711]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1053730][bookmark: 23262]Configuring RADIUS Server Groups[bookmark: marker-1053713][bookmark: marker-1053714][bookmark: marker-1053715][bookmark: marker-1053716][bookmark: marker-1053717][bookmark: marker-1053718][bookmark: marker-1053719][bookmark: marker-1053720][bookmark: marker-1053721][bookmark: marker-1053722][bookmark: marker-1053723][bookmark: marker-1053724][bookmark: marker-1053725][bookmark: marker-1053726] 

 
      [bookmark: pgfId-1053731]If you want to use an external RADIUS server for authentication, authorization, or accounting, you must first create at least one RADIUS server group per AAA protocol and add one or more servers to each group. You identify AAA server groups by name. 

 
      [bookmark: pgfId-1238454]To add a RADIUS server group, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1053742]Detailed Steps

 
     
 
      [bookmark: pgfId-1259484] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups .

 
      [bookmark: pgfId-1259485]Step 2[image: ] In the AAA Server Groups area, click  Add .

 
      [bookmark: pgfId-1259486]The Add AAA Server Group dialog box appears.

 
      [bookmark: pgfId-1259487]Step 3[image: ] In the Server Group field, enter a name for the group.

 
      [bookmark: pgfId-1259488]Step 4[image: ] From the Protocol drop-down list, choose the RADIUS server type.

 
      [bookmark: pgfId-1259489]Step 5[image: ] In the Accounting Mode field, click  Simultaneous or  Single .

 
      [bookmark: pgfId-1259493]In Single mode, the ASA sends accounting data to only one server. 

 
      [bookmark: pgfId-1259497]In Simultaneous mode, the ASA sends accounting data to all servers in the group.

 
      [bookmark: pgfId-1259498]Step 6[image: ] In the Reactivation Mode field, click  Depletion or  Timed .

 
      [bookmark: pgfId-1259499]In Depletion mode, failed servers are reactivated only after all of the servers in the group are inactive.

 
      [bookmark: pgfId-1259500]In Timed mode, failed servers are reactivated after 30 seconds of down time.

 
      [bookmark: pgfId-1259501]Step 7[image: ] If you chose the Depletion reactivation mode, enter a time interval in the Dead Time field.

 
      [bookmark: pgfId-1259502]The Dead Time is the duration of time, in minutes, that elapses between the disabling of the last server in a group and the subsequent re-enabling of all servers.

 
      [bookmark: pgfId-1259503]Step 8[image: ] In the Max Failed Attempts field, add the number of failed attempts allowed.

 
      [bookmark: pgfId-1259504]This option sets the number of failed connection attempts allowed before declaring a nonresponsive server to be inactive.

 
      [bookmark: pgfId-1259505]Step 9[image: ] (Optional) If you are adding a RADIUS server type, perform the following steps:

 
      [bookmark: pgfId-1259506] a.[image: ] Check the  Enable interim accounting update check box if you want to enable multi-session accounting for clientless SSL and AnyConnect sessions.

 
      [bookmark: pgfId-1259507] b.[image: ] Check the  Enable Active Directory Agent Mode check box to specify the shared secret between the ASA and the AD agent and indicate that a RADIUS server group includes AD agents that are not full-function RADIUS servers. Only a RADIUS server group that has been configured using this option can be associated with user identity. 

 
      [bookmark: pgfId-1259511] c.[image: ] Click the  VPN3K Compatibility Option down arrow to expand the list, and click one of the following options to specify whether or not a downloadable ACL received from a RADIUS packet should be merged with a Cisco AV pair ACL:

 
      [bookmark: pgfId-1259512]–[image: ]  Do not merge 

 
      [bookmark: pgfId-1259513]–[image: ]  Place the downloadable ACL after Cisco AV-pair ACL 

 
      [bookmark: pgfId-1259514]–[image: ]  Place the downloadable ACL before Cisco AV-pair ACL 

 
      [bookmark: pgfId-1259515]Step 10[image: ] Click  OK .

 
      [bookmark: pgfId-1259516]The Add AAA Server Group dialog box closes, and the new server group is added to the AAA Server Groups table.

 
      [bookmark: pgfId-1259517]Step 11[image: ] In the AAA Server Groups dialog box, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1259518]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1210083][bookmark: 44488][bookmark: 23109]Adding a RADIUS Server to a Group

 
      [bookmark: pgfId-1210084]To add a RADIUS server to a group, perform the following steps:

 
    
 
     
      [bookmark: pgfId-1210085]Detailed Steps

 
     
 
      [bookmark: pgfId-1259529] Step 1[image: ] Choose  Configuration >  Device Management >  Users/AAA >  AAA Server Groups , and in the AAA Server Groups area, click the server group to which you want to add a server.

 
      [bookmark: pgfId-1259530]The row is highlighted in the table.

 
      [bookmark: pgfId-1259531]Step 2[image: ] In the Servers in the Selected Group area (lower pane), click  Add .

 
      [bookmark: pgfId-1259532]The Add AAA Server Group dialog box appears for the server group.

 
      [bookmark: pgfId-1259533]Step 3[image: ] From the  Interface Name drop-down list, choose the interface name on which the authentication server resides.

 
      [bookmark: pgfId-1259534]Step 4[image: ] In the Server Name or IP Address field, add either a server name or IP address for the server that you are adding to the group.

 
      [bookmark: pgfId-1259535]Step 5[image: ] In the Timeout field, either add a timeout value or keep the default. The timeout is the length of time, in seconds, that the ASA waits for a response from the primary server before sending the request to the backup server.

 
      [bookmark: pgfId-1259542]Step 6[image: ] In the ACL Netmask Convert field, specify how you want the ASA to handle netmasks received in downloadable ACLs. Choose from the following options:

 
      
      		 [bookmark: pgfId-1259546]Detect automatically—The ASA attempts to determine the type of netmask expression used. If the ASA detects a wildcard netmask expression, the ASA converts it to a standard netmask expression.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1259553]Note Because some wildcard expressions are difficult to detect clearly, this setting may misinterpret a wildcard netmask expression as a standard netmask expression. 


      
      
 
     

     

 
      
      		 [bookmark: pgfId-1259557]Standard—The ASA assumes downloadable ACLs received from the RADIUS server contain only standard netmask expressions. No translation from wildcard netmask expressions is performed. 

 
      		 [bookmark: pgfId-1259561]Wildcard—The ASA assumes downloadable ACLs received from the RADIUS server contain only wildcard netmask expressions, and it converts them all to standard netmask expressions when the ACLs are downloaded.

 
     

 
      [bookmark: pgfId-1259562]Step 7[image: ] In the Common Password field, specify a case-sensitive password that is common among users who access this RADIUS authorization server through this ASA. Be sure to provide this information to your RADIUS server administrator.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1259566]Note For an authentication RADIUS server (rather than authorization), do not configure a common password. 

If you leave this field blank, the username is the password for accessing this RADIUS authorization server. 

Never use a RADIUS authorization server for authentication. Common passwords or usernames as passwords are less secure than assigning unique user passwords.

Although the password is required by the RADIUS protocol and the RADIUS server, users do not need to know it.


      
      
 
     

     

 
      [bookmark: pgfId-1259567]Step 8[image: ] If you use double authentication and enable password management in the tunnel group, then the primary and secondary authentication requests include MS-CHAPv2 request attributes. If a RADIUS server does not support MS-CHAPv2, then you can configure that server to send a non-MS-CHAPv2 authentication request by unchecking this check box.

 
      [bookmark: pgfId-1259568]Step 9[image: ] In the Retry Interval field, specify the length of time, from 1 to 10 seconds, that the ASA waits between attempts to contact the server. 

 
      [bookmark: pgfId-1259572]Step 10[image: ] In the Accounting Mode field, click  Simultaneous or  Single .

 
      [bookmark: pgfId-1259576]In Single mode, the ASA sends accounting data to only one server. 

 
      [bookmark: pgfId-1259580]In Simultaneous mode, the ASA sends accounting data to all servers in the group.

 
      [bookmark: pgfId-1259581]Step 11[image: ] In the Server Accounting Port field, specify the server port to be used for accounting of users. The default port is 1646.

 
      [bookmark: pgfId-1259582]Step 12[image: ] In the Server Authentication Port field, specify the server port to be used for authentication of users. The default port is 1645.

 
      [bookmark: pgfId-1259583]Step 13[image: ] In the Server Secret Key field, specify the shared secret key used to authenticate the RADIUS server to the ASA. The server secret that you configure should match the one configured on the RADIUS server. If you do not know the server secret, ask the RADIUS server administrator. The maximum field length is 64 characters.

 
      [bookmark: pgfId-1259587]Step 14[image: ] Click  OK .

 
      [bookmark: pgfId-1259588]The Add AAA Server Group dialog box closes, and the AAA server is added to the AAA server group.

 
      [bookmark: pgfId-1259589]Step 15[image: ] In the AAA Server Groups pane, click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1259590]


      
      
 
     
  
     

 
     
      [bookmark: pgfId-1231142] 
     

    
 
     
      [bookmark: pgfId-1259603][bookmark: 82799][bookmark: 89869][bookmark: 14300]Adding an Authentication Prompt

 
      [bookmark: pgfId-1259607]You can specify the AAA challenge text for HTTP, FTP, and Telnet access through the ASA when requiring user authentication from RADIUS servers. This text is primarily for cosmetic purposes and appears above the username and password prompts that users see when they log in. If you do not specify an authentication prompt, users see the following when authenticating with a RADIUS server:

 
      [bookmark: pgfId-1259625] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1259610]Connection Type
          
  
         		
           
           [bookmark: pgfId-1259612]Default Prompt
          
  
        

 
         
         		 [bookmark: pgfId-1259614]FTP

  
         		 [bookmark: pgfId-1259616]FTP authentication

  
        

 
         
         		 [bookmark: pgfId-1259618]HTTP

  
         		 [bookmark: pgfId-1259620]HTTP authentication

  
        

 
         
         		 [bookmark: pgfId-1259622]Telnet

  
         		 [bookmark: pgfId-1259624]None

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1259626]To add an authentication prompt, perform the following steps:

 
     
 
      [bookmark: pgfId-1259627] Step 1[image: ] From the Configuration > Device Management > Users/AAA > Authentication Prompt pane, enter text in the Prompt field to add as a message to appear above the username and password prompts that users see when they log in.

 
      [bookmark: pgfId-1259628]The following table shows the allowed character limits for authentication prompts:

 
      [bookmark: pgfId-1259646] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1259631]Application
          
  
         		
           
           [bookmark: pgfId-1259633]Character Limit 
          
  
        

 
         
         		 [bookmark: pgfId-1259635]Microsoft Internet Explorer

  
         		 [bookmark: pgfId-1259637]37

  
        

 
         
         		 [bookmark: pgfId-1259639]Telnet

  
         		 [bookmark: pgfId-1259641]235

  
        

 
         
         		 [bookmark: pgfId-1259643]FTP

  
         		 [bookmark: pgfId-1259645]235

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1259647]Step 2[image: ] In the Messages area, add messages in the User accepted message and User rejected message fields.

 
      [bookmark: pgfId-1259648]If the user authentication occurs from Telnet, you can use the User accepted message and User rejected message options to display different status prompts to indicate that the authentication attempt is either accepted or rejected by the RADIUS server.

 
      [bookmark: pgfId-1259652]If the RADIUS server authenticates the user, the ASA displays the User accepted message text, if specified, to the user; otherwise, the ASA displays the User rejected message text, if specified. Authentication of HTTP and FTP sessions displays only the challenge text at the prompt. The User accepted message and User rejected message text are not displayed.

 
      [bookmark: pgfId-1259656]Step 3[image: ] Click  Apply to save the changes to the running configuration.

 
      [bookmark: pgfId-1259657]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1259659][bookmark: 93308]Testing RADIUS Server Authentication and Authorization

 
     [bookmark: pgfId-1259663]To determine whether the ASA can contact a RADIUS server and authenticate or authorize a user, perform the following steps:

 
    
 
     [bookmark: pgfId-1259664] Step 1[image: ] From the Configuration > Device Management > Users/AAA > AAA Server Groups > AAA Server Groups table, click the server group in which the server resides.

 
     [bookmark: pgfId-1259665]The row is highlighted in the table.

 
     [bookmark: pgfId-1259666]Step 2[image: ] From the Servers in the Selected Group table, click the server that you want to test.

 
     [bookmark: pgfId-1259667]The row is highlighted in the table.

 
     [bookmark: pgfId-1259668]Step 3[image: ] Click  Test .

 
     [bookmark: pgfId-1259669]The Test AAA Server dialog box appears for the selected server.

 
     [bookmark: pgfId-1259670]Step 4[image: ] Click the type of test that you want to perform— Authentication or  Authorization . 

 
     [bookmark: pgfId-1259671]Step 5[image: ] In the Username field, enter a username.

 
     [bookmark: pgfId-1259672]Step 6[image: ] If you are testing authentication, in the Password field, enter the password for the username.

 
     [bookmark: pgfId-1259673]Step 7[image: ] Click  OK .

 
     [bookmark: pgfId-1259680]The ASA sends an authentication or authorization test message to the server. If the test fails, ASDM displays an error message.

 
     [bookmark: pgfId-1259681]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1055556][bookmark: 39586]Monitoring RADIUS Servers

 
     [bookmark: pgfId-1055557]To monitor RADIUS servers, see the following panes:

 
     [bookmark: pgfId-1055592] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1055560]Path
         
  
        		
          
          [bookmark: pgfId-1055562]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1055565]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055567]Shows the configured RADIUS server statistics.

  
       

 
        
        		 [bookmark: pgfId-1055571]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055573]Shows the RADIUS server running configuration.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1055594][bookmark: 89792]Additional References

 
     [bookmark: pgfId-1055597]For additional information related to implementing AAA through RADIUS servers, see the “RFCs” section.

 
     
      [bookmark: pgfId-1055621][bookmark: 74323]RFCs

 
      
       
       
         
         		 
           
           [bookmark: pgfId-1055602]RFC
          
  
         		 
           
           [bookmark: pgfId-1055604]Title
          
  
        

 
         
         		 [bookmark: pgfId-1055606]2138

  
         		 [bookmark: pgfId-1055608] Remote Authentication Dial In User Service (RADIUS) 

  
        

 
         
         		 [bookmark: pgfId-1055610]2139

  
         		 [bookmark: pgfId-1055612] RADIUS Accounting 

  
        

 
         
         		 [bookmark: pgfId-1055614]2548

  
         		 [bookmark: pgfId-1055616] Microsoft Vendor-specific RADIUS Attributes 

  
        

 
         
         		 [bookmark: pgfId-1055618]2868

  
         		 [bookmark: pgfId-1055620] RADIUS Attributes for Tunnel Protocol Support 

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1055623][bookmark: 21826]Feature History for RADIUS Servers

 
     [bookmark: pgfId-1055627] Table 34-3  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1055667],

 
     
      
       
        [bookmark: pgfId-1055631]Table 34-3 [bookmark: 67500]Feature History for RADIUS Servers

 
       
      
        
        		
          
          [bookmark: pgfId-1055637]Feature Name
         
  
        		
          
          [bookmark: pgfId-1055639]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1055641]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1055643]RADIUS Servers for AAA

  
        		 [bookmark: pgfId-1055645]7.0(1)

  
        		 [bookmark: pgfId-1055647]Describes how to configure RADIUS servers for AAA.

  [bookmark: pgfId-1259711]We introduced the following screens:

  [bookmark: pgfId-1055651]Configuration > Device Management > Users/AAA > AAA Server Groups
 Configuration > Device Management > Users/AAA > Authentication Prompt.

  
       

 
        
        		 [bookmark: pgfId-1055653]Key vendor-specific attributes (VSAs) sent in RADIUS access request and accounting request packets from the ASA

  
        		 [bookmark: pgfId-1055658]8.4(3)

  
        		 [bookmark: pgfId-1055660]Four New VSAs—Tunnel Group Name (146) and Client Type (150) are sent in RADIUS access request packets from the ASA. Session Type (151) and Session Subtype (152) are sent in RADIUS accounting request packets from the ASA. All four attributes are sent for all accounting request packet types: Start, Interim-Update, and Stop. The RADIUS server (for example, ACS and ISE) can then enforce authorization and policy attributes or use them for accounting and billing purposes.
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     [bookmark: pgfId-1104224][bookmark: 97923]Configuring Web Cache Services Using WCCP[bookmark: marker-1104229]
      
      
 
     
 

 
     [bookmark: pgfId-1125119]This chapter describes how to configure web caching services using WCCP, and includes the following sections:

 
     
     		 [bookmark: pgfId-1104450]Information About WCCP

 
     		 [bookmark: pgfId-1104454]Guidelines and Limitations

 
     		 [bookmark: pgfId-1105257]Licensing Requirements for WCCP

 
     		 [bookmark: pgfId-1147069]Adding or Editing WCCP Service Groups

 
     		 [bookmark: pgfId-1147073]Configuring Packet Redirection

 
     		 [bookmark: pgfId-1105402]WCCP Monitoring

 
     		 [bookmark: pgfId-1105418]Feature History for WCCP

 
    

 
   
 
    
     [bookmark: pgfId-1105267][bookmark: 41713]Information About WCCP

 
     [bookmark: pgfId-1116111]Web Cache Communication Protocol (WCCP) is a content routing protcol that allows utilization of Cisco Cache Engines (or other caches running WCCP) to localize web traffic patterns in the network, enabling content requests to be fulfilled locally. The purpose of web caching is to reduce latency and network traffic. Previously-accessed web pages are stored in a cache buffer, so if users need the page again, they can retrieve it from the cache instead of the web server.

 
     [bookmark: pgfId-1116115]WCCP specifies interactions between the ASA and external web caches. The feature transparently redirects selected types of traffic to a group of web cache engines to optimize resource usage and lower response times. The ASA only supports WCCP Version 2.

 
     [bookmark: pgfId-1101393]Using an ASA as an intermediary eliminates the need for a separate router to do the WCCP redirection, because the ASA redirects requests to cache engines. When the ASA determines that a packet needs redirection, it skips TCP state tracking, TCP sequence number randomization, and NAT on these traffic flows.

 
   
 
    
     [bookmark: pgfId-1101443][bookmark: 37863]Guidelines and Limitations

 
     [bookmark: pgfId-1101469]The following WCCPv2 features are supported for the ASA:

 
     
     		 [bookmark: pgfId-1094606]Redirection of multiple TCP and UDP port-destined traffic.

 
     		 [bookmark: pgfId-1094607]Authentication for cache engines in a service group.

 
     		 [bookmark: pgfId-1104306]Multiple cache engines in a service group.

 
     		 [bookmark: pgfId-1104325]GRE encapsulation.

 
    

 
     [bookmark: pgfId-1104272]The following WCCPv2 features are not supported for the ASA:

 
     
     		 [bookmark: pgfId-1104273]Multiple routers in a service group. 

 
     		 [bookmark: pgfId-1094613]Multicast WCCP.

 
     		 [bookmark: pgfId-1094614]The Layer 2 redirect method.

 
     		 [bookmark: pgfId-1094615]WCCP source address spoofing.

 
     		 [bookmark: pgfId-1115300]WAAS devices.

 
    

 
     [bookmark: pgfId-1094616]ASA Implementation of WCCP

 
     [bookmark: pgfId-1094620]In the ASA implementation of WCCP, the protocol interacts with other configurable features according to the following:

 
     
     		 [bookmark: pgfId-1144360]AAA for network access will not work in combination with WCCP.

 
     		 [bookmark: pgfId-1144361]An inbound access rule always takes higher priority over WCCP. For example, if an ACL does not permit a client to communicate with a server, then traffic is not redirected to a cache engine.

 
     		 [bookmark: pgfId-1094622]TCP intercept, authorization, URL filtering, inspect engines, and IPS features are not applied to a redirected flow of traffic.

 
     		 [bookmark: pgfId-1094623]When a cache engine cannot service a request and a packet is returned, or when a cache miss happens on a cache engine and it requests data from a web server, then the contents of the traffic flow is subject to all the other configured features of the ASA.

 
     		 [bookmark: pgfId-1107954]If you have two WCCP services and they use two different redirection ACLs that overlap and match the same packets (with a deny or a permit action), the packets behave according to the first service-group found and installed rules. The packets are not passed thorugh all service-groups.

 
    

 
     [bookmark: pgfId-1102658]Failover Guidelines

 
     [bookmark: pgfId-1102659]Supports Active/Active and Active/Standby failover. WCCP redirect tables are not replicated to standby units. After a failover, packets are not redirected until the tables are rebuilt. Sessions redirected before failover are probably reset by the web server.

 
     [bookmark: pgfId-1102660]Firewall Mode Guidelines

 
     [bookmark: pgfId-1102661]Supported in routed and transparent firewall modes.

 
     [bookmark: pgfId-1102662]Context Mode Guidelines

 
     [bookmark: pgfId-1102663]Supported in single mode and multiple context mode.

 
     [bookmark: pgfId-1102664]IPv6 Guidelines

 
     [bookmark: pgfId-1102665]Does not support IPv6 traffic for redirection.

 
     [bookmark: pgfId-1126878]Additional Guidelines

 
     [bookmark: pgfId-1126863]The ASA selects the highest IP address configured on any interface as the WCCP router ID. This address is used to establish a GRE tunnel with the cache engine.

 
     [bookmark: pgfId-1141317]WCCP does not support ACLs that include a user, user group, or a fully qualified domain name object.

 
   
 
    
     [bookmark: pgfId-1144622][bookmark: 1H_Head1. Licensing Requirements for WCCP]Licensing Requirements for WCCP

 
     [bookmark: pgfId-1148807] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1148800]Model
         
  
        		
          
          [bookmark: pgfId-1148802]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1148804]All models

  
        		 [bookmark: pgfId-1148806]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1147080][bookmark: 1H_Head1. Configuring WCCP]Configuring WCCP Service Groups

 
     [bookmark: pgfId-1147081]To allocate space and enable support of the specified WCCP service group, perform the following steps:

 
    
 
     [bookmark: pgfId-1147082] Step 1[image: ] In the ASDM main application window, choose  Configuration > Device Management > Advanced > WCCP > Service Groups .

 
     [bookmark: pgfId-1147083]Step 2[image: ] To add a new service group, click  Add to display the A dd Service Group dialog box.  

 
     [bookmark: pgfId-1147084]Step 3[image: ] To modify an existing service group, click  Edit to display the Edit Service Group dialog box.

 
     [bookmark: pgfId-1147085]Step 4[image: ] To remove a selected service group, click  Delete .

 
     [bookmark: pgfId-1147088]Step 5[image: ]  To continue, see “Adding or Editing WCCP Service Groups” section. 

 
     [bookmark: pgfId-1147090]Step 6[image: ] Click  Apply to save your changes, or click  Reset to discard them and enter new ones.

 
     [bookmark: pgfId-1147091]


     
     
 
    
  
    

 
     
      [bookmark: pgfId-1147094][bookmark: 2H_Head2. Adding or Editing WCCP Service Groups]Adding or Editing WCCP Service Groups

 
      [bookmark: pgfId-1147095]To add a new service group or change the service group parameters for a configured service group, perform the following steps:

 
     
 
      [bookmark: pgfId-1147096] Step 1[image: ] Click either the Web Cache Service or the Dynamic Service Number radio button. The maximum number of services, including those specified with a dynamic service identifier is 256.

 
      [bookmark: pgfId-1147097]Step 2[image: ] Enter the dynamic service identifier, which means the service definition is dictated by the cache. Valid dynamic service numbers are 0 to 254, and are used as the name of the service group. 

 
      [bookmark: pgfId-1147098]Step 3[image: ] In the Options area, perform the following steps:

 
      [bookmark: pgfId-1147099] a.[image: ] Choose the predefined ACL that controls traffic redirected to this service group.

 
      [bookmark: pgfId-1147100] b.[image: ] Choose the predefined ACL that determines which web caches are allowed to participate in the service group. Only extended ACLs are allowed.

 
      [bookmark: pgfId-1147101] c.[image: ] Enter a password up to seven characters long, which is used for MD5 authentication for messages received from the service group. 

 
      [bookmark: pgfId-1147102] d.[image: ] Confirm the password.

 
      [bookmark: pgfId-1147103] e.[image: ] Click  Manage to display the ACL Manager window, where you can create or change an ACL.

 
      [bookmark: pgfId-1147104]Step 4[image: ] Click  OK to close the Add or Edit Service Group dialog box.

 
      [bookmark: pgfId-1147108]Step 5[image: ] To continue, see the “Configuring Packet Redirection” section.

 
      [bookmark: pgfId-1147109]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1147112][bookmark: 1H_Head1. Configuring Packet Redirection]Configuring Packet Redirection

 
     [bookmark: pgfId-1147113]To configure packet redirection on the ingress of an interface using WCCP, perform the following steps:

 
    
 
     [bookmark: pgfId-1147114] Step 1[image: ] In the ASDM main application window, choose  Configuration > Device Management > Advanced > WCCP > Redirection .

 
     [bookmark: pgfId-1147115]Step 2[image: ] To add a new WCCP packet redirection, click  Add to display the Add WCCP Redirection dialog box.

 
     [bookmark: pgfId-1147116]Step 3[image: ] To modify an existing WCCP packet redirection, click  Edit to display the Edit WCCP Redirection dialog box.

 
     [bookmark: pgfId-1147117]Step 4[image: ] To remove a selected WCCP packet redirection, click  Delete .

 
     [bookmark: pgfId-1147121]Step 5[image: ] To continue, see the “Adding or Editing Packet Redirection” section.

 
     [bookmark: pgfId-1147122]


     
     
 
    
  
    

 
     
      [bookmark: pgfId-1147125][bookmark: 51096]Adding or Editing Packet Redirection

 
      [bookmark: pgfId-1147126]To add or change packet redirection on the ingress of an interface using WCCP, perform the following steps:

 
     
 
      [bookmark: pgfId-1147127] Step 1[image: ] Choose the interface on which to enable WCCP redirection from the drop-down list.

 
      [bookmark: pgfId-1147128]Step 2[image: ] Choose the service group from the drop-down list.

 
      [bookmark: pgfId-1147129]Step 3[image: ] Click  OK to close the Edit WCCP Redirection dialog box. 

 
      [bookmark: pgfId-1147130]Step 4[image: ] (Optional) If you need to create a new service group, click  New to display the Add Service Group dialog box.

 
      [bookmark: pgfId-1147133]Step 5[image: ] (Optional) To continue, see the “Adding or Editing WCCP Service Groups” section.

 
      [bookmark: pgfId-1147135]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1101602][bookmark: 1H_Head1. WCCP Monitoring Commands]WCCP Monitoring 

 
     [bookmark: pgfId-1105296]To monitor WCCP, perform the following steps:

 
     [bookmark: pgfId-1105326] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1105299]Path
         
  
        		
          
          [bookmark: pgfId-1105301]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1147155] Tools > Command Line Interface 

  [bookmark: pgfId-1105305]Type  show running-config wccp , then click  Send .

  
        		 [bookmark: pgfId-1105307]Shows the current WCCP configuration.

  
       

 
        
        		 [bookmark: pgfId-1147161] Tools > Command Line Interface 

  [bookmark: pgfId-1105311]Type  show running-config wccp interface , then click  Send .

  
        		 [bookmark: pgfId-1105313]Shows the current WCCP interfaces status.

  
       

 
        
        		 [bookmark: pgfId-1105315]Monitoring > Properties > WCCP > WCCP Service Groups

  
        		 [bookmark: pgfId-1105317]Shows configured WCCP service groups.

  
       

 
        
        		 [bookmark: pgfId-1105319]Monitoring > Properties > WCCP > WCCP Redirection

  
        		 [bookmark: pgfId-1105321]Shows configured WCCP interface statistics.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1105286][bookmark: 1H_Heading1. Feature History for WCCP]Feature History for WCCP

 
     [bookmark: pgfId-1101606] Table 19-1  lists the release history for this feature. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1101627] 

 
     
      
       
        [bookmark: pgfId-1101610]Table 19-1 [bookmark: 50557]Feature History for WCCP

 
       
      
        
        		
          
          [bookmark: pgfId-1101616]Feature Name
         
  
        		
          
          [bookmark: pgfId-1101618]Releases
         
  
        		
          
          [bookmark: pgfId-1101620]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1101622]WCCP

  
        		 [bookmark: pgfId-1101624]7.2(1) 

  
        		 [bookmark: pgfId-1101626]WCCP specifies interactions between the ASA and external web caches.

  [bookmark: pgfId-1147167]We introduced the following screens:

  [bookmark: pgfId-1107648] Configuration > Device Management > Advanced > WCCP > Service Groups
 Configuration > Device Management > Advanced > WCCP > Redirection 
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     [bookmark: pgfId-1086173][bookmark: 42671]Adding a Standard Access Control List
      
      
 
     
 

 
     [bookmark: pgfId-1086174]This chapter describes how to configure a standard ACL and includes the following sections:

 
     
     		 [bookmark: pgfId-1086178]Information About Standard ACLs

 
     		 [bookmark: pgfId-1057268]Licensing Requirements for Standard ACLs

 
     		 [bookmark: pgfId-1046652]Guidelines and Limitations

 
     		 [bookmark: pgfId-1068149]Default Settings

 
     		 [bookmark: pgfId-1046685]Adding Standard ACLs

 
     		 [bookmark: pgfId-1068119]Feature History for Standard ACLs

 
    

 
   
 
    
     [bookmark: pgfId-1056837][bookmark: 15525]Information About Standard ACLs

 
     [bookmark: pgfId-1077429]Standard ACLs identify the destination IP addresses of OSPF routes and can be used in a route map for OSPF redistribution. Standard ACLs cannot be applied to interfaces to control traffic. 

 
   
 
    
     [bookmark: pgfId-1077431][bookmark: 29596]Licensing Requirements for Standard ACLs

 
     [bookmark: pgfId-1067555]The following table shows the licensing requirements for this feature:

 
     [bookmark: pgfId-1162111] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1162104]Model
         
  
        		
          
          [bookmark: pgfId-1162106]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1162108]All models

  
        		 [bookmark: pgfId-1162110]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1057302][bookmark: 16098][bookmark: 58316]Guidelines and Limitations

 
     [bookmark: pgfId-1071208]This section includes the guidelines and limitations for this feature:

 
     
     		 [bookmark: pgfId-1071212]Context Mode Guidelines

 
     		 [bookmark: pgfId-1081054]Firewall Mode Guidelines 

 
     		 [bookmark: pgfId-1081071]IPv6 Guidelines

 
     		 [bookmark: pgfId-1071228]Additional Guidelines and Limitations

 
    

 
     [bookmark: pgfId-1071231][bookmark: 87419]Context Mode Guidelines

 
     [bookmark: pgfId-1071232]Supported in single context mode only.

 
     [bookmark: pgfId-1078951][bookmark: 25097]Firewall Mode Guidelines

 
     [bookmark: pgfId-1078964]Supported in routed and transparent firewall modes.

 
     [bookmark: pgfId-1081088][bookmark: 61868]IPv6 Guidelines

 
     [bookmark: pgfId-1081105]Supports IPv6.

 
     [bookmark: pgfId-1071249][bookmark: 23253]Additional Guidelines and Limitations

 
     [bookmark: pgfId-1071250]The following guidelines and limitations apply for standard ACLs:

 
     
     		 [bookmark: pgfId-1084451]Standard ACLs identify the destination IP addresses (not source addresses) of OSPF routes and can be used in a route map for OSPF redistribution. Standard ACLs cannot be applied to interfaces to control traffic.

 
     		 [bookmark: pgfId-1079744]When specifying a source, local, or destination address, use the following guidelines:

 
    

 
     [bookmark: pgfId-1079753]–[image: ] Use a 32-bit quantity in four-part, dotted-decimal format.

 
     
     		 [bookmark: pgfId-1158673]If you add descriptive remarks to your ACL with non-English characters on one platform (such as Windows) then try to remove them from another platform (such as Linux), you might not be able to edit or delete them because the original characters might not be correctly recognized. This limitation is due to an underlying platform dependency that encodes different language characters in different ways.

 
    

 
   
 
    
     [bookmark: pgfId-1117642][bookmark: 60355]Default [bookmark: marker-1117641]Settings

 
     [bookmark: pgfId-1117646] Table 22-1  lists the default settings for standard ACL parameters.

 
     [bookmark: pgfId-1074589] 

 
     
      
       
        [bookmark: pgfId-1074570]Table 22-1 [bookmark: 30979]Default Standard ACL Parameters 

 
       
      
        
        		
          
          [bookmark: pgfId-1074574]Parameters
         
  
        		
          
          [bookmark: pgfId-1074576]Default
         
  
       

 
        
        		 [bookmark: pgfId-1074578]deny

  
        		 [bookmark: pgfId-1074580]The ASA denies all packets on the originating interface unless you specifically permit access.

  [bookmark: pgfId-1079366]ACL logging generates system log message 106023 for denied packets. Deny packets must be present to log denied packets. 

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1074591][bookmark: 71793]Adding Standard ACLs

 
     [bookmark: pgfId-1055477]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1158681]Using Standard ACLs

 
    

 
     
      [bookmark: pgfId-1158688][bookmark: 67641][bookmark: 30332]Using Standard ACLs[bookmark: marker-1158686] [bookmark: marker-1158687] 

 
      [bookmark: pgfId-1158689]Standard ACLs identify the destination IP addresses (not source addresses) of OSPF routes and can be used in a route map for OSPF redistribution. Standard ACLs cannot be applied to interfaces to control traffic.

 
      [bookmark: pgfId-1158690]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1158694]Adding a Standard ACL

 
      		 [bookmark: pgfId-1158698]Adding an ACE to a Standard ACL

 
      		 [bookmark: pgfId-1158702]Editing an ACE in a Standard ACL

 
     

 
    
 
     
      [bookmark: pgfId-1158704][bookmark: 15424]Adding a Standard ACL

 
      [bookmark: pgfId-1158705]To add a standard ACL to your configuration, perform the following steps:

 
      [bookmark: pgfId-1158706]


      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > 
      Firewall > 
      Advanced > 
      Standard ACL. 
     

 
      [bookmark: pgfId-1158707]Step 2[image: ] Click  Add , and from the drop-down list, choose  Add ACL .

 
      [bookmark: pgfId-1158708]Step 3[image: ] In the Add ACL dialog box, add a name or number (without spaces) to identify the ACL.

 
      [bookmark: pgfId-1158709]Step 4[image: ] Click  OK. 

 
      [bookmark: pgfId-1158710]The ACL name appears in the main pane.

 
      [bookmark: pgfId-1158711]You may add additional ACLs.

 
      [bookmark: pgfId-1158712]Step 5[image: ] Click  Apply to save the ACLs to your configuration.

 
      [bookmark: pgfId-1158713]You can now add one or more ACEs to the newly created ACL.

 
      [bookmark: pgfId-1158717]To add an ACE, see the “Adding an ACE to a Standard ACL” section.

 
      [bookmark: pgfId-1158718]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1158721][bookmark: 74659]Adding an ACE to a Standard ACL[bookmark: marker-1158720]

 
      [bookmark: pgfId-1158722]Before you can add an ACE to a configuration, you must first add an ACL. For information about adding a standard ACL, see the “Adding a Standard ACL” section. For information about editing ACEs, see the “Editing an ACE in a Standard ACL” section

 
      [bookmark: pgfId-1158729]To add an ACE to an ACL that exists in your configuration, perform the following steps:

 
      [bookmark: pgfId-1158730]


      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > 
      Firewall > 
      Advanced > 
      Standard ACL. 
     

 
      [bookmark: pgfId-1158731]Step 2[image: ] In the main pane, select the ACL for which you want to add an ACE.

 
      [bookmark: pgfId-1158732]Step 3[image: ] Click  Add , and choose  Add ACE from the drop-down list.

 
      [bookmark: pgfId-1158733]The Add ACE dialog box appears.

 
      [bookmark: pgfId-1158734]Step 4[image: ] (Optional) To specify the placement of the new ACE, select an existing ACE, and click Insert... to add the ACE before the selected ACE, or click Insert After... to add the ACE after the selected ACE.

 
      [bookmark: pgfId-1158735]Step 5[image: ] Click one of the following radio buttons to choose an action:

 
      
       
       		 [bookmark: pgfId-1158736] Permit —Permits access if the conditions are matched.

 
       		 [bookmark: pgfId-1158737] Deny —Denies access if the conditions are matched.

 
      

 
     

 
      [bookmark: pgfId-1158738]Step 6[image: ] In the Address field, enter the IP address of the destination to which you want to perform or deny access.

 
      [bookmark: pgfId-1158739]You can also browse for the address of a network object by clicking the ellipsis at the end of the Address field.

 
      [bookmark: pgfId-1158740]Step 7[image: ] (Optional) In the Description field, enter a description that makes an ACE easier to understand.

 
      [bookmark: pgfId-1158741]The description can contain multiple lines; however, each line can be no more than 100 characters in length.

 
      [bookmark: pgfId-1158742]Step 8[image: ] Click  OK .

 
      [bookmark: pgfId-1158743]The newly created ACE appears under the ACL.

 
      [bookmark: pgfId-1158744]Step 9[image: ] Click Apply to save the ACE to your configuration.

 
      [bookmark: pgfId-1158745]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1158747][bookmark: 33089]Editing an ACE in a Standard ACL

 
      [bookmark: pgfId-1158748]To edit an ACE in a standard ACL, perform the following steps:

 
      [bookmark: pgfId-1158749]


      
      
 
     
 
     Step 1
     [image: ] Choose 
      Configuration > 
      Firewall > 
      Advanced > 
      Standard ACL. 
     

 
      [bookmark: pgfId-1158750]Step 2[image: ] In the main pane, select the existing ACE that you want to edit.

 
      [bookmark: pgfId-1158751]Step 3[image: ] Click  Edit. 

 
      [bookmark: pgfId-1158752]The Edit ACE dialog box appears.

 
      [bookmark: pgfId-1158753]Step 4[image: ] Enter the desired changes. 

 
      [bookmark: pgfId-1158754]Step 5[image: ] Click  OK .

 
      [bookmark: pgfId-1158755]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1046350][bookmark: 60078][bookmark: 57918][bookmark: 85708][bookmark: 62233][bookmark: 56721][bookmark: 96108][bookmark: 12973][bookmark: 92503]Feature History for Standard ACLs

 
     [bookmark: pgfId-1068790] Table 22-2  lists the release history for this feature.

 
     [bookmark: pgfId-1068794] 

 
     
      
       
        [bookmark: pgfId-1068883]Table 22-2 [bookmark: 27355]Feature History for Standard ACLs

 
       
      
        
        		
          
          [bookmark: pgfId-1068889]Feature Name
         
  
        		
          
          [bookmark: pgfId-1068891]Releases
         
  
        		
          
          [bookmark: pgfId-1068893]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1068895]Standard ACLs

  
        		 [bookmark: pgfId-1068897]7.0(1)

  
        		 [bookmark: pgfId-1070971]Standard ACLs identify the destination IP addresses of OSPF routes, which can be used in a route map for OSPF redistribution.

  [bookmark: pgfId-1158766]The feature was introduced.
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     [bookmark: pgfId-1042019][bookmark: 46163]Troubleshooting
      
      
 
     
 

 
     [bookmark: pgfId-1093131]This chapter describes how to troubleshoot the ASA and includes the following sections:

 
     
     		 [bookmark: pgfId-1279231]Configuring and Running Captures with the Packet Capture Wizard

 
    

 
   
 
    
     [bookmark: pgfId-1279237]  [bookmark: 35271][bookmark: 61601]Configuring and Running Captures with the Packet Capture Wizard

 
     [bookmark: pgfId-1279239]You can use the Packet Capture Wizard to configure and run captures for troubleshooting errors. The captures can use ACLs to limit the type of traffic captured, the source and destination addresses and ports, and one or more interfaces. The wizard runs one capture on each of the ingress and egress interfaces. You can save the captures on your PC to examine them in a packet analyzer.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1279240]Note This tool does not support clientless SSL VPN capture.


     
     
 
    

    

 
     [bookmark: pgfId-1279241]To configure and run captures, perform the following steps:

 
    
 
     [bookmark: pgfId-1279242] Step 1[image: ] In the main ASDM application window, choose  Wizards > Packet Capture Wizard .

 
     [bookmark: pgfId-1279244]The Overview of Packet Capture screen appears, with a list of the tasks through which the wizard will guide you to complete. Those tasks include the following:

 
     
      
      		 [bookmark: pgfId-1279245]Selecting an ingress interface.

 
      		 [bookmark: pgfId-1279246]Selecting an egress interface.

 
      		 [bookmark: pgfId-1279247]Setting the buffer parameters.

 
      		 [bookmark: pgfId-1279248]Running the captures.

 
      		 [bookmark: pgfId-1279249]Saving the captures to your PC (optional).

 
     

 
    

 
     [bookmark: pgfId-1279250]Step 2[image: ] Click  Next .

 
     [bookmark: pgfId-1279255]In a clustering environment, the Cluster Option screen appears. Go to Step 3.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1279259]Note For more information about clustering, see Chapter10, “Configuring a Cluster of ASAs”


     
     
 
    

    

 
     [bookmark: pgfId-1279263]In a non-clustering environment, the Ingress Traffic Selector screen appears. Go to Step 4.

 
     [bookmark: pgfId-1279265]Step 3[image: ] [bookmark: 17549]In the Cluster Option screen, choose one of the following options for running a capture:  This device only or  The whole cluster[image: ] , then click  Next to display the Ingress Selector screen.

 
     [bookmark: pgfId-1279267]Step 4[image: ] [bookmark: 43976]To capture packets on an interface, click the  Select Interface radio button. To capture packets on the ASA CX dataplane, click the  Use backplane channel radio button.

 
     [bookmark: pgfId-1279271]Step 5[image: ] In the Packet Match Criteria area, do one of the following:

 
     
      
      		 [bookmark: pgfId-1279272]To specify the ACL to use for matching packets, click the  Specify access-list radio button, and then choose the ACL from the Select ACL drop-down list. To add a previously configured ACL to the current drop-down list, click  Manage to display the ACL Manager pane. Choose an ACL, and click  OK .

 
      		 [bookmark: pgfId-1279273]To specify packets parameters, click the  Specify Packet Parameters radio button.

 
     

 
    

 
     [bookmark: pgfId-1279278]Step 6[image: ] Tocontinue, see the “Ingress Traffic Selector” section.

 
     [bookmark: pgfId-1279280]Step 7[image: ] Click  Next to display the Egress Traffic Selector screen. To continue, see the “Egress Traffic Selector” section.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1279284]Note The source port services, destination port services, and ICMP type are read-only and are based on the choices that you made in the Ingress Traffic Selector screen. 


     
     
 
    

    

 
     [bookmark: pgfId-1279286]Step 8[image: ] Click  Next to display the Buffers & Captures screen. To continue, see the “Buffers” section.

 
     [bookmark: pgfId-1279290]Step 9[image: ] In the Capture Parameters area, to obtain the latest capture every 10 seconds automatically, check the  Get capture every 10 seconds check box. By default, this capture uses the circular buffer.

 
     [bookmark: pgfId-1279291]Step 10[image: ] In the Buffer Parameters area, you specify the buffer size and packet size. The buffer size is the maximum amount of memory that the capture can use to store packets. The packet size is the longest packet that the capture can hold. We recommend that you use the longest packet size to capture as much information as possible. 

 
     [bookmark: pgfId-1279292] a.[image: ] Enter the packet size. The valid size ranges from 14 - 1522 bytes.

 
     [bookmark: pgfId-1279293] b.[image: ] Enter the buffer size. The valid size ranges from 1534 - 33554432 bytes.

 
     [bookmark: pgfId-1279294] c.[image: ] Check the  Use circular buffer check box to store captured packets. 

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1279295]Note When you choose this setting, if all the buffer storage is used, the capture starts overwriting the oldest packets.


     
     
 
    

    

 
     [bookmark: pgfId-1279297]Step 11[image: ] Click  Next to display the Summary screen, which shows the cluster[image: ] options for all units in the cluster (if you are using clustering), traffic selectors, and buffer parameters that you have entered. To continue, see the “Summary” section. 

 
     [bookmark: pgfId-1279302]Step 12[image: ] Click  Next to display the Run Captures screen, and then click  Start to begin capturing packets. Click  Stop to end the capture. To continue, see the “Run Captures” section. If you are using cluster[image: ]ing, go to Step 14.

 
     [bookmark: pgfId-1279306]Step 13[image: ] Click  Get Capture Buffer  to determine how much buffer space you have remaining. Click  Clear Buffer on Device to remove the current content and allow room in the buffer to capture more packets.

 
     [bookmark: pgfId-1279307]Step 14[image: ] In a clustering environment, on the Run Captures screen, perform one or more of the following steps:

 
     
      
      		 [bookmark: pgfId-1279308]Click  Get Cluster Capture Summary to view a summary of packet capture information for all units in the cluster, followed by packet capture information for each unit. 

 
      		 [bookmark: pgfId-1279309]Click  Get Capture Buffer  to determine how much buffer space you have remaining in each unit of the cluster. The Capture Buffer from Device dialog box appears. 

 
      		 [bookmark: pgfId-1279310]Click  Clear Buffer on Device to remove the current content for one or all of the units in a cluster and allow room in the buffer to capture more packets.

 
     

 
    

 
     [bookmark: pgfId-1279312]Step 15[image: ] Click  Save captures  to display the Save Capture dialog box. You have the option of saving either the ingress capture, the egress capture, or both. To continue, see the “Save Captures” section.

 
     [bookmark: pgfId-1279316]Step 16[image: ] To save the ingress packet capture, click  Save Ingress Capture  to display the Save capture file dialog box. Specify the storage location on your PC, and click  Save .

 
     [bookmark: pgfId-1279317]Step 17[image: ] Click  Launch Network Sniffer Application to start the packet analysis application specified in Tools > Preferences for analyzing the ingress capture.

 
     [bookmark: pgfId-1279318]Step 18[image: ] To save the egress packet capture, click  Save Egress Capture to display the Save capture file dialog box. Specify the storage location on your PC, and click  Save .

 
     [bookmark: pgfId-1279319]Step 19[image: ] Click  Launch Network Sniffer Application to start the packet analysis application specified in Tools > Preferences for analyzing the egress capture.

 
     [bookmark: pgfId-1279320]Step 20[image: ] Click  Close, then click  Finish to exit the wizard.

 
     [bookmark: pgfId-1279321]


     
     
 
    
  
    

 
     
      [bookmark: pgfId-1279324][bookmark: 33011]Ingress Traffic Selector

 
      [bookmark: pgfId-1279325]To configure the ingress interface, source and destination hosts or networks, and the protocol for packet capture, perform the following steps:

 
     
 
      [bookmark: pgfId-1279326] Step 1[image: ] In the Point of Ingress area, choose the ingress interface name from the drop-down list. 

 
      [bookmark: pgfId-1279330]Step 2[image: ] Enter the ingress source host and network. To capture packets on the ASA CX dataplane, click the  Use backplane channel radio button. 

 
      [bookmark: pgfId-1279331]Step 3[image: ] Enter the ingress destination host and network.

 
      [bookmark: pgfId-1279332]Step 4[image: ] Enter the protocol type to capture. Available protocols are ah, eigrp, esp, gre, icmp, icmp6, igmp, igrp, ip, ipinip, nos, ospf, pcp, pim, snp, tcp, or udp.

 
      [bookmark: pgfId-1279333] a.[image: ] Enter the ICMP type for ICMP only. Available types include all, alternate address, conversion-error, echo, echo-reply, information-reply, information-request, mask-reply, mask-request, mobile-redirect, parameter-problem, redirect, router-advertisement, router-solicitation, source-quench, time-exceeded, timestamp-reply, timestamp-request, traceroute, or unreachable.

 
      [bookmark: pgfId-1279334] b.[image: ] Specify the source and destination port services for the TCP and UDP protocols only. Available options include the following:

 
      [bookmark: pgfId-1279335]–[image: ] To include all services, choose All Services.

 
      [bookmark: pgfId-1279336]–[image: ] To include a service group, choose Service Groups.

 
      [bookmark: pgfId-1279337]–[image: ] To include a specific service, choose one of the following: aol, bgp, chargen, cifx, citrix-ica, ctiqbe, daytime, discard, domain, echo, exec, finger, ftp, ftp-data, gopher, h323, hostname, http, https, ident, imap4, irc, kerberos, klogin, kshell, ldap, ldaps, login, lotusnotes, lpd, netbios-ssn, nntp, pcanywhere-data, pim-auto-rp, pop2, pop3, pptp, rsh, rtsp, sip, smtp, sqlnet, ssh, sunrpc, tacacs, talk, telnet, uucp, or whois.

 
      [bookmark: pgfId-1279338]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1279341][bookmark: 70066]Egress Traffic Selector

 
      [bookmark: pgfId-1279342]To configure the egress interface, source and destination hosts/networks, and source and destination port services for packet capture, perform the following steps:

 
     
 
      [bookmark: pgfId-1279343] Step 1[image: ] To capture packets on an interface, click the  Select Interface radio button. To capture packets on the ASA CX dataplane, click the  Use backplane channel radio button.

 
      [bookmark: pgfId-1279347]Step 2[image: ] In the Point of Egress area, choose the egress interface name from the drop-down list. 

 
      [bookmark: pgfId-1279348]Step 3[image: ] Enter the egress source host and network.

 
      [bookmark: pgfId-1279349]Step 4[image: ] Enter the egress destination host and network.

 
      [bookmark: pgfId-1279350]The protocol type selected during the ingress configuration is already listed.

 
      [bookmark: pgfId-1279351]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1279354][bookmark: 79072]Buffers

 
      [bookmark: pgfId-1279355]To configure the packet size, buffer size, and use of the circular buffer for packet capture, perform the following steps.

 
     
 
      [bookmark: pgfId-1279356] Step 1[image: ] Enter the longest packet that the capture can hold. Use the longest size available to capture as much information as possible. 

 
      [bookmark: pgfId-1279357]Step 2[image: ] Enter the maximum amount of memory that the capture can use to store packets.

 
      [bookmark: pgfId-1279358]Step 3[image: ] Use the circular buffer to store packets. When the circular buffer has used all of the buffer storage, the capture will overwrite the oldest packets first.

 
      [bookmark: pgfId-1279359]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1279362][bookmark: 38087]Summary

 
      [bookmark: pgfId-1279363]The Summary screen shows the cluster options (if you are using clustering), traffic selectors, and the buffer parameters for the packet capture selected in the previous wizard screens.

 
    
 
     
      [bookmark: pgfId-1279369][bookmark: 35636]Run Captures

 
      [bookmark: pgfId-1279370]To start and stop the capture session, view the capture buffer, launch a network analyzer application, save packet captures, and clear the buffer, perform the following steps:

 
     
 
      [bookmark: pgfId-1279371] Step 1[image: ] To begin the packet capture session on a selected interface, click  Start .

 
      [bookmark: pgfId-1279372]Step 2[image: ] To stop the packet capture session on a selected interface, click  Stop .

 
      [bookmark: pgfId-1279373]Step 3[image: ] To obtain a snapshot of the captured packets on the interface, click  Get Capture Buffer .

 
      [bookmark: pgfId-1279374]Step 4[image: ] To show the capture buffer on the ingress interface, click  Ingress .

 
      [bookmark: pgfId-1279375]Step 5[image: ] To show the capture buffer on the egress interface, click  Egress .

 
      [bookmark: pgfId-1279376]Step 6[image: ] To clear the buffer on the device, click  Clear Buffer on Device .

 
      [bookmark: pgfId-1279377]Step 7[image: ] To start the packet analysis application for analyzing the ingress capture or the egress capture specified in Tools > Preferences, click  Launch Network Sniffer Application .

 
      [bookmark: pgfId-1279378]Step 8[image: ] To save the ingress and egress captures in either ASCII or PCAP format, click  Save Captures .

 
      [bookmark: pgfId-1279379]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1279385][bookmark: 86610]Save Captures

 
      [bookmark: pgfId-1279386]To save the ingress and egress packet captures to ASCII or PCAP file format for further packet analysis, perform the following steps:

 
     
 
      [bookmark: pgfId-1279387] Step 1[image: ] To save the capture buffer in ASCII format, click  ASCII .

 
      [bookmark: pgfId-1279388]Step 2[image: ] To save the capture buffer in PCAP format, click  PCAP .

 
      [bookmark: pgfId-1279389]Step 3[image: ] To specify a file in which to save the ingress packet capture, click  Save ingress capture .

 
      [bookmark: pgfId-1279390]Step 4[image: ] To specify a file in which to save the egress packet capture, click  Save egress capture .

 
      [bookmark: pgfId-1279391]
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     [bookmark: pgfId-1002608][bookmark: 36611]Configuring the ASA to Integrate with Cisco TrustSec
      
      
 
     
 

 
     [bookmark: pgfId-1091132]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1393741]Information About the ASA Integrated with Cisco TrustSec

 
     		 [bookmark: pgfId-1416190]Licensing Requirements for Cisco TrustSec

 
     		 [bookmark: pgfId-1416195]Prerequisites for Using Cisco TrustSec

 
     		 [bookmark: pgfId-1420401]Guidelines and Limitations

 
     		 [bookmark: pgfId-1427456]Configuring the ASA for Cisco TrustSec Integration

 
     		 [bookmark: pgfId-1508343]Monitoring Cisco TrustSec

 
     		 [bookmark: pgfId-1394281]Feature History for the Cisco TrustSec Integration

 
    

 
   
 
    
     [bookmark: pgfId-1647138][bookmark: 46592]Information About the ASA Integrated with Cisco TrustSec

 
     [bookmark: pgfId-1125093]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1800897]Information about Cisco TrustSec

 
     		 [bookmark: pgfId-1800901]About SGT and SXP Support in Cisco TrustSec

 
     		 [bookmark: pgfId-1800905]Roles in the Cisco TrustSec Feature

 
     		 [bookmark: pgfId-1680882]Security Group Policy Enforcement

 
     		 [bookmark: pgfId-1564368]How the ASA Enforces Security Group-Based Policies

 
     		 [bookmark: pgfId-1804195]Effects of Changes to Security Groups on the ISE

 
     		 [bookmark: pgfId-1564372]About Speaker and Listener Roles on the ASA

 
     		 [bookmark: pgfId-1805882]SXP Chattiness

 
     		 [bookmark: pgfId-1812461]SXP Timers

 
     		 [bookmark: pgfId-1805903]IP-SGT Manager Database

 
     		 [bookmark: pgfId-1635478]Features of the ASA-Cisco TrustSec Integration

 
    

 
     
      [bookmark: pgfId-1526240][bookmark: 74207]Information about Cisco TrustSec

 
      [bookmark: pgfId-1677869]Traditionally, security features such as firewalls performed access control based on predefined IP addresses, subnets and protocols. However, with enterprises transitioning to borderless networks, both the technology used to connect people and organizations and the security requirements for protecting data and networks have evolved significantly. End points are becoming increasingly nomadic and users often employ a variety of end points (for example, laptop versus desktop, smart phone, or tablet), which means that a combination of user attributes plus end-point attributes provide the key characteristics (in addition to existing 6-tuple based rules), that enforcement devices such as switches and routers with firewall features or dedicated firewalls can reliably use for making access control decisions.

 
      [bookmark: pgfId-1677870]As a result, the availability and propagation of end point attributes or client identity attributes have become increasingly important requirements to enable security across the customers’ networks, at the access, distribution, and core layers of the network, and in the data center.

 
      [bookmark: pgfId-1677871]Cisco TrustSec provides access control that builds upon an existing identity-aware infrastructure to ensure data confidentiality between network devices and integrate security access services on one platform. In the Cisco TrustSec feature, enforcement devices use a combination of user attributes and end-point attributes to make role-based and identity-based access control decisions. The availability and propagation of this information enables security across networks at the access, distribution, and core layers of the network.

 
      [bookmark: pgfId-1677927]Implementing Cisco TrustSec into your environment has the following advantages:

 
      
      		 [bookmark: pgfId-1677998]Provides a growing mobile and complex workforce with appropriate and more secure access from any device

 
      		 [bookmark: pgfId-1677999]Lowers security risks by providing comprehensive visibility of who and what is connecting to the wired or wireless network 

 
      		 [bookmark: pgfId-1678000]Offers exceptional control over activity of network users accessing physical or cloud-based IT resources 

 
      		 [bookmark: pgfId-1678001]Reduces total cost of ownership through centralized, highly secure access policy management and scalable enforcement mechanisms 

 
     

 
      [bookmark: pgfId-1678021]For more information about Cisco TrustSec, see  http://www.cisco.com/go/trustsec .

 
    
 
     
      [bookmark: pgfId-1633880][bookmark: 19282]About SGT and SXP Support in Cisco TrustSec

 
      [bookmark: pgfId-1635615]In the Cisco TrustSec feature, security group access transforms a topology-aware network into a role-based network, which enables end-to-end policies enforced on the basis of role-based access-control (RBACL). Device and user credentials acquired during authentication are used to classify packets by security groups. Every packet entering the Cisco TrustSec cloud is tagged with an security group tag (SGT). The tagging helps trusted intermediaries identify the source identity of the packet and enforce security policies along the data path. An SGT can indicate a privilege level across the domain when the SGT is used to define a security group ACL.

 
      [bookmark: pgfId-1645181]An SGT is assigned to a device through IEEE 802.1X authentication, web authentication, or MAC authentication bypass (MAB), which occurs with a RADIUS vendor-specific attribute. An SGT can be assigned statically to a particular IP address or to a switch interface. An SGT is passed along dynamically to a switch or access point after successful authentication. 

 
      [bookmark: pgfId-1678185]The Security-group eXchange Protocol (SXP) is a protocol developed for Cisco TrustSec to propagate the IP-to-SGT mapping database across network devices that do not have SGT-capable hardware support to hardware that supports SGTs and security group ACLs. SXP, a control plane protocol, passes IP-SGT mapping from authentication points (such as legacy access layer switches) to upstream devices in the network.

 
      [bookmark: pgfId-1651966]The SXP connections are point-to-point and use TCP as the underlying transport protocol. SXP uses the well-known TCP port number 64999 to initiate a connection. Additionally, an SXP connection is uniquely identified by the source and destination IP addresses. 

 
    
 
     
      [bookmark: pgfId-1633641][bookmark: 83424]Roles in the Cisco TrustSec Feature

 
      [bookmark: pgfId-1633642]To provide identity and policy-based access enforcement, the Cisco TrustSec feature includes the following roles: 

 
      
      		 [bookmark: pgfId-1633643]Access Requestor (AR)—Access requestors are end point devices that request access to protected resources in the network. They are primary subjects of the architecture and their access privilege depends on their Identity credentials. 

 
     

 
      [bookmark: pgfId-1679874]Access requestors include end-point devices such PCs, laptops, mobile phones, printers, cameras, and MACsec-capable IP phones.

 
      
      		 [bookmark: pgfId-1633209]Policy Decision Point (PDP)—A policy decision point is responsible for making access control decisions. The PDP provides features such as 802.1x, MAB, and web authentication. The PDP supports authorization and enforcement through VLAN, DACL, and security group access (SGACL/SXP/SGT).

 
     

 
      [bookmark: pgfId-1679880]In the Cisco TrustSec feature, the Cisco Identity Services Engine (ISE) acts as the PDP. The Cisco ISE provides identity and access control policy functionality. 

 
      
      		 [bookmark: pgfId-1633210]Policy Information Point (PIP)—A policy information point is a source that provides external information (for example, reputation, location, and LDAP attributes) to policy decision points.

 
     

 
      [bookmark: pgfId-1679889]Policy information points include devices such as Session Directory, Sensor IPS, and Communication Manager.

 
      
      		 [bookmark: pgfId-1633211]Policy Administration Point (PAP)—A policy administration point defines and inserts policies into the authorization system. The PAP acts as an identity repository by providing Cisco TrustSec tag-to-user identity mapping and Cisco TrustSec tag-to-server resource mapping.

 
     

 
      [bookmark: pgfId-1679898]In the Cisco TrustSec feature, the Cisco Secure Access Control System (a policy server with integrated 802.1x and SGT support) acts as the PAP.

 
      
      		 [bookmark: pgfId-1633212]Policy Enforcement Point (PEP)—A policy enforcement point is the entity that carries out the decisions (policy rules and actions) made by the PDP for each AR. PEP devices learn identity information through the primary communication path that exists across networks. PEP devices learn the identity attributes of each AR from many sources, such as end point agents, authorization servers, peer enforcement devices, and network flows. In turn, PEP devices use SXP to propagate IP-SGT mapping to mutually trusted peer devices across the network.

 
     

 
      [bookmark: pgfId-1679907]Policy enforcement points include network devices such as Catalyst switches, routers, firewalls (specifically the ASA), servers, VPN devices, and SAN devices.

 
      [bookmark: pgfId-1633219]The ASA serves the PEP role in the identity architecture. Using SXP, the ASA learns identity information directly from authentication points and uses it to enforce identity-based policies.

 
    
 
     
      [bookmark: pgfId-1634847][bookmark: 31414]Security Group Policy Enforcement 

 
      [bookmark: pgfId-1634848]Security policy enforcement is based on security group name. An end-point device attempts to access a resource in the data center. Compared to traditional IP-based policies configured on firewalls, identity-based policies are configured based on user and device identities. For example, mktg-contractor is allowed to access mktg-servers; mktg-corp-users are allowed to access mktg-server and corp-servers.

 
      [bookmark: pgfId-1634849]The benefits of this type of deployment include:

 
      
      		 [bookmark: pgfId-1634850]User group and resource are defined and enforced using single object (SGT) simplified policy management.

 
      		 [bookmark: pgfId-1681142]User identity and resource identity are retained throughout the Cisco TrustSec-capable switch infrastructure.

 
     

 
      [bookmark: pgfId-1799326]Figure 39-1 show a deployment for security group name-based policy enforcement.

 
      [bookmark: pgfId-1681146]Figure 39-1 [bookmark: 65570]Security Group Name-Based Policy Enforcement Deployment

 
      [bookmark: pgfId-1710535] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1634859]Implementing Cisco TrustSec allows you to configure security policies that support server segmentation and includes the following features: 

 
      
      		 [bookmark: pgfId-1634860]A pool of servers can be assigned an SGT for simplified policy management.

 
      		 [bookmark: pgfId-1634861]The SGT information is retained within the infrastructure of Cisco Trustsec-capable switches.

 
      		 [bookmark: pgfId-1634865]The ASA can use the IP-SGT mapping for policy enforcement across the Cisco TrustSec domain.

 
      		 [bookmark: pgfId-1634866]Deployment simplification is possible because 802.1x authorization for servers is mandatory.

 
     

 
    
 
     
      [bookmark: pgfId-1633443][bookmark: 60894]How the ASA Enforces Security Group-Based Policies 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1640873]Note User-based security policies and security-group based policies can coexist on the ASA. Any combination of network, user-based, and security-group based attributes can be configured in an security policy. See Chapter 38, “Configuring the Identity Firewall” for information about configuring user-based security policies.


      
      
 
     

     

 
      [bookmark: pgfId-1646933]To configure the ASA to function with Cisco TrustSec, you must import a Protected Access Credential (PAC) file from the ISE. For more information, see the “Importing a Protected Access Credential (PAC) File” section. 

 
      [bookmark: pgfId-1647509]Importing the PAC file to the ASA establishes a secure communication channel with the ISE. After the channel is established, the ASA initiates a PAC secure RADIUS transaction with the ISE and downloads Cisco TrustSec environment data (that is, the security group table). The security group table maps SGTs to security group names. Security group names are created on the ISE and provide user-friendly names for security groups. 

 
      [bookmark: pgfId-1648439]The first time that the ASA downloads the security group table, it walks through all entries in the table and resolves all the security group names included in security policies that have been configured on it; then the ASA activates those security policies locally. If the ASA cannot resolve a security group name, it generates a syslog message for the unknown security group name. 

 
      [bookmark: pgfId-1643441]Figure 39-2 shows how a security policy is enforced in Cisco TrustSec.

 
      [bookmark: pgfId-1643208]Figure 39-2 [bookmark: 24655]Security Policy Enforcement

 
      [bookmark: pgfId-1712133] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1673690] 1.[image: ] An end point device connects to an access layer device directly or via remote access and authenticates with Cisco TrustSec.

 
      [bookmark: pgfId-1643212] 2.[image: ] The access layer device authenticates the end-point device with the ISE by using authentication methods such as 802.1X or web authentication. The end-point device passes role and group membership information to classify the device into the appropriate security group.

 
      [bookmark: pgfId-1643213] 3.[image: ] The access layer device uses SXP to propagate the IP-SGT mapping to the upstream devices. 

 
      [bookmark: pgfId-1649640] 4.[image: ] The ASA receives the packet and looks up the SGTs for the source and destination IP addresses using the IP-SGT mapping passed by SXP. 

 
      [bookmark: pgfId-1651821]If the mapping is new, the ASA records it in its local IP-SGT Manager database. The IP-SGT Manager database, which runs in the control plane, tracks IP-SGT mapping for each IPv4 or IPv6 address. The database records the source from which the mapping was learned. The peer IP address of the SXP connection is used as the source of the mapping. Multiple sources can exist for each IP-SGT mapped entry.

 
      [bookmark: pgfId-1651908]If the ASA is configured as a Speaker, the ASA transmits all IP-SGT mapping entries to its SXP peers. For more information, see the “About Speaker and Listener Roles on the ASA” section. 

 
      [bookmark: pgfId-1656598] 5.[image: ] If a security policy is configured on the ASA with that SGT or security group name, the ASA enforces the policy. (You can create security policies on the ASA that include SGTs or security group names. To enforce policies based on security group names, the ASA needs the security group table to map security group names to SGTs.)

 
      [bookmark: pgfId-1800414]If the ASA cannot find a security group name in the security group table and it is included in a security policy, the ASA considers the security group name to be unknown and generates a syslog message. After the ASA refreshes the security group table from the ISE and learns the security group name, the ASA generates a syslog message indicating that the security group name is known.

 
    
 
     
      [bookmark: pgfId-1804206][bookmark: 48022]Effects of Changes to Security Groups on the ISE

 
      [bookmark: pgfId-1804210]The ASA periodically refreshes the security group table by downloading an updated table from the ISE. Security groups can change on the ISE between downloads. These changes are not reflected on the ASA until it refreshes the security group table. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1804214]Tip We recommend that you schedule policy configuration changes on the ISE during a maintenance window, then manually refresh the security group table on the ASA to make sure the security group changes have been incorporated. 


      
      
 
     

     

 
      [bookmark: pgfId-1804218]Handling policy configuration changes in this way maximizes the chances of security group name resolution and immediate activation of security policies.

 
      [bookmark: pgfId-1804219]The security group table is automatically refreshed when the environment data timer expires. You can also trigger a security group table refresh on demand. 

 
      [bookmark: pgfId-1804947]If a security group changes on the ISE, the following events occur when the ASA refreshes the security group table:

 
      
      		 [bookmark: pgfId-1804223]Only security group policies that have been configured using security group names need to be resolved with the security group table.Policies that include security group tags are always active.

 
      		 [bookmark: pgfId-1804950]When the security group table is available for the first time, all policies with security group names are walked through, security group names are resolved, and policies are activated. All policies with tags are walked through, and syslogs are generated for unknown tags.

 
      		 [bookmark: pgfId-1806085]If the security group table has expired, policies continue to be enforced according to the most recently downloaded security group table until you clear it, or a new table becomes available. 

 
      		 [bookmark: pgfId-1806086]When a resolved security group name becomes unknown on the ASA, it deactivates the security policy; however, the security policy persists in the ASA running configuration.

 
      		 [bookmark: pgfId-1806087]If an existing secuity group is deleted on the PAP, a previously known security group tag can become unknown, but no change in policy status occurs on the ASA. A previously known security group name can become unresolved, and the policy is then inactivated. If the security group name is reused, the policy is recompiled using the new tag.

 
      		 [bookmark: pgfId-1804226]If a new security group is added on the PAP, a previously unknown security group tag can become known, a syslog message is generated, but no change in policy status occurs. A previously unknown security group name can become resolved, and associated policies are then activated.

 
      		 [bookmark: pgfId-1804227]If a tag has been renamed on the PAP, policies that were configured using tags display the new name, and no change in policy status occurs. Policies that were configured with security group names are recompiled using the new tag value.

 
     

 
    
 
     
      [bookmark: pgfId-1643577][bookmark: 57470][bookmark: 73045]About Speaker and Listener Roles on the ASA

 
      [bookmark: pgfId-1667081]The ASA supports SXP to send and receive IP-SGT mapping entries to and from other network devices. Using SXP allows security devices and firewalls to learn identity information from access switches without the need for hardware upgrades or changes. SXP can also be used to pass IP-SGT mapping entries from upstream devices (such as datacenter devices) back to downstream devices. The ASA can receive information from both upstream and downstream directions.

 
      [bookmark: pgfId-1667076]When configuring an SXP connection on the ASA to an SXP peer, you must designate the ASA as a Speaker or a Listener for that connection so that it can exchange Identity information:

 
      
      		 [bookmark: pgfId-1643591]Speaker mode—Configures the ASA so that it can forward all active IP-SGT mapping entries collected on the ASA to upstream devices for policy enforcement.

 
      		 [bookmark: pgfId-1643598]Listener mode—Configures the ASA so that it can receive IP-SGT mapping entries from downstream devices (SGT-capable switches) and use that information to create policy definitions.

 
     

 
      [bookmark: pgfId-1667166]If one end of an SXP connection is configured as a Speaker, then the other end must be configured as a Listener, and vice versa. If both devices on each end of an SXP connection are configured with the same role (either both as Speakers or both as Listeners), the SXP connection fails and the ASA generates a syslog message.

 
      [bookmark: pgfId-1804959]Multiple SXP connections can learn IP-SGT mapping entries that have been downloaded from the IP-SGT mapping database. After an SXP connection to an SXP peer is established on the ASA, the Listener downloads the entire IP-SGT mapping database from the Speaker. All changes that occur after this are sent only when a new device appears on the network. As a result, the rate of SXP information flow is proportional to the rate at which end hosts authenticate to the network. 

 
      [bookmark: pgfId-1804232]IP-SGT mapping entries that have been learned through SXP connections are maintained in the SXP IP-SGT mapping database. The same mapping entries may be learned through different SXP connections. The mapping database maintains one copy for each mapping entry learned. Multiple mapping entries of the same IP-SGT mapping value are identified by the peer IP address of the connection from which the mapping was learned. SXP requests that the IP-SGT Manager add a mapping entry when a new mapping is learned the first time and remove a mapping entry when the last copy in the SXP database is removed.

 
      [bookmark: pgfId-1804233]Whenever an SXP connection is configured as a Speaker, SXP requests that the IP-SGT Manager forward all the mapping entries collected on the device to the peer. When a new mapping is learned locally, the IP-SGT Manager requests that SXP forward it through connections that are configured as Speakers.

 
      [bookmark: pgfId-1643613]Configuring the ASA to be both a Speaker and a Listener for an SXP connection can cause SXP looping, which means that SXP data can be received by an SXP peer that originally transmitted it. 

 
    
 
     
      [bookmark: pgfId-1812390][bookmark: 41343]SXP Chattiness 

 
      [bookmark: pgfId-1812445]The rate of SXP information flow is proportional to the rate at which end hosts authenticate into the network. After an SXP peering is established, the listener device downloads the entire IP-SGT database from the speaker device. After that, all changes are sent incrementally only when a new device appears on the network or leaves the network. Also, note that only access devices that are attached to the new device initiate this incremental update to the upstream device.

 
      [bookmark: pgfId-1812398]In other words, SXP protocol is no chattier than the authentication rate, which is limited to the capability of the authentication server. Therefore, SXP chattiness is not a major concern. 

 
    
 
     
      [bookmark: pgfId-1812400][bookmark: 45564]SXP Timers

 
      
      		 [bookmark: pgfId-1805226]Retry Open Timer—The retry open timer is triggered if one SXP connection on the device is not up. After the retry open timer expires, the device goes through the entire connection database and if any connection is in the off or “pending on” state, the retry open timer restarts. The default timer value is 120 seconds. A zero value means the retry timer does not start. The retry open timer continues until all the SXP connections are set up, or the retry open timer has been configured to be 0.

 
      		 [bookmark: pgfId-1805231]Delete Hold-Down Timer—The connection-specific delete hold-down timer is triggered when a connection on the Listener is torn down. The mapping entries that have been learned are not deleted immediately, but are held until the delete hold-down timer expires. The mapping entries are deleted after this timer expires. The delete hold-down timer value is set to 120 seconds and is not configurable.

 
      		 [bookmark: pgfId-1805235]Reconciliation Timer—If an SXP connection is brought up within the delete hold-down timer period, a bulk update is performed on this connection. This means that the most recent mapping entries are learned and are associated with a new connection instantiation identifier. A periodic, connection-specific reconciliation timer starts in the background. When this reconciliation timer expires, it scans the entire SXP mapping database and identifies all mapping entries that have not been learned in the current connection session (that is, mapping entries with an unmatched connection instantiation identifier), and marks them for deletion. These entries are deleted in the subsequent reconciliation review. The default reconciliation timer value is 120 seconds. A zero value is not allowed on the ASA to prevent obsolete entries from staying for an unspecified length of time and causing unexpected results in policy enforcement.

 
      		 [bookmark: pgfId-1805240]HA Reconciliation Timer—When HA is enabled, the SXP mapping database of the active and standby units are in sync. The new active unit tries to establish new SXP connections to all its peers and acquires the latest mapping entries. An HA reconciliation timer provides a way of identifying and removing old mapping entries. It starts after a failover occurs, which gives the ASA time to acquire the latest mapping entries. After the HA reconciliation timer expires, the ASA scans the entire SXP mapping database and identifies all the mapping entries have not been learned in the current connection session. Mapping entries with unmatched instantiation identifiers are marked for deletion. This reconciliation mechanism is the same as that of the reconciliation timer. The time value is the same as the reconciliation timer and is configurable.

 
     

 
      [bookmark: pgfId-1805224]After an SXP peer terminates its SXP connection, the ASA starts a delete hold-down timer. Only SXP peers designated as Listeners can terminate a connection. If an SXP peer connects while the delete hold-down timer is running, the ASA starts the reconciliation timer; then the ASA updates the IP-SGT mapping database to learn the most recent mapping. 

 
    
 
     
      [bookmark: pgfId-1804244][bookmark: 71076]IP-SGT Manager Database

 
      [bookmark: pgfId-1805669]The IP-SGT Manager database does not synchronize any entries from the active unit to the standby unit. Each source from which the IP-SGT Manager database receives IP-SGT mapping entries synchronizes its database from the active unit to the standby unit, then provides the final IP-SGT mapping to the IP-SGT Manager on the standby unit.

 
      [bookmark: pgfId-1805670]For Version 9.0(1), the IP-SGT Manager database receives IP-SGT mapping updates from the SXP source only. 

 
    
 
     
      [bookmark: pgfId-1527720][bookmark: 74558]Features of the ASA-Cisco TrustSec Integration

 
      [bookmark: pgfId-1555568]The ASA includes Cisco TrustSec as part of its identity-based firewall feature. Cisco TrustSec provides the following capabilities:

 
      [bookmark: pgfId-1535446]Flexibility

 
      
      		 [bookmark: pgfId-1553491]The ASA can be configured as an SXP Speaker or Listener, or both.

 
     

 
      [bookmark: pgfId-1652334]See the “About Speaker and Listener Roles on the ASA” section. 

 
      
      		 [bookmark: pgfId-1561122]The ASA supports SXP for IPv6 and IPv6-capable network devices. 

 
      		 [bookmark: pgfId-1808649]SXP can change mapping entries for IPv4 and IPv6 addresses.

 
      		 [bookmark: pgfId-1808650]SXP end points support IPv4 and IPv6 addresses.

 
      		 [bookmark: pgfId-1808654]The ASA supports SXP Version 2 only.

 
      		 [bookmark: pgfId-1557991]The ASA negotiates SXP versions with different SXP-capable network devices. SXP version negotiation eliminates the need for static configuration of versions. 

 
      		 [bookmark: pgfId-1667368]You can configure the ASA to refresh the security group table when the SXP reconcile timer expires and you can download the security group table on demand. When the security group table on the ASA is updated from the ISE, changes are reflected in the appropriate security policies.

 
      		 [bookmark: pgfId-1558157]The ASA supports security policies based on security group names in the source or destination fields, or both. You can configure security policies on the ASA based on combinations of security groups, IP address, Active Directory group/user name, and FQDN.

 
     

 
      [bookmark: pgfId-1562160]Availability

 
      
      		 [bookmark: pgfId-1536787]You can configure security group-based policies on the ASA in both the Active/Active and Active/Standby configurations.

 
      		 [bookmark: pgfId-1558524]The ASA can communicate with the ISE configured for high availability (HA). 

 
      		 [bookmark: pgfId-1806186]You can configure multiple ISE servers on the ASA and if the first server is unreachable, it continues to the next server, and so on. However, if the server list is downloaded as part of the Cisco TrsutSec environment data, it is ignored.

 
      		 [bookmark: pgfId-1556717]If the PAC file downloaded from the ISE expires on the ASA and it cannot download an updated security group table, the ASA continues to enforce security policies based on the last downloaded security group table until the ASA downloads an updated table.

 
     

 
      [bookmark: pgfId-1806262]Clustering

 
      
      		 [bookmark: pgfId-1806292]For Layer 2 networks, all units share the same IP address. When you change the interface address, the changed configuration is sent to all other units. When the IP address is updated from the interface of a particular unit, a notification is sent to update the IP-SGT local database on this unit. 

 
      		 [bookmark: pgfId-1806293]For Layer 3 networks, a pool of addresses is configured for each interface on the master unit, and this configuration is synchronized to the slave units. On the master unit, a notification of the IP addresses that have been assigned to the interface is sent, and the IP-SGT local database is updated. The IP-SGT local database on each slave unit can be updated with the IP address information for the master unit by using the address pool configuration that has been synchronized to it, where the first address in the pool for each interface always belongs to the master unit.

 
     

 
      [bookmark: pgfId-1806294]When a slave unit boots, it notifies the master unit. Then the master unit goes through the address pool on each interface and computes the IP address for the new slave unit that sent it the notification, and updates the IP-SGT local database on the master unit. The master unit also notifies the other slave units about the new slave unit. As part of this notification processing, each slave unit computes the IP address for the new slave unit and adds this entry to the IP-SGT local database on each slave unit. All the slave units have the address pool configuration to determine the IP address value. For each interface, the value is determined as follows:

 
      [bookmark: pgfId-1806296]Master IP + (M-N), where:

 
      [bookmark: pgfId-1806297]M—Maximum number of units (up to 8 are allowed)

 
      [bookmark: pgfId-1806298]N—Slave unit number that sent the notification

 
      [bookmark: pgfId-1806300]When the IP address pool changes on any interface, the IP addresses for all the slave units and the master unit need to be recalculated and updated in the IP-SGT local database on the master unit, as well as on every other slave unit. The old IP address needs to be deleted, and the new IP address needs to be added.

 
      [bookmark: pgfId-1806301]When this changed address pool configuration is synchronized to the slave unit, as a part of configuration change processing, each slave unit recomputes the IP address for the master unit and for every other slave unit whose IP address has changed, then removes the entry for the old IP address and adds the new IP address.

 
      [bookmark: pgfId-1535451]Scalability

 
      [bookmark: pgfId-1554444] Table 39-1  show the number of IP-SGT mapping entries that the ASA supports.

 
      [bookmark: pgfId-1555015] 

 
      
       
        
         [bookmark: pgfId-1554961]Table 39-1 [bookmark: 76604]Capacity Numbers for IP-SGT Mapping Entries

 
        
       
         
         		
           
           [bookmark: pgfId-1554968]ASA Model
          
  
         		
           
           [bookmark: pgfId-1554970]Number of IP-SGT Mapping Entries
          
  
        

 
         
         		 [bookmark: pgfId-1554972]5505

  
         		 [bookmark: pgfId-1554974]250

  
        

 
         
         		 [bookmark: pgfId-1554976]5510

  
         		 [bookmark: pgfId-1554978]1000

  
        

 
         
         		 [bookmark: pgfId-1554980]5520

  
         		 [bookmark: pgfId-1554982]2500 

  
        

 
         
         		 [bookmark: pgfId-1554984]5540

  
         		 [bookmark: pgfId-1554986]5000

  
        

 
         
         		 [bookmark: pgfId-1554988]5550

  
         		 [bookmark: pgfId-1554990]7500

  
        

 
         
         		 [bookmark: pgfId-1554992]5580-20

  
         		 [bookmark: pgfId-1554994]10,000

  
        

 
         
         		 [bookmark: pgfId-1554996]5580-40

  
         		 [bookmark: pgfId-1554998]20,000

  
        

 
         
         		 [bookmark: pgfId-1572951]5585-X with SSP-10

  
         		 [bookmark: pgfId-1555002]18,750

  
        

 
         
         		 [bookmark: pgfId-1583486]5585-X with SSP-20

  
         		 [bookmark: pgfId-1555006]25,000

  
        

 
         
         		 [bookmark: pgfId-1583507]5585-X with SSP-40

  
         		 [bookmark: pgfId-1555010]50,000

  
        

 
         
         		 [bookmark: pgfId-1583519]5585-X with SSP-60

  
         		 [bookmark: pgfId-1555014]100,000

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1573730] Table 39-2  shows the number of SXP connections that the ASA supports.

 
      [bookmark: pgfId-1554741] 

 
      
       
        
         [bookmark: pgfId-1554687]Table 39-2 [bookmark: 17355]SXP Connections 

 
        
       
         
         		
           
           [bookmark: pgfId-1554694]ASA Model
          
  
         		
           
           [bookmark: pgfId-1554696]Number of SXP TCP Connections
          
  
        

 
         
         		 [bookmark: pgfId-1554698]5505

  
         		 [bookmark: pgfId-1554700]10

  
        

 
         
         		 [bookmark: pgfId-1554702]5510

  
         		 [bookmark: pgfId-1554704]25

  
        

 
         
         		 [bookmark: pgfId-1554706]5520

  
         		 [bookmark: pgfId-1554708]50

  
        

 
         
         		 [bookmark: pgfId-1554710]5540

  
         		 [bookmark: pgfId-1554712]100

  
        

 
         
         		 [bookmark: pgfId-1554714]5550

  
         		 [bookmark: pgfId-1554716]150

  
        

 
         
         		 [bookmark: pgfId-1554718]5580-20

  
         		 [bookmark: pgfId-1554720]250

  
        

 
         
         		 [bookmark: pgfId-1554722]5580-40

  
         		 [bookmark: pgfId-1554724]500

  
        

 
         
         		 [bookmark: pgfId-1583543]5585-X with SSP-10

  
         		 [bookmark: pgfId-1554728]150

  
        

 
         
         		 [bookmark: pgfId-1583545]5585-X with SSP-20

  
         		 [bookmark: pgfId-1554732]250

  
        

 
         
         		 [bookmark: pgfId-1583547]5585-X with SSP-40

  
         		 [bookmark: pgfId-1554736]500

  
        

 
         
         		 [bookmark: pgfId-1583549]5585-X with SSP-60

  
         		 [bookmark: pgfId-1554740]1000

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1516214][bookmark: 99650]Licensing Requirements for Cisco TrustSec

 
     [bookmark: pgfId-1825530] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1825523]Model
         
  
        		
          
          [bookmark: pgfId-1825525]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1825527]All models

  
        		 [bookmark: pgfId-1825529]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1712437][bookmark: 16588]Prerequisites for Using Cisco TrustSec

 
     [bookmark: pgfId-1658791]Before configuring the ASA to use Cisco TrustSec, you must perform the following tasks:

 
     
     		 [bookmark: pgfId-1656725]Registering the ASA with the ISE 

 
     		 [bookmark: pgfId-1807772]Creating a Security Group on the ISE

 
     		 [bookmark: pgfId-1807776]Generating the PAC File

 
    

 
     
      [bookmark: pgfId-1807781][bookmark: 64360]Registering the ASA with the ISE

 
      [bookmark: pgfId-1615186]The ASA must be configured as a recognized Cisco TrustSec network device in the ISE before the ASA can successfully import a PAC file. To register the ASA with the ISE, perform the following steps:

 
      [bookmark: pgfId-1657538] 1.[image: ] Log into the ISE. 

 
      [bookmark: pgfId-1657882] 2.[image: ] Choose  Administration >  Network Devices  >  Network Devices . 

 
      [bookmark: pgfId-1657913] 3.[image: ] Click  Add . 

 
      [bookmark: pgfId-1807726] 4.[image: ] Enter the IP address of the ASA. 

 
      [bookmark: pgfId-1807727] 5.[image: ] When the ISE is being used for user authentication, enter a shared secret in the Authentication Settings area. 

 
      [bookmark: pgfId-1682926]When you configure the AAA sever on the ASA, provide the shared secret that you create here on the ISE. The AAA server on the ASA uses this shared secret to communicate with the ISE. 

 
      [bookmark: pgfId-1682930] 6.[image: ] Specify a device name, device ID, password, and a download interval for the ASA. See the ISE documentation for how to perform these tasks.

 
    
 
     
      [bookmark: pgfId-1682932][bookmark: 91378]Creating a Security Group on the ISE

 
      [bookmark: pgfId-1658298]When configuring the ASA to communicate with the ISE, you specify a AAA server. When configuring the AAA server on the ASA, you must specify a server group. The security group must be configured to use the RADIUS protocol. To create a security group on the ISE, perform the following steps:

 
      [bookmark: pgfId-1658118] 1.[image: ] Log into the ISE. 

 
      [bookmark: pgfId-1654835] 2.[image: ] Choose  Policy >  Policy Elements >  Results >  Security Group Access >  Security Group .

 
      [bookmark: pgfId-1654837] 3.[image: ] Add a security group for the ASA. (Security groups are global and not ASA specific.) 

 
      [bookmark: pgfId-1658605]The ISE creates an entry under Security Groups with a tag. 

 
      [bookmark: pgfId-1658496] 4.[image: ] Under the Security Group Access section, configure device ID credentials and a password for the ASA. 

 
    
 
     
      [bookmark: pgfId-1655433][bookmark: 50651]Generating the PAC File

 
      [bookmark: pgfId-1656871]Before generating the PAC file, you must have registered the ASA with the ISE. To generate the PAC file, perform the following steps:

 
      [bookmark: pgfId-1656900] 1.[image: ] Log into the ISE. 

 
      [bookmark: pgfId-1656920] 2.[image: ] Choose  Administration >  Network Resources  >  Network Devices . 

 
      [bookmark: pgfId-1656935] 3.[image: ] From the list of devices, choose the ASA. 

 
      [bookmark: pgfId-1656951] 4.[image: ] Under the Security Group Access (SGA), click  Generate PAC . 

 
      [bookmark: pgfId-1656959] 5.[image: ] To encrypt the PAC file, enter a password.

 
      [bookmark: pgfId-1657366]The password (or encryption key) that you enter to encrypt the PAC file is independent of the password that was configured on the ISE as part of the device credentials. 

 
      [bookmark: pgfId-1683010]The ISE generates the PAC file. The ASA can import the PAC file from flash or from a remote server via TFTP, FTP, HTTP, HTTPS, or SMB. (The PAC file does not have to reside on the ASA flash before you can import it.)

 
      [bookmark: pgfId-1807675]For information about the PAC file, see the “Importing a Protected Access Credential (PAC) File” section.

 
    
 
   
 
    
     [bookmark: pgfId-1217800][bookmark: 93713]Guidelines and Limitations

 
     [bookmark: pgfId-1217801]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1091226]Context Mode Guidelines

 
     [bookmark: pgfId-1091227]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1091229]Firewall Mode Guidelines

 
     [bookmark: pgfId-1091230]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1091234]IPv6 Guidelines

 
     [bookmark: pgfId-1100829]Supports IPv6 for SXP endpoints.

 
     [bookmark: pgfId-1578299]Clustering Guidelines

 
     [bookmark: pgfId-1578324]Supported on the master unit and on slave units in a clustering environment. 

 
     [bookmark: pgfId-1683953]Failover Guidelines

 
     [bookmark: pgfId-1683954]Supports a list of servers via configuration. If the first server is unreachable, the ASA tries to contact the second server in the list, and so on. However, the server list downloaded as part of the Cisco TrustSec environment data is ignored.

 
     [bookmark: pgfId-1807477]Supports both Active/Standby and Active/Active scenarios. All SXP data is replicated from the active unit to the standby unit after it takes over.

 
     [bookmark: pgfId-1543312]Additional Guidelines

 
     [bookmark: pgfId-1807637]Cisco TrustSec supports the Smart Call Home feature in single context and multi-context mode, but not in the system context.

 
     [bookmark: pgfId-1807610]Limitations

 
     
     		 [bookmark: pgfId-1616334]The ASA can only be configured to interoperate in a single Cisco TrustSec domain. 

 
     		 [bookmark: pgfId-1616317]The ASA does not support static configuration of SGT-name mapping on the device.

 
     		 [bookmark: pgfId-1543328]NAT is not supported in SXP messages.

 
     		 [bookmark: pgfId-1565764]SXP conveys IP-SGT mapping to enforcement points in the network. If an access layer switch belongs to a different NAT domain than the enforcing point, the IP-SGT map that it uploads is invalid, and an IP-SGT mapping database lookup on the enforcement device does not yield valid results. As a result, the ASA cannot apply security group-aware security policy on the enforcement device.

 
     		 [bookmark: pgfId-1778342]You can configure a default password for the ASA to use for SXP connections, or you can choose not to use a password; however, connection-specific passwords are not supported for SXP peers. The configured default SXP password should be consistent across the deployment network. If you configure a connection-specific password, connections may fail and a warning message appears. If you configure the connection with the default password, but it is not configured, the result is the same as when you have configured the connection with no password.

 
     		 [bookmark: pgfId-1543330]SXP connection loops can form when a device has bidirectional connections to a peer or is part of a unidirectionally connected chain of devices. (The ASA can learn IP-SGT mapping for resources from the access layer in the data center. The ASA might need to propagate these tags to downstream devices.) SXP connection loops can cause unexpected behavior of SXP message transport. In cases where the ASA is configured to be a Speaker and Listener, an SXP connection loop can occur, causing SXP data to be received by the peer that originally transmitted it.

 
     		 [bookmark: pgfId-1615837]When changing the ASA local IP address, you must ensure that all SXP peers have updated their peer list. In addition, if SXP peers changes its IP addresses, you must ensure those changes are reflected on the ASA.

 
     		 [bookmark: pgfId-1658909]Automatic PAC file provisioning is not supported. The ASA administrator must request the PAC file from the ISE administrative interface and import it into the ASA. For information about the PAC file, see the “Generating the PAC File” section and the “Importing a Protected Access Credential (PAC) File” section.

 
     		 [bookmark: pgfId-1616127]PAC files have expiration dates. You must import the updated PAC file before the current PAC file expires; otherwise, the ASA cannot retrieve environment data updates.

 
     		 [bookmark: pgfId-1616381]When a security group changes on the ISE (for example, it is renamed or deleted), the ASA does not change the status of any ASA security policies that contain an SGT or security group name associated with the changed security group; however, the ASA generates a syslog message to indicate that those security policies changed. 

 
    

 
     [bookmark: pgfId-1658966]See the “Refreshing Environment Data” section for information about manually updating the security group table on the ASA to include changes from the ISE. 

 
     
     		 [bookmark: pgfId-1617848]The multicast types are not supported in ISE 1.0. 

 
     		 [bookmark: pgfId-1684858]An SXP connection stays in the initializing state among two SXP peers interconnected by the ASA; as shown in the following example: 

 
    

 
     [bookmark: pgfId-1685477](SXP peer A) - - - - (ASA) - - - (SXP peer B)

 
     [bookmark: pgfId-1685467]Therefore, when configuring the ASA to integrate with Cisco TrustSec, you must enable the no-NAT, no-SEQ-RAND, and MD5-AUTHENTICATION TCP options on the ASA to configure SXP connections. Create a TCP state bypass policy for traffic destined to SXP port TCP 64999 among the SXP peers. Then apply the policy on the appropriate interfaces. 

 
     [bookmark: pgfId-1684878]For example, the following set of commands shows how to configure the ASA for a TCP state bypass policy:

 
    
     [bookmark: pgfId-1684011]access-list SXP-MD5-ACL extended permit tcp host peerA host peerB eq 64999
    

    
     [bookmark: pgfId-1684012]access-list SXP-MD5-ACL extended permit tcp host peerB host peerA eq 64999
    

    
     [bookmark: pgfId-1684285] 
    

    
     [bookmark: pgfId-1684014]tcp-map SXP-MD5-OPTION-ALLOW
    

    
     [bookmark: pgfId-1684015] tcp-options range 19 19 allow
    

    
     [bookmark: pgfId-1684299] 
    

    
     [bookmark: pgfId-1684017]class-map SXP-MD5-CLASSMAP
    

    
     [bookmark: pgfId-1684018] match access-list SXP-MD5-ACL
    

    
     [bookmark: pgfId-1684769] 
    

    
     [bookmark: pgfId-1684020]policy-map type inspect dns preset_dns_map
    

    
     [bookmark: pgfId-1684021] parameters
    

    
     [bookmark: pgfId-1684022] message-length maximum 512
    

    
     [bookmark: pgfId-1684023]policy-map global_policy
    

    
     [bookmark: pgfId-1684039]class SXP-MD5-CLASSMAP
    

    
     [bookmark: pgfId-1684040] set connection random-sequence-number disable
    

    
     [bookmark: pgfId-1684041] set connection advanced-options SXP-MD5-OPTION-ALLOW
    

    
     [bookmark: pgfId-1685292] set connection advanced-options tcp-state-bypass
    

    
     [bookmark: pgfId-1685141]service-policy global_policy global
    

    
     [bookmark: pgfId-1685131] 
    

   
 
    
     [bookmark: pgfId-1543424][bookmark: 98320]Configuring the ASA for Cisco TrustSec Integration

 
     [bookmark: pgfId-1543425]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1524211]Task Flow for Configuring the ASA to Integrate with Cisco TrustSec

 
     		 [bookmark: pgfId-1524038]Configuring the AAA Server for Cisco TrustSec Integration

 
     		 [bookmark: pgfId-1656311]Importing a Protected Access Credential (PAC) File

 
     		 [bookmark: pgfId-1532750]Configuring the Security Exchange Protocol (SXP)

 
     		 [bookmark: pgfId-1532758]Adding an SXP Connection Peer

 
     		 [bookmark: pgfId-1585643]Refreshing Environment Data

 
     		 [bookmark: pgfId-1733617]Configuring the Security Policy

 
    

 
     
      [bookmark: pgfId-1529634][bookmark: 95319]Task Flow for Configuring the ASA to Integrate with Cisco TrustSec

 
      [bookmark: pgfId-1530629]Prerequisite

 
      [bookmark: pgfId-1530664]Before configuring the ASA to integrate with Cisco TrustSec, you must complete the following tasks:

 
      
      		 [bookmark: pgfId-1659023]Register the ASA with the ISE.

 
      		 [bookmark: pgfId-1807797]Create a security group on the ISE.

 
      		 [bookmark: pgfId-1659031]Generate the PAC file on the ISE to import into the ASA.

 
     

 
      [bookmark: pgfId-1799871]See the “Prerequisites for Using Cisco TrustSec” section for more information.

 
      [bookmark: pgfId-1799875]To configure the ASA to integrate with Cisco TrustSec, perform the following tasks:

 
     
 
      [bookmark: pgfId-1799876] Step 1[image: ] Configure the AAA server.

 
      [bookmark: pgfId-1538980]See the “Configuring the AAA Server for Cisco TrustSec Integration” section.

 
      [bookmark: pgfId-1655595]Step 2[image: ] Import the PAC file from the ISE.

 
      [bookmark: pgfId-1655599]See the “Importing a Protected Access Credential (PAC) File” section.

 
      [bookmark: pgfId-1538895]Step 3[image: ] Enable and set the default values for SXP.

 
      [bookmark: pgfId-1539077]See the “Configuring the Security Exchange Protocol (SXP)” section.

 
      [bookmark: pgfId-1530714]Step 4[image: ] Add SXP connection peers for the Cisco TrustSec architecture.

 
      [bookmark: pgfId-1539099]See the “Adding an SXP Connection Peer” section.

 
      [bookmark: pgfId-1585664]Step 5[image: ] As necessary, refresh environment data for the ASA.

 
      [bookmark: pgfId-1585675]See the “Refreshing Environment Data” section.

 
      [bookmark: pgfId-1724689]Step 6[image: ] Configure the security policy.

 
      [bookmark: pgfId-1724693]See the “Configuring the Security Policy” section.

 
      [bookmark: pgfId-1724694]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1524816][bookmark: 38650]Configuring the AAA Server for Cisco TrustSec Integration

 
      [bookmark: pgfId-1585874]As part of configuring the ASA to integrate with Cisco TrustSec, you must configure the ASA so that it can communicate with the ISE.

 
      [bookmark: pgfId-1531250]Prerequisites

 
      
      		 [bookmark: pgfId-1565919]The referenced server group must be configured to use the RADIUS protocol. If you add a non-RADIUS server group to the ASA, the configuration fails.

 
      		 [bookmark: pgfId-1659268]If the ISE is also used for user authentication, obtain the shared secret that was entered on the ISE when you registered the ASA with the ISE. Contact your ISE administrator to obtain this information. 

 
     

 
      [bookmark: pgfId-1811932]To configure the ASA to communicate with the ISE for Cisco TrustSec integration, perform the following steps:

 
     
 
      [bookmark: pgfId-1811933] Step 1[image: ] In the main ASDM application window, choose  Configuration >  Firewall >  Identity By TrustSec . 

 
      [bookmark: pgfId-1811937]Step 2[image: ] To add a server group to the ASA, click  Manage in the Server Group Setup area, The Configure AAA Server Group dialog box appears.

 
      [bookmark: pgfId-1811938]Step 3[image: ] In the AAA Server Group field, enter the name of the security group created on the ISE for the ASA. 

 
      [bookmark: pgfId-1811939]The server group name you specify here must match the name of the security group created on the ISE for the ASA. If these two group names do not match, the ASA cannot communicate with the ISE. Contact your ISE administrator to obtain this information.

 
      [bookmark: pgfId-1811940]Step 4[image: ] In the Protocol drop-down list, select RADIUS. 

 
      [bookmark: pgfId-1811941]For information about completing the remaining fields in the AAA Server Group dialog box, see the “Configuring RADIUS Server Groups” section.

 
      [bookmark: pgfId-1811948]Step 5[image: ] Click  OK . The ASA adds the group to the list of AAA Server Groups.

 
      [bookmark: pgfId-1811949]Step 6[image: ] To add a server to a group, select the AAA sever group you just created and click  Add in the Servers in the Selected Group area (lower pane). The Add AAA Server dialog box appears.

 
      [bookmark: pgfId-1811950]Step 7[image: ] In the Interface Name field, select the network interface where the ISE server resides.

 
      [bookmark: pgfId-1811951]Step 8[image: ] In the Server Name or IP Address field, enter the IP address of the ISE server. 

 
      [bookmark: pgfId-1811954]For information about completing the remaining fields in the AAA Server dialog box, see the “Adding a RADIUS Server to a Group” section. 

 
      [bookmark: pgfId-1811959]Step 9[image: ] Click  OK . The ASA adds the ISE server to the list of AAA servers.

 
      [bookmark: pgfId-1811960]Step 10[image: ] Click  Apply to save the addition of the ISE server and server group for the integration with Cisco TrustSec.

 
      [bookmark: pgfId-1811961]The changes are saved to the running configuration.

 
      [bookmark: pgfId-1811962]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1655901][bookmark: 87689]Importing a Protected Access Credential (PAC) File 

 
      [bookmark: pgfId-1655905]Importing the PAC file to the ASA establishes the connection with the ISE. After the channel is established, the ASA initiates a secure RADIUS transaction with the ISE and downloads Cisco TrustSec environment data (that is, the security group table). The security group table maps SGTs to security group names. Security group names are created on the ISE and provide user-friendly names for security groups. 

 
      [bookmark: pgfId-1683131]More specifically, no channel is established before the RADIUS transaction. The ASA initiates a RADIUS transaction with the ISE using the PAC file for authentication. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1655912]Tip The PAC file includes a shared key that allows the ASA and ISE to secure the RADIUS transactions that occur between them. Given the sensitive nature of this key, it must be stored securely on the ASA. 


      
      
 
     

     

 
      [bookmark: pgfId-1655932]When you import the PAC file, the file is converted to ASCII HEX format and sent to the ASA in non-interactive mode. After successfully importing the file, the ASA downloads Cisco TrustSec environment data from the ISE without requiring the device password configured in the ISE.

 
      [bookmark: pgfId-1655948]Prerequisites

 
      
      		 [bookmark: pgfId-1683319]The ASA must be configured as a recognized Cisco TrustSec network device in the ISE before the ASA can generate a PAC file. The ASA can import any PAC file, but it only works on the ASA when the file was generated by a correctly configured ISE. See the “Registering the ASA with the ISE” section for more information. 

 
      		 [bookmark: pgfId-1655963]Obtain the password used to encrypt the PAC file when generating it on the ISE. 

 
     

 
      [bookmark: pgfId-1657356]The ASA requires this password to import and decrypt the PAC file. 

 
      
      		 [bookmark: pgfId-1683239]Access to the PAC file generated by the ISE. The ASA can import the PAC file from flash or from a remote server via TFTP, FTP, HTTP, HTTPS, or SMB. (The PAC file does not need to reside on the ASA flash before you can import it.)

 
      		 [bookmark: pgfId-1683240]The server group has been configured for the ASA.

 
     

 
      [bookmark: pgfId-1655964]Restrictions

 
      
      		 [bookmark: pgfId-1655971]When the ASA is part of an HA configuration, you must import the PAC file to the primary ASA device.

 
      		 [bookmark: pgfId-1655972]When the ASA is part of a clustering configuration, you must import the PAC file to the master device.

 
     

 
      [bookmark: pgfId-1811975]To import a PAC file, perform the following steps:

 
     
 
      [bookmark: pgfId-1811976] Step 1[image: ] In the main ASDM application window, choose  Configuration >  Firewall >  Identity By TrustSec . 

 
      [bookmark: pgfId-1811977]Step 2[image: ] Check the  Enable Security Exchange Protocol check box to enable SXP.

 
      [bookmark: pgfId-1811978]Step 3[image: ] In the Server Group Setup area, click  Import PAC . The Import PAC dialog box appears.

 
      [bookmark: pgfId-1811979]Step 4[image: ] In the Filename field, enter the path and filename for the PAC file by using one of the following formats:

 
      
      		 [bookmark: pgfId-1811980]disk0: Path and filename on disk0

 
      		 [bookmark: pgfId-1811981]disk1: Path and filename on disk1

 
      		 [bookmark: pgfId-1811982]flash: Path and filename on flash

 
     

 
      [bookmark: pgfId-1811983]Step 5[image: ] In the Password field, enter the password used to encrypt the PAC file. The password is independent of the password that was configured on the ISE as part of the device credentials.

 
      [bookmark: pgfId-1811984]Step 6[image: ] In the Confirm Password field, reenter the password to confirm it.

 
      [bookmark: pgfId-1811985]Step 7[image: ] Click  Import .

 
      [bookmark: pgfId-1811986]Step 8[image: ] Click  Apply to save the changes.

 
      [bookmark: pgfId-1811987]The changes are saved to the running configuration.

 
      [bookmark: pgfId-1811988]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1623325][bookmark: 33326]Configuring the Security Exchange Protocol (SXP)

 
      [bookmark: pgfId-1545373]Configuring the Security Exchange Protocol (SXP) involves enabling the protocol in the ASA and setting the following default values for SXP:

 
      
      		 [bookmark: pgfId-1576033]The source IP address of SXP connections

 
      		 [bookmark: pgfId-1533448]The authentication password between SXP peers

 
      		 [bookmark: pgfId-1661060]The retry interval for SXP connections

 
      		 [bookmark: pgfId-1661061]The Cisco TrustSec SXP reconcile period

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1816784]Note For SXP to be operational on the ASA, at least one interface must be in the UP/UP state. 

Currently, when SXP is enabled with all interfaces down, the ASA does not display a message indicating that SXP is not working or it could not be enabled. If you check the configuration by entering the show running-config command, the command output displays the following message: 
“WARNING: SXP configuration in process, please wait for a few moments and try again.” 

This message is generic and does not specify the reason why SXP is not working.


      
      
 
     

     

 
      [bookmark: pgfId-1811996]To configure the default settings for the ASA integration with Cisco TrustSec, perform the following steps:

 
     
 
      [bookmark: pgfId-1811997] Step 1[image: ] In the main ASDM application window, choose  Configuration >  Firewall >  Identity By TrustSec . 

 
      [bookmark: pgfId-1811998]Step 2[image: ] Check the  Enable Security Exchange Protocol check box to enable SXP. By default, SXP is disabled.

 
      [bookmark: pgfId-1811999]In multi-context mode, you enable SXP in the user context.

 
      [bookmark: pgfId-1812000]Step 3[image: ] In the Default Source field, enter the default local IP address for SXP connections. The IP address can be an IPv4 or IPv6 address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1812001]Note The ASA determines the local IP address for an SXP connection as the outgoing interface IP address that is reachable by the peer IP address. If the configured local address is different from the outgoing interface IP address, the ASA cannot connect to the SXP peer and generates a syslog message. 


      
      
 
     

     

 
      [bookmark: pgfId-1812002]Step 4[image: ] In the Default Password field, enter the default password for TCP MD5 authentication with SXP peers. By default, SXP connections do not have a password set.

 
      [bookmark: pgfId-1812003]You can specify the password as an encrypted string up to 162 characters or an ASCII key string up to 80 characters. Configuring an encryption level for the password is optional. If you configure an encryption level, you can only set one level:

 
      
      		 [bookmark: pgfId-1812004]Level 0—unencrypted cleartext

 
      		 [bookmark: pgfId-1812005]Level 8—encrypted text

 
     

 
      [bookmark: pgfId-1812009]Step 5[image: ] In the Retry Timer field, enter the default time interval between ASA attempts to set up new SXP connections between SXP peers.

 
      [bookmark: pgfId-1812013]The ASA continues to try to connect to new SXP peers until a successful connection is made. The retry timer is triggered as long as there is one SXP connection on the ASA that is not up.

 
      [bookmark: pgfId-1812017]Enter the retry timer value as a number in the range of 0 to 64000 seconds. If you specify 0 seconds, the timer never expires and the ASA does not try to connect to SXP peers. By default, the timer value  is 120 seconds.

 
      [bookmark: pgfId-1812024]When the retry timer expires, the ASA goes through the connection database and if the database contains any connections that are off or in a “pending on” state, the ASA restarts the retry timer.

 
      [bookmark: pgfId-1812028]Step 6[image: ] In the Reconcile Timer field, enter the default reconcile timer value.

 
      [bookmark: pgfId-1812032]After an SXP peer terminates its SXP connection, the ASA starts a hold-down timer. If an SXP peer connects while the hold-down timer is running, the ASA starts the reconcile timer; then the ASA updates the SXP mapping database  to learn the latest mapping.

 
      [bookmark: pgfId-1812042]When the reconcile timer expires, the ASA scans the SXP mapping database to identify stale mapping entries (entries that were learned in a previous connection session). The ASA marks these connections as obsolete. When the reconcile timer expires, the ASA removes the obsolete entries from the SXP mapping database.

 
      [bookmark: pgfId-1812049]Enter the reconcile timer value as a number in the range of 1 to 64000 seconds. By default, the timer value  is 120 seconds.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1812050]Note You cannot specify 0 seconds for the timer, because this value would prevent the reconcile timer from starting. Not allowing the reconcile timer to run would keep stale entries for an undefined period and cause unexpected results from policy enforcement.


      
      
 
     

     

 
      [bookmark: pgfId-1812051]Step 7[image: ] Click  Apply to save the default settings.

 
      [bookmark: pgfId-1812052]The changes are saved to the running configuration.

 
      [bookmark: pgfId-1812053]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1532477][bookmark: 82579]Adding an SXP Connection Peer

 
      [bookmark: pgfId-1661070]SXP connections between peers are point-to-point and use TCP as the underlying transport protocol.

 
      [bookmark: pgfId-1812058]To add an SXP connection peer, perform the following steps:

 
     
 
      [bookmark: pgfId-1812059] Step 1[image: ] In the main ASDM application window, choose  Configuration >  Firewall >  Identity By TrustSec . 

 
      [bookmark: pgfId-1812060]Step 2[image: ] If necessary, check the  Enable Security Exchange Protocol check box to enable SXP.

 
      [bookmark: pgfId-1812061]Step 3[image: ] Click  Add . The Add Connection dialog box appears.

 
      [bookmark: pgfId-1812062]Step 4[image: ] In the Peer IP Address field, enter the IPv4 or IPv6 address of the SXP peer. The peer IP address must be reachable from the ASA outgoing interface.

 
      [bookmark: pgfId-1812066]Step 5[image: ]  ( Optional ) In the Source IP Address field, enter the local IPv4 or IPv6 address of the SXP connection. Specifying the source IP address is optional, however, specifying it safeguards misconfiguration.

 
      [bookmark: pgfId-1812067]Step 6[image: ] From the Password drop-down list, specify whether to use the authentication key for the SXP connection by choosing one of the following values:

 
      
       
       		 [bookmark: pgfId-1812068]Default—Use the default password configured for SXP connections.

 
      

 
     

 
      [bookmark: pgfId-1812072]See the “Configuring the Security Exchange Protocol (SXP)” section.

 
      
       
       		 [bookmark: pgfId-1812073]None—Do not use a password for the SXP connection.

 
      

 
     

 
      [bookmark: pgfId-1812074]Step 7[image: ]  ( Optional ) From the Mode drop-down list, specify the mode of the SXP connection by choosing one of the following values: 

 
      
       
       		 [bookmark: pgfId-1812075]Local—Use the local SXP device.

 
       		 [bookmark: pgfId-1812076]Peer—Use the peer SXP device.

 
      

 
     

 
      [bookmark: pgfId-1812080]Step 8[image: ] From the Role drop-down list, specify whether the ASA functions as a Speaker or Listener for the SXP connection:

 
      
      		 [bookmark: pgfId-1812084]Speaker—The ASA can forward IP-SGT mapping to upstream devices.

 
      		 [bookmark: pgfId-1812088]Listener—The ASA can receive IP-SGT mapping from downstream devices.

 
     

 
      [bookmark: pgfId-1812092]See the “About Speaker and Listener Roles on the ASA” section.

 
      [bookmark: pgfId-1812093]Step 9[image: ] Click  OK . The peer appears in the Connection Peers list.

 
      [bookmark: pgfId-1812094]Step 10[image: ] Click  Apply to save your settings.

 
      [bookmark: pgfId-1812095]The changes are saved to the running configuration.

 
      [bookmark: pgfId-1812096]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1623948][bookmark: 42358][bookmark: 83838][bookmark: 27044]Refreshing Environment Data

 
      [bookmark: pgfId-1623952]The ASA downloads environment data from the ISE, which includes the Security Group Tag (SGT) name table. The ASA automatically refreshes its environment data that is obtained from the ISE when you complete the following tasks on the ASA:

 
      
      		 [bookmark: pgfId-1586537]Configure a AAA server to communicate with the ISE.

 
      		 [bookmark: pgfId-1586422]Import a PAC file from the ISE.

 
      		 [bookmark: pgfId-1585620]Identify the AAA server group that the ASA will use for retrieval of Cisco TrustSec environment data.

 
     

 
      [bookmark: pgfId-1586651]Normally, you do not need to manually refresh the environment data from the ISE; however, security groups can change on the ISE. These changes are not reflected on the ASA until you refresh the data in the ASA security group table, so refresh the data on the ASA to make sure that any security group changes made on the ISE are reflected on the ASA.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1586674]Tip We recommend that you schedule policy configuration changes on the ISE and the manual data refresh on the ASA during a maintenance window. Handling policy configuration changes in this way maximizes the chances of security group names getting resolved and security policies becoming active immediately on the ASA.


      
      
 
     

     

 
      [bookmark: pgfId-1586947]Prerequisites

 
      [bookmark: pgfId-1586950]The ASA must be configured as a recognized Cisco TrustSec network device in the ISE and the ASA must have successfully imported a PAC file, so that the changes made for Cisco TrustSec are applied to the ASA. 

 
      [bookmark: pgfId-1588289]Restrictions

 
      
      		 [bookmark: pgfId-1588296]When the ASA is part of an HA configuration, you must refresh the environment data on the primary ASA device.

 
      		 [bookmark: pgfId-1588297]When the ASA is part of a clustering configuration, you must refresh the environment data on the master device.

 
     

 
      [bookmark: pgfId-1799166]To refresh the environment data, perform the following steps:

 
     
 
      [bookmark: pgfId-1812106] Step 1[image: ] In the main ASDM application window, choose  Configuration >  Firewall >  Identity By TrustSec . 

 
      [bookmark: pgfId-1812107]Step 2[image: ] In the Server Group Setup area, click  Refresh  Environment  Data .

 
      [bookmark: pgfId-1812111]The ASA refreshes the Cisco TrustSec environment data from the ISE and resets the reconcile timer to the configured default value.

 
      [bookmark: pgfId-1812112]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1724741][bookmark: 43632]Configuring the Security Policy

 
      [bookmark: pgfId-1724782]You can incorporate TrustSec policy in many ASA features. Any feature that uses extended ACLs (unless listed in this chapter as unsupported) can take advantage of TrustSec. You can now add security group arguments to extended ACLs, as well as traditional network-based parameters.

 
      
      		 [bookmark: pgfId-1724789]To configure access rule, Chapter 6, “Configuring Access Rules.”

 
      		 [bookmark: pgfId-1724792]To configure security group object groups, which can be used in the ACL, see the “Configuring Local User Groups” section.

 
     

 
      [bookmark: pgfId-1724794]For example, an access rule permits or denies traffic on an interface using network information. With TrustSec, you can now control access based on security group. See Chapter 6, “Configuring Access Rules,” in the firewall configuration guide. For example, you could create an access rule for sample_securitygroup1 10.0.0.0 255.0.0.0, meaning the security group could have any IP address on subnet 10.0.0.0/8.

 
      [bookmark: pgfId-1589949]You can configure security policies based on combinations of security group names (servers, users, unmanaged devices, and so on), user-based attributes, and traditional IP-address-based objects (IP address, Active Directory object, and FQDN). Security group membership can extend beyond roles to include device and location attributes and is independent of user group membership.

 
    
 
   
 
    
     [bookmark: pgfId-1510432][bookmark: 31646][bookmark: 25331]Monitoring Cisco TrustSec

 
     [bookmark: pgfId-1606785]To monitor Cisco TrustSec on the ASA, choose one of the following paths in ASDM:

 
     [bookmark: pgfId-1797830] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1797837]Path
         
  
        		
          
          [bookmark: pgfId-1797839]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1797841] 
   Monitoring >  Properties >  Identity By TrustSec >  SXP Connections 

  
        		 [bookmark: pgfId-1797843]Displays the configured default values for the Cisco TrustSec infrastructure and the SXP commands.

  
       

 
        
        		 [bookmark: pgfId-1797849] 
   Monitoring >  Properties >  Connections 

  
        		 [bookmark: pgfId-1797851]Displays data for all SXP connections. Filters the IP address-security group table mapping entries so that you view the data by security group table value, security group name, or IP address.

  
       

 
        
        		 [bookmark: pgfId-1797853] 
 Monitoring >  Properties >  Identity By TrustSec >  Environment Data 

  
        		 [bookmark: pgfId-1797855]Displays the Cisco TrustSec environment information contained in the security group table on the ASA.

  
       

 
        
        		 [bookmark: pgfId-1797861] 
   Monitoring >  Properties >  Identity By TrustSec >  IP Mapping 

  
        		 [bookmark: pgfId-1812176]Displays the IP address-security group table mapping entries from the IP address-security group table mapping database maintained in the datapath. Filters the IP address-security group table mapping entries so that you view the data by security group table value, security group name, or IP address.

 to display where the selected security group object is used in an ACL or nested in another security group object.  
       

 
        
        		 [bookmark: pgfId-1797865] 
 Monitoring >  Properties >  Identity By TrustSec >  PAC 

  
        		 [bookmark: pgfId-1797867]Displays information about the PAC file imported into the ASA from the ISE. Displays a warning message when the PAC file has expired or is within 30 days of expiring.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1596424][bookmark: 74663]Feature History for the Cisco TrustSec Integration

 
     [bookmark: pgfId-1812135] Table 39-3  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1356691] 

 
     
      
       
        [bookmark: pgfId-1356648]Table 39-3 [bookmark: 94847]Feature History for the Cisco TrustSec Integration

 
       
      
        
        		
          
          [bookmark: pgfId-1356654]Feature Name
         
  
        		
          
          [bookmark: pgfId-1356656]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1356658]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1356660]Cisco TrustSec Integration

  
        		 [bookmark: pgfId-1356662]9.0(1)

  
        		 [bookmark: pgfId-1712730]Cisco TrustSec provides access control that builds upon an existing identity-aware infrastructure to ensure data confidentiality between network devices and integrate security access services on one platform. In the Cisco TrustSec feature, enforcement devices use a combination of user attributes and end-point attributes to make role-based and identity-based access control decisions. 

  [bookmark: pgfId-1712734]In this release, the ASA integrates with Cisco TrustSec to provide security group-based policy enforcement. Access policies within the Cisco TrustSec domain are topology-independent, based on the roles of source and destination devices rather than on network IP addresses. 

  [bookmark: pgfId-1712738]The ASA can use the Cisco TrustSec feature for other types of security group-based policies, such as application inspection; for example, you can configure a class map that includes an access policy based on a security group. 

  [bookmark: pgfId-1812140]We introduced or modified the following screens: 

  [bookmark: pgfId-1712741]Configuration > Firewall > Identity By TrustSec
 Configuration > Firewall > Objects > Security Groups Object Groups
 Configuration > Firewall > Access Rules > Add Access Rules
 Monitoring > Properties > Identity By Tag.
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     [bookmark: pgfId-1376965][bookmark: 29255]Configuring the Identity Firewall
      
      
 
     
 

 
     [bookmark: pgfId-1376969]This chapter describes how to configure the ASA for the Identity Firewall and includes the following sections: 

 
     
     		 [bookmark: pgfId-1054670]Information About the Identity Firewall

 
     		 [bookmark: pgfId-1295615]Licensing for the Identity Firewall

 
     		 [bookmark: pgfId-1233515]Guidelines and Limitations

 
     		 [bookmark: pgfId-1300289]Prerequisites

 
     		 [bookmark: pgfId-1296874]Configuring the Identity Firewall

 
     		 [bookmark: pgfId-1285918]Monitoring the Identity Firewall

 
     		 [bookmark: pgfId-1295594]Feature History for the Identity Firewall

 
    

 
   
 
    
     [bookmark: pgfId-1146517][bookmark: 78267]Information About the Identity Firewall

 
     [bookmark: pgfId-1146518]This section includes the following topics: 

 
     
     		 [bookmark: pgfId-1295701]Overview of the Identity Firewall

 
     		 [bookmark: pgfId-1295709]Architecture for Identity Firewall Deployments

 
     		 [bookmark: pgfId-1295719]Features of the Identity Firewall

 
     		 [bookmark: pgfId-1295714]Deployment Scenarios

 
    

 
     
      [bookmark: pgfId-1286049][bookmark: 65345]Overview of the Identity Firewall

 
      [bookmark: pgfId-1289843]In an enterprise, users often need access to one or more server resources. Typically, a firewall is not aware of the users’ identities and, therefore, cannot apply security policies based on identity. To configure per-user access policies, you must configure a user authentication proxy, which requires user interaction (a username/password query).

 
      [bookmark: pgfId-1289845]The Identity Firewall in the ASA provides more granular access control based on users’ identities. You can configure access rules and security policies based on user names and user group names rather than through source IP addresses. The ASA applies the security policies based on an association of IP addresses to Windows Active Directory login information and reports events based on the mapped usernames instead of network IP addresses. 

 
      [bookmark: pgfId-1289847]The Identity Firewall integrates with Microsoft Active Directory in conjunction with an external Active Directory (AD) Agent that provides the actual identity mapping. The ASA uses Windows Active Directory as the source to retrieve the current user identity information for specific IP addresses and allows transparent authentication for Active Directory users. 

 
      [bookmark: pgfId-1289841]Identity-based firewall services enhance the existing access control and security policy mechanisms by allowing users or groups to be specified in place of source IP addresses. Identity-based security policies can be interleaved without restriction between traditional IP address-based rules.

 
      [bookmark: pgfId-1297131]The key benefits of the Identity Firewall include: 

 
      
      		 [bookmark: pgfId-1297132]Decoupling network topology from security policies

 
      		 [bookmark: pgfId-1297133]Simplifying the creation of security policies

 
      		 [bookmark: pgfId-1297134]Providing the ability to easily identify user activities on network resources

 
      		 [bookmark: pgfId-1297135]Simplifying user activity monitoring 

 
     

 
    
 
     
      [bookmark: pgfId-1287981][bookmark: 77615]Architecture for Identity Firewall Deployments

 
      [bookmark: pgfId-1288451]The Identity Firewall integrates with Window Active Directory in conjunction with an external Active Directory (AD) Agent that provides the actual identity mapping.

 
      [bookmark: pgfId-1303121]The identity firewall consists of three components: 

 
      
      		 [bookmark: pgfId-1288598]ASA

 
      		 [bookmark: pgfId-1288607]Microsoft Active Directory

 
     

 
      [bookmark: pgfId-1344833]Although Active Directory is part of the Identity Firewall on the ASA, Active Directory administrators manage it. The reliability and accuracy of the data depends on data in Active Directory. 

 
      [bookmark: pgfId-1344834]Supported versions include Windows Server 2003, Windows Server 2008, and Windows Server 2008 R2 servers.

 
      
      		 [bookmark: pgfId-1288599]Active Directory (AD) Agent

 
     

 
      [bookmark: pgfId-1303691]The AD Agent runs on a Windows server. Supported Windows servers include Windows 2003, Windows 2008, and Windows 2008 R2.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1370003]Note Windows 2003 R2 is not supported for the AD Agent server. 


      
      
 
     

     

 
      [bookmark: pgfId-1515026]Figure 38-1 show the components of the Identity Firewall. The succeeding table describes the roles of these components and how they communicate with one another.

 
      [bookmark: pgfId-1296081]Figure 38-1 [bookmark: 67504]Identity Firewall Components

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1463670] 

 
      
       
       
         
         		
           
           [bookmark: pgfId-1463605]1
          
  
         		 [bookmark: pgfId-1463610] On the ASA : Administrators configure local user groups and Identity Firewall policies. 

  
         		
           
           [bookmark: pgfId-1463612]4
          
  
         		 [bookmark: pgfId-1463617] Client <-> ASA : The client logs into the network through Microsoft Active Directory. The AD Server authenticates users and generates user login security logs.

  [bookmark: pgfId-1463618]Alternatively, the client can log into the network through a cut-through proxy or VPN.

  
        

 
         
         		
           
           [bookmark: pgfId-1463620]2
          
  
         		 [bookmark: pgfId-1463628] ASA <-> AD Server : The ASA sends an LDAP query for the Active Directory groups configured on the AD Server.

  [bookmark: pgfId-1463632]The ASA consolidates local and Active Directory groups and applies access rules and Modular Policy Framework security policies based on user identity.

  
         		
           
           [bookmark: pgfId-1463634]5
          
  
         		 [bookmark: pgfId-1463639] ASA <-> Client : Based on the policies configured on the ASA, it grants or denies access to the client.

  [bookmark: pgfId-1463646]If configured, the ASA probes the NetBIOS of the client to pass inactive and no-response users. 

  
        

 
         
         		
           
           [bookmark: pgfId-1463648]3
          
  
         		 [bookmark: pgfId-1463653] ASA <-> AD Agent : Depending on the Identity Firewall configuration, the ASA downloads the IP-user database or sends a RADIUS request to the AD Agent that asks for the user’s IP address. 

  [bookmark: pgfId-1463660]The ASA forwards the new mapped entries that have been learned from web authentication and VPN sessions to the AD Agent. 

  
         		
           
           [bookmark: pgfId-1463662]6
          
  
         		 [bookmark: pgfId-1463664] AD Agent <-> AD Server : The AD Agent maintains a cache of user ID and IP address mapped entries. and notifies the ASA of changes.

  [bookmark: pgfId-1463669]The AD Agent sends logs to a syslog server.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-1463672][bookmark: 74995]Features of the Identity Firewall

 
      [bookmark: pgfId-1463673]The Identity Firewall includes the following key features.

 
      [bookmark: pgfId-1297109]Flexibility

 
      
      		 [bookmark: pgfId-1302682]The ASA can retrieve user identity and IP address mapping from the AD Agent by querying the AD Agent for each new IP address or by maintaining a local copy of the entire user identity and IP address database.

 
      		 [bookmark: pgfId-1301566]Supports host group, subnet, or IP address for the destination of a user identity policy.

 
      		 [bookmark: pgfId-1372099]Supports a fully qualified domain name (FQDN) for the source and destination of a user identity policy.

 
      		 [bookmark: pgfId-1294540]Supports the combination of 5-tuple policies with ID-based policies. The identity-based feature works in tandem with the existing 5-tuple solution.

 
      		 [bookmark: pgfId-1294542]Supports use with IPS and Application Inspection policies.

 
      		 [bookmark: pgfId-1301775]Retrieves user identity information from remote access VPN, AnyConnect VPN, L2TP VPN and cut-through proxy. All retrieved users are populated to all ASAs that are connected to the AD Agent.

 
     

 
      [bookmark: pgfId-1349489]Scalability

 
      
      		 [bookmark: pgfId-1349496]Each AD Agent supports 100 ASAs. Multiple ASAs are able to communicate with a single AD Agent to provide scalability in larger network deployments. 

 
      		 [bookmark: pgfId-1349497]Supports 30 Active Directory servers provided the IP address is unique among all domains.

 
      		 [bookmark: pgfId-1349498]Each user identity in a domain can have up to 8 IP addresses. 

 
      		 [bookmark: pgfId-1349505]Supports up to 64,000 user identity-IP address mapped entries in active policies for the ASA 5500 Series models. This limit controls the maximum number of users who have policies applied. The total number of users are the aggregate of all users configured in all different contexts.

 
      		 [bookmark: pgfId-1349512]Supports up to 1024 user identity-IP address mapped entries in active policies for the ASA 5505. 

 
      		 [bookmark: pgfId-1349516]Supports up to 256 user groups in active ASA policies. 

 
      		 [bookmark: pgfId-1349517]A single access rule can contain one or more user groups or users. 

 
      		 [bookmark: pgfId-1349518]Supports multiple domains. 

 
     

 
      [bookmark: pgfId-1349400]Availability

 
      
      		 [bookmark: pgfId-1302030]The ASA retrieves group information from the Active Directory and falls back to web authentication for IP addresses when the AD Agent cannot map a source IP address to a user identity. 

 
      		 [bookmark: pgfId-1302166]The AD Agent continues to function when any of the Active Directory servers or the ASA are not responding. 

 
      		 [bookmark: pgfId-1302389]Supports configuring a primary AD Agent and a secondary AD Agent on the ASA. If the primary AD Agent stops responding, the ASA can switch to the secondary AD Agent. 

 
      		 [bookmark: pgfId-1372126]If the AD Agent is unavailable, the ASA can fall back to existing identity sources such as cut-through proxy and VPN authentication. 

 
      		 [bookmark: pgfId-1302404]The AD Agent runs a watchdog process that automatically restarts its services when they are down.

 
      		 [bookmark: pgfId-1301413]Allows a distributed IP address/user mapping database for use among ASAs. 

 
     

 
    
 
     
      [bookmark: pgfId-1295841][bookmark: 60321]Deployment Scenarios

 
      [bookmark: pgfId-1295858]You can deploy the components of the Identity Firewall in the following ways, depending on your environmental requirements.

 
      [bookmark: pgfId-1305004]Figure 38-2 shows how you can deploy the components of the Identity Firewall to allow for redundancy. Scenario 1 shows a simple installation without component redundancy. Scenario 2 also shows a simple installation without redundancy. However, in this deployment scenario, the Active Directory server and AD Agent are co-located on the same Windows server. 

 
      [bookmark: pgfId-1295917]Figure 38-2 [bookmark: 93902]Deployment Scenario without Redundancy

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1296090] 

 
      [bookmark: pgfId-1305367]Figure 38-3 shows how you can deploy the Identity Firewall components to support redundancy. Scenario 1 shows a deployment with multiple Active Directory servers and a single AD Agent installed on a separate Windows server. Scenario 2 shows a deployment with multiple Active Directory servers and multiple AD Agents installed on separate Windows servers. 

 
      [bookmark: pgfId-1296359]Figure 38-3 [bookmark: 75250]Deployment Scenario with Redundant Components

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1296416] 

 
      [bookmark: pgfId-1297479]Figure 38-4 shows how all Identity Firewall components—Active Directory server, the AD Agent, and the clients—are installed and communicate on the LAN.

 
      [bookmark: pgfId-1296431]Figure 38-4 [bookmark: 28886]LAN -based Deployment

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1296419] 

 
      [bookmark: pgfId-1296478]Figure 38-5 shows a WAN-based deployment to support a remote site. The Active Directory server and the AD Agent are installed on the main site LAN. The clients are located at a remote site and connect to the Identity Firewall components over a WAN.

 
      [bookmark: pgfId-1296505]Figure 38-5 [bookmark: 63618]WAN-based Deployment

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1296489] 

 
      [bookmark: pgfId-1305901]Figure 38-6 also shows a WAN-based deployment to support a remote site. The Active Directory server is installed on the main site LAN. However, the AD Agent is installed and accessed by the clients at the remote site. The remote clients connect to the Active Directory servers at the main site over a WAN.

 
      [bookmark: pgfId-1296621]Figure 38-6 [bookmark: 96279]WAN-based Deployment with Remote AD Agent

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1296622] 

 
      [bookmark: pgfId-1305737]Figure 38-7 shows an expanded remote site installation. An AD Agent and Active Directory servers are installed at the remote site. The clients access these components locally when logging into network resources located at the main site. The remote Active Directory server must synchronize its data with the central Active Directory servers located at the main site. 

 
      [bookmark: pgfId-1296667]Figure 38-7 [bookmark: 38711]WAN-based Deployment with Remote AD Agent and AD Servers

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1296668] 

 
    
 
   
 
    
     [bookmark: pgfId-1300378][bookmark: 19431][bookmark: 33762]Licensing for the Identity Firewall

 
     [bookmark: pgfId-1300457]The following table shows the licensing requirements for this feature: 

 
     [bookmark: pgfId-1559215] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1559208]Model
         
  
        		
          
          [bookmark: pgfId-1559210]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1559212]All models

  
        		 [bookmark: pgfId-1559214]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1300381][bookmark: 28091]Guidelines and Limitations

 
     [bookmark: pgfId-1300382]This section includes the guidelines and limitations for this feature. 

 
     [bookmark: pgfId-1299969]Context Mode Guidelines 

 
     [bookmark: pgfId-1299971]Supported in single and multiple context mode. 

 
     [bookmark: pgfId-1299973]Firewall Mode Guidelines 

 
     [bookmark: pgfId-1299975]Supported in routed and transparent firewall modes. 

 
     [bookmark: pgfId-1300302]Failover Guidelines

 
     
     		 [bookmark: pgfId-1372867]The Identity Firewall supports user identity-IP address mapping and AD Agent status replication from active to standby when Stateful Failover is enabled. However, only user identity-IP address mapping, AD Agent status, and domain status are replicated. User and user group records are not replicated to the standby ASA. 

 
     		 [bookmark: pgfId-1372843]When failover is configured, the standby ASA must also be configured to connect to the AD Agent directly to retrieve user groups. The standby ASA does not send NetBIOS packets to clients even when the NetBIOS probing options are configured for the Identity Firewall. 

 
     		 [bookmark: pgfId-1301996]When a client is determined to be inactive by the active ASA, the information is propagated to the standby ASA. User statistics are not propagated to the standby ASA.

 
     		 [bookmark: pgfId-1372932]When you have failover configured, you must configure the AD Agent to communicate with both the active and standby ASAs. See the  Installation and Setup Guide for the Active Directory Agent for the steps to configure the ASA on the AD Agent server.

 
    

 
     [bookmark: pgfId-1322148]IPv6 Guidelines 

 
     
     		 [bookmark: pgfId-1322149]Supports IPv6. 

 
     		 [bookmark: pgfId-1322150]The AD Agent supports endpoints with IPv6 addresses. It can receive IPv6 addresses in log events, maintain them in its cache, and send them through RADIUS messages.

 
     		 [bookmark: pgfId-1322151]NetBIOS over IPv6 is not supported.

 
    

 
     [bookmark: pgfId-1299985]Additional Guidelines and Limitations

 
     
     		 [bookmark: pgfId-1299709]A full URL as a destination address is not supported.

 
     		 [bookmark: pgfId-1299718]For NetBIOS probing to function, the network between the ASA, AD Agent, and clients must support UDP-encapsulated NetBIOS traffic. 

 
     		 [bookmark: pgfId-1306527]MAC address checking by the Identity Firewall does not work when intervening routers are present. Users logged into clients that are behind the same router have the same MAC addresses. With this implementation, all the packets from the same router are able to pass the check, because the ASA is unable to ascertain the actual MAC addresses behind the router.

 
     		 [bookmark: pgfId-1349541]The following ASA features do not support using the identity-based object and FQDN in an extended ACL:

 
    

 
     [bookmark: pgfId-1349542]–[image: ] Route maps

 
     [bookmark: pgfId-1349543]–[image: ] Crypto maps

 
     [bookmark: pgfId-1349544]–[image: ] WCCP

 
     [bookmark: pgfId-1349545]–[image: ] NAT

 
     [bookmark: pgfId-1349546]–[image: ] Group policy (except for VPN filters)

 
     [bookmark: pgfId-1526866]–[image: ] DAP

 
     
     		 [bookmark: pgfId-1526873]You can use the  user-identity update active-user-database command to actively initiate a user-IP address download from the AD agent.

 
    

 
     [bookmark: pgfId-1526874]By design, if a previous download session has finished, the ASA does not allow you to issue this command again.

 
     [bookmark: pgfId-1526875]As a result, if the user-IP database is very large, the previous download session is not finished yet, and you issue another  user-identity update active-user-database command, the following error message appears: 

 
    
     [bookmark: pgfId-1526876]“ERROR: one update active-user-database is already in progress.”
    

    
     [bookmark: pgfId-1526877] 
    

     [bookmark: pgfId-1526878]You need to wait until the previous session is completely finished, then you can issue another  user-identity update active-user-database command.

 
     [bookmark: pgfId-1526879]Another example of this behavior occurs because of packet loss from the AD Agent to the ASA.

 
     [bookmark: pgfId-1526880]When you issue a  user-identity update active-user-database command, the ASA requests the total number of user-IP mapped entries to be downloaded. Then the AD Agent initiates a UDP connection to the ASA and sends the change of authorization request packet.

 
     [bookmark: pgfId-1526881]If for some reason the packet is lost, there is no way for the ASA to discern this. As a result, the ASA holds the session for 4-5 minutes, during which time this error message continues to appear if you have issued the  user-identity update active-user-database command.

 
     
     		 [bookmark: pgfId-1527148]When you use the Cisco Context Directory Agent (CDA) in conjunction with the ASA or Cisco Ironport Web Security Appliance (WSA), make sure that you open the following ports:

 
    

 
     [bookmark: pgfId-1527217]–[image: ] Authentication port for UDP—1645

 
     [bookmark: pgfId-1527260]–[image: ] Accounting port for UDP—1646

 
     [bookmark: pgfId-1527273]–[image: ] Listening port for UDP—3799

 
     [bookmark: pgfId-1527284]The listening port is used to send change of authorization requests from the CDA to the ASA or to the WSA.

 
     
     		 [bookmark: pgfId-1552399]For domain names, the following characters are not valid: \/:*?"<>|. For naming conventions, see  http://support.microsoft.com/kb/909264 .

 
     		 [bookmark: pgfId-1552422]For usernames, the following characters are not valid: \/[]:;=,+*?"<>|@.

 
     		 [bookmark: pgfId-1552428]For user group names, the following characters are not valid: \/[]:;=,+*?"<>|.

 
    

 
   
 
    
     [bookmark: pgfId-1526869][bookmark: 45801]Prerequisites

 
     [bookmark: pgfId-1341092]Before configuring the Identity Firewall in the ASA, you must meet the prerequisites for the AD Agent and Microsoft Active Directory. 

 
     [bookmark: pgfId-1300559]AD Agent

 
     
     		 [bookmark: pgfId-1318937]The AD Agent must be installed on a Windows server that is accessible to the ASA. Additionally, you must configure the AD Agent to obtain information from the Active Directory servers and to communicate with the ASA. 

 
     		 [bookmark: pgfId-1318887]Supported Windows servers include Windows 2003, Windows 2008, and Windows 2008 R2. 

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1372973]Note Windows 2003 R2 is not supported for the AD Agent server. 


     
     
 
    

    

 
     
     		 [bookmark: pgfId-1300548]For the steps to install and configure the AD Agent, see the Installation and Setup Guide for the Active Directory Agent .

 
     		 [bookmark: pgfId-1318880]Before configuring the AD Agent in the ASA, obtain the secret key value that the AD Agent and the ASA use to communicate. This value must match on both the AD Agent and the ASA. 

 
    

 
     [bookmark: pgfId-1318853]Microsoft Active Directory

 
     
     		 [bookmark: pgfId-1318902]Microsoft Active Directory must be installed on a Windows server and accessible by the ASA. Supported versions include Windows 2003, 2008, and 2008 R2 servers.

 
     		 [bookmark: pgfId-1319181]Before configuring the Active Directory server on the ASA, create a user account in Active Directory for the ASA. 

 
     		 [bookmark: pgfId-1319234]Additionally, the ASA sends encrypted log-in information to the Active Directory server by using SSL enabled over LDAP. SSL must be enabled on the Active Directory server. See the documentation for Microsoft Active Directory for how to enable SSL for Active Directory. 

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1375610]Note Before running the AD Agent Installer, you must install the patches listed in the README First for the Cisco Active Directory Agent on each Microsoft Active Directory server that the AD Agent monitors. These patches are required even when the AD Agent is installed directly on the domain controller server. 


     
     
 
    

    

 
   
 
    
     [bookmark: pgfId-1146718][bookmark: 64012]Configuring the Identity Firewall

 
     [bookmark: pgfId-1233779]This section contains the following topic:

 
     
     		 [bookmark: pgfId-1295558]Task Flow for Configuring the Identity Firewall

 
     		 [bookmark: pgfId-1324544]Configuring the Active Directory Domain

 
     		 [bookmark: pgfId-1549165]Configuring Active Directory Server Groups

 
     		 [bookmark: pgfId-1531911]Configuring Active Directory Agents

 
     		 [bookmark: pgfId-1549173]Configuring Active Directory Agent Groups

 
     		 [bookmark: pgfId-1347276]Configuring Identity Options

 
     		 [bookmark: pgfId-1347312]Configuring Identity-Based Security Policy

 
    

 
   
 
    
     [bookmark: pgfId-1295544][bookmark: 73415]Task Flow for Configuring the Identity Firewall

 
     [bookmark: pgfId-1309048]To configure the Identity Firewall, perform the following tasks:

 
    
 
     [bookmark: pgfId-1299178] Step 1[image: ] Configure the Active Directory domain in the ASA.

 
     [bookmark: pgfId-1324261]See the “Configuring the Active Directory Domain” section and the “Configuring Active Directory Server Groups” section.

 
     [bookmark: pgfId-1353066]See also the “Deployment Scenarios” section for the ways in which you can deploy the Active Directory servers to meet your environment requirements.

 
     [bookmark: pgfId-1297888]Step 2[image: ] Configure the AD Agent in ASA. 

 
     [bookmark: pgfId-1325030]See the “Configuring Active Directory Server Groups” section and the “Configuring Active Directory Agent Groups” section.

 
     [bookmark: pgfId-1353105]See also “Deployment Scenarios” section for the ways in which you can deploy the AD Agents to meet your environment requirements.

 
     [bookmark: pgfId-1345342]Step 3[image: ] Configure Identity Options. 

 
     [bookmark: pgfId-1345346]See the “Configuring Identity Options” section. 

 
     [bookmark: pgfId-1297906]Step 4[image: ] Configure Identity-based Security Policy. After the AD domain and AD Agent are configured, you can create identity-based object groups and ACLs for use in many features. 

 
     [bookmark: pgfId-1514736]See the “Configuring Identity-Based Security Policy” section.

 
     [bookmark: pgfId-1514710]


     
     
 
    
  
    

 
     
      [bookmark: pgfId-1345615][bookmark: 45722]Configuring the Active Directory Domain

 
      [bookmark: pgfId-1345622]Active Directory domain configuration on the ASA is required for the ASA to download Active Directory groups and accept user identities from specific domains when receiving IP-user mapping from the AD Agent. 

 
    
 
     
      [bookmark: pgfId-1345623]Prerequisites

 
      
      		 [bookmark: pgfId-1345624]Active Directory server IP address 

 
      		 [bookmark: pgfId-1345625]Distinguished Name for LDAP base DN 

 
      		 [bookmark: pgfId-1345626]Distinguished Name and password for the Active Directory user that the Identity Firewall uses to connect to the Active Directory domain controller 

 
     

 
      [bookmark: pgfId-1345627]To configure the Active Directory domain, perform the following steps:

 
     
 
      [bookmark: pgfId-1549194] Step 1[image: ] Choose  Configuration >  Firewall >  Identity Options . 

 
      [bookmark: pgfId-1549195]Step 2[image: ] If necessary, check the  Enable User Identity check box to enable user identity. 

 
      [bookmark: pgfId-1549196]Step 3[image: ] In the Domains section, click  Add or select a domain from the list and click  Edit . 

 
      [bookmark: pgfId-1549197]The Domain dialog box appears. 

 
      [bookmark: pgfId-1549198]Step 4[image: ] In the Domain NETBIOS Name field, enter a name up to 32 characters consisting of [a-z], [A-Z], [0-9], [!@#$%^&()-_=+[]{};,. ] except '.' and ' ' at the first character. If the domain name includes a space, you must enclose that space character in quotation marks. The domain name is not case sensitive. 

 
      [bookmark: pgfId-1549199]When you edit the name of an existing domain, the domain name associated with existing users and user groups is not changed. 

 
      [bookmark: pgfId-1549200]Step 5[image: ] From the AD Server Group list, select the Active Directory servers to associate with this domain or click  Manage to add a new server group to the list. See the “Configuring Active Directory Server Groups” section.

 
      [bookmark: pgfId-1549204]Step 6[image: ] Click  OK to save the domain settings and close this dialog box. 

 
      [bookmark: pgfId-1549205]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1549206]What to Do Next

 
      [bookmark: pgfId-1345754]See the “Configuring Active Directory Server Groups” section and the “Configuring Active Directory Agent Groups” section.

 
    
 
     
      [bookmark: pgfId-1549219][bookmark: 24473]Configuring Active Directory Server Groups

 
      [bookmark: pgfId-1549220]To configure the Active Directory server group, perform the following steps:

 
     
 
      [bookmark: pgfId-1549221] Step 1[image: ] Choose  Configuration >  Firewall >  Identity Options >  Add >  Manage . 

 
      [bookmark: pgfId-1549222]The Configure Active Directory Server Groups dialog box appears.

 
      [bookmark: pgfId-1549223]Step 2[image: ] To add an Active Directory server group for the Identify Firewall, click  Add . 

 
      [bookmark: pgfId-1549224]The Add Active Directory Server Group dialog box appears. 

 
      [bookmark: pgfId-1549225]Step 3[image: ] To add servers to an Active Directory server group, select the group from the Active Directory Server Groups list, then click  Add . 

 
      [bookmark: pgfId-1549226]The Add Active Directory Server dialog box appears. 

 
      [bookmark: pgfId-1549227]Step 4[image: ] Click  OK to save the settings and close this dialog box. 

 
      [bookmark: pgfId-1549228]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1549229]What to Do Next

 
      [bookmark: pgfId-1549235]See the “Configuring Active Directory Agents” section and the “Configuring Active Directory Agent Groups” section.

 
    
 
     
      [bookmark: pgfId-1345781][bookmark: 48913]Configuring Active Directory Agents

 
      [bookmark: pgfId-1345796]Prerequisites 

 
      [bookmark: pgfId-1515100]Make sure that you have the following information before configuring the AD Agents:

 
      
      		 [bookmark: pgfId-1345797]AD agent IP address 

 
      		 [bookmark: pgfId-1345801]Shared secret between the ASA and AD agent 

 
     

 
      [bookmark: pgfId-1345802]To configure the AD Agents, perform the following steps:

 
     
 
      [bookmark: pgfId-1549241] Step 1[image: ] Choose  Configuration >  Firewall >  Identity Options . 

 
      [bookmark: pgfId-1549242]Step 2[image: ] If necessary, check the  Enable User Identity check box to enable the feature. 

 
      [bookmark: pgfId-1549243]Step 3[image: ] In the Active Directory Agent section, click  Manage . 

 
      [bookmark: pgfId-1549244]The Configure Active Directory Agents dialog box appears. 

 
      [bookmark: pgfId-1549245]Step 4[image: ] To add an AD Agent, click the  Add button. Alternatively, choose an agent group from the list and click  Edit . 

 
      [bookmark: pgfId-1549249]To continue, see the “Configuring Active Directory Agent Groups” section. 

 
      [bookmark: pgfId-1549250]Step 5[image: ] Click  OK to save your changes. 

 
      [bookmark: pgfId-1549251]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1345869]What to Do Next

 
      [bookmark: pgfId-1549258]Configure AD Agent groups. See the “Configuring Active Directory Agent Groups” section.

 
      [bookmark: pgfId-1345877]Configure access rules for the Identity Firewall. See the “Configuring Identity-Based Security Policy” section.

 
    
 
     
      [bookmark: pgfId-1549266][bookmark: 24644]Configuring Active Directory Agent Groups

 
      [bookmark: pgfId-1549270]Configure the primary and secondary AD Agents for the AD Agent Server Group. When the ASA detects that the primary AD Agent is not responding and a secondary agent is specified, the ASA switches to the secondary AD Agent. The Active Directory server for the AD agent uses RADIUS as the communication protocol; therefore, you should specify a key attribute for the shared secret between the ASA and AD Agent.

 
      [bookmark: pgfId-1549277]To configure the AD Agent Groups, perform the following steps:

 
     
 
      [bookmark: pgfId-1549278] Step 1[image: ] From the Configure Active Directory Agents dialog box, click  Add . 

 
      [bookmark: pgfId-1549279]The Add Active Directory Agent Group dialog box appears.

 
      [bookmark: pgfId-1549280]Step 2[image: ] Enter a name for the AD Agent group. 

 
      [bookmark: pgfId-1549281]Step 3[image: ] From the Primary Active Directory Agent section, specify the interface on which the ASA listens for traffic from the AD Agent server, and enter the FQDN of the server or IP address. 

 
      [bookmark: pgfId-1549285]Step 4[image: ] In the Primary Active Directory Agent section, enter a timeout interval and the retry interval for the attempts that the ASA will continue to contact the AD Agent when it is not responding. 

 
      [bookmark: pgfId-1549289]Step 5[image: ] Enter the shared secret key that is used between the primary AD Agent and the ASA.

 
      [bookmark: pgfId-1549293]Step 6[image: ] From the Secondary Active Directory Agent section, specify the interface on which the ASA listens for traffic from the AD Agent server, and enter the FQDN of the server or IP address. 

 
      [bookmark: pgfId-1549297]Step 7[image: ] In the Secondary Active Directory Agent section, enter a timeout interval and the retry interval for the the attempts that the ASA will continue to perform to contact the AD Agent when it is not responding. 

 
      [bookmark: pgfId-1549301]Step 8[image: ] Enter the shared secret key that is used between the secondary AD Agent and the ASA.

 
      [bookmark: pgfId-1549305]Step 9[image: ] Click  OK to save your changes and close this dialog box. 

 
      [bookmark: pgfId-1549306]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1549307]What to Do Next

 
      [bookmark: pgfId-1549310]Configure access rules for the Identity Firewall. See the “Configuring Identity-Based Security Policy” section.

 
    
 
     
      [bookmark: pgfId-1322556][bookmark: 78229]Configuring Identity Options

 
      [bookmark: pgfId-1331818]Use this pane to add or edit the Identity Firewall feature; check the  Enable check box to enable the feature. By default, the Identity Firewall feature is disabled.

 
    
 
     
      [bookmark: pgfId-1325469]Prerequisites

 
      [bookmark: pgfId-1325470]Before configuring the identify options for the Identity Firewall, you must meet the prerequisites for the AD Agent and Microsoft Active Directory. See the “Prerequisites” section for the requirements of the AD Agent and Microsoft Active Directory installation. 

 
      [bookmark: pgfId-1325471]To configure the Identity Options for the Identity Firewall, perform the following steps:

 
     
 
      [bookmark: pgfId-1549321] Step 1[image: ] Choose  Configuration >  Firewall >  Identity Options . 

 
      [bookmark: pgfId-1549322]Step 2[image: ] If necessary, check the  Enable User Identity check box to enable the feature. 

 
      [bookmark: pgfId-1549323]Step 3[image: ] To add a domain for the Identity Firewall, click  Add to display the Add Domain dialog box.

 
      [bookmark: pgfId-1549326]Step 4[image: ] To continue, see the “Configuring the Active Directory Domain” section. 

 
      [bookmark: pgfId-1549328]Step 5[image: ] For domains that have already been added to the Domains list, check whether to disable rules when the domain is down because the Active Directory domain controller is not responding. 

 
      [bookmark: pgfId-1549332]When a domain is down and this option is checked for that domain, the ASA disables the user identity rules associated with the users in that domain. Additionally, the status of all user IP addresses in that domain is marked as disabled in the Monitoring > Properties > Identity > Users  pane.

 
      [bookmark: pgfId-1549333]Step 6[image: ] From the Default Domain drop-down list, select the default domain for the Identity Firewall. 

 
      [bookmark: pgfId-1549334]The default domain is used for all users and user groups when a domain has not been explicitly configured for those users or groups. When a default domain is not specified, the default domain for users and groups is LOCAL.

 
      [bookmark: pgfId-1549335]Additionally, the Identity Firewall uses the LOCAL domain for all locally defined user groups or locally defined users (users who log in and authenticate by using a VPN or web portal).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1549336]Note The default domain name that you select must match the NetBIOS domain name configured on the Active Directory domain controller. If the domain name does not match, the AD Agent incorrectly associates the user-IP mapping with the domain name that you entered when configuring the ASA.
To view the NetBIOS domain name, open the Active Directory user event security log in any text editor.


      
      
 
     

     

 
      [bookmark: pgfId-1549340]For multiple context modes, you can set a default domain name for each context, as well as within the system execution space. 

 
      [bookmark: pgfId-1549341]Step 7[image: ] In the Active Directory Agent section, select the AD Agent group from the drop-down list. To add AD Agent groups, click  Manage . For more information, see the “Configuring Active Directory Agents” section. 

 
      [bookmark: pgfId-1549345]Step 8[image: ] In the Hello Timer field, enter a number between 10 to 65535 seconds. 

 
      [bookmark: pgfId-1549352]The hello timer between the ASA and the AD Agent defines how frequently the ASA exchanges hello packets. The ASA uses the hello packet to obtain ASA replication status (in-sync or out-of-sync) and domain status (up or down). If the ASA does not receive a response from the AD Agent, it resends a hello packet after the specified interval. 

 
      [bookmark: pgfId-1549365]Specify the number of times that the ASA will continue to send hello packets to the AD Agent. By default, the number of seconds is set to 30 and the retry times is set to 5. 

 
      [bookmark: pgfId-1549369]Step 9[image: ] In the Poll Group Timer field, enter the number of hours that the ASA uses to query the DNS server to resolve fully qualified domain names (FQDN). By default, the poll timer is set to 4 hours. 

 
      [bookmark: pgfId-1549370]Step 10[image: ] In the Retrieve User Information, select an option from the list:

 
      
      		 [bookmark: pgfId-1549374]On Demand—Specifies that the ASA retrieve the user mapping information of an IP address from the AD Agent when the ASA receives a packet that requires a new connection and the user of its source IP address is not in the user-identity database.

 
      		 [bookmark: pgfId-1549381]Full Download—Specifies that the ASA send a request to the AD Agent to download the entire IP-user mapping table when the ASA starts and then to receive incremental IP-user mapping when users log in and log out.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1549385]Note Selecting On Demand has the benefit of using less memory because only users of received packets are queried and stored. 


      
      
 
     

     

 
      [bookmark: pgfId-1549386]Step 11[image: ] In the Error Conditions section, select whether to disable rules if the AD Agent is not responding. 

 
      [bookmark: pgfId-1549390]When the AD Agent is down and this option is selected, the ASA disables the user identity rules associated with the users in that domain. Additionally, the status of all user IP addresses in that domain are marked as disabled in the Monitoring > Properties > Identity > Users pane.

 
      [bookmark: pgfId-1549391]Step 12[image: ] In the Error Conditions section, select whether to remove a user’s IP address when the NetBIOS probe fails. 

 
      [bookmark: pgfId-1549392]Selecting this option specifies the action when NetBIOS probing to a user is blocked (for example, the user client does not respond to a NetBIOS probe). The network connection might be blocked to that client or the client is not active. When this option is selected, the ASA disables the identity rules associated with that user’s IP address. 

 
      [bookmark: pgfId-1549396]Step 13[image: ] In the Error Conditions section, choose whether or not to remove a user’s MAC address when it is inconsistent with the IP address that the ASA has currently mapped to that MAC address. When this option is selected, the ASA disables the user identity rules associated with the specific user.

 
      [bookmark: pgfId-1549403]Step 14[image: ] In the Error Conditions section, choose whether to track users that are not found. 

 
      [bookmark: pgfId-1549404]Step 15[image: ] In the Users section, choose the Idle Timeout option and enter a time in minutes, from 1 minute to 65535. By default, the idle timeout is set to 60 minutes. 

 
      [bookmark: pgfId-1549408]Enabling this option configures a timer when an active user is considered idle, meaning the ASA does not receive traffic from the user’s IP address for more than the specified time. After the timer expires, the user’s IP address is marked inactive and removed from the local cached IP-user database and the ASA no longer notifies the AD Agent about that IP address. Existing traffic is still allowed to pass. When the Idle Timeout option is enabled, the ASA runs an inactive timer even when the NetBIOS Logout Probe is configured.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1549415]Note The Idle Timeout option does not apply to VPN or cut-through proxy users. 


      
      
 
     

     

 
      [bookmark: pgfId-1549416]Step 16[image: ] In the NetBIOS Logout Probe section, enable NetBIOS probing and set the probe timer (from 1 to 65535 minutes) before a user's IP addresses is probed and the retry interval (from 1 to 256 retries) between retry probes. 

 
      [bookmark: pgfId-1549420]Enabling this option configures how often the ASA probes the user host to determine whether the user client is still active. To minimize the NetBIOS packets, ASA only sends a NetBIOS probe to the client when the user has been idle for more than the specified number of minutes in the Idle Timeout minutes field.

 
      [bookmark: pgfId-1549424]Step 17[image: ] In the NetBIOS Logout Probe section, select an option from the User Name list:

 
      
      		 [bookmark: pgfId-1549425]Match Any—As long as the NetBIOS response from the host includes the username of the user assigned to the IP address, the user identity is be considered valid. Specifying this option requires that the host enabled the Messenger service and configured a WINS server.

 
      		 [bookmark: pgfId-1549426]Exact Match—The username of the user assigned to the IP address must be the only one in the NetBIOS response. Otherwise, the user identity of that IP address is considered invalid. Specifying this option requires that the host enabled the Messenger service and configured a WINS server.

 
      		 [bookmark: pgfId-1549430]User Not Needed—As long as the ASA received a NetBIOS response from the host, the user identity is considered valid.

 
     

 
      [bookmark: pgfId-1549431]Step 18[image: ] Click  Apply to save the Identity Firewall configuration. 

 
      [bookmark: pgfId-1549432]


      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1322680]What to Do Next

 
      [bookmark: pgfId-1322625]Configure the Active Directory domain and server groups. See the “Configuring the Active Directory Domain” section and the “Configuring Active Directory Server Groups” section. 

 
      [bookmark: pgfId-1331883]Configure AD Agents. See the “Configuring Active Directory Server Groups” section. 

 
    
 
     
      [bookmark: pgfId-1309174][bookmark: 14636]Configuring Identity-Based Security Policy

 
      [bookmark: pgfId-1473565]You can incorporate identity-based policy in many ASA features. Any feature that uses extended ACLs (other than those listed as unsupported in the “Guidelines and Limitations” section) can take advantage of an identity firewall. You can now add user identity arguments to extended ACLs, as well as network-based parameters.

 
      [bookmark: pgfId-1474668]Features that can use identity include the following:

 
      
      		 [bookmark: pgfId-1474676]Access rules—An access rule permits or denies traffic on an interface using network information. With an identity firewall, you can control access based on user identity. See Chapter 6, “Configuring Access Rules,” in the firewall configuration guide.

 
      		 [bookmark: pgfId-1475423]AAA rules—An authentication rule (also known as cut-through proxy) controls network access based on the user. Because this function is very similar to an access rule plus an identity firewall, AAA rules can now be used as a backup method of authentication if a user’s AD login expires. For example, for any user without a valid login, you can trigger a AAA rule. To ensure that the AAA rule is only triggered for users that do not have valid logins, you can specify special usernames in the extended ACL used for the access rule and for the AAA rule: None (users without a valid login) and Any (users with a valid login). In the access rule, configure your policy as usual for users and groups, but then include a AAA rule that permits all None users; you must permit these users so they can later trigger a AAA rule. Then, configure a AAA rule that denies Any users (these users are not subject to the AAA rule, and were handled already by the access rule), but permits all None users. For example:

 
     

 
     
      [bookmark: pgfId-1475973]access-list 100 ex permit ip user CISCO\xyz any any
     

     
      [bookmark: pgfId-1475974]access-list 100 ex deny ip user CISCO\abc any any
     

     
      [bookmark: pgfId-1475975]access-list 100 ex permit ip user NONE any any 
     

     
      [bookmark: pgfId-1475976]access-list 100 ex deny any any 
     

     
      [bookmark: pgfId-1475977]access-group 100 in interface inside
     

     
      [bookmark: pgfId-1476012] 
     

     
      [bookmark: pgfId-1475978]access-list 200 ex deny ip user ANY any any 
     

     
      [bookmark: pgfId-1475979]access-list 200 ex permit user NONE any any
     

     
      [bookmark: pgfId-1475980]aaa authenticate match 200 inside user-identity 
     

     
      [bookmark: pgfId-1475922] 
     

      [bookmark: pgfId-1476022]For more information, see Chapter 7, “Configuring AAA Rules for Network Access,” in the firewall configuration guide.

 
      
      		 [bookmark: pgfId-1475923]Cloud Web Security—You can control which users are sent to the Cloud Web Security proxy server. In addition, you can configure policy on the Cloud Web Security ScanCenter that is based on user groups that are included in ASA traffic headers sent to Cloud Web Security. See Chapter 25, “Configuring the ASA for Cisco Cloud Web Security,” in the firewall configuration guide.

 
      		 [bookmark: pgfId-1476092]VPN filter—Although a VPN does not support identity firewall ACLs in general, you can configure the ASA to enforce identity-based access rules on VPN traffic. By default, VPN traffic is not subject to access rules. You can force VPN clients to abide by access rules that use an identity firewall ACL (with the  no sysopt connection permit-vpn command). You can also use an identity firewall ACL with the VPN filter feature; a VPN filter accomplishes a similar effect as allowing access rules in general.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1294455][bookmark: 51855]Monitoring the Identity Firewall

 
     [bookmark: pgfId-1290053]This section includes the following topic:

 
     
     		 [bookmark: pgfId-1286901]Monitoring AD Agents

 
     		 [bookmark: pgfId-1290068]Monitoring Groups

 
     		 [bookmark: pgfId-1290073]Monitoring Memory Usage for the Identity Firewall

 
     		 [bookmark: pgfId-1290074]Monitoring Users for the Identity Firewall

 
    

 
     
      [bookmark: pgfId-1290222][bookmark: 11431]Monitoring AD Agents

 
      [bookmark: pgfId-1549445]To monitor the AD Agent component of the Identity Firewall, perform the following steps:

 
     
 
      [bookmark: pgfId-1549446] Step 1[image: ] Choose  Monitoring >  Properties >  Identity >  AD Agent . 

 
      [bookmark: pgfId-1549447]Step 2[image: ] Click  Refresh to update the data in the pane. 

 
      [bookmark: pgfId-1549448]


      
      
 
     
  
     

 
      [bookmark: pgfId-1326013]This pane displays the following information about the primary and secondary AD Agents:

 
      
      		 [bookmark: pgfId-1326383]Status of the AD Agents

 
      		 [bookmark: pgfId-1326390]Status of the domains

 
      		 [bookmark: pgfId-1326408]Statistics for the AD Agents

 
     

 
    
 
     
      [bookmark: pgfId-1290224][bookmark: 77086]Monitoring Groups

 
      [bookmark: pgfId-1549458]To monitor the user groups configured for the Identity Firewall, perform the following steps: 

 
     
 
      [bookmark: pgfId-1549459] Step 1[image: ] Choose  Monitoring >  Properties >  Identity >  Group . 

 
      [bookmark: pgfId-1549460]Step 2[image: ] To display a list of the access rules using the selected group, click  Where used . 

 
      [bookmark: pgfId-1549461]Step 3[image: ] Click  Refresh to update the data in the pane. 

 
      [bookmark: pgfId-1549462]


      
      
 
     
  
     

 
      [bookmark: pgfId-1549467]This pane displays the list of user groups in the  domain \ group_name format.

 
    
 
     
      [bookmark: pgfId-1290114][bookmark: 35574]Monitoring Memory Usage for the Identity Firewall

 
      [bookmark: pgfId-1549475]To monitor the memory usage that the Identity Firewall consumes on the ASA, perform the following steps: 

 
     
 
      [bookmark: pgfId-1549476] Step 1[image: ] Choose  Monitoring >  Properties >  Identity >  Memory Usage . 

 
      [bookmark: pgfId-1549477]Step 2[image: ] Click  Refresh to update the data in the pane. 

 
      [bookmark: pgfId-1549478]


      
      
 
     
  
     

 
      [bookmark: pgfId-1325794]This pane displays the memory usage in bytes of various modules in the Identity Firewall: 

 
      
      		 [bookmark: pgfId-1328899]Users

 
      		 [bookmark: pgfId-1328933]Groups

 
      		 [bookmark: pgfId-1328950]User Stats

 
      		 [bookmark: pgfId-1328967]LDAP

 
     

 
      [bookmark: pgfId-1329094]The ASA sends an LDAP query for the Active Directory groups configured on the Active Directory server. The Active Directory server authenticates users and generates user login security logs.

 
      
      		 [bookmark: pgfId-1328984]AD Agent

 
      		 [bookmark: pgfId-1329001]Miscellaneous

 
      		 [bookmark: pgfId-1329018]Total Memory Usage

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1329224]Note How you configure the Identity Firewall to retrieve user information from the AD Agent affects the amount of memory used by the feature. You specify whether the ASA uses on-demand retrieval or full download retrieval. Choosing on-demand retrieval has the benefit of using less memory because only users of received packets are queried and stored. For more information, see the “Configuring Identity Options” section.


      
      
 
     

     

 
    
 
     
      [bookmark: pgfId-1321959][bookmark: 64799]Monitoring Users for the Identity Firewall

 
      [bookmark: pgfId-1549488]To display information about all users contained in the IP-user mapping database used by the Identity Firewall, perform the following steps: 

 
     
 
      [bookmark: pgfId-1549489] Step 1[image: ] Choose  Monitoring >  Properties >  Identity >  User . 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1549490]Note Active users are highlighted in green.


      
      
 
     

     

 
      [bookmark: pgfId-1549491]Step 2[image: ] To display additional information about an active user, select the user in the list and click  Details . The Details button is enabled for active users only.

 
      [bookmark: pgfId-1549492]Step 3[image: ] To display a list of the access rules using the selected user, click  Where used . 

 
      [bookmark: pgfId-1549493]Step 4[image: ] Click  Refresh to update the data in the pane. 

 
      [bookmark: pgfId-1549494]


      
      
 
     
  
     

 
      [bookmark: pgfId-1330911]This pane displays the following information for users:

 
      [bookmark: pgfId-1468287] 

 
      
       
       
         
         		 [bookmark: pgfId-1468280] domain \ user_name  

  
         		 [bookmark: pgfId-1468282]Status (active or inactive)

  
         		 [bookmark: pgfId-1468284]Connections

  
         		 [bookmark: pgfId-1468286]Minutes Idle

  
        

 
       
      

 
     
 
      [bookmark: pgfId-1331109]The default domain name can be the real domain name, a special reserved word, or LOCAL. The Identity Firewall uses the LOCAL domain name for all locally defined user groups or locally defined users (users who log in and authenticate by using a VPN or web portal). When the default domain is not specified, the default domain is LOCAL.

 
      [bookmark: pgfId-1329980]The idle time is stored on a per-user basis instead of by the IP address of a user. 

 
      [bookmark: pgfId-1549504]If the option to disable rules when the Active Directory server is down and the domain is down, or the option to disable rules in the AD Agent is down and the AD Agent is down, all the logged-in users have the disabled status. You configure these options in the Identity Options pane. 

 
      [bookmark: pgfId-1549505]Alternatively, you can view statistics for users by accessing the Firewall Dashboard pane. The Firewall Dashboard tab lets you view important information about the traffic passing through your ASA. Choose the  Home >  Firewall Dashboard >  Top Usage Statistics  >  Top 10 Users tab. 

 
      [bookmark: pgfId-1549506]The Top 10 Users tab displays data only when you have configured the Identity Firewall feature in the ASA, which includes configuring these additional components—the Microsoft Active Directory and Cisco Active Directory (AD) Agent. For more information, see the “Configuring the Identity Firewall” section.

 
      [bookmark: pgfId-1549513]Depending on which option you choose, the Top 10 Users tab shows statistics for received EPS packets, sent EPS packets, and sent attacks for the top 10 users. For each user (displayed as  domain \ user_name ), the tab displays the average EPS packet, the current EPS packet, the trigger, and total events for that user. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1549514]Note The first three tabs in the Top Usage Status area display threat detection data and are unrelated to the Identity Firewall feature. 


      
      
 
     

     

 
    
 
   
 
    
     [bookmark: pgfId-1321962][bookmark: 50983]Feature History for the Identity Firewall

 
     [bookmark: pgfId-1294628] Table 38-1  lists the release history for this feature. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1294655]\

 
     
      
       
        [bookmark: pgfId-1294632]Table 38-1 [bookmark: 12416]Feature History for the Identity Firewall

 
       
      
        
        		
          
          [bookmark: pgfId-1294638]Feature Name
         
  
        		
          
          [bookmark: pgfId-1294640]Releases
         
  
        		
          
          [bookmark: pgfId-1294642]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1294644]Identity Firewall

  
        		 [bookmark: pgfId-1294646]8.4(2)

  
        		 [bookmark: pgfId-1304094]The Identity Firewall feature was introduced.

  [bookmark: pgfId-1549524]We introduced or modified the following screens:

  [bookmark: pgfId-1394145]Configuration > Firewall > Identity Options
 Configuration > Firewall > Objects > Local User Groups
 Monitoring > Properties > Identity.
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     [bookmark: pgfId-1052814][bookmark: 16034]Configuring the Local Database for AAA
      
      
 
     
 

 
     [bookmark: pgfId-1052815]This chapter describes how to configure local servers for AAAand includes the following sections:

 
     
     		 [bookmark: pgfId-1052820]Information About the Local Database

 
     		 [bookmark: pgfId-1217710]Fallback Support

 
     		 [bookmark: pgfId-1217722]How Fallback Works with Multiple Servers in a Group

 
     		 [bookmark: pgfId-1052824]Licensing Requirements for the Local Database

 
     		 [bookmark: pgfId-1052828]Guidelines and Limitations

 
     		 [bookmark: pgfId-1052832]Adding a User Account to the Local Database

 
     		 [bookmark: pgfId-1234167]Testing Local Database Authentication and Authorization

 
     		 [bookmark: pgfId-1052840]Monitoring the Local Database

 
     		 [bookmark: pgfId-1052844]Feature History for the Local Database

 
    

 
   
 
    
     [bookmark: pgfId-1052852][bookmark: 17790]Information About the Local Database[bookmark: marker-1052851]

 
     [bookmark: pgfId-1217437]You can use the local database for the following functions:

 
     
     		 [bookmark: pgfId-1217441]ASDM per-user access

 
     		 [bookmark: pgfId-1217442]Console authentication

 
     		 [bookmark: pgfId-1217443]Telnet and SSH authentication

 
     		 [bookmark: pgfId-1217444] enable command authentication

 
    

 
     [bookmark: pgfId-1217448]This setting is for CLI-access only and does not affect the ASDM login.

 
     
     		 [bookmark: pgfId-1217449]Command authorization 

 
    

 
     [bookmark: pgfId-1217453]If you turn on command authorization using the local database, then the ASA refers to the user privilege level to determine which commands are available. Otherwise, the privilege level is not generally used. By default, all commands are either privilege level 0 or level 15. ASDM allows you to enable three predefined privilege levels, with commands assigned to level 15 (Admin), level 5 (Read Only), and level 3 (Monitor Only). If you use the predefined levels, then assign users to one of these three privilege levels.

 
     
     		 [bookmark: pgfId-1217457]Network access authentication

 
     		 [bookmark: pgfId-1217458]VPN client authentication

 
    

 
     [bookmark: pgfId-1217459]For multiple context mode, you can configure usernames in the system execution space to provide individual logins at the CLI using the  login command; however, you cannot configure any AAA rules that use the local database in the system execution space.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1217586]Note You cannot use the local database for network access authorization.


     
     
 
    

    

 
   
 
    
     [bookmark: pgfId-1217597][bookmark: 78797]Fallback Support

 
     [bookmark: pgfId-1216036]The local database can act as a fallback method for several functions. This behavior is designed to help you prevent accidental lockout from the ASA.

 
     [bookmark: pgfId-1218013]When a user logs in, the servers in the group are accessed one at a time, starting with the first server that you specify in the configuration, until a server responds. If all servers in the group are unavailable, the ASA tries the local database if you have configured it as a fallback method (for management authentication and authorization only). If you do not have a fallback method, the ASA continues to try the AAA servers.

 
     [bookmark: pgfId-1053521]For users who need fallback support, we recommend that their usernames and passwords in the local database match their usernames and passwords on the AAA servers. This practice provides transparent fallback support. Because the user cannot determine whether a AAA server or the local database is providing the service, using usernames and passwords on AAA servers that are different than the usernames and passwords in the local database means that the user cannot be certain which username and password should be given.

 
     [bookmark: pgfId-1053522]The local database supports the following fallback functions:

 
     
     		 [bookmark: pgfId-1053523]Console and enable password authentication—If the servers in the group are all unavailable, the ASA uses the local database to authenticate administrative access, which can also include enable password authentication.

 
     		 [bookmark: pgfId-1053527]Command authorization—If the TACACS+ servers in the group are all unavailable, the local database is used to authorize commands based on privilege levels.

 
     		 [bookmark: pgfId-1217526]VPN authentication and authorization—VPN authentication and authorization are supported to enable remote access to the ASA if AAA servers that normally support these VPN services are unavailable. When a VPN client of an administrator specifies a tunnel group configured to fallback to the local database, the VPN tunnel can be established even if the AAA server group is unavailable, provided that the local database is configured with the necessary attributes.

 
    

 
   
 
    
     [bookmark: pgfId-1217655][bookmark: 91498]How Fallback Works with Multiple Servers in a Group

 
     [bookmark: pgfId-1217656]If you configure multiple servers in a server group and you enable fallback to the local database for the server group, fallback occurs when no server in the group responds to the authentication request from the ASA. To illustrate, consider this scenario:

 
     [bookmark: pgfId-1217660]You configure an LDAP server group with two Active Directory servers, server 1 and server 2, in that order. When the remote user logs in, the ASA attempts to authenticate to server 1.

 
     [bookmark: pgfId-1217667]If server 1 responds with an authentication failure (such as user not found), the ASA does not attempt to authenticate to server 2. 

 
     [bookmark: pgfId-1217668]If server 1 does not respond within the timeout period (or the number of authentication attempts exceeds the configured maximum), the ASA tries server 2.

 
     [bookmark: pgfId-1217675]If both servers in the group do not respond, and the ASA is configured to fall back to the local database, the ASA tries to authenticate to the local database.

 
   
 
    
     [bookmark: pgfId-1217569][bookmark: 64095][bookmark: 29939][bookmark: 77027]Licensing Requirements for the Local Database

 
     [bookmark: pgfId-1238236] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1238229]Model
         
  
        		
          
          [bookmark: pgfId-1238231]License Requirement
         
  
       

 
        
        		 [bookmark: pgfId-1238233]All models

  
        		 [bookmark: pgfId-1238235]Base License.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1053631][bookmark: 54199]Guidelines and Limitations

 
     [bookmark: pgfId-1053632]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1053633]Context Mode Guidelines

 
     [bookmark: pgfId-1053634]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1053635]Firewall Mode Guidelines

 
     [bookmark: pgfId-1053636]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1053637]IPv6 Guidelines

 
     [bookmark: pgfId-1053638]Supports IPv6.

 
     [bookmark: pgfId-1218094]Additional Guidelines

 
     [bookmark: pgfId-1218080]To prevent lockout from the ASA when using the local database for authentication or authorization, see the “Recovering from a Lockout”.

 
   
 
    
     [bookmark: pgfId-1217137][bookmark: 85665][bookmark: 23262][bookmark: 89869]Adding a User Acc[bookmark: marker-1217130]ount to the Local Dat[bookmark: marker-1217131]aba[bookmark: marker-1217132]se

 
     [bookmark: pgfId-1055089][bookmark: 97852]To add a user to the local database, perform the following steps:

 
     
      [bookmark: pgfId-1055126]Detailed Steps

 
     
 
      [bookmark: pgfId-1234186] Step 1[image: ] Choose  Configuration > Device Management > Users/AAA > User Accounts , and then click  Add .

 
      [bookmark: pgfId-1234187]The Add User Account-Identity dialog box appears.

 
      [bookmark: pgfId-1234188]Step 2[image: ] In the Username field, enter a username from 4 to 64 characters long. 

 
      [bookmark: pgfId-1234189]Step 3[image: ] In the Password field, enter a password between 3 and 32 characters. Passwords are case-sensitive. The field displays only asterisks. To protect security, we recommend a password length of at least 8 characters.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1234192]Note To configure the enable password from the User Accounts pane (see the “Configuring the Hostname, Domain Name, and Passwords” section), change the password for the enable_15 user. The enable_15 user is always present in the User Accounts pane, and represents the default username. This method of configuring the enable password is the only method available in ASDM for the system configuration. If you configured other enable level passwords at the CLI (enable password 10, for example), then those users are listed as enable_10, and so on.


      
      
 
     

     

 
      [bookmark: pgfId-1234197]Step 4[image: ] In the Confirm Password field, reenter the password. 

 
      [bookmark: pgfId-1234198]For security purposes, only asterisks appear in the password fields.

 
      [bookmark: pgfId-1234199]Step 5[image: ] To specify the VPN groups that the user belongs to, enter a group name in the Member of field, and click  Add .

 
      [bookmark: pgfId-1234200]To delete a VPN group, choose the group in the window, and click  Delete .

 
      [bookmark: pgfId-1234201]Step 6[image: ] In the Access Restriction area, set the management access level for a user. You must first enable management authorization by clicking the  Perform authorization for exec shell access option on the Configuration > Device Management > Users/AAA > AAA Access > Authorization tab.

 
      [bookmark: pgfId-1234202]Choose one of the following options:

 
      
       
       		 [bookmark: pgfId-1234203] Full Access (ASDM, Telnet, SSH and console) —If you configure authentication for management access using the local database (see the “Configuring Authentication for CLI, ASDM, and enable command Access” section), then this option lets the user use ASDM, SSH, Telnet, and the console port. If you also enable authentication, then the user can access global configuration mode.

 
      

 
     

 
      [bookmark: pgfId-1234207]–[image: ]  Privilege Level —Selects the privilege level for this user to use with local command authorization. The range is 0 (lowest) to 15 (highest). See the  “Configuring Command Authorization” section for more information.

 
      
       
       		 [bookmark: pgfId-1234211] CLI login prompt for SSH, Telnet and console (no ASDM access) —If you configure authentication for management access using the local database (see the “Configuring Authentication for CLI, ASDM, and enable command Access” section), then this option lets the user use SSH, Telnet, and the console port. The user cannot use ASDM for configuration (if you configure HTTP authentication). ASDM monitoring is allowed. If you also configure enable authentication, then the user cannot access global configuration mode.

 
       		 [bookmark: pgfId-1234215] No ASDM, SSH, Telnet, or console access —If you configure authentication for management access using the local database (see the “Configuring Authentication for CLI, ASDM, and enable command Access” section), then this option disallows the user from accessing any management access method for which you configured authentication (excluding the Serial  option; serial access is allowed).

 
      

 
     

 
      [bookmark: pgfId-1234222]Step 7[image: ] (Optional) To enable public key authentication for SSH connections to the ASA on a per-user basis, click one of the following options in the navigation pane:

 
      
      		 [bookmark: pgfId-1234223] Public Key Authentication —Paste in a Base64-encoded public key. You can generate the key using any SSH key generation software (such as ssh keygen) that can generate SSH-RSA raw keys (with no certificates).When you view an existing key, the key is encrypted using a SHA-256 hash. If you need to copy and paste a hashed key, check the  Key is hashed  check box.

 
     

 
      [bookmark: pgfId-1234224]To remove an authentication key, click  Delete Key to display a confirmation dialog box. Click  Yes to remove the authentication key, or click  No to retain it.

 
      
       
       		 [bookmark: pgfId-1234225] Public Key Using PKF —Check the  Specify a new PKF key check box, and paste or import a public key file (PKF) formatted key, up to 4096 bits. Use this format for keys that are too large to paste in Base64 format. For example, you can generate a 4096-bit key using ssh keygen, then convert it to PKF, and import on this pane. When you view an existing key, the key is encrypted using a SHA-256 hash. If you need to copy and paste a hashed key, copy it from the Public Key Athentication pane, and paste it in that pane on the new ASA with the  Key is hashed check box checked.

 
      

 
     

 
      [bookmark: pgfId-1234229]To remove an authentication key, click  Delete Key to display a confirmation dialog box. Click  Yes to remove the authentication key, or click  No to retain it.

 
      [bookmark: pgfId-1234230]Step 8[image: ] Click VPN Policy to configure VPN policy attributes for this user. See the Configuring VPN Policy Attributes for a Local User section in the VPN configuration guide.

 
      [bookmark: pgfId-1234237]Step 9[image: ] Click  Apply .

 
      [bookmark: pgfId-1234238]The user is added to the local database, and the changes are saved to the running configuration.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1234239]Tip You can search for specific text in each column of the Configuration > Device Management > Users/AAA > User Accounts pane. Enter the specific text that you want to locate in the Find box, then click the Up or Down arrow. You can also use the asterisk (“*”) and question mark (“?”) as wild card characters in the text search.


      
      
 
     

     

 
      [bookmark: pgfId-1234240]


      
      
 
     
  
     

 
      [bookmark: pgfId-1221264]The following example generates a shared key for SSH on a Linux or Macintosh system, and imports it to the ASA:

 
     
 
      [bookmark: pgfId-1221329] Step 1[image: ] Generate the ssh-rsa public and private keys for 4096 bits on your computer:

 
     
      [bookmark: pgfId-1221653]jcrichton-mac:~ john$ ssh-keygen -b 4096
     

     
      [bookmark: pgfId-1221654]Generating public/private rsa key pair.
     

     
      [bookmark: pgfId-1221655]Enter file in which to save the key (/Users/john/.ssh/id_rsa): 
     

     
      [bookmark: pgfId-1221656]/Users/john/.ssh/id_rsa already exists.
     

     
      [bookmark: pgfId-1221657]Overwrite (y/n)? y
     

     
      [bookmark: pgfId-1221661]Enter passphrase (empty for no passphrase): pa$$phrase
     

     
      [bookmark: pgfId-1221662]Enter same passphrase again: pa$$phrase
     

     
      [bookmark: pgfId-1221663]Your identification has been saved in /Users/john/.ssh/id_rsa.
     

     
      [bookmark: pgfId-1221664]Your public key has been saved in /Users/john/.ssh/id_rsa.pub.
     

     
      [bookmark: pgfId-1221665]The key fingerprint is:
     

     
      [bookmark: pgfId-1221666]c0:0a:a2:3c:99:fc:00:62:f1:ee:fa:f8:ef:70:c1:f9 john@jcrichton-mac
     

     
      [bookmark: pgfId-1221667]The key's randomart image is:
     

     
      [bookmark: pgfId-1221668]+--[ RSA 4096]----+
     

     
      [bookmark: pgfId-1221669]| . |
     

     
      [bookmark: pgfId-1221670]| o . |
     

     
      [bookmark: pgfId-1221671]|+... o |
     

     
      [bookmark: pgfId-1221672]|B.+..... |
     

     
      [bookmark: pgfId-1221673]|.B ..+ S |
     

     
      [bookmark: pgfId-1221674]| = o |
     

     
      [bookmark: pgfId-1221675]| + . E |
     

     
      [bookmark: pgfId-1221676]| o o |
     

     
      [bookmark: pgfId-1221677]| ooooo |
     

     
      [bookmark: pgfId-1221678]+-----------------+
     

     
      [bookmark: pgfId-1221725] 
     

      [bookmark: pgfId-1221621]Step 2[image: ] Convert the key to PKF format:

 
     
      [bookmark: pgfId-1221819]jcrichton-mac:~ john$ cd .ssh
     

     
      [bookmark: pgfId-1221820]jcrichton-mac:.ssh john$ ssh-keygen -e -f id_rsa.pub
     

     
      [bookmark: pgfId-1221821]---- BEGIN SSH2 PUBLIC KEY ----
     

     
      [bookmark: pgfId-1221822]Comment: "4096-bit RSA, converted by ramona@rboersma-mac from OpenSSH"
     

     
      [bookmark: pgfId-1221823]AAAAB3NzaC1yc2EAAAADAQABAAACAQDNUvkgza37lB/Q/fljpLAv1BbyAd5PJCJXh/U4LO
     

     
      [bookmark: pgfId-1221824]hleR/qgIROjpnDaS7Az8/+sjHmq0qXC5TXkzWihvRZbhefyPhPHCi0hIt4oUF2ZbXESA/8
     

     
      [bookmark: pgfId-1221825]jUT4ehXIUE7FrChffBBtbD4d9FkV8A2gwZCDJBxEM26ocbZCSTx9QC//wt6E/zRcdoqiJG
     

     
      [bookmark: pgfId-1221826]p4ECEdDaM+56l+yf73NUigO7wYkqcrzjmI1rZRDLVcqtj8Q9qD3MqsV+PkJGSGiqZwnyIl
     

     
      [bookmark: pgfId-1221827]QbfYxXHU9wLdWxhUbA/xOjJuZ15TQMa7KLs2u+RtrpQgeTGTffIh6O+xKh93gwTgzaZTK4
     

     
      [bookmark: pgfId-1221828]CQ1kuMrRdNRzza0byLeYPtSlv6Lv6F6dGtwlqrX5a+w/tV/aw9WUg/rapekKloz3tsPTDe
     

     
      [bookmark: pgfId-1221829]p866AFzU+Z7pVR1389iNuNJHQS7IUA2m0cciIuCM2we/tVqMPYJl+xgKAkuHDkBlMS4i8b
     

     
      [bookmark: pgfId-1221830]Wzyd+4EUMDGGZVeO+corKTLWFO1wIUieRkrUaCzjComGYZdzrQT2mXBcSKQNWlSCBpCHsk
     

     
      [bookmark: pgfId-1221831]/r5uTGnKpCNWfL7vd/sRCHyHKsxjsXR15C/5zgHmCTAaGOuIq0Rjo34+61+70PCtYXebxM
     

     
      [bookmark: pgfId-1221832]Wwm19e3eH2PudZd+rj1dedfr2/IrislEBRJWGLoR/N+xsvwVVM1Qqw1uL4r99CbZF9NghY
     

     
      [bookmark: pgfId-1221833]NRxCQOY/7K77IQ==
     

     
      [bookmark: pgfId-1221834]---- END SSH2 PUBLIC KEY ----
     

     
      [bookmark: pgfId-1221835]jcrichton-mac:.ssh john$
     

     
      [bookmark: pgfId-1221346] 
     

      [bookmark: pgfId-1221347]Step 3[image: ] Copy the key to your clipboard.

 
      [bookmark: pgfId-1222044]Step 4[image: ] In ASDM, choose  Configuration > Device Management > Users/AAA > User Accounts , select the username and then click  Edit . Click  Public Key Using PKF  and paste [image: ]the key into the window:

 
      [bookmark: pgfId-1234253] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1221404]Step 5[image: ] Verify the user (test) can SSH to the ASA:

 
     
      [bookmark: pgfId-1221406]jcrichton-mac:.ssh john$ ssh test@10.86.118.5
     

     
      [bookmark: pgfId-1222283]The authenticity of host '10.86.118.5 (10.86.118.5)' can't be established.
     

     
      [bookmark: pgfId-1222284]RSA key fingerprint is 39:ca:ed:a8:75:5b:cc:8e:e2:1d:96:2b:93:b5:69:94.
     

     
      [bookmark: pgfId-1222285]Are you sure you want to continue connecting (yes/no)? yes
     

     
      [bookmark: pgfId-1222457] 
     

      [bookmark: pgfId-1222461]The following dialog box appears for you to enter your passphrase:

 
      [bookmark: pgfId-1222462] 

 
      
      [image: ] 
     
 
      [bookmark: pgfId-1222287]Meanwhile, in the terminal session:

 
     
      [bookmark: pgfId-1222550]Warning: Permanently added '10.86.118.5' (RSA) to the list of known hosts.
     

     
      [bookmark: pgfId-1222288]Identity added: /Users/john/.ssh/id_rsa (/Users/john/.ssh/id_rsa)
     

     
      [bookmark: pgfId-1222289]Type help or '?' for a list of available commands.
     

     
      [bookmark: pgfId-1222290]asa> 
     

     
      [bookmark: pgfId-1222440] 
     

      [bookmark: pgfId-1222445]


      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1234265][bookmark: 14300][bookmark: 93308]Testing Local Database Authentication and Authorization

 
     [bookmark: pgfId-1234269]To determine whether the ASA can contact a local database and authenticate or authorize a user, perform the following steps:

 
    
 
     [bookmark: pgfId-1234270] Step 1[image: ] From the Configuration > Device Management > Users/AAA > AAA Server Groups > AAA Server Groups table, click the server group in which the server resides.

 
     [bookmark: pgfId-1234271]The row is highlighted in the table.

 
     [bookmark: pgfId-1234272]Step 2[image: ] From the Servers in the Selected Group table, click the server that you want to test.

 
     [bookmark: pgfId-1234273]The row is highlighted in the table.

 
     [bookmark: pgfId-1234274]Step 3[image: ] Click  Test .

 
     [bookmark: pgfId-1234275]The Test AAA Server dialog box appears for the selected server.

 
     [bookmark: pgfId-1234276]Step 4[image: ] Click the type of test that you want to perform— Authentication or  Authorization . 

 
     [bookmark: pgfId-1234277]Step 5[image: ] In the Username field, enter a username.

 
     [bookmark: pgfId-1234278]Step 6[image: ] If you are testing authentication, in the Password field, enter the password for the username.

 
     [bookmark: pgfId-1234279]Step 7[image: ] Click  OK .

 
     [bookmark: pgfId-1234286]The ASA sends an authentication or authorization test message to the server. If the test fails, ASDM displays an error message.

 
     [bookmark: pgfId-1234287]


     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1055556][bookmark: 39586]Monitoring the Local Database

 
     [bookmark: pgfId-1055557]To monitor the local database, see the following panes:

 
     [bookmark: pgfId-1055592] 

 
     
      
      
        
        		
          
          [bookmark: pgfId-1055560]Path
         
  
        		
          
          [bookmark: pgfId-1055562]Purpose
         
  
       

 
        
        		 [bookmark: pgfId-1055565]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055567]Shows the configured database statistics.

  
       

 
        
        		 [bookmark: pgfId-1055571]  Monitoring > Properties > AAA Servers

  
        		 [bookmark: pgfId-1055573]Shows the AAA server running configuration.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-1055623][bookmark: 89792][bookmark: 21826]Feature History for the Local Database

 
     [bookmark: pgfId-1055627] Table 33-1  lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1055667] 

 
     
      
       
        [bookmark: pgfId-1225286]Table 33-1 [bookmark: 67500]Feature History for the Local Database

 
       
      
        
        		
          
          [bookmark: pgfId-1225292]Feature Name
         
  
        		
          
          [bookmark: pgfId-1225294]Platform Releases
         
  
        		
          
          [bookmark: pgfId-1225296]Feature Information
         
  
       

 
        
        		 [bookmark: pgfId-1225298]Local database configuration for AAA

  
        		 [bookmark: pgfId-1225300]7.0(1)

  
        		 [bookmark: pgfId-1225302]Describes how to configure the local database for AAA use.

  [bookmark: pgfId-1234302]We introduced the following screens:

  [bookmark: pgfId-1225306]Configuration > Device Management > Users/AAA > AAA Server Groups
 Configuration > Device Management > Users/AAA > User Accounts.

  
       

 
        
        		 [bookmark: pgfId-1225375]Support for SSH public key authentication

  
        		 [bookmark: pgfId-1225350]9.1(2)

  
        		 [bookmark: pgfId-1225355]You can now enable public key authentication for SSH connections to the ASA on a per-user basis. You can specify a public key file (PKF) formatted key or a Base64 key. The PKF key can be up to 4096 bits. Use PKF format for keys that are too large to for the ASA support of the Base64 format (up to 2048 bits).

  [bookmark: pgfId-1234308]We introduced the following screens:

  [bookmark: pgfId-1234309]Configuration > Device Management > Users/AAA > User Accounts > Edit User Account > Public Key Authentication
 Configuration > Device Management > Users/AAA > User Accounts > Edit User Account > Public Key Using PKF

  [bookmark: pgfId-1225362] Also available in 8.4(4.1); PKF key format support is only in 9.1(2). 
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